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Legal Notices

Novell, Inc. makes no representations or warranties with respect to the contents or use of this documentation, and 
specifically disclaims any express or implied warranties of merchantability or fitness for any particular purpose. 
Further, Novell, Inc. reserves the right to revise this publication and to make changes to its content, at any time, 
without obligation to notify any person or entity of such revisions or changes.

Further, Novell, Inc. makes no representations or warranties with respect to any software, and specifically disclaims 
any express or implied warranties of merchantability or fitness for any particular purpose. Further, Novell, Inc. 
reserves the right to make changes to any and all parts of Novell software, at any time, without any obligation to 
notify any person or entity of such changes.

Any products or technical information provided under this Agreement may be subject to U.S. export controls and the 
trade laws of other countries. You agree to comply with all export control regulations and to obtain any required 
licenses or classification to export, re-export, or import deliverables. You agree not to export or re-export to entities 
on the current U.S. export exclusion lists or to any embargoed or terrorist countries as specified in the U.S. export 
laws. You agree to not use deliverables for prohibited nuclear, missile, or chemical biological weaponry end uses. 
Please refer to www.novell.com/info/exports/ for more information on exporting Novell software. Novell assumes no 
responsibility for your failure to obtain any necessary export approvals.

Copyright © 2003-2005 Novell, Inc. All rights reserved. No part of this publication may be reproduced, photocopied, 
stored on a retrieval system, or transmitted without the express written consent of the publisher.

Novell, Inc. has intellectual property rights relating to technology embodied in the product that is described in this 
document. In particular, and without limitation, these intellectual property rights may include one or more of the U.S. 
patents listed at http://www.novell.com/company/legal/patents/ and one or more additional patents or pending patent 
applications in the U.S. and in other countries.

Novell, Inc.
404 Wyman Street, Suite 500
Waltham, MA 02451
U.S.A.
www.novell.com

Online Documentation: To access the online documentation for this and other Novell products, and to get 
updates, see www.novell.com/documentation.
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Novell Trademarks

C3PO is a trademark of Novell, Inc.
Custom 3rd-Party Object is a trademark of Novell, Inc.
ConsoleOne is a registered trademark of Novell, Inc., in the United States and other countries.
DirXML is a registered trademark of Novell, Inc., in the United States and other countries.
eDirectory is a trademark of Novell, Inc.
Evolution is a trademark of Novell, Inc.
ExteNd is a trademark of Novell, Inc.
GroupWise is a registered trademark of Novell, Inc., in the United States and other countries.
NDS is a registered trademark of Novell, Inc., in the United States and other countries.
NetWare is a registered trademark of Novell, Inc., in the United States and other countries.
NLM is a trademark of Novell, Inc.
Novell is a registered trademark of Novell, Inc., in the United States and other countries.
Novell Client is a trademark of Novell, Inc.
Novell Cluster Services is a trademark of Novell, Inc.
Novell Storage Services is a trademark of Novell, Inc.
QuickFinder is a trademark of Novell, Inc.

Third-Party Materials

All third-party trademarks are the property of their respective owners.
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About This Guide

This Novell® GroupWise® 7 Interoperability Guide helps you use GroupWise in the context of other 
software products. The guide provides assistance with Novell products and third-party products:

For information about additional GroupWise-related software from GroupWise partners, see the 
Novell Partner Product Guide (http://www.novell.com/partnerguide).

Audience

This guide is intended for network administrators who install and administer GroupWise.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comment feature at the bottom of each page of the 
online documentation, or go to www.novell.com/documentation/feedback.html and enter your 
comments there.

Documentation Updates

For the most recent version of the GroupWise 7 Interoperability Guide, visit the Novell GroupWise 
7 documentation Web site (http://www.novell.com/documentation/gw7).

Additional Documentation

For additional GroupWise documentation, see the following guides at the Novell GroupWise 7 
documentation Web site (http://www.novell.com/documentation/gw7):

• Installation Guide
• Administration Guide
• Multi-System Administration Guide
• Troubleshooting Guides
• GroupWise Client User Guides

Documentation Conventions

In Novell documentation, a greater-than symbol (>) is used to separate actions within a step and 
items within a cross-reference path.

Novell Products • Part I, “Novell Cluster Services on NetWare,” on page 15

• Part II, “Novell Cluster Services on Linux,” on page 121

• Part III, “Other Novell Products,” on page 203

Third-Party Products • Part IV, “Microsoft Clustering Services,” on page 213

• Part V, “Non-GroupWise Clients,” on page 281

• Part VI, “Other Third-Party Products,” on page 293
13
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A trademark symbol (TM, ®, etc.) denotes a Novell trademark. An asterisk denotes a third-party 
trademark.

When a single pathname can be written with a backslash for some platforms or a forward slash for 
other platforms, the pathname is presented with a backslash. Users of platforms that require a 
forward slash, such as Linux*, should use forward slashes as required by your software.

When a startup switch can be written with a forward slash for some platforms or a double hyphen for 
other platforms, the startup switch is presented with a forward slash. Users of platforms that require 
a double hyphen, such as Linux, should use double hyphens as required by your software.
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INovell Cluster Services on 
NetWare

Chapter 1, “Introduction to GroupWise 7 and Novell Cluster Services on NetWare,” on page 17
Chapter 2, “Planning GroupWise in a NetWare Cluster,” on page 19
Chapter 3, “Setting Up a Domain and Post Office in a NetWare Cluster,” on page 39
Chapter 4, “Implementing the Internet Agent in a NetWare Cluster,” on page 65
Chapter 5, “Implementing WebAccess in a NetWare Cluster,” on page 83
Chapter 6, “Implementing GroupWise Gateways in a Novell Cluster,” on page 103
Chapter 7, “Monitoring a GroupWise System in a NetWare Cluster,” on page 105
Chapter 8, “Backing Up a GroupWise System in a NetWare Cluster,” on page 107
Chapter 9, “Moving an Existing GroupWise 7 System into a NetWare Cluster,” on page 109
Chapter 10, “Implementing Messenger in a NetWare Cluster,” on page 111
Novell Cluster Services on NetWare 15
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1Introduction to GroupWise 7 and 
Novell Cluster Services on 
NetWare

Before implementing GroupWise® 7 with Novell® Cluster ServicesTM, make sure you have a solid 
understanding of Novell Cluster Services by reviewing the following information resources:

• AppNote: An Introduction to Novell Cluster Services (http://developer.novell.com/research/
appnotes/1999/may/01/a990501_.pdf)

• Novell Open Enterprise Server (OES) Product Documentation: OES Novell Cluster 
Services 1.8 Administration Guide for NetWare (http://www.novell.com/documentation/oes/
cluster_admin/data/h4hgu4hs.html#bktitle)

• NetWare 6.5 Product Documentation: Novell Cluster Services (http://www.novell.com/
documentation/ncs65)

• NetWare 6 Product Documentation: Novell Cluster Services (http://www.novell.com/
documentation/ncs6p)

• NetWare 5.1 Product Documentation: Novell Cluster Services (http://www.novell.com/
documentation/ncs)

When you review the information resources recommended above, you discover that clustering 
employs very specialized terminology. The following brief glossary provides basic definitions of 
clustering terms and relates them to your GroupWise system:

cluster: A grouping of from two to 32 NetWare® servers configured using Novell Cluster Services 
so that data storage locations and applications can transfer from one server to another without 
interrupting their availability to users. 

node: A clustered server; in other words, a single NetWare server that is part of a cluster. 

resource: An IP address, volume, application, service, and so on, that can function successfully 
anywhere in the cluster. The volumes where domains and post offices reside are a specific type of 
cluster resources termed “volume resources.” In this section, the terms “cluster resource” and 
“volume resource” are used instead of “resource” to avoid confusion with GroupWise resources 
(such as conference rooms and projectors).

failover: The process of moving cluster resources from a failed node to a functional node so that 
availability to users is uninterrupted. For example, if the node where the POA is running goes down, 
the POA and its post office fail over to a secondary node so that users can continue to use 
GroupWise. When setting up cluster resources, you need to consider what components need to fail 
over together in order to continue functioning.

fan-out-failover: The configuration where cluster resources from a failed node fail over to different 
nodes in order to distribute the load from the failed node across multiple nodes. For example, if a 
node runs a cluster resource consisting of a domain and its MTA, another cluster resource consisting 
of a post office and its POA, and a third cluster resource for WebAccess, each cluster resource can 
be configured to fail over separately to different secondary nodes. 
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failback: The process of returning cluster resources to their preferred node after the situation 
causing the failover has been resolved. For example, if a POA and its post office fail over to a 
secondary node, that cluster resource can be configured to fail back to its preferred node when the 
problem is resolved.

migration: The process of manually moving a cluster resource from its preferred node to a 
secondary node for the purpose of performing maintenance on the preferred node, temporarily 
lightening the load on the preferred node, and so on. 

shared disk system: The hardware housing the physical disk volumes that are shared among the 
cluster nodes. 

shared volume: A volume in a shared disk system that can be accessed from any cluster node that 
needs the data stored on it.

cluster-enabled shared volume: A shared volume for which a Volume Resource object has been 
created in Novell eDirectoryTM. The properties of the Volume Resource object provide load and 
unload scripts for programs installed on the volume, failover/failback/migration policies for the 
volume, and the failover path for the volume. Cluster-enabling is highly recommended for 
GroupWise.

GroupWise volume: As used in this section, a cluster-enabled shared volume that is used for 
GroupWise, such as for storing a domain, post office, software distribution directory, and so on. This 
section also uses the terms Internet Agent volume, WebAccess Agent volume, Messenger volume, 
and gateway volume in a similar manner.

storage area network (SAN): The cluster nodes together with their shared disk system and shared 
volumes.

virtual server: A logical server, rather than a physical server, to which cluster-enabled shared 
volumes are tied.

active/active mode: The configuration of a clustered application where the application runs 
simultaneously on multiple nodes in the cluster. Active/active mode is recommended when the 
GroupWise MTA, POA, Internet Agent, and WebAccess Agent run in protected memory because 
protected memory isolates them from each other, even if they are running on the same node. Active/
active mode is also recommended when configuring the Netscape* Enterprise Server* for use with 
GroupWise WebAccess.

active/passive mode: The configuration of a clustered application where the application runs on 
only one node at a time in the cluster. The GroupWise MTA, POA, Internet Agent, and WebAccess 
Agent must run in active/passive mode if they are not running in protected memory because only 
one instance of each agent/database combination can be running at the same time in the cluster.
7 Interoperability Guide
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2Planning GroupWise in a NetWare 
Cluster

The majority of this part of the GroupWise 7 Interoperability Guide (Chapter 2, “Planning 
GroupWise in a NetWare Cluster,” on page 19 through Chapter 8, “Backing Up a GroupWise 
System in a NetWare Cluster,” on page 107) is designed for those who are creating a new 
GroupWise® system, or at least new domains and post offices, in the context of Novell® Cluster 
ServicesTM. If you already have an existing GroupWise 7 system and need to configure it to work in 
a newly installed cluster, see Chapter 9, “Moving an Existing GroupWise 7 System into a NetWare 
Cluster,” on page 109.

When you implement a new GroupWise system or a new domain or post office in a clustering 
environment, overall GroupWise system design does not need to change substantially. For a review, 
see “Installing a Basic GroupWise System” in the GroupWise 7 Installation Guide. However, the 
configuration of individual components of your GroupWise system will be significantly different. 
This section helps you plan the following GroupWise components in a cluster:

• A new GroupWise system consisting of the primary domain and the initial post office
• A new secondary domain 
• A new post office
• The GroupWise agents (MTA and POA)

During the planning process, component configuration alternatives are explained. For example, you 
might want the domain and post office together on the same shared volume or on different shared 
volumes. You might want to install the agents to standard sys:\system directories or to 
manually created vol:\system directories on shared volumes where domains and post offices 
reside. You might or might not need to run the agents in protected memory. 

The “System Clustering Worksheet” on page 34 lists all the information you need as you set up 
GroupWise in a clustering environment. You should print the worksheet and fill it out as you 
complete the tasks listed below:

• Section 2.1, “Meeting Software Version Requirements,” on page 20
• Section 2.2, “Installing Novell Cluster Services,” on page 20
• Section 2.3, “Planning a New Clustered Domain,” on page 21
• Section 2.4, “Planning a New Clustered Post Office,” on page 22
• Section 2.5, “Planning a New Library for a Clustered Post Office,” on page 23
• Section 2.6, “Deciding Whether to Cluster-Enable the Shared Volumes Used by GroupWise,” 

on page 23
• Section 2.7, “Ensuring Successful Name Resolution for GroupWise Volumes,” on page 25
• Section 2.8, “Deciding How to Install and Configure the Agents in a Cluster,” on page 27
• Section 2.9, “GroupWise Clustering Worksheets,” on page 34

After you have completed the tasks and filled out “System Clustering Worksheet” on page 34, you 
are ready to continue with Chapter 3, “Setting Up a Domain and Post Office in a NetWare Cluster,” 
on page 39.
Planning GroupWise in a NetWare Cluster 19
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2.1  Meeting Software Version Requirements
GroupWise 7 can be clustered on a system that meets the following requirements:

• GroupWise 7
• OES NetWare®

or
NetWare 6.5
or
NetWare 6
or
NetWare 5.1 with Support Pack 3 or higher

IMPORTANT: Novell Cluster Services does not support mixed NetWare versions within a cluster.

2.2  Installing Novell Cluster Services
Install Novell Cluster Services by following the instructions provided in the documentation for your 
version of NetWare, as listed in Chapter 1, “Introduction to GroupWise 7 and Novell Cluster 
Services on NetWare,” on page 17.

The installation process includes:

• Meeting hardware and software requirements
• Setting up a shared disk system
• Creating a new NetWare Cluster object to represent the cluster in Novell eDirectoryTM

• Adding nodes to the cluster
• Installing the Novell Cluster Services software on all nodes in the cluster
• Mounting the shared volumes where you will set up GroupWise domains and post offices and 

install the GroupWise agents

As you install Novell Cluster Services, record key information about the cluster on the System 
Clustering Worksheet:

SYSTEM CLUSTERING WORKSHEET

Under Item 1: Software Version Updates for Cluster, mark any updates required for nodes in the 
cluster to ensure that all nodes in the cluster are running the same version of NetWare.
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The number of nodes and shared volumes that are available in the cluster strongly influences where 
you place GroupWise domains and post offices. You have several alternatives:

• Your whole GroupWise system can run in a single cluster.
• Parts of your GroupWise system can run in one cluster while other parts of it run in one or more 

other clusters.
• Parts of your GroupWise system can run in a cluster while other parts run outside of the cluster, 

on non-clustered servers.

If you do not have the system resources to run all of your GroupWise system in a clustering 
environment, you must decide which parts have the most urgent need for the high availability 
provided by clustering. Here are some suggestions:

• Post offices and their POAs must be available in order for users to access their GroupWise 
mailboxes. Therefore, post offices and their POAs are excellent candidates for the high 
availability provided by clustering.

• In a like manner, WebAccess provides user access to GroupWise mailboxes across the Internet 
through users’ Web browsers. It is another good candidate for clustering.

• Domains and their MTAs are less noticeable to users when they are unavailable (unless users in 
different post offices happen to be actively engaged in an e-mail discussion when the MTA 
goes down). On the other hand, domains and their MTAs are critical to GroupWise 
administrators, although administrators might be more tolerant of a down server than end users 
are. Critical domains in your system would be the primary domain and, if you have one, a hub 
or routing domain. These domains should be in the cluster, even if other domains are not.

• The Internet Agent might or might not require high availability in your GroupWise system, 
depending on the importance of immediate messaging across the Internet and the use of POP3 
or IMAP4 clients by GroupWise users. 

There is no right or wrong way to implement GroupWise in a clustering environment. It all depends 
on the specific needs of your particular GroupWise system and its users.

2.3  Planning a New Clustered Domain
The considerations involved in planning a new domain in a clustering environment are essentially 
the same as for any other environment.

• Primary Domain: If you are setting up a new GroupWise system in a clustering environment, 
you will be creating the primary domain as you complete the tasks in this section. In 
preparation, review “Planning Your Basic GroupWise System”, then print and fill out the 

SYSTEM CLUSTERING WORKSHEET

Under Item 2: eDirectory Tree for Cluster, record the name of the eDirectory tree where the new 
NetWare Cluster object has been created.

Under Item 3: Cluster Name, record the name of the NetWare Cluster object that you created for your 
GroupWise system. 

Under Item 4: Cluster Context, record the full context of the NetWare Cluster object.

Under Item 5: Nodes in Cluster, list the nodes that you have added to the cluster.
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“Basic GroupWise System Worksheet” in “Installing a Basic GroupWise System” in the 
GroupWise 7 Installation Guide. This covers planning the primary domain and an initial post 
office in the primary domain.

• Secondary Domain: If your GroupWise system already exists, you will be creating a new 
secondary domain. In preparation, review “Planning a New Domain”, then print and fill out the 
“Domain Worksheet” in “Domains” in the GroupWise 7 Administration Guide.

Regardless of the type of domain you are creating, keep in mind the following cluster-specific 
details as you fill out the worksheet you need:

• When you specify the location for the domain directory (and for a new GroupWise system, the 
post office directory) on the worksheet, include the shared volume where you want the 
directory to reside.

• Do not concern yourself with the GroupWise agent information on the worksheet. You will 
plan the agent installation later. If you are filling out the Basic GroupWise System Worksheet, 
stop with item 17. If you are filling out the Domain Worksheet, stop with item 10.

When you have completed the worksheet, transfer the key information from the Basic GroupWise 
System Worksheet or the Domain Worksheet to the System Clustering Worksheet.

IMPORTANT: Do not create the new domain until you are instructed to do so in Chapter 3, 
“Setting Up a Domain and Post Office in a NetWare Cluster,” on page 39.

2.4  Planning a New Clustered Post Office
The considerations involved in planning a new post office in a clustering environment are 
essentially the same as for any other environment. The initial post office in a new GroupWise 
system is planned on the Basic GroupWise System Worksheet. To plan additional new post offices, 
review “Planning a New Post Office ”, then print and fill out the “Post Office Worksheet” in “Post 
Offices” in the GroupWise 7 Administration Guide. When you specify the locations for the post 
office directories, include the shared volumes where you want the post office directories to reside. 

When you have completed the worksheet, transfer key information from the Basic GroupWise 
System Worksheet or the Post Office Worksheet to the System Clustering Worksheet.

SYSTEM CLUSTERING WORKSHEET

Under Item 10: Domain Name, transfer the domain name and database directory to the System 
Clustering Worksheet. 

Under Item 7: Shared Volume for Domain, transfer the domain location to the System Clustering 
Worksheet. You will fill out the rest of the information under item 7 later.

SYSTEM CLUSTERING WORKSHEET

Under Item 11: Post Office Name, transfer the post office name and database location to the System 
Clustering Worksheet. 

If you will create the post office on a different shared volume from where the domain is located, under 
Item 8: Shared Volume for Post Office, transfer the post office location to the System Clustering 
Worksheet. You will fill out the rest of the information under item 8 later. 
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IMPORTANT: Do not create the new post office until you are instructed to do so in Chapter 3, 
“Setting Up a Domain and Post Office in a NetWare Cluster,” on page 39.

2.5  Planning a New Library for a Clustered Post 
Office
The considerations involved in planning a new library in a clustering environment are essentially the 
same as for any other environment. You can plan a library for a clustered post office by following 
the standard instructions provided in “Creating and Managing Libraries” in the GroupWise 7 
Administration Guide and filling out the “Basic Library Worksheet” or the “Full-Service Library 
Worksheet”. Then provide the library information on the System Clustering Worksheet.

IMPORTANT: Do not create the new library until you are instructed to do so in Chapter 3, “Setting 
Up a Domain and Post Office in a NetWare Cluster,” on page 39.

2.6  Deciding Whether to Cluster-Enable the 
Shared Volumes Used by GroupWise
Cluster-enabling the shared volumes where domains and post offices reside greatly simplifies 
GroupWise administration. If you are creating a new GroupWise system, you might also want to 
cluster-enable shared volumes for the GroupWise administration snap-ins to ConsoleOne® and for 
the GroupWise software distribution directory so that these locations are always available within the 
cluster. To review the concept of cluster-enabled shared volumes, see the applicable section of 
clustering documentation for your version of NetWare, as listed in Chapter 1, “Introduction to 
GroupWise 7 and Novell Cluster Services on NetWare,” on page 17.

The advantages of cluster-enabling GroupWise volumes include:

• Drive mappings always occur through the virtual server associated with the cluster-enabled 
volume, rather than through a physical server. This guarantees that you can always map a drive 
to the domain or post office database no matter which node it is currently located on. 

• The GroupWise snap-ins to ConsoleOne always work no matter which node is running 
ConsoleOne. 

• Cluster-enabling the domain volume and installing the GroupWise agents to this volume 
guarantees that the GroupWise snap-ins to ConsoleOne can always find the configuration files 
that they need to access. 

• When you rebuild a domain database or a post office database, you do not need to determine 
which node the database is currently located on. 

• Help desk personnel do not need to be trained to determine where GroupWise is running before 
they connect to a domain to create a new GroupWise user. 

SYSTEM CLUSTERING WORKSHEET

Under Item 14: Library Location, mark where you want to create the library’s document storage area. 

If the document storage area will be located outside the post office directory structure, specify a user 
name and password that the POA can use to access the volume where the document storage area 
will reside.
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When you cluster-enable a volume, additional eDirectory objects are created:

Table 2-1   eDirectory Objects

IMPORTANT: Notice that the default object names include the underscore (_) character. Some 
DNS name servers cannot resolve object names that include underscore characters. If you have met 
the system requirements described in Section 2.1, “Meeting Software Version Requirements,” on 
page 20, you can rename these objects as needed when you cluster enable the volume.

Cluster-enabling the shared volumes used by GroupWise is highly recommended. Throughout the 
rest of this document, the term “GroupWise volume” means “a cluster-enabled shared volume used 
by GroupWise.”

eDirectory 
Object Object Name and Description

clustername_volumename (default object name)
A new Volume object represents the cluster-enabled volume. It is created by renaming 
the original Volume object that was tied to a physical server and associating it with a 
virtual server instead.

For example, if your cluster name is GWCLUSTER and your original volume name is 
gwvol1, the new Volume object representing the cluster-enabled volume is named 
gwcluster_gwvol1.

clustername_volumename_SERVER (default object name)
A new Server object represents the virtual server to which the new cluster-enabled 
volume is tied.

Continuing with the above example, the new Server object representing the virtual server 
is named GWCLUSTER_GWVOL1_SERVER.

volumename_SERVER.clustername (default object name)
A new Volume Resource object stores property information for the cluster-enabled 
volume, such as start, failover, and failback mode information and load/unload scripts. 
These modes and scripts enable the cluster-enabled volume to function much like an 
independent server; hence, the SERVER portion of its name. The Volume Resource 
object is created in the Cluster container object. 

Continuing with the above example, the new Volume Resource object is named 
GWVOL1_SERVER.GWCLUSTER.
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IMPORTANT: Because cluster-enabling the volumes where domains and post offices reside is so 
strongly recommended, this documentation does not include the steps for setting up domains and 
post offices on non-cluster-enabled volumes. If you decide not to cluster-enable GroupWise 
volumes, you should adjust the steps presented in this documentation for your system’s specialized 
needs. Novell Cluster Services does provide a GroupWise Mail Server template for use when 
creating GroupWise Cluster Resource objects instead of cluster-enabled Volume Resource objects. 

2.7  Ensuring Successful Name Resolution for 
GroupWise Volumes
Because you are using cluster-enabled volumes for GroupWise domains and post offices, you must 
ensure that short name resolution is always successful. For example, in ConsoleOne, if you right-
click a Domain object in the GroupWise View and then click Connect, ConsoleOne must be able to 
resolve the domain database location, as provided in the UNC Path field, to the network address of 
the current, physical location of that domain within your cluster. It is through short name resolution 
that all GroupWise cluster resources (such as domain and post office volumes) are accessed and 
managed in ConsoleOne.

A client program (such as ConsoleOne) that runs on a Windows* workstation, can be configured to 
use several different short name resolution methods. To see which methods are in use at a particular 
workstation, view the protocol preferences for the Novell ClientTM that is installed on the Windows 
workstation:

SYSTEM CLUSTERING WORKSHEET

Under Item 6: Shared Volumes for GroupWise Administration, list any shared volumes you want to 
use for GroupWise administration purposes. For example, you might have a shared pub: volume with 
a public directory where you install the GroupWise snap-ins to ConsoleOne instead of installing them 
on multiple administrator workstations. You might have a shared apps: volume where you create the 
GroupWise software distribution directory. Mark whether or not you want to cluster-enable the 
GroupWise administration volumes.

Under Item 7: Shared Volume for Domain, specify the name of the shared volume where you will 
create the domain. Mark whether or not you want to cluster-enable the domain volume. Also mark 
whether you will place the post office on the same volume with the domain.

If you want the post office on a different volume from where the domain is located, under Item 8: 
Shared Volume for Post Office, specify the name of the shared volume where you will create the post 
office. Mark whether or not you want to cluster-enable the post office volume. 
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Figure 2-1   Novell Client Preferences Property Page

Short name resolution methods that pertain to clustering your GroupWise system are discussed 
below:

Table 2-2   Short Name Resolution Methods

Short 
Name 
Resolution 
Method

Description

eDirectory You can use eDirectory to resolve short names into specific network addresses. However, 
when using eDirectory for short name resolution, you must remember to consider current 
context in the name resolution process. eDirectory short name resolution works only if 
your current context is the same as the context of the eDirectory object you need to 
access.

Hosts Files Windows uses the following files when performing short name resolution at the 
workstation:

• Windows 2000/XP/2003: 
\winnt\system32\drivers\etc\hosts

Using these files at the Windows workstation is not a preferred method for TCP/IP name 
resolution (except perhaps for the administrator’s workstation).

However, whenever you cluster-enable a volume, you should add its virtual server to the 
sys:\etc\hosts file of all nodes in the cluster. 
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Specific setup instructions for each of these short name resolution methods will be provided in 
Chapter 3, “Setting Up a Domain and Post Office in a NetWare Cluster,” on page 39.

2.8  Deciding How to Install and Configure the 
Agents in a Cluster
There are several cluster-specific issues to consider as you plan to install the NetWare MTA and 
POA in your clustered GroupWise system:

• “Planning Secondary IP Addresses and Cluster-Unique Port Numbers for Agents in the 
Cluster” on page 27

• “Determining Appropriate Failover Paths for the Agents” on page 29
• “Deciding Where to Install the Agent Software” on page 30
• “Deciding Whether to Run the Agents in Protected Memory” on page 32
• “Planning the NetWare Agent Installation” on page 33

2.8.1  Planning Secondary IP Addresses and Cluster-Unique 
Port Numbers for Agents in the Cluster
The GroupWise agents listen on all IP addresses, both primary and secondary, that are bound to the 
server on their specified port numbers. This means that any time there is a possibility of two of the 
same type of agent loading on the same node, it is important that each agent use a cluster-unique port 

DNS Perhaps the most common short name resolution option is Domain Name Service (DNS). 
As with the HOSTS file, it is good practice to place all of your virtual servers into DNS. 

For short name resolution to work using DNS, the client workstation must either belong to 
the same DNS zone (such as support.novell.com) as the cluster resource, or the cluster 
resource zone must be configured in the client’s DNS suffix search path under TCP/IP 
settings for the workstation.

The underscore (_) character is part of default cluster-related object names. Because it is 
not supported by the DNS RFC, some DNS name servers cannot resolve default cluster-
related object names. If you are using such a DNS name server on NetWare 5.1, make 
sure you have installed the latest Novell Cluster Services snap-in to ConsoleOne, so that 
you can change cluster-related object names as needed to remove the underscore 
characters.

SLP NetWare 6.x and NetWare 5.1 both use Service Location Protocol (SLP) to advertise 
service information across TCP/IP-based networks, which provides short name resolution 
of TCP/IP-based cluster resources within the network. On NetWare 6.x, Novell Cluster 
Services propagates virtual server information into SLP by default.

On NetWare 5.1, Novell Cluster Services does not propagate virtual server information 
into SLP by default. If you want to propagate virtual server information to SLP on 
NetWare 5.1, you can run the (unsupported) CVSBIND utility, which gives you reliable 
short name resolution within your cluster regardless of shortcomings you might encounter 
with other name resolution methods. 

Short 
Name 
Resolution 
Method

Description
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number, even though each agent is using a unique secondary IP address. The best way for you to 
avoid port conflicts is to plan your cluster so that each agent in the cluster runs on a cluster-unique 
port. Print out a copy of the “IP Address Worksheet” on page 36 to help you plan secondary IP 
addresses and cluster-unique port numbers for all GroupWise agents.

The following filled-out version of the IP Address Worksheet illustrates one way this can be done:

Domain Information

Post Office Information

Internet Agent Information

WebAccess Information

This example places the Development post office on the same node and on the same GroupWise 
volume with the Provo1 domain; therefore, the Provo1 MTA and the Development POA can use the 
same secondary IP address. The Manufacturing post office is placed on a different node on a 
different GroupWise volume, so that the Manufacturing post office has a different secondary IP 
address.

Domain MTA
IP Address

MTA 
MTP Port

MTA 
HTTP Port

Provo1 172.16.5.81 7100 7180

Post Office POA
IP Address

POA 
C/S Port

POA 
MTP Port

POA 
HTTP Port

Development (same as MTA) 1677 7101 7181

Manufacturing 172.16.5.82 1678 7102 7182

Internet Agent GWIA
IP Address

MTA 
MTP Port

MTA Live 
Remote Port

MTA 
HTTP 
Port

GWIA 
HTTP Port

GWIA Domain
MTA

172.16.5.83 7110 7677 7183 N/A

Internet Agent 
(GWIA)

(same as MTA) N/A N/A N/A 9850

WebAccess Agent WebAccess 
IP Address

MTA 
MTP Port

MTA 
HTTP Port

WebAccess 
Agent Port

WebAccess
HTTP Port

WebAccess 
Domain MTA

172.16.5.84 7120 7184 N/A N/A

WebAccess Agent 
(GWINTER)

(same as MTA) N/A N/A 7205 7205
(same as agent)
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The example also illustrates that the MTA, the POA, and the Internet Agent use different port 
numbers for agent ports and HTTP ports. In contrast, the WebAccess Agent uses the same port 
number for the agent port and the HTTP port.

The example uses default port numbers where possible. For example, the default MTA message 
transfer port is 7100 and the default POA client/server port is 1677. Incrementing port numbers are 
used in the example when multiple components have the same type of ports. For example, port 
numbers 1677 and 1678 are both POA client/server ports and port numbers 7180 through 7184 are 
all HTTP ports. Incrementing from the default port numbers generates unique, though related, port 
numbers. 

If you are going to set up a GroupWise name server to help GroupWise clients locate their post 
offices, make sure that the default POA port number of 1677 is used somewhere in the cluster. For 
more information, see “Simplifying Client/Server Access with a GroupWise Name Server” in “Post 
Office Agent” in the GroupWise 7 Administration Guide.

After you have filled out the IP Address Worksheet, transfer the secondary IP addresses and cluster-
unique port numbers from the IP Address Worksheet to the System Clustering Worksheet and the 
Agent Clustering Worksheet so that they are available in the sequence in which you will need them 
as you set up GroupWise in a cluster.

2.8.2  Determining Appropriate Failover Paths for the Agents
By default, a GroupWise volume is configured to have all nodes in the cluster in its failover path, 
organized in ascending alphanumeric order. Only one node at a time can have a particular 
GroupWise volume mounted and active. If a GroupWise volume’s preferred node fails, the volume 

IP ADDRESS WORKSHEET

Fill out the “IP Address Worksheet” on page 36 to help you plan secondary IP addresses and cluster-
unique port numbers for all GroupWise agents in the cluster. (MTA, POA, Internet Agent, WebAccess 
Agent).

SYSTEM CLUSTERING WORKSHEET

If you are setting up a new GroupWise system, under Item 6: Shared Volumes for GroupWise 
Administration, specify secondary IP addresses for your GroupWise administration volumes.

Under Item 7: Shared Volume for Domain, use the domain MTA secondary IP address from the IP 
Address Worksheet as the domain volume IP address.

If you are planning the post office on a different volume from the domain, under Item 8: Shared 
Volume for Post Office, use the post office POA secondary IP address from the IP Address 
Worksheet as the post office volume IP address.

AGENT CLUSTERING WORKSHEET

Under Item 4: MTA Network Information, transfer the secondary IP address and cluster-unique port 
numbers for the MTA from the IP Address Worksheet to the Agent Clustering Worksheet.

Under Item 7: POA Network Information, transfer the secondary IP address and cluster-unique port 
numbers for the POA from the IP Address Worksheet to the Agent Clustering Worksheet.
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fails over to the next node in the failover path. You will want to customize the failover path for each 
GroupWise volume based on the fan-out-failover principle.

When a node fails, its volumes should not all fail over together to the same secondary node. Instead, 
the volumes should be distributed across multiple nodes in the cluster. This prevents any one node 
from shouldering the entire processing load typically carried by another node. In addition, some 
volumes should never have the potential of being mounted on the same node during a failover 
situation. For example, a post office and POA that service a large number of very active GroupWise 
client users should never fail over to a node where another very large post office and heavily loaded 
POA reside. If they did, users on both post offices would notice a decrease in responsiveness of the 
GroupWise client.

2.8.3  Deciding Where to Install the Agent Software 
When you install the NetWare MTA and POA in a clustering environment, you can choose between 
two different installation locations:

Table 2-3   Agent Software Installation Locations

A simple way to look at the agent location alternatives would be that if you have fewer nodes on 
failover paths than you have GroupWise volumes for domains and post offices, then it would be 
most efficient to install the agent software to the nodes. Conversely, if you have fewer GroupWise 
volumes than you have nodes on failover paths, then it would be most efficient to install the agent 

AGENT CLUSTERING WORKSHEET

Under Item 3: Domain Failover Path, list the nodes that you want to have in the domain volume 
failover path. The MTA might need to run on any node that the domain volume fails over to.

If you are planning the post office on a different GroupWise volume from where the domain is located, 
under Item 6: Post Office Failover Path, list the nodes that you want to have in the post office volume 
failover path. The POA might need to run on any node that the post office volume fails over to.

Location Description

sys:\system 
on each node
in the cluster

This is the default location provided by the Agent Installation program. Because 
the agents must be installed on each node where they might need to run during 
a failover situation, you need to do one of the following if you select this 
alternative:

• Run the Agent Installation program multiple times in order to install the 
agent software and to create the agent startup files on each node that is 
on a GroupWise volume failover path.

• Run the Agent Installation program, then copy the agent software and 
startup files to each node that is on a GroupWise volume failover path.

system directory 
on each GroupWise 
volume

If you create a vol:\system directory on a GroupWise volume, the agent 
software and startup files fail over and back with the domains and post offices 
that the agents service.

Unless you have a very small GroupWise system with all domains and post 
offices on a single GroupWise volume, you still need to install the agent 
software multiple times, once to each GroupWise volume.
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software to the GroupWise volumes. However, there are issues to consider that extend beyond 
efficiency during installation.

The following sections can help you choose which installation location would be best for your 
clustered GroupWise system:

• “Advantages of a vol:\system Directory on Each GroupWise Volume” on page 31
• “Disadvantages of a vol:\system Directory on Each GroupWise Volume” on page 31
• “Recommendation” on page 31

Advantages of a vol:\system Directory on Each GroupWise Volume

Using a vol:\system directory on each GroupWise volume has several advantages:

• If you change information in the agent startup files, you only need to change it in one place, not 
on every node on any GroupWise volume failover path. 

• Having the agent startup files on the same GroupWise volume as the domain or post office 
makes them easy to find. 

• When you update the agent software, you only need to update it in one place for a particular 
domain or post office, not on every node on a GroupWise volume failover path. This prevents 
the potential problem of having a domain or post office fail over to a location where a different 
version of the agent software is installed.

• If you ever need to add or replace a physical server in the cluster, you only need to install 
NetWare and Novell Cluster Services to the new server, then add that node to the appropriate 
failover paths. No extra GroupWise configuration is necessary because there are no 
sys:\system dependencies for the GroupWise agents. 

• If you want to back up the GroupWise software, you do not have to include the 
sys:\system directory in the backup.

Disadvantages of a vol:\system Directory on Each GroupWise Volume

Installing the agents on a GroupWise volume does have some disadvantages:

• GroupWise administrators who are used to the GroupWise agents being installed in 
sys:\system might be confused by not finding them there in the clustered GroupWise 
system.

• You must remember where you installed the GroupWise agents when you update the agent 
software. Accidently installing a GroupWise Support Pack to the default location of 
sys:\system would not have the desired results if the original agent software was installed 
to the vol:\system directory on a GroupWise volume.

Recommendation

Whichever method you choose, be consistent throughout the entire cluster. Either put all the 
GroupWise agents on the GroupWise volumes with the domains and post offices they service, or put 
them all in sys:\system directories. If you put them on GroupWise volumes, make sure there are 
no agent files in sys:\system directories to confuse the issue at a later time.

Even if you choose to install the agents to multiple sys:\system directories, you can still store 
the agent startup files on the GroupWise volumes. The significant advantage of this approach is that 
you only have one startup file to modify per agent.
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2.8.4  Deciding Whether to Run the Agents in Protected 
Memory
On a NetWare server, using protected memory allows you to create isolated memory spaces where 
NLMTM programs can run without affecting other NLM programs running on the same node. This 
contributes to the high availability of the cluster. Using protected memory has the following 
advantages:

• When using protected memory, the node can restart a specific memory space if any NLM 
program within that memory space abends. This allows for recovery without failing the entire 
node, which enhances both up time and database integrity.

• Using protected memory gives you the ability to unload a single instance of an agent, rather 
than all instances.

• If you use protected memory, you can run the agents in active/active mode, rather than active/
passive mode.

If you have any possibility of the same type of GroupWise agent loading multiple times on any node 
in the cluster, you must use protected memory so that you can unload agents individually. Check 
your failover paths (Agent Clustering Worksheet items 3 and 6) for failover combinations where 
multiple instances of the same type of agent might need to run on the same node.

Protected memory does result in higher memory utilization (about 5% to 10%) and a slight 
performance penalty. Make sure your nodes have sufficient memory to handle the number of 
memory spaces that might reside on them. Keep in mind that if you load the MTA and the POA in 
different memory spaces, the agent engine (gwenn5.nlm) will load twice on the node. Remember 
to provide memory for any GroupWise volumes that could fail over to a node, in addition to that 
node’s regular processing load.

AGENT CLUSTERING WORKSHEET

Under Item 1: Agent Installation Location, mark whether you will install the agent software to a 
vol:\system directory on a GroupWise volume or to sys:\system on each node in the cluster. If 
necessary, specify where the agent startup files will be stored.

Under Item 2: Domain Name, transfer the domain name and location from the System Clustering 
Worksheet to the Agent Clustering Worksheet.

Under Item 5: Post Office Name, transfer the post office name and location from the System 
Clustering Worksheet to the Agent Clustering Worksheet.
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2.8.5  Planning the NetWare Agent Installation
Aside from the cluster-specific issues discussed in the preceding sections, the considerations 
involved in planning to install the GroupWise NetWare agents are the same in a clustering 
environment as for any other environment. Review “Planning the GroupWise Agents”, then print 
and fill out the “GroupWise Agent Installation Worksheet” in “Installing GroupWise Agents” in the 
GroupWise 7 Installation Guide for each location where you will install the NetWare MTA and/or 
POA. 

Fill out the NetWare Agent Worksheet, taking into account the following cluster-specific issues: 

AGENT CLUSTERING WORKSHEET

Under Item 8: Load Agents in Protected Memory?, mark whether or not you need to run the 
GroupWise agents in protected memory. 

If you will use protected memory, provide one or two unique protected memory space names. If you 
will create the domain and post office on the same GroupWise volume, the MTA and POA can use the 
same memory space, although this is not required. If you will create the domain and post office on 
different GroupWise volumes, the MTA and POA must use different memory spaces.

If you will use protected memory, a user name and password for the POA to use to access its post 
office volume might be required, depending on the version of NetWare you are using.

Provide a user name and password if you are using the following versions of NetWare:

• NetWare 5.1 Support Pack 2 or earlier

• Initial release of NetWare 6

A user name and password are no longer needed on the following later versions of NetWare.

• NetWare 5.1 Support Pack 3 or later

• NetWare 6 Support Pack 1 or later

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Item 2: Agents and Locations, mark POA Local to Post Office and MTA Local to Domain. In a 
clustering environment, a domain or post office and its agent must reside on the same GroupWise 
volume in order to fail over together.

Under Item 3: Installation Path, take into account your decision based on “Deciding Where to Install 
the Agent Software” on page 30.

Under Item 4: Configure GroupWise Agents for Clustering, mark Yes. This will cause the Agent 
Installation program to customize the agent startup files for clustering.

Under Item 6: Domains and Item 7: Post Offices, refer to the Domain and Post Office Worksheets you 
filled out in Section 2.3, “Planning a New Clustered Domain,” on page 21 and Section 2.4, “Planning a 
New Clustered Post Office,” on page 22, and to the IP Address Worksheet you completed during 
“Planning Secondary IP Addresses and Cluster-Unique Port Numbers for Agents in the Cluster” on 
page 27.

Under Item 10: Launch GroupWise Agents Now, mark No. You will configure the agents to run in 
protected mode later.
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IMPORTANT: Do not install the NetWare agent software until you are instructed to do so in 
Chapter 3, “Setting Up a Domain and Post Office in a NetWare Cluster,” on page 39.

Continue with Chapter 3, “Setting Up a Domain and Post Office in a NetWare Cluster,” on page 39.

2.9  GroupWise Clustering Worksheets
• “System Clustering Worksheet” on page 34
• “IP Address Worksheet” on page 36
• “Agent Clustering Worksheet” on page 37

2.9.1  System Clustering Worksheet

Item Explanation

1) Software Version Updates
for Cluster:

List any servers that need to be updated so that all nodes in 
the cluster are running the same version of NetWare.

For more information, see Section 2.1, “Meeting Software 
Version Requirements,” on page 20.

2) eDirectory Tree for Cluster: Record the eDirectory tree where you created the new Novell 
Cluster object when you installed Novell Cluster Services.

For more information, see Section 2.2, “Installing Novell 
Cluster Services,” on page 20

3) Cluster Name:

Cluster IP Address:

Record the name of the new NetWare Cluster object that you 
created for your GroupWise system. Also record the virtual IP 
address of the cluster that will remain constant regardless of 
which node is currently active.

For more information, see Section 2.2, “Installing Novell 
Cluster Services,” on page 20.

4) Cluster Context: Record the full context where you created the new NetWare 
Cluster object.

For more information, see Section 2.2, “Installing Novell 
Cluster Services,” on page 20.

5) Nodes in Cluster List the nodes that are part of the cluster that you set up for 
your GroupWise system.

For more information, see Section 2.2, “Installing Novell 
Cluster Services,” on page 20.
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6) Shared Volumes for GroupWise 
Administration:

Cluster Enabled?

• Yes (highly recommended)

Cluster volume IP addresses

• No

GroupWise Administration Snap-ins to 
ConsoleOne

• public directory

• Other

GroupWise Software Distribution 
Directory

• \grpwise\software directory

• Other

Specify the names (cluster_volume) of the shared volumes 
where the GroupWise administration snap-ins to ConsoleOne 
and the GroupWise software distribution directory will reside.

For cluster-enabling, specify the IP addresses of the virtual 
servers (volume_SERVER.cluster) to which the cluster-
enabled volumes are tied.

For more information, see Section 2.6, “Deciding Whether to 
Cluster-Enable the Shared Volumes Used by GroupWise,” on 
page 23.

7) Shared Volume for Domain:

Cluster Enabled?

• Yes (highly recommended)

Cluster volume IP address

• No

Post Office on Same Volume as 
Domain?

• Yes

• No

Specify the name (cluster_volume) of the shared volume 
where the GroupWise domain will reside.

For cluster-enabling, specify the IP address of the virtual 
server (volume_SERVER.cluster) to which the cluster-enabled 
volume is tied.

For more information, see Section 2.4, “Planning a New 
Clustered Post Office,” on page 22 and Section 2.6, “Deciding 
Whether to Cluster-Enable the Shared Volumes Used by 
GroupWise,” on page 23.

8) Shared Volume for Post Office:

Cluster Enabled?

• Yes (highly recommended)

Cluster volume IP address

• No

Specify the name (cluster_volume) of the shared volume 
where the GroupWise post office will reside.

For cluster-enabling, specify the IP address of the virtual 
server (volume_SERVER.cluster) to which the cluster-enabled 
volume is tied.

For more information, see Section 2.4, “Planning a New 
Clustered Post Office,” on page 22 and Section 2.6, “Deciding 
Whether to Cluster-Enable the Shared Volumes Used by 
GroupWise,” on page 23.

9) IP Address Resolution Methods:

• eDirectory

• hosts file

• DNS

• SLP (highly recommended)

Mark the short name address resolution methods you want to 
implement to ensure that the UNC paths stored in ConsoleOne 
can be successfully resolved into physical network addresses.

For more information, see Section 2.7, “Ensuring Successful 
Name Resolution for GroupWise Volumes,” on page 25

Item Explanation
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2.9.2  IP Address Worksheet
• “Domain Information” on page 36
• “Post Office Information” on page 36
• “Internet Agent Information” on page 37
• “WebAccess Information” on page 37

Domain Information

Post Office Information

10) Domain Name:

Domain Database Location:

Specify a unique name for the domain. Specify the directory on 
the GroupWise volume where you want to create the new 
domain.

For more information, see Section 2.3, “Planning a New 
Clustered Domain,” on page 21.

11) Post Office Name:

Post Office Database Location:

Specify a unique name for the post office. Specify the directory 
on the GroupWise volume where you want to create the post 
office.

For more information, see Section 2.4, “Planning a New 
Clustered Post Office,” on page 22.

12) Document Storage Area Location:

• At the post office

• Outside the post office

• Separate post office

Document Storage Area Access

• POA /user startup switch setting

• POA /password startup switch 
setting

If you need a library for a clustered post office, mark where you 
want to create its document storage area and provide a 
directory if necessary.

For more information, see Section 2.5, “Planning a New 
Library for a Clustered Post Office,” on page 23.

Domain MTA
IP Address

MTA 
MTP Port

MTA 
HTTP Port

Post Office POA
IP Address

POA 
C/S Port

POA 
MTP Port

POA 
HTTP Port

Item Explanation
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Internet Agent Information

WebAccess Information

2.9.3  Agent Clustering Worksheet

Internet Agent GWIA
IP Address

MTA 
MTP Port

MTA 
Live Remote 
Port

MTA 
HTTP Port

GWIA 
HTTP Port

GWIA Domain 
MTA

N/A

Internet Agent 
(GWIA)

(same) N/A N/A N/A

WebAccess 
Agent

WebAccess 
IP Address

MTA 
MTP Port

MTA 
HTTP Port

WebAccess 
Agent Port

WebAccess
HTTP Port

WebAccess 
Domain MTA

N/A N/A

WebAccess 
Agent 
(GWINTER)

(same) N/A N/A

Item Explanation

1) agent installation location:

• vol:\system on the GroupWise 
volume

• sys:\system on each node

Consolidate multiple startup files on 
GroupWise volume?

Mark the location where you will install the agent software. 

If necessary, specify the location where you will consolidate 
multiple agent startup files on a GroupWise volume.

For more information, see “Deciding Where to Install the 
Agent Software” on page 30.

2) Domain Name:

Domain Location:

Transfer this information from the System Clustering 
Worksheet (item 10).

3) Domain Failover Path: List other nodes in the cluster where the GroupWise domain 
and its MTA could fail over.

For more information, see “Determining Appropriate Failover 
Paths for the Agents” on page 29.

4) MTA Network Information:

• MTA IP address

• MTA message transfer port

• MTA HTTP port

Gather the MTA network address information from the “IP 
Address Worksheet” on page 36.

For more information, see “Planning Secondary IP 
Addresses and Cluster-Unique Port Numbers for Agents in 
the Cluster” on page 27.
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5) Post Office Name:

Post Office Location:

Transfer this information from the System Clustering 
Worksheet (item 11).

6) Post Office Failover Path: List other nodes in the cluster where the GroupWise post 
office and its POA could fail over.

For more information, see “Determining Appropriate Failover 
Paths for the Agents” on page 29.

7) POA Network Information:

• POA IP address

• POA client/server port

• POA message transfer port

• POA HTTP port

Gather the POA network address information from the “IP 
Address Worksheet” on page 36.

For more information, see “Planning Secondary IP 
Addresses and Cluster-Unique Port Numbers for Agents in 
the Cluster” on page 27.

8) Load Agents in Protected Memory?

• No

• Yes

MTA protected address space

POA protected address space

POA /user startup switch setting

POA /password startup switch 
setting 

Mark whether you need to run the agents in protected 
memory. If so, specify a unique address space for each 
agent. For the POA, specify a user name and password if 
required by your version of NetWare.

For more information, see “Deciding Whether to Run the 
Agents in Protected Memory” on page 32.

Item Explanation
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3Setting Up a Domain and Post 
Office in a NetWare Cluster

You should have already reviewed “Planning GroupWise in a NetWare Cluster” on page 19 and 
filled out the “System Clustering Worksheet” on page 34, the “IP Address Worksheet” on page 36, 
and the “Agent Clustering Worksheet” on page 37. You are now ready to complete the following 
tasks to set up GroupWise® in a clustering environment:

• Section 3.1, “Preparing the Cluster for GroupWise,” on page 39
• Section 3.2, “Setting Up a New GroupWise System in a Cluster,” on page 42
• Section 3.3, “Creating a New Secondary Domain in a Cluster,” on page 44
• Section 3.4, “Creating a New Post Office in a Cluster,” on page 45
• Section 3.5, “Installing and Configuring the MTA and the POA in a Cluster,” on page 46
• Section 3.6, “Testing Your Clustered GroupWise System,” on page 55
• Section 3.7, “Managing Your Clustered GroupWise System,” on page 56
• Section 3.8, “What’s Next,” on page 60
• Section 3.9, “Clustering Quick Checklists,” on page 60

3.1  Preparing the Cluster for GroupWise
After you have installed Novell® Cluster ServicesTM, as described in Novell Cluster Services 
Overview and Installation, complete the following tasks to prepare the cluster for your GroupWise 
system:

• “Ensuring Required Software Versions” on page 39
• “Cluster-Enabling Shared Volumes for Use with GroupWise” on page 39
• “Configuring Short Name Resolution” on page 40

3.1.1  Ensuring Required Software Versions
Double-check each node in the cluster to make sure it meets the requirements described in Section 
2.1, “Meeting Software Version Requirements,” on page 20.

3.1.2  Cluster-Enabling Shared Volumes for Use with 
GroupWise
To cluster-enable a shared volume for use with GroupWise:

1 Select a System Clustering Worksheet item (6, 7, or 8) where you selected Yes under Cluster 
Enabled?.

2 Complete the steps in the cluster-enabling section of the cluster documentation for your version 
of NetWare®, as listed in Chapter 1, “Introduction to GroupWise 7 and Novell Cluster Services 
on NetWare,” on page 17.
Setting Up a Domain and Post Office in a NetWare Cluster 39



40 GroupWise 

novdocx (E
N

U
)  6 D

ecem
ber 2005
The System Clustering Worksheet provides the volume to cluster-enable for use the 
GroupWise, the cluster-enabled volume IP address, and the failover path for the GroupWise 
volume.
For a review of the new Novell eDirectoryTM objects that are created when you cluster-enable a 
shared volume, see Section 2.6, “Deciding Whether to Cluster-Enable the Shared Volumes 
Used by GroupWise,” on page 23.
If you have installed the latest version of ConsoleOne® and the Novell Cluster Services snap-
in, you can rename the cluster-related objects in case your DNS name server cannot resolve 
object names that include the underscore (_) character.

3 Repeat Step 1 and Step 2 above for the other shared volumes on your System Clustering 
Worksheet that need to be cluster-enabled.

4 Continue with “Configuring Short Name Resolution” on page 40.

3.1.3  Configuring Short Name Resolution
To ensure that GroupWise volumes are always locatable, configure the short name resolution 
methods that you want to rely on for GroupWise (System Clustering Worksheet item 9):

• “eDirectory” on page 40
• “Hosts Files” on page 41
• “DNS” on page 41
• “SLP” on page 42

After configuring your selected short name resolution methods, continue with the task you need to 
perform:

• Section 3.2, “Setting Up a New GroupWise System in a Cluster,” on page 42
• Section 3.3, “Creating a New Secondary Domain in a Cluster,” on page 44
• Section 3.4, “Creating a New Post Office in a Cluster,” on page 45

eDirectory

Most commonly, you will use eDirectory to resolve the UNC path of a volume into its network 
address. For example, on the workstation where you run ConsoleOne, you need to map a drive to the 
location of a domain directory so that ConsoleOne can access the domain database. You could use a 
map command as shown in the example below:

Syntax:
 map drive: = .cluster_volume.context

Example:
 map m: = .GWCLUSTER_GWVOL1.GWServers

When specifying the map commands, use System Clustering Worksheet item 3 for cluster. Use 
System Clustering Worksheet item 7 or 8 for each volume where a domain or post office resides. Use 
System Clustering Worksheet item 4 for context.
7 Interoperability Guide
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Hosts Files

Because each GroupWise volume where you plan to create a domain or post office has been 
associated with a virtual server, you should add lines for the new virtual servers to one or more of 
the following files as needed:

• NetWare: 
sys:\etc\hosts
(on all nodes in the cluster; recommended)

• Windows 2000/2003: 
\winnt\system32\drivers\etc\hosts
(on the administrator’s workstation only; optional)

The lines you add to a hosts file could look similar to the following example (all on one line, of 
course):

Syntax:
 IP_address cluster_volume_SERVER.context

cluster_volume_SERVER

Remember that cluster_volume_SERVER represents the name of the virtual server created when 
you cluster-enabled the volume.

Example:
 172.16.5.81

gwcluster_gwvol1_SERVER.gwcluster.com
gwcluster_gwvol1_SERVER

When specifying the lines in the hosts files, use System Clustering Worksheet item 7 or 8 for each 
IP_address and volume where a domain or post office resides. Use System Clustering Worksheet 
item 3 for cluster. Use System Clustering Worksheet item 4 for context.

DNS

Because each GroupWise volume where you plan to create a domain or post office has been 
associated with a virtual server, you should add all your new virtual servers to DNS. Then you could 
use a map command as shown in the example below (all on one line, of course):

Syntax:
 map drive: =

 \\volume_SERVER.cluster.com\volume

Remember that volume_SERVER represents the name of the Volume Resource object created when 
you cluster-enabled the volume. A cluster-enabled volume can function like a server, as these 
commands illustrate.

Example:
 map m: =

 \\gwvol1_SERVER.gwcluster.com\gwvol1

Or, if the ConsoleOne workstation is in the same DNS domain as the GroupWise volume:

Syntax:
 map drive: = \\volume_SERVER\volume
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Example:
 map m: = \\gwvol1_SERVER\gwvol1

When specifying the map commands you will need, use System Clustering Worksheet item 7 or 8 
for each volume where a domain or post office resides. Use System Clustering Worksheet item 3 for 
cluster. 

SLP

On NetWare 6.x, Novell Cluster Services automatically propagates virtual server information into 
SLP and provides the most reliable name resolution.

On NetWare 5.1, Novell Cluster Services does not propagate virtual server information into SLP by 
default. If you want to use SLP for name resolution on NetWare 5.1, you must download the 
(unsupported) CVSBIND utility from the Technical Information Document NWCS Bindery Tool 
(http://support.novell.com/cgi-bin/search/searchtid.cgi?/2957434.htm). Install CVSBIND according 
to the instructions included with the download, then determine the server-specific commands you 
will need to use with CVSBIND. 

Syntax:
 cvsbind add cluster_volume_SERVER ip_address
cvsbind del cluster_volume_SERVER ip_address

Remember that cluster_volume_SERVER represents the name of the virtual server created when 
you cluster-enabled the volume.

Example:
 cvsbind add gwcluster_gwvol1_SERVER 172.16.5.81
cvsbind del gwcluster_gwvol1_SERVER 172.16.5.81

Later, in “Modifying the Volume Resource Load Script for the Agents” on page 48 and “Modifying 
the Volume Resource Unload Script for the Agents” on page 50, you need to add the cvsbind 
commands to the load and unload scripts for GroupWise volume resources.

3.2  Setting Up a New GroupWise System in a 
Cluster
The GroupWise Installation Advisor walks you through setting up the primary domain and an initial 
post office in the primary domain. You might be creating your primary domain and initial post office 
on the same GroupWise volume or on two different volumes. After you have created the primary 
domain and initial post office and installed the GroupWise agents, you can create additional 
secondary domains and post offices as needed.

To set up the primary domain and initial post office for a new GroupWise system in a clustering 
environment:

1 If necessary, map a drive to each GroupWise administration volume (System Clustering 
Worksheet item 6).

2 Map a drive to the GroupWise volume for the domain (System Clustering Worksheet item 7) 
and, if needed, to the GroupWise volume for the post office (System Clustering Worksheet item 
8), where the primary domain and the initial post office for your new GroupWise system will 
be created.
7 Interoperability Guide
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The GroupWise volume name will be cluster_volume. For assistance with mapping a drive to a 
cluster-enabled volume, see “Configuring Short Name Resolution” on page 40.

3 Manually create the domain directory (System Clustering Worksheet item 10) and the post 
office directory (System Clustering Worksheet item 12). 
This step is not required, but in a clustered environment, the following step is easier if the 
domain directory already exists.

4 Run the GroupWise Installation Advisor to set up your initial GroupWise system, following the 
steps provided in “NetWare and Windows: Setting Up a Basic GroupWise System” in 
“Installing a Basic GroupWise System” in the GroupWise 7 Installation Guide. Keep in mind 
the following cluster-specific details:

• When you specify the ConsoleOne directory and the software distribution directory, be 
sure to browse to each location through the GroupWise volume accessed in Step 1 above.

• When you specify the domain directory and post office directory, be sure to browse 
through the GroupWise volume accessed in Step 2 to select the directory created in Step 3 
above.

• For the post office link type, select TCP/IP Link.

• When providing the MTA and POA network address information, use the Agent 
Clustering Worksheet that you filled out in Section 2.8, “Deciding How to Install and 
Configure the Agents in a Cluster,” on page 27. The information you provide is used to 
configure the MTA and POA objects in the domain and post office even though you have 
not yet installed the agent software.

• Do not create users in the post office at this time.

• In the Summary dialog box, the domain directory and post office directory that you 
browsed to should display as UNC paths using the virtual server name with the 
GroupWise volume.

5 When you have finished creating the primary domain and the initial post office, continue with 
installing the GroupWise Agents, starting with Step 4 on page 47 in Section 3.5, “Installing and 
Configuring the MTA and the POA in a Cluster,” on page 46.
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3.3  Creating a New Secondary Domain in a 
Cluster
After you have set up the primary domain and initial post office, as described in Section 3.2, 
“Setting Up a New GroupWise System in a Cluster,” on page 42, you can create additional 
secondary domains as needed.

To create a new secondary domain in a clustering environment:
1 Map a drive to the GroupWise volume for the domain (System Clustering Worksheet item 7) 

where the new secondary domain will be created.
The GroupWise volume name will be cluster_volume. For assistance with mapping a drive to a 
cluster-enabled volume, see “Configuring Short Name Resolution” on page 40.

2 Manually create the domain directory (System Clustering Worksheet item 10).
This step is not required, but in a clustered environment, Step 5 is easier if the domain directory 
already exists.

3 If you selected vol:\system on GroupWise volume as the agent installation location (under 
Agent Clustering Worksheet item 1), create the vol:\system directory on the GroupWise 
volume accessed in Step 1.
or
If you selected sys:\system on each node, decide which node you will install the agents to 
first.

4 In ConsoleOne, connect to the primary domain in your GroupWise system, as described in 
“Connecting to a Domain” in “Domains” in the GroupWise 7 Administration Guide.

5 Create the new domain, following the steps provided in “Creating the New Domain” in 
“Domains” in the GroupWise 7 Administration Guide. Keep in mind the following cluster-
specific details:

• Use the Domain Worksheet you filled out in Section 2.3, “Planning a New Clustered 
Domain,” on page 21 to fill in the fields in the Create GroupWise Domain dialog box.

• In the Domain Database Location field, be sure to browse through the drive you mapped 
in Step 1 to the domain directory you created in Step 2 above.

• In the Link to Domain field, link the new domain to the primary domain of your 
GroupWise system. 

• The Configure Link option is selected by default. Select TCP/IP Link to the Other 
Domain. Refer to the Agent Clustering Worksheet that you filled out in “Planning 
Secondary IP Addresses and Cluster-Unique Port Numbers for Agents in the Cluster” on 
page 27 for the secondary IP address and cluster-unique port numbers that you need to 
specify in order to configure the link.

6 Use the Link Configuration tool to change the links from the new domain to all other domains 
in the cluster to direct TCP/IP links, following the steps provided in “Changing the Link 
Protocol between Domains to TCP/IP” in “Message Transfer Agent” in the GroupWise 7 
Administration Guide. 
Although a complete mesh link configuration is the most efficient, it might not be feasible in all 
situations. Set up as many direct TCP/IP links as possible for best MTA performance in the 
cluster.

7 Make sure you are still connected to the primary domain.
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8 Rebuild the domain database for the new domain, following the steps provided in “Rebuilding 
Domain or Post Office Databases” in “Databases” in the GroupWise 7 Administration Guide. 
Be sure to browse to the database location (under System Clustering Worksheet item 10) 
through the virtual server that was created when you cluster-enabled the GroupWise volume.
The database rebuild is necessary in order to transfer the MTA configuration information and 
the domain link information into the secondary domain database, because the MTA for the new 
domain is not yet running.

9 Continue with Section 3.4, “Creating a New Post Office in a Cluster,” on page 45.

3.4  Creating a New Post Office in a Cluster
You can create a new post office on the same GroupWise volume where its domain resides or on a 
separate GroupWise volume. If the post office and its domain are on the same GroupWise volume, 
they fail over together. If they are on separate GroupWise volumes, they fail over separately.

To create a new post office in a clustering environment:
1 If you selected Yes for Post Office on Same Volume as Domain? (under System Clustering 

Worksheet item 7), map a drive to the GroupWise volume for the domain (System Clustering 
Worksheet item 7). 
or
Map a drive to the GroupWise volume for the post office (System Clustering Worksheet item 
8). 
The GroupWise volume name will be cluster_volume. For assistance with mapping a drive to a 
cluster-enabled volume, see “Configuring Short Name Resolution” on page 40.

2 Manually create the post office directory (System Clustering Worksheet item 12).
This step is not required, but in a clustered environment, Step 4 is easier if the post office 
directory already exists.

3 In ConsoleOne, connect to the GroupWise domain where you want to create the new post 
office, as described in “Connecting to a Domain” in “Domains” in the GroupWise 7 
Administration Guide. 

4 Create the new post office, following the steps provided in “Creating the New Post Office” in 
“Post Offices” in the GroupWise 7 Administration Guide. Keep in mind the following cluster-
specific details:

• Use the Post Office Worksheet you filled out in Section 2.4, “Planning a New Clustered 
Post Office,” on page 22 to fill in the fields in the Create GroupWise Post Office dialog 
box.

• In the Post Office Database Location field, be sure to browse through the drive you 
mapped in Step 1 to the post office directory you created in Step 2 above.

• If you want to create a library at the post office (System Clustering Worksheet item 14), 
select Create Library.

• The Configure Link option is selected by default. Select TCP/IP Link from Domain to New 
Post Office. Refer to the Agent Clustering Worksheet that you filled in during “Planning 
Secondary IP Addresses and Cluster-Unique Port Numbers for Agents in the Cluster” on 
page 27 for the secondary IP address and cluster-unique port numbers that you need to 
specify in order to configure the link.

5 Right-click the new Post Office object, then click Properties.
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6 Click GroupWise > Post Office Settings; in the Access Mode field, select Client/Server Only.
7 Right-click the new POA object, then click Properties.

On the POA Agent Settings and Scheduled Events pages, you might want to specify unique 
times for the following POA activities to prevent multiple POAs from performing the same 
activities on the same node at the same time during a failover situation:

• Start User Upkeep
• Generate Address Book for Remote
• Enable QuickFinder Indexing 
• Mailbox/Library Maintenance Event

For more information about these repetitive POA activities, see “Performing Nightly User 
Upkeep”, “Regulating Indexing”, and “Scheduling Database Maintenance” in “Post Office 
Agent” in the GroupWise 7 Administration Guide.

8 Make sure you are still connected to the domain that owns the new post office.
9 Rebuild the post office database for the new post office, following the steps provided in 

“Rebuilding Domain or Post Office Databases” in “Databases” in the GroupWise 7 
Administration Guide. Be sure to browse to the database location (under System Clustering 
Worksheet item 11) through the virtual server that was created when you cluster-enabled the 
GroupWise volume.
The database rebuild is necessary in order to transfer the POA configuration information and 
the post office link information into the post office database, because the POA for the new post 
office is not yet running.

10 If you want to create a library (System Clustering Worksheet item 14) for the clustered post 
office, follow the steps in “Setting Up a Basic Library” or “Setting Up a Full-Service Library” 
in “Libraries and Documents” in the GroupWise 7 Administration Guide, after you have 
completely finished setting up the clustered post office.

11 Continue with Section 3.5, “Installing and Configuring the MTA and the POA in a Cluster,” on 
page 46.

3.5  Installing and Configuring the MTA and the 
POA in a Cluster
After you have created a new domain and/or post office, you are ready to install and configure the 
GroupWise agents. Complete all the tasks below if you are setting up a new GroupWise system or if 
you have created a new GroupWise volume where you want to install the agent software:

• “Installing the Agent Software in a Cluster” on page 47
• “Editing Clustered Agent Startup Files” on page 48
• “Configuring the GroupWise Volume Resource to Load and Unload the Agents” on page 48

Under some circumstances, the agent software has already been installed and you simply need to 
create a new startup file specific to the new domain or post office. For example: 

• You have created a new domain and/or post office on a GroupWise volume where the agent 
software is already installed in the vol:\system directory of the GroupWise volume.

• In your GroupWise system, the agent software is already installed to multiple sys:\system 
directories.
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In these circumstances, follow the instructions in “Setting Up New Instances of the Agents without 
Installing the Agent Software” on page 52 instead of completing the tasks above.

3.5.1  Installing the Agent Software in a Cluster
To install the MTA and the POA:

1 Map a drive to the GroupWise volume for the domain (Agent Clustering Worksheet item 2) or 
the post office (Agent Clustering Worksheet item 5).
The GroupWise volume name will be cluster_volume. For assistance with mapping a drive to a 
cluster-enabled volume, see “Configuring Short Name Resolution” on page 40.

2 If you selected vol:\system on GroupWise volume as the agent installation location (under 
Agent Clustering Worksheet item 1), create the vol:\system directory on the GroupWise 
volume accessed in Step 1.
or
If you selected sys:\system on each node, decide which node you will install the agents to 
first.

3 Start the Agent Installation program, following the steps provided in “Installing the NetWare 
Agent Software” in “Installing GroupWise Agents” in the GroupWise 7 Installation Guide. 

4 Install the NetWare agents, keeping in mind the following cluster-specific details:

• Use the NetWare Agent Clustering Worksheet that you filled out in “Planning the 
NetWare Agent Installation” on page 33 to fill in the fields during the agent installation 
process.

• In the Installation Path dialog box, be sure to browse through the drive you mapped in 
Step 1 to the location you chose in Step 2 above. Also select Configure GroupWise Agents 
for Clustering.

• In the Domains / Post Offices dialog box, click Add for each domain and post office that 
the agents will service. In the Path to Database field, be sure to browse through the drive 
you mapped in Step 1 above to the domain directory or the post office directory. In the 
HTTP Port field, specify the cluster-unique HTTP port planned for each agent (under 
Agent Clustering Worksheet items 4 and 7).

• In the Installation Complete dialog box, do not select Launch GroupWise Agents Now. 
You will configure the agents to launch in protected mode later.

5 If you need to install the agents to sys:\system on multiple nodes in the cluster:
5a Repeat Step 4, mapping new drives as needed.
5b If you selected Yes for Consolidate Multiple Startup Files on GroupWise Volume? (under 

Agent Clustering Worksheet item 1), copy one complete set of agent startup files and the 
grpwise.ncf file to the planned location, then delete all agent startup files, as well as 
the grpwise.ncf file, from the sys:\system directories to avoid future confusion. 
The grpwise.ncf file includes a load command for each instance of each agent. You 
will use this information later when you create the load and unload scripts for the volume 
resources.

6 Continue with “Editing Clustered Agent Startup Files” on page 48.
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3.5.2  Editing Clustered Agent Startup Files
By default, the Agent Installation program creates agent startup files in the agent installation 
directory. Each MTA startup file is named after the domain it services, with a .mta extension. Each 
POA startup file is named after the post office it services, with a .poa extension.

Because you selected Configure GroupWise Agents for Clustering during installation, the Agent 
Installation program set the MTA /home startup switch and the POA /home startup switch using the 
format:

volume:\directory

so that the startup files are valid no matter which node the agents are currently running on.

The Agent Installation program also adds a /cluster startup switch to POA startup files to ensure that 
GroupWise clients detect the clustering environment and try more persistently to reconnect in a 
failover, failback, or migration situation. 

One additional manual modification of POA startup files is required for robust functionality in a 
clustering environment. Uncomment the /ip startup switch and provide the secondary IP address of 
the GroupWise volume where the post office is located (Agent Clustering Worksheet item 7). This 
information is available to the POA in its eDirectory object properties. However, in some failover 
situations, reconnection to the MTA is improved when the information is immediately available to 
the POA in its startup file.

If you are running the POA in protected memory and your version of NetWare requires it, add the /
user and /password startup switches (under Agent Clustering Worksheet item 8) in order to provide a 
user name and password that the POA can use to access its post office volume.

If the POA needs to access a remote document storage area, add the /user and /password startup 
switches (under System Clustering Worksheet item 12) in order to provide a user name and 
password that the POA can use to access the volume where the document storage area resides. As an 
alternative to startup switches, you can assign the POA object all rights except Supervisor and 
Access control, as long as the remote document storage area is located in the same tree with the post 
office.

3.5.3  Configuring the GroupWise Volume Resource to Load 
and Unload the Agents
The properties of the Volume Resource object define how the GroupWise volume functions within 
the cluster, how NLMTM programs are loaded and unloaded, and how failover and failback situations 
are handled. At this point, you might have one volume resource with a domain and post office on it, 
or you might have two volume resources, one for the domain and one for the post office. Complete 
the following tasks for each volume resource:

• “Modifying the Volume Resource Load Script for the Agents” on page 48
• “Modifying the Volume Resource Unload Script for the Agents” on page 50
• “Setting the Failover Path and Policies for the Agents” on page 51

Modifying the Volume Resource Load Script for the Agents

The volume resource load script executes whenever the GroupWise volume comes online.
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To set up the load script:
1 In ConsoleOne, browse to and select the Cluster object.

If necessary, click View > Console View to display its contents.
2 Right-click the Volume Resource object (volume_SERVER), then click Properties > Load to 

display the default volume resource load script for the GroupWise volume.
3 Make the following changes to the default load script:

• Remove the trustmig command. It is not necessary to migrate trustees for a GroupWise 
volume. Removing this line helps the load script to execute faster.

• On NetWare 5.1, if you selected SLP as a short name resolution method, add the 
cvsbind add command for the GroupWise volume to the load script. 
cvsbind add cluster_volume_SERVER IP_address

• If you selected vol:\system on GroupWise volume as the agent installation location 
(Agent Clustering Worksheet item 1), add a search add command to add the new 
vol:\system directory to the server search path.
search add volume:\system

• If you selected sys:\system on each node as the installation location (Agent 
Clustering Worksheet item 1) but you are storing the agent startup files on the GroupWise 
volume, add that location to the server search path.

• If you selected No under Load Agents in Protected Memory? (Agent Clustering Worksheet 
item 8), add the following abend recovery options:
set auto restart after abend = 2
set auto restart after abend delay time = 0
set auto restart down timeout = 60
set developer option = off

These settings provide the best possible handling of GroupWise databases in the event that 
an abend should occur within the cluster when the agents are not running in protected 
memory.

• Transfer the agent load commands from the grpwise.ncf file into the load script. 
Use Ctrl+C to copy and Ctrl+V to paste text into the load script page. Then delete or 
rename the grpwise.ncf file to avoid future confusion.
load volume:\system\agent.nlm @startup_file

• If you selected Yes under Load Agents in Protected Memory? (Agent Clustering 
Worksheet item 8), add the address space parameter to the agent load commands to 
specify the protected address space for each agent. Add a protection restart 
command for each address space name. 
load address space=addr_space_name

 volume:\system\agent.nlm @startup_file
protection restart name

The result would look similar to the following example:
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NOTE: The set commands are needed in the load script only when the agents are not running 
in protected memory. The address space parameters are needed in the load commands only 
when the agents are running in protected memory.

4 Click Apply to save the load script.
5 If necessary, click OK to confirm that you must offline and then online the volume resource in 

order for the changes to take effect.
6 Continue with “Modifying the Volume Resource Unload Script for the Agents” on page 50.

Modifying the Volume Resource Unload Script for the Agents

The volume resource unload script executes whenever the GroupWise volume goes offline. 
Programs should be unloaded in the reverse order of how they were loaded. This ensures that 
supporting programs are not unloaded before programs that rely on them in order to function 
properly.

To set up the unload script:
1 In ConsoleOne, in the properties pages for the Volume Resource object (volume_SERVER), 

click Unload to display the default volume resource unload script.
2 Make the following changes to the default unload script:

• If you selected Yes under Load Agents in Protected Memory? (Agent Clustering 
Worksheet item 8), add an unload address space command for each address 
space. Add an unload kill address space command to ensure that the address 
space is completely cleaned up. 

unload address space=addr_space_name
unload kill address space=addr_space_name

If your system seems to be trying to kill the address space before the GroupWise agents 
have been completely unloaded, resulting in the agents hanging in the unloading state, 
load the delay.nlm program and set a delay of several seconds before issuing the 
unload kill address space command to allow the GroupWise agents adequate 
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time to unload completely. The length of the delay varies from system to system; ten 
seconds is a good starting place.

unload address space=addr_space_name
load delay.nlm
delay 10
unload kill address space=addr_space_name

• If you selected No under Load Agents in Protected Memory? (Agent Clustering Worksheet 
item 8), create an unload command parallel to each load command that you placed in 
the load script. 
unload volume:\directory\agent.nlm

• On NetWare 5.1, if you selected SLP as a short name resolution method, add the 
cvsbind del command for the GroupWise volume to the unload script. 
cvsbind del cluster_volume_SERVER IP_address

• Remove the trustmig command just like you did in the load script. 
The result would look similar to the following example:

3 Click Apply to save the unload script.
4 If necessary, click OK to confirm that you must offline and then online the volume resource in 

order for the changes to take effect.
5 Continue with “Setting the Failover Path and Policies for the Agents” on page 51.

Setting the Failover Path and Policies for the Agents

To modify the failover path and policies for a GroupWise volume resource:
1 In ConsoleOne, in the properties pages for the Volume Resource object (volume_SERVER), 

click Nodes to display the default failover path for the GroupWise volume resource.
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2 Arrange the nodes in the cluster into the desired failover path for the domain or post office 
volume (under Agent Clustering Worksheet items 3 or 6).

3 Click Apply to save the failover path.
4 Click Policies to display the default start, failover, and failback policies.

The default policy settings are often appropriate. By default, a volume resource:

• Fails over automatically if the node it is running on fails
• Starts automatically on the next node in its failover path
• Continues running at its failover location, even after its most preferred node is again 

available
If you are considering changing these defaults, see the section about failover and failback 
modes in the cluster documentation for your version of NetWare, as listed in Chapter 1, 
“Introduction to GroupWise 7 and Novell Cluster Services on NetWare,” on page 17.

5 Click OK when you are finished editing the GroupWise volume resource properties.
6 Continue with Section 3.6, “Testing Your Clustered GroupWise System,” on page 55.

3.5.4  Setting Up New Instances of the Agents without Installing 
the Agent Software
There are two steps to setting up new instances of the agents without installing the agent software:

• “Creating New Startup Files” on page 53
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• “Modifying Existing Load and Unload Scripts” on page 53

Creating New Startup Files

Each MTA startup file is named after the domain it services, with a .mta extension. Each POA 
startup file is named after the post office it services, with a .poa extension. If the existing agent 
software is located in the vol:\system directory of a GroupWise volume, the startup files are 
there as well. If the existing agent software is located in multiple sys:\system directories, the 
startup files might be located there as well, or they might be in a directory on a GroupWise volume.

To create a new startup file without installing the agent software:
1 Make a copy of an existing startup file and name it after the domain or post office that will be 

serviced by the agent.
2 Edit the setting of the /home startup switch to point to the location of the new domain directory 

or post office directory. Be careful to maintain the syntax of the original line.
3 Scroll down through the startup file looking for other active (not commented out) startup 

switches, then modify them as needed for the new agent.
For example, you might find that the /httpport switch is active and needs to be changed to a 
cluster-unique port number for the new agent.

4 Save the new startup file.
5 Continue with “Modifying Existing Load and Unload Scripts” on page 53.

Modifying Existing Load and Unload Scripts

The agent startup file names are part of the load commands found in GroupWise volume resource 
load scrips.

If you created the new domain and/or post office on a new GroupWise volume, skip back to 
“Configuring the GroupWise Volume Resource to Load and Unload the Agents” on page 48 for 
instructions to create new load and unload scripts.

If you created the new domain and/or post office on an existing GroupWise volume, most of the 
configuration of the volume resource has already been done. You just need to add new load and 
unload commands to the existing scripts. Continue with the steps below:

To modify existing load and unload scripts:
1 In ConsoleOne, browse to and select the Cluster object.

If necessary, click View > Console View to display its contents.
2 Right-click the Volume Resource object (volume_SERVER), then click Properties > Load to 

display the volume resource load script for the GroupWise volume.
3 Following the pattern of the existing load commands, add load commands for the new 

instances of the agents you are setting up. Use Ctrl+C to copy and Ctrl+V to paste lines in the 
load script page.
The results would be similar to the following example:
Setting Up a Domain and Post Office in a NetWare Cluster 53



54 GroupWise 

novdocx (E
N

U
)  6 D

ecem
ber 2005
4 Click Apply to save the modified load script.
5 Click Unload 
6 Add corresponding unload commands for the new instances of the agents.

7 Click Apply to save the modified unload script.
You might want to review other properties of the Volume Resource object, such as the failover 
path on the Nodes page and the failover/failback/migration procedures on the Policies page, in 
light of the fact that an additional domain and/or post office now resides on the GroupWise 
volume.

8 Change other Volume Resource properties as needed.
9 Click OK to save the modified properties.

10 In the Cluster State View, take the GroupWise volume offline and then bring it online again to 
test the new startup files and the modified load and unload scripts. If you need assistance with 
these tasks, see Section 3.6, “Testing Your Clustered GroupWise System,” on page 55.
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3.6  Testing Your Clustered GroupWise System
After you have configured the GroupWise volume resources, you can test the load and unload 
scripts by bringing the GroupWise volume online and taking it offline again.

1 In ConsoleOne, select the Cluster object, then click View > Cluster State.

The new GroupWise volume resource shows Offline in the State column.
2 Click the new GroupWise volume resource, then click Online.

The State column for the volume resource now displays Running.

3 Observe the server console where the MTA and/or POA are loading to see that they start and 
run correctly. 
If you are using protected memory, you can use the protection command at the server 
console prompt to list all the address spaces on the node and what NLM programs are running 
in each one.

4 Click the new GroupWise volume resource, then click Offline.
The State column for the volume resource returns to Offline.

5 Observe the server console where the MTA and/or POA are unloading to see that they shut 
down correctly. 
If you are using protected memory, you can use the protection command again to make 
sure that the address spaces used by the GroupWise agents are no longer present.

6 Repeat Step 2 whenever you are ready to bring the new GroupWise volume resource online 
permanently.
On NetWare 6.x, these actions can also be performed from your Web browser. See “Using 
Novell Remote Manager on NetWare 6.x” on page 57.

7 Continue with Section 3.7, “Managing Your Clustered GroupWise System,” on page 56.
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3.7  Managing Your Clustered GroupWise System
After you have set up a basic clustered GroupWise system, you should consider some long-term 
management issues.

• “Updating GroupWise Objects with Cluster-Specific Descriptions” on page 56
• “Using Novell Remote Manager on NetWare 6.x” on page 57
• “Knowing What to Expect in MTA and POA Failover Situations” on page 60

3.7.1  Updating GroupWise Objects with Cluster-Specific 
Descriptions
After setting up your clustered GroupWise system, while the cluster-specific information is fresh in 
your mind, you should record that cluster-specific information as part of the GroupWise objects in 
ConsoleOne so that you can easily refer to it later. Be sure to keep the information recorded in the 
GroupWise objects up to date if the configuration of your system changes.

• “Recording Cluster-Specific Information for a Domain and Its MTA” on page 56
• “Recording Cluster-Specific Information for a Post Office and Its POA” on page 56
• “Recording Cluster-Specific Information for a Software Distribution Directory” on page 57

Recording Cluster-Specific Information for a Domain and Its MTA

To permanently record important cluster-specific information for the domain:
1 In ConsoleOne, browse to and right-click the Domain object, then click Properties.
2 In the Description field of the domain Identification page, provide a cluster-specific description 

of the domain, including the secondary IP address of its cluster-enabled volume and the cluster-
unique port numbers used by its MTA. 

3 Click OK to save the domain description.
4 Select the Domain object to display its contents.
5 Right-click the MTA object, then click Properties.
6 In the Description field of the MTA Identification page, record the secondary IP address of the 

cluster-enabled domain volume and the cluster-unique port numbers used by the MTA. 
This information appears on the MTA console, no matter which node in the cluster it is 
currently running on.

7 Click OK to save the MTA description.
8 Continue with “Recording Cluster-Specific Information for a Post Office and Its POA” on 

page 56.

Recording Cluster-Specific Information for a Post Office and Its POA

To permanently record important cluster-specific information for a post office:
1 In ConsoleOne, browse to and right-click the Post Office object, then click Properties.
2 In the Description field of the post office Identification page, provide a cluster-specific 

description of the post office, including the secondary IP address of its cluster-enabled volume 
and the cluster-unique port numbers used by its POA. 
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3 Click OK to save the post office description.
4 Select the Post Office object to display its contents.
5 Right-click the POA object, then click Properties.
6 In the Description field of the POA Identification page, record the secondary IP address of the 

cluster-enabled post office volume and the cluster-unique port numbers used by the POA. 
This information appears on the POA console, no matter which node in the cluster it is 
currently running on.

7 Click OK to save the POA description.
8 If necessary, continue with “Recording Cluster-Specific Information for a Software 

Distribution Directory” on page 57.
or
Continue with “Knowing What to Expect in MTA and POA Failover Situations” on page 60.

Recording Cluster-Specific Information for a Software Distribution Directory

To permanently record important cluster-specific information about a software distribution directory 
located on a cluster-enabled volume:

1 In ConsoleOne, click Tools > System Operations > Software Directory Management.
2 Select the software distribution directory, then click Edit.
3 In the description field, record the secondary IP address of the cluster-enabled volume where 

the software distribution directory resides. 
4 Click OK, then click Close to save the software distribution directory description.
5 Continue with “Knowing What to Expect in MTA and POA Failover Situations” on page 60.

3.7.2  Using Novell Remote Manager on NetWare 6.x
On NetWare 6.x, you can use Novell Remote Manager to manage many aspects of your GroupWise 
cluster from your Web browser. For instructions on setting up and accessing this useful network 
administration utility, see the NetWare 6.x Novell Remote Manager Administration Guide at the 
Novell Documentation Web site (http://www.novell.com/documentation/index.html). Cluster 
management features are automatically added to Novell Remote Manager when you install Novell 
Cluster Services.

After you have accessed Novell Remote Manager, you might find that many GroupWise cluster 
management tasks are easier to perform with Novell Remote Manager than with ConsoleOne. The 
following sections help you configure and manage the cluster using Novell Remote Manager:

• “Configuring Your GroupWise Cluster” on page 57
• “Managing Your GroupWise Cluster” on page 59

Configuring Your GroupWise Cluster

On the main Novell Remote Manager page:
1 In the left frame, scroll down to the Clustering section, then click Cluster Config.
Setting Up a Domain and Post Office in a NetWare Cluster 57

http://www.novell.com/documentation/index.html


58 GroupWise 

novdocx (E
N

U
)  6 D

ecem
ber 2005
The Cluster Configuration page displays the cluster name, the nodes in the cluster, and the 
resources in the cluster. It also enables you to create new GroupWise Volume Resource objects 
(termed Cluster Volumes in the Novell Remote Manager interface). 

2 Click the cluster name to display the Cluster object properties:

Click a linked item to edit the Cluster object properties. Click your browser’s Back button to 
return to the Cluster Configuration page.

3 On the Cluster Configuration page, click a server to display the Server object properties:

Click a linked item to edit the Server object properties. Click Back or Delete to perform the 
specified action.

4 On the Cluster Configuration page, click a GroupWise volume to display the Volume Resource 
object properties:
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Click a linked item to edit Volume Resource object properties. Click Back or Delete to perform 
the specified action.

5 On the Cluster Configuration page, click New Cluster Volume to create a new GroupWise 
Volume Resource object, then follow the instructions to provide the information needed to 
create the new Cluster Volume object.

Managing Your GroupWise Cluster

On the main Novell Remote Manager page:
1 In the left frame, scroll down to the Clustering section, then click Cluster Management.

The Cluster Status page displays the nodes and volume resources in the cluster. The master 
node in the cluster is marked with a yellow ball. Status information is listed for each volume 
resource. You can set the refresh rate for the status information at the top of the Cluster Status 
page. 

2 Select a page refresh rate, then click Begin Refresh so that the page automatically refreshes at 
the selected rate. 

3 Click a cluster resource to bring it online, take it offline, or migrate it to another node.

To take the currently running volume resource offline, click Offline. To migrate the volume 
resource, select a node from the drop-down list, then click Migrate.

4 On the Cluster Resource page, click Event Log to view a list of cluster events.
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The event log can help you resolve problems with cluster functioning.

3.7.3  Knowing What to Expect in MTA and POA Failover 
Situations
In a failover situation, the agents might need to perform some database repair as they start on the 
new node. The time required depends on the size of the databases involved. 

Typically, the POA returns to full functionality faster than the MTA. This benefits GroupWise client 
users, who can reconnect to their mailboxes very quickly and probably do not notice if messages to 
users in other post offices are not delivered immediately. The only time a user would need to restart 
the GroupWise client would be if he or she was actually in the process of sending a message when 
the POA went down. Notify can continue running even if the connection to the POA becomes 
unavailable and then it reconnects automatically when the POA is again available.

The MTA typically takes some time reestablishing the links to its post offices, other domains, and 
gateways, but this situation usually resolves itself in a few minutes without administrator 
intervention. If it does not, you can manually restart the MTA to speed up the process. 

In comparison to failover, migration typically takes longer because the agents methodically 
terminate their threads and close their databases as part of their normal shutdown procedure. 
However, as a result, no database repair is required when the agents start up again in their new 
location.

Continue with Section 3.8, “What’s Next,” on page 60.

3.8  What’s Next
Now that you have at least one GroupWise domain and post office up and running in a clustering 
environment, you are ready to proceed with the rest of your GroupWise system setup by:

• Adding users to post offices. See “Users” in the GroupWise 7 Administration Guide.
• Setting up the GroupWise client software and helping users to get started using it. See “Client” 

in the GroupWise 7 Administration Guide. Also see the GroupWise 7 Windows Client User 
Guide.

• Connecting your clustered GroupWise system to the Internet. See Chapter 4, “Implementing 
the Internet Agent in a NetWare Cluster,” on page 65.

• Providing access to users’ GroupWise mailboxes from their Web browsers. See Chapter 5, 
“Implementing WebAccess in a NetWare Cluster,” on page 83.

• Connecting your clustered GroupWise system to other e-mail systems through GroupWise 
gateways. See Chapter 6, “Implementing GroupWise Gateways in a Novell Cluster,” on 
page 103. 

• Monitoring the status of your clustered GroupWise system from your Web browser. See 
Chapter 7, “Monitoring a GroupWise System in a NetWare Cluster,” on page 105.

• Backing up your clustered GroupWise system. See Chapter 8, “Backing Up a GroupWise 
System in a NetWare Cluster,” on page 107.

3.9  Clustering Quick Checklists
• “GroupWise System Quick Checklist” on page 61
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• “Domain Quick Checklist” on page 62
• “Post Office Quick Checklist” on page 62

3.9.1  GroupWise System Quick Checklist
Plan your new clustered GroupWise system.

See Chapter 2, “Planning GroupWise in a NetWare Cluster,” on page 19.
Cluster-enable the volumes where GroupWise domains and post offices will reside. 
See “Cluster-Enabling Shared Volumes for Use with GroupWise” on page 39.
Make sure that short name resolution works throughout your network.
See “Configuring Short Name Resolution” on page 40.
Create the primary domain and initial post office in your new clustered GroupWise system.
See Section 3.2, “Setting Up a New GroupWise System in a Cluster,” on page 42.
Set up the agents for the primary domain and the initial post office. 
See Section 3.5, “Installing and Configuring the MTA and the POA in a Cluster,” on page 46.
Modify the volume resource load script(s):

• Remove the trustmig command
• Add the cvsbind add command (NetWare 5.1 only; optional)
• Add the search add command (optional)
• If you will not run the agents in protected memory, add the set auto restart 

commands and the set developer option = off command
• Add the agent load command(s)
• If you will run the agents in protected memory, add the address space parameter to 

the load command(s) and add a corresponding protection restart command for 
each address space

See “Modifying the Volume Resource Load Script for the Agents” on page 48.
Modify the volume resource unload script(s):

• Add the agent or address space unload command(s)
• Add the cvsbind del command if you used the cvsbind add command in the load 

script (NetWare 5.1 only; optional)
• Remove the trustmig command

See “Modifying the Volume Resource Unload Script for the Agents” on page 50.
Set up the volume failover path(s) and policies. 
See “Setting the Failover Path and Policies for the Agents” on page 51.
Test your new clustered GroupWise system. 
See Section 3.6, “Testing Your Clustered GroupWise System,” on page 55.
Record cluster-specific information in the properties pages of the GroupWise objects that the 
information pertains to.
See Section 3.7, “Managing Your Clustered GroupWise System,” on page 56.
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3.9.2  Domain Quick Checklist
Plan your new clustered domain. 

See Section 2.3, “Planning a New Clustered Domain,” on page 21.
Cluster-enable the volume where the domain will reside. 
See “Cluster-Enabling Shared Volumes for Use with GroupWise” on page 39.
Make sure that short name resolution for the new domain volume works throughout your 
network. 
See “Configuring Short Name Resolution” on page 40.
Create the new domain. 
See Section 3.3, “Creating a New Secondary Domain in a Cluster,” on page 44.
Set up the MTA for the new domain.
See Section 3.5, “Installing and Configuring the MTA and the POA in a Cluster,” on page 46.
Modify the domain volume resource load script:

• Remove the trustmig command
• Add the cvsbind add command (NetWare 5.1 only; optional)
• Add the search add command (optional)
• If you will not run the MTA in protected memory, add the set auto restart 

commands and the set developer option = off command
• Add the MTA load command
• If you will run the MTA in protected memory, add the address space parameter to 

the MTA load command and add a corresponding protection restart command 
for the address space 

See “Modifying the Volume Resource Load Script for the Agents” on page 48.
Modify the domain volume resource unload script:

• Add the MTA or address space unload command
• Add the cvsbind del command if you used the cvsbind add command in the load 

script (NetWare 5.1 only; optional)
• Remove the trustmig command

See “Modifying the Volume Resource Unload Script for the Agents” on page 50.
Set up the domain volume failover path and policies. 
See “Setting the Failover Path and Policies for the Agents” on page 51.
Test your new clustered domain.
See Section 3.6, “Testing Your Clustered GroupWise System,” on page 55.
Record cluster-specific information in the properties pages of the GroupWise objects that the 
information pertains to.
See Section 3.7, “Managing Your Clustered GroupWise System,” on page 56.

3.9.3  Post Office Quick Checklist
Plan your new clustered post office.
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See Section 2.4, “Planning a New Clustered Post Office,” on page 22.
Cluster-enable the volume where the post office will reside. 
See “Cluster-Enabling Shared Volumes for Use with GroupWise” on page 39.
Make sure that short name resolution for the new post office volume works throughout your 
network. 
See “Configuring Short Name Resolution” on page 40.
Create the new post office.
See Section 3.4, “Creating a New Post Office in a Cluster,” on page 45.
Set up the POA for the new post office.
See Section 3.5, “Installing and Configuring the MTA and the POA in a Cluster,” on page 46.
Add the /ip startup switch to the POA startup file in order to provide the secondary IP address 
of the post office volume. If you are running the POA in protected memory, add the /user and /
password startup switches so the POA can access the volume.
See “Editing Clustered Agent Startup Files” on page 48.
Modify the post office volume resource load script:

• Remove the trustmig command
• Add the cvsbind add command (NetWare 5.1 only; optional)
• Add the search add command (optional)
• If you will not run the POA in protected memory, add the set auto restart 

commands and the set developer option = off command
• Add the POA load command
• If you will run the POA in protected memory, add the address space parameter to the 

POA load command and add a corresponding protection restart command for 
the address space

See “Modifying the Volume Resource Load Script for the Agents” on page 48.
Modify the post office volume resource unload script:

• Add the POA or address space unload command
• Add the cvsbind del command if you used the cvsbind add command in the load 

script (NetWare 5.1 only; optional)
• Remove the trustmig command

See “Modifying the Volume Resource Unload Script for the Agents” on page 50.
Set up the post office volume failover path and policies. 
See “Setting the Failover Path and Policies for the Agents” on page 51.
Test your new clustered post office.
See Section 3.6, “Testing Your Clustered GroupWise System,” on page 55.
Record cluster-specific information in the properties pages of the GroupWise objects that the 
information pertains to. 
See Section 3.7, “Managing Your Clustered GroupWise System,” on page 56.
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4Implementing the Internet Agent in 
a NetWare Cluster

You should already have set up at least a basic GroupWise® system, as described in Chapter 2, 
“Planning GroupWise in a NetWare Cluster,” on page 19 and Chapter 3, “Setting Up a Domain and 
Post Office in a NetWare Cluster,” on page 39. As part of this process, the “System Clustering 
Worksheet” on page 34 and the “IP Address Worksheet” on page 36 were filled out. If you do not 
have access to the filled-out worksheets, print the worksheets now and fill in the clustering and 
network address information as it currently exists on your system. You need this information as you 
implement the Internet Agent in a cluster.

• Section 4.1, “Planning the Internet Agent in a Cluster,” on page 65
• Section 4.2, “Setting Up the Internet Agent in a Cluster,” on page 69
• Section 4.3, “Managing the Internet Agent in a Cluster,” on page 78
• Section 4.4, “Internet Agent Clustering Worksheet,” on page 80
• Section 4.5, “Internet Agent Quick Checklist,” on page 81

4.1  Planning the Internet Agent in a Cluster
A main system configuration difference between a GroupWise system in a clustering environment 
and a GroupWise system in a regular environment is that you need to create a separate domain to 
house each GroupWise gateway, including the Internet Agent.

The Section 4.4, “Internet Agent Clustering Worksheet,” on page 80 lists all the information you 
need as you set up the Internet Agent in a clustering environment. You should print the worksheet 
and fill it out as you complete the tasks listed below:

• “Planning a Domain for the Internet Agent” on page 65
• “Deciding Whether to Cluster-Enable the Internet Agent Volume” on page 66
• “Determining an Appropriate Failover Path for the Internet Agent Volume” on page 66
• “Planning a Secondary IP Address and Cluster-Unique Port Numbers for the Internet Agent 

and Its MTA” on page 67
• “Preparing Your Firewall for the Internet Agent” on page 67
• “Deciding Where to Install the Internet Agent and Its MTA” on page 68
• “Deciding Whether to Run the Internet Agent and Its MTA in Protected Memory” on page 68
• “Planning the MTA Installation” on page 68
• “Planning the Internet Agent Installation” on page 69

4.1.1  Planning a Domain for the Internet Agent
The considerations involved in planning a domain for the Internet Agent are much the same as 
planning any other domain. In preparation, review “Planning a New Domain”, then print and fill out 
the “Domain Worksheet” in “Domains” in the GroupWise 7 Administration Guide. 
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Keep in mind the following cluster-specific details:

• When you specify the location for the domain directory on the Domain Worksheet, include the 
shared volume where you want the domain directory to reside.

• Do not concern yourself with the GroupWise agent information on the Domain Worksheet. You 
can stop with item 10. You will plan the MTA installation later.

When you have completed the Domain Worksheet, transfer the key information from the Domain 
Worksheet to the Internet Agent Clustering Worksheet.

4.1.2  Deciding Whether to Cluster-Enable the Internet Agent 
Volume
You should plan to cluster-enable the shared volume where the Internet Agent domain will reside. 
For a review of the benefits of cluster-enabling volumes, see Section 2.6, “Deciding Whether to 
Cluster-Enable the Shared Volumes Used by GroupWise,” on page 23, which describes the issues in 
the context of planning MTA and POA installations. 

Cluster-enabling relies on successful short name resolution throughout your system. Review Section 
2.7, “Ensuring Successful Name Resolution for GroupWise Volumes,” on page 25, which describes 
the issues in the context of planning MTA and POA installations.

4.1.3  Determining an Appropriate Failover Path for the Internet 
Agent Volume
As with the MTA and the POA, you need to decide which nodes in the cluster would be appropriate 
locations for the Internet Agent volume to fail over to. For a review of failover paths, see 
“Determining Appropriate Failover Paths for the Agents” on page 29, which describes the issues in 
the context of planning MTA and POA installations. 

INTERNET AGENT CLUSTERING WORKSHEET

Under Item 1: Shared Volume for Internet Agent, transfer the domain location to the Internet Agent 
Clustering Worksheet. 

Under Item 2: Internet Agent Domain Name, transfer the domain name and database directory to the 
Internet Agent Clustering Worksheet. 

INTERNET AGENT CLUSTERING WORKSHEET

Under Item 1: Shared Volume for Internet Agent, mark Yes under Cluster Enabled?.

INTERNET AGENT CLUSTERING WORKSHEET

Under Item 3: Internet Agent Failover Path, list the nodes that you want to have in the Internet Agent 
volume failover path.
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4.1.4  Planning a Secondary IP Address and Cluster-Unique 
Port Numbers for the Internet Agent and Its MTA
As with the MTA and the POA, the Internet Agent needs a secondary IP address and cluster-unique 
port numbers. As part of planning to install the MTA and POA, you should already have determined 
the secondary IP address and cluster-unique port numbers for the Internet Agent and its MTA as you 
filled out the “IP Address Worksheet” on page 36. If you do not have a filled-out copy of this 
worksheet for your system, print it now and fill in current system information.

4.1.5  Preparing Your Firewall for the Internet Agent
The Internet Agent receives incoming messages on the secondary IP address of the Internet Agent 
domain volume. Your firewall configuration must be modified to allow inbound TCP/IP traffic from 
the Internet to the Internet Agent secondary IP address on the following standard ports:

Table 4-1   Standard Ports

By default, the Internet Agent sends outgoing messages on the primary IP address of the server 
where it is running. If you decide to use this default configuration, your firewall must be configured 
to allow outbound TCP/IP traffic from all nodes in the Internet Agent volume failover path.

If the Internet Agent has a large number of nodes on its failover path, you could configure the 
Internet Agent to send outgoing messages to a relay host, which would then send them out through 
the firewall using its own IP address rather than the address of the particular node where the Internet 
Agent was running. This reduces the amount of modification to your firewall required to set up the 
Internet Agent. However, if the relay host goes down, outgoing messages are delayed.

As another alternative, you can configure the Internet Agent to use its secondary IP address for 
sending as well as receiving messages. Setup instructions for this configuration are provided in 

INTERNET AGENT CLUSTERING WORKSHEET

Under Item 5: MTA Network Information, transfer the MTA secondary IP address and cluster-unique 
port numbers from the Internet Agent section of the IP Address Worksheet to the Internet Agent 
Clustering Worksheet. 

Under Item 1: Shared Volume for Internet Agent, copy the MTA secondary IP address under Cluster 
Volume IP Address as well, because they are the same.

Under Item 7: Internet Agent Network Information, transfer the Internet Agent secondary IP address 
(the same as for its MTA) and the cluster-unique Internet Agent port number from the Internet Agent 
section of the IP Address Worksheet to the Internet Agent Clustering Worksheet.

Protocol Standard Port

IMAP4 143

LDAP 389

POP3 110

SMTP 25
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“Forcing Use of the Internet Agent Secondary IP Address” on page 77, which you can complete 
after installing the Internet Agent.

In preparation for installing the Internet Agent, configure your firewall as needed to handle the 
Internet Agent’s use of primary and secondary IP addresses when sending and receiving messages.

4.1.6  Deciding Where to Install the Internet Agent and Its MTA
As with the MTA and the POA, you can choose to install the Internet Agent and its MTA to the 
sys:\system directory of each node or to a vol:\system directory on the Internet Agent 
volume. For a discussion of these alternatives, see “Deciding Where to Install the Agent Software” 
on page 30, which describes the issues in the context of planning MTA and POA installations. If you 
only have one Internet Agent for your GroupWise system with several servers in its failover path, it 
is an easy choice: Install it once to a vol:\system directory on the Internet Agent volume.

4.1.7  Deciding Whether to Run the Internet Agent and Its MTA 
in Protected Memory
As with the MTA and the POA, you can choose whether to run the Internet Agent in protected 
memory. For a review of the benefits of protected memory, see “Deciding Whether to Run the 
Agents in Protected Memory” on page 32, which describes the issues in the context of planning 
MTA and POA installations.

You might think that protected memory is not necessary if you have only one Internet Agent for your 
GroupWise system because it could never fail over to a node where another Internet Agent was 
running. However, because the Internet Agent in a cluster is installed into its own domain with its 
own MTA, this MTA could fail over to a node where another MTA was already running. Therefore, 
it is safest to load the MTA into protected memory. Loading the Internet Agent into protected 
memory is optional.

4.1.8  Planning the MTA Installation
Follow the instructions in “Planning the NetWare Agent Installation” on page 33, then return to this 
point. After you follow the instructions, you have a filled-out NetWare Agent Worksheet to use 
when you install the MTA.

INTERNET AGENT CLUSTERING WORKSHEET

Under Item 4: MTA Installation Location and Item 6: Internet Agent Installation Location, mark whether 
you will install the Internet Agent and its MTA to a vol:\system directory on the Internet Agent 
volume or to sys:\system on each node in the cluster. If necessary, specify where the MTA startup 
file and the Internet Agent configuration file will be stored.

INTERNET AGENT CLUSTERING WORKSHEET

Under Item 8: Load Internet Agent and Its MTA in Protected Memory?, mark whether you need to run 
the Internet Agent and its MTA in protected memory. If you do, provide a protected memory address 
space name for each agent.
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IMPORTANT: Do not install the NetWare MTA until you are instructed to do so in Section 4.2, 
“Setting Up the Internet Agent in a Cluster,” on page 69.

4.1.9  Planning the Internet Agent Installation
Aside from the cluster-specific issues discussed in the preceding sections, the considerations 
involved in planning to install the Internet Agent are the same in a clustering environment as for any 
other environment. Review the installation instructions in “NetWare and Windows: Installing the 
Internet Agent Software” in “Installing the GroupWise Internet Agent” in the GroupWise 7 
Installation Guide. You might want to print this section and write down the types of planning 
information you have provided on worksheets in other sections. You will need this information as 
you install the Internet Agent in your cluster.

IMPORTANT: Do not install the Internet Agent software until you are instructed to do so in 
Section 4.2, “Setting Up the Internet Agent in a Cluster,” on page 69.

4.2  Setting Up the Internet Agent in a Cluster
You should already have reviewed Section 4.1, “Planning the Internet Agent in a Cluster,” on 
page 65 and filled out the Section 4.4, “Internet Agent Clustering Worksheet,” on page 80. You are 
now ready to complete the following tasks to set up the Internet Agent in a clustering environment:

• “Cluster-Enabling a Shared Volume for Use with the WebAccess Agent” on page 89
• “Creating a Domain for the Internet Agent” on page 70
• “Installing the MTA for the Internet Agent Domain” on page 70
• “Installing and Configuring the Internet Agent in a Cluster” on page 70
• “Testing the Clustered Internet Agent” on page 77
• Section 4.3, “Managing the Internet Agent in a Cluster,” on page 78

4.2.1  Cluster-Enabling a Shared Volume for Use with the 
Internet Agent
To cluster-enable the Internet Agent shared volume:

1 Complete the cluster-enabling steps in the applicable section of the cluster documentation for 
your version of NetWare, as listed in Chapter 1, “Introduction to GroupWise 7 and Novell 
Cluster Services on NetWare,” on page 17.
The Internet Agent Clustering Worksheet provides the volume to cluster-enable, the cluster-
enabled volume IP address, and the failover path for the Internet Agent volume.
For a review of the new Novell® eDirectoryTM objects that are created when you cluster-enable 
a shared volume, see Section 2.6, “Deciding Whether to Cluster-Enable the Shared Volumes 
Used by GroupWise,” on page 23.
If you have installed the latest version of ConsoleOne® and the Novell Cluster Services snap-
in, you can rename the cluster-related objects in case your DNS name server cannot resolve 
object names that include the underscore (_) character.
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2 To ensure successful short name resolution, add entries for the Internet Agent virtual server to 
support your preferred methods of short name resolution, as described in “Configuring Short 
Name Resolution” on page 40.

3 To ensure that the Internet Agent has incoming and outgoing access to the Internet, make sure 
your firewall is properly configured, as described in “Preparing Your Firewall for the Internet 
Agent” on page 67.

4 Continue with “Creating a Domain for the Internet Agent” on page 70.

4.2.2  Creating a Domain for the Internet Agent
The Internet Agent domain will be a secondary domain. To create it, follow the instructions in 
Section 3.3, “Creating a New Secondary Domain in a Cluster,” on page 44, taking your information 
from the Internet Agent Clustering Worksheet, rather than the System Clustering Worksheet, then 
return to this point. 

Do not create any post offices in the Internet Agent domain.

Continue with “Installing the MTA for the Internet Agent Domain” on page 70.

4.2.3  Installing the MTA for the Internet Agent Domain
The MTA for the Internet Agent domain can be installed just like any other MTA in your clustered 
GroupWise system. Follow the instructions in “Installing the Agent Software in a Cluster” on 
page 47, then return to this point. 

You do not need to edit the MTA startup file. You do not need to modify the Volume Resource 
properties until after you have installed the Internet Agent.

Continue with “Installing and Configuring the Internet Agent in a Cluster” on page 70.

4.2.4  Installing and Configuring the Internet Agent in a Cluster
After you have created a domain for the Internet Agent and installed the MTA for that domain, you 
are ready to install and configure the Internet Agent.

• “Installing the Internet Agent Software in a Cluster” on page 70
• “Configuring the Internet Agent Volume Resource to Load and Unload the Internet Agent and 

Its MTA” on page 71
• “Enabling Internet Addressing for Your Clustered GroupWise System” on page 76
• “Verifying GWIA Object Properties” on page 76

Installing the Internet Agent Software in a Cluster
1 Map a drive to the Internet Agent volume (Internet Agent Clustering Worksheet item 1).

The Internet Agent volume name will be cluster_volume. For assistance with mapping a drive 
to a cluster-enabled volume, see “Configuring Short Name Resolution” on page 40.

2 If you selected vol:\system on Internet Agent Volume as the Internet Agent installation 
location (Internet Agent Clustering Worksheet item 6), create the vol:\system directory on 
the Internet Agent volume accessed in Step 1.
or
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If you selected sys:\system on Each Node, decide which node you will install the Internet 
Agent to first, then map a drive to sys:\system on that node.

3 Start the Internet Agent Installation program and install the NetWare® Internet Agent, 
following the steps provided in “NetWare and Windows: Installing the Internet Agent 
Software” in “Installing the GroupWise Internet Agent” in the GroupWise 7 Installation Guide. 
Keep in mind the following cluster-specific details:

• Use the notes you made during “Planning the Internet Agent Installation” on page 69 to 
fill in the fields during the Internet Agent installation process.

• In the Installation Path dialog box, be sure to browse through the drive you mapped to the 
location you chose in Step 2 above. Deselect Update AUTOEXEC File and select 
Configure GroupWise Agents for Clustering.

• In the GroupWise Domain dialog box, be sure to browse through the drive you mapped in 
Step 1 to the domain directory (Internet Agent Clustering Worksheet item 2). 

• The Internet Agent Installation program creates the gwia.ncf file, which includes the 
load command for the Internet Agent. You need this information later when you create 
the load script for the Volume Resource object.

4 If you need to install the Internet Agent to sys:\system to each node in the cluster:
4a Repeat Step 3, mapping new drives as needed.
4b If you selected Yes for Consolidate Multiple Configuration Files on Internet Agent 

Volume? (under Internet Agent Clustering Worksheet item 6), copy the gwia.cfg file to 
the planned location, then delete it from the sys:\system directories to avoid future 
confusion.

5 Make sure you have completed all the tasks described in “Installing the GroupWise Internet 
Agent” in the GroupWise 7 Installation Guide. 
The Internet Agent starts automatically immediately after Installation.

6 Stop each Internet Agent you have installed before configuring it for clustering.
7 Continue with “Configuring the Internet Agent Volume Resource to Load and Unload the 

Internet Agent and Its MTA” on page 71.

Configuring the Internet Agent Volume Resource to Load and Unload the Internet 
Agent and Its MTA

The properties of the Volume Resource object define how the Internet Agent volume functions 
within the cluster, how NLMTM programs are loaded and unloaded, and how failover and failback 
situations are handled. Complete the following tasks for the Internet Agent volume:

• “Modifying the Volume Resource Load Script for the Internet Agent” on page 71
• “Modifying the Volume Resource Unload Script for the Internet Agent” on page 73
• “Setting the Failover Path and Policies for the Internet Agent” on page 75

Modifying the Volume Resource Load Script for the Internet Agent

The volume resource load script executes whenever the Internet Agent volume comes online.

To set up the load script:
1 In ConsoleOne, browse to and select the Cluster object.

If necessary, click View > Console View to display its contents.
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2 Right-click the Volume Resource object (volume_SERVER), then click Properties > Load to 
display the default volume resource load script for the Internet Agent volume.
The next step assumes that this is the first time you have edited this load script. If other 
GroupWise agents are already running from this volume, some of the modifications have 
already been made.

3 Make the following changes to the default load script:

• Remove the trustmig command. It is not necessary to migrate trustees for the Internet 
Agent volume. Removing this line helps the load script to execute faster.

• On NetWare 5.1, if you are using SLP as a short name resolution method, as described in 
“Configuring Short Name Resolution” on page 40, add the cvsbind add command for 
the Internet Agent volume to the load script. 
cvsbind add cluster_volume_SERVER IP_address

• If you selected vol:\system on Internet Agent volume as the installation location 
(Internet Agent Clustering Worksheet items 4 and 6), add a search add command to 
add the new vol:\system directory to the server search path.
search add volume:\system

• If you selected sys:\system on each node as the installation location (Internet Agent 
Clustering Worksheet items 4 and 6) but you are storing the MTA startup file and the 
Internet Agent configuration file on the Internet Agent volume, add that location to the 
server search path.

• If you selected No under Load Internet Agent and Its MTA in Protected Memory? (Internet 
Agent Clustering Worksheet item 8), add the following abend recovery options:
set auto restart after abend = 2
set auto restart after abend delay time = 0
set auto restart down timeout = 60
set developer option = off

These settings provide the best possible handling of GroupWise databases in the event that 
an abend should occur within the cluster.

• Transfer the MTA load command from the grpwise.ncf file located in the 
vol:\system directory into the load script. Use Ctrl+C and Ctrl+V to copy and paste 
text into the load script page. Then delete or rename the grpwise.ncf file to avoid 
future confusion.
load volume:\system\gwmta.nlm @domain.mta

• Add a delay so that the MTA is fully loaded before the Internet Agent starts to load:
load delay.nlm 
delay 10

The length of the delay varies from system to system; ten seconds is a good starting place.
• Transfer the Internet Agent load command from the gwia.ncf file located in the 
vol:\system directory into the load script. Use Ctrl+C and Ctrl+V to copy and paste 
text into the load script page. Then delete or rename the gwia.ncf file to avoid future 
confusion.
load volume:\system\gwia.nlm @gwia.cfg

• If you selected Yes under Load Internet Agent and Its MTA in Protected Memory? (Internet 
Agent Clustering Worksheet item 8), add the address space parameter to the load 
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commands to specify the protected address space where the Internet Agent and its MTA 
will run. Add a protection restart command for the address space name. 
load address space=addr_space_name

volume:\system\gwmta.nlm @domain.mta
load address space=addr_space_name

 volume:\system\gwia.nlm @gwia.cfg
protection restart addr_space_name

The result would look similar to the following example:

NOTE: The set commands are needed in the load script only when the MTA and the Internet 
Agent are not running in protected memory. The address space parameters are needed in the 
load commands only when the MTA and the Internet Agent are running in protected memory.

4 Click Apply to save the load script.
5 If necessary, click OK to confirm that you must offline and then online the volume resource in 

order for the changes to take effect.
6 Continue with “Modifying the Volume Resource Unload Script for the Internet Agent” on 

page 73.

Modifying the Volume Resource Unload Script for the Internet Agent

The volume resource unload script executes whenever the Internet Agent volume goes offline. 
Programs should be unloaded in the reverse order of how they were loaded. This ensures that 
supporting programs are not unloaded before programs that rely on them in order to function 
properly.

To set up the unload script:
1 In ConsoleOne, in the properties pages for the Volume Resource object (volume_SERVER), 

click Unload to display the default volume resource unload script.
The next step assumes that this is the first time you have edited this unload script. If other 
GroupWise agents are already running from this volume, some of the modifications have 
already been made.

2 Make the following changes to the default unload script:
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• If you selected Yes under Load Internet Agent and Its MTA in Protected Memory? (Internet 
Agent Clustering Worksheet item 8), add an unload address space command and 
an unload kill address space command to ensure that the address space is 
completely cleaned up. 

unload address space=addr_space_name
unload kill address space=addr_space_name

If your system seems to be trying to kill the address space before the Internet Agent and its 
MTA have been completely unloaded, resulting in the agents hanging in the unloading 
state, set a delay of several seconds before issuing the unload kill address 
space command to allow the Internet Agent and its MTA adequate time to unload 
completely. The length of the delay varies from system to system; ten seconds is a good 
starting place.

unload address space=addr_space_name 
delay 10 
unload kill address space=addr_space_name

• If you selected No under Load Internet Agent and Its MTA in Protected Memory? (Internet 
Agent Clustering Worksheet items 8), create an unload command parallel to each load 
command that you placed in the load script. 
unload volume:\system\gwia.nlm
unload volume:\system\gwmta.nlm

• On NetWare 5.1, if you are using SLP as a short name resolution method, add the 
cvsbind del command for the Internet Agent volume to the unload script. 
cvsbind del cluster_volume_SERVER IP_address

• Remove the trustmig command just like you did in the load script. 
The result would look similar to the following example:

3 Click Apply to save the unload script.
4 If necessary, click OK to confirm that you must offline and then online the volume resource in 

order for the changes to take effect.
5 Continue with “Setting the Failover Path and Policies for the Internet Agent” on page 75.
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Setting the Failover Path and Policies for the Internet Agent

To modify the failover path and policies for the Internet Agent volume resource:
1 In ConsoleOne, in the properties pages for the Volume Resource object (volume_SERVER), 

click Nodes to display the default failover path for the Internet Agent volume resource.

2 Arrange the nodes in the cluster into the desired failover path for the Internet Agent volume 
(Internet Agent Clustering Worksheet item 3).

3 Click Apply to save the failover path.
4 Click Policies to display the default start, failover, and failback policies.

The default policy settings are often appropriate. By default, a volume resource:

• Fails over automatically if the node it is running on fails
• Starts automatically on the next node in its failover path
• Continues running at its failover location, even after its most preferred node is again 

available
If you are considering changing these defaults, see the applicable section about failover and 
failback modes in the cluster documentation for your version of NetWare, as listed in Chapter 
1, “Introduction to GroupWise 7 and Novell Cluster Services on NetWare,” on page 17.

5 Click OK when you are finished editing the Internet Agent volume resource properties.
6 Continue with “Enabling Internet Addressing for Your Clustered GroupWise System” on 

page 76.
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Enabling Internet Addressing for Your Clustered GroupWise System

Setting up Internet addressing for a clustered Internet Agent is no different from setting it up for an 
Internet Agent in a any other environment. Follow the instructions in “Enabling Internet 
Addressing” in “System” in the GroupWise 7 Administration Guide, then return to this point.

Verifying GWIA Object Properties

During installation of the Internet Agent, the GWIA object should have been configured correctly. 
However, it can be helpful to verify certain cluster-specific information in order to familiarize 
yourself with the configuration of a clustered Internet Agent.

• “Accessing GWIA Object Properties” on page 76
• “Verifying the Reference to the Volume Resource” on page 76
• “Verifying the Reference to the Virtual Server” on page 76
• “Verifying Post Office Links” on page 76
• “Forcing Use of the Internet Agent Secondary IP Address” on page 77

Accessing GWIA Object Properties
1 In ConsoleOne, browse to and select the Internet Agent domain in order to display its contents.
2 Right-click the GWIA object, then click Properties.
3 Continue with “Verifying the Reference to the Volume Resource” on page 76.

Verifying the Reference to the Volume Resource

In the GWIA object properties pages:
1 Click SMTP/MIME > Settings. 
2 Verify the contents of the Hostname/DNS "A Record" Name field.

It displays the hostname as currently configured in DNS. It should match the Volume Resource 
object name (volume_SERVER) of the Internet Agent volume, not the name of a physical 
server in the cluster.

3 Make changes if necessary.
4 Continue with “Verifying the Reference to the Virtual Server” on page 76.

Verifying the Reference to the Virtual Server

In the GWIA object properties pages:
1 Click Server Directories. 
2 Verify that the displayed directories match the virtual server name (cluster_volume_SERVER) 

associated with the Volume Resource object, not the name of a physical server in the cluster.
3 Make changes if necessary.
4 Continue with “Verifying Post Office Links” on page 76.

Verifying Post Office Links

In the GWIA object properties pages:
1 Click Post Office Links.
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2 Verify that the Access Mode column displays C/S (for client/server mode) for all post offices 
serviced by the Internet Agent.

3 Verify that the Links column displays the secondary IP addresses of the GroupWise volumes 
where post offices reside, not the IP addresses of any physical servers in the cluster.

4 Make changes if necessary.
5 Continue with “Forcing Use of the Internet Agent Secondary IP Address” on page 77.

Forcing Use of the Internet Agent Secondary IP Address

If you want the Internet Agent to send outgoing messages on its secondary IP address, rather than 
using the default of its primary IP address:

1 Click GroupWise > Network Address.
2 In the TCP/IP Address field, provide the secondary IP address (under Internet Agent Clustering 

Worksheet item 1) for the Internet Agent to use for sending outgoing messages.
3 Click SMTP/MIME, then click Settings.
4 Select Bind to TCIP/IP Address at Connection Time.
5 Click OK.
6 Continue with “Testing the Clustered Internet Agent” on page 77.

4.2.5  Testing the Clustered Internet Agent
After you have configured the Internet Agent volume resource, you can test the load and unload 
scripts by bringing the Internet Agent volume online and taking it offline again.

1 In ConsoleOne, select the Cluster object, then click View > Cluster State.

The new Internet Agent volume resource shows Offline in the State column.
2 Click the new Internet Agent volume resource, then click Online.
Implementing the Internet Agent in a NetWare Cluster 77



78 GroupWise 

novdocx (E
N

U
)  6 D

ecem
ber 2005
The State column for the volume resource now displays Running.
3 Observe the server console where the Internet Agent and its MTA are loading to see that they 

start and run correctly. 
If you are using protected memory, you can use the protection command at the server 
console prompt to list all the address spaces on the node and what NLM programs are running 
in each one.

4 Click the new Internet Agent volume resource, then click Offline.
The State column for the volume resource returns to Offline.

5 Observe the server console where the Internet Agent and its MTA are unloading to see that they 
shut down correctly. 
If you are using protected memory, you can use the protection command again to make 
sure that the address space used by the Internet Agent and its MTA is no longer present.

6 Repeat Step 2 whenever you are ready to bring the new Internet Agent volume resource online 
permanently.
On NetWare 6.x, these actions can also be performed from your Web browser. See “Using 
Novell Remote Manager on NetWare 6.x” on page 57.

7 Continue with Section 4.3, “Managing the Internet Agent in a Cluster,” on page 78.

4.3  Managing the Internet Agent in a Cluster
After you have installed the Internet Agent in a cluster, you should consider some long-term 
management issues.

• “Updating GroupWise Objects with Cluster-Specific Descriptions” on page 78
• “Knowing What to Expect in an Internet Agent Failover Situation” on page 79

4.3.1  Updating GroupWise Objects with Cluster-Specific 
Descriptions
After installing the Internet Agent in your clustered GroupWise system, while the cluster-specific 
information is fresh in your mind, you should record that cluster-specific information as part of the 
GroupWise objects in ConsoleOne so that you can easily refer to it later. Be sure to update the 
information recorded in the GroupWise objects if the configuration of your system changes.

• “Recording Cluster-Specific Information about the Internet Agent Domain and Its MTA” on 
page 79
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• “Recording Cluster-Specific Information about the Internet Agent” on page 79

Recording Cluster-Specific Information about the Internet Agent Domain and Its MTA

To permanently record important cluster-specific information for the Internet Agent domain:
1 In ConsoleOne, browse to and right-click the Domain object, then click Properties.
2 In the Description field of the Internet Agent domain Identification page, provide a cluster-

specific description of the Internet Agent domain, including the secondary IP address of its 
cluster-enabled volume and the cluster-unique port numbers used by its MTA. 

3 Click OK to save the Internet Agent domain description.
4 Select the Internet Agent Domain object to display its contents.
5 Right-click the MTA object, then click Properties.
6 In the Description field of the MTA Identification page, record the secondary IP address of the 

cluster-enabled Internet Agent domain volume and the cluster-unique port numbers used by the 
MTA. 
This information appears on the MTA console, no matter which node in the cluster it is 
currently running on.

7 Click OK to save the MTA description.
8 Continue with “Recording Cluster-Specific Information about the Internet Agent” on page 79.

Recording Cluster-Specific Information about the Internet Agent

With the contents of the Internet Agent domain still displayed:
1 Right-click the GWIA object, then click Properties.
2 Click GroupWise, then click Identification.
3 In the Description field, record the secondary IP address of the cluster-enabled Internet Agent 

domain volume and the cluster-unique port numbers used by the Internet Agent. 
This information appears on the Internet Agent console, no matter which node in the cluster it 
is currently running on.

4 Click OK to save the Internet Agent information.
5 Continue with “Knowing What to Expect in an Internet Agent Failover Situation” on page 79.

4.3.2  Knowing What to Expect in an Internet Agent Failover 
Situation
The failover behavior of the MTA for the Internet Agent domain is the same as for an MTA in a 
regular domain. See “Knowing What to Expect in MTA and POA Failover Situations” on page 60.

Failover of the Internet Agent itself is more complex. The various clients (POP3, IMAP4, and 
LDAP) receive an error message that the node is not available. Most of the clients do not attempt to 
reconnect automatically, so the user must exit the client and restart it to reestablish the connection 
after the failover process is complete. Fortunately, the Internet Agent restarts quickly in its failover 
location so users can reconnect quickly.

As with the MTA and the POA, migration of the Internet Agent takes longer than failover. In fact, 
the Internet Agent can seem especially slow to shut down properly as it finishes its normal 
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processing and stops its threads. For a busy Internet Agent, you might need to wait several minutes 
for it to shut down properly.

4.4  Internet Agent Clustering Worksheet

Item Explanation

1) Shared Volume for Internet 
Agent:

Cluster Enabled?

• Yes (highly recommended)

Cluster volume IP address

• No

Specify the name (cluster_volume) of the shared volume where the 
Internet Agent domain will be created.

For cluster-enabling, specify the IP addresses of the virtual server 
(volume_SERVER.cluster) to which the cluster-enabled volume is 
tied.

For more information, see “Deciding Whether to Cluster-Enable the 
Internet Agent Volume” on page 66.

2) Internet Agent 
Domain Name:

Domain Database Location:

Specify a unique name for the Internet Agent domain. Specify the 
directory on the Internet Agent volume where you want to create the 
new domain.

For more information, see “Planning a Domain for the Internet Agent” 
on page 65.

3) Internet Agent 
Failover Path:

List other nodes in the cluster where the Internet Agent and its MTA 
could fail over.

For more information, see “Determining an Appropriate Failover Path 
for the Internet Agent Volume” on page 66.

4) MTA Installation Location:

• vol:\system on Internet 
Agent volume

• sys:\system on each 
node
Consolidate multiple MTA 
startup files on Internet 
Agent volume?

Mark the location where you will install the MTA software. If 
necessary, specify the location where you will consolidate multiple 
MTA startup files on an Internet Agent volume.

For more information, see “Deciding Where to Install the Internet 
Agent and Its MTA” on page 68.

5) MTA Network Information:

• MTA IP address

• MTA message transfer port

• MTA live remote port

• MTA HTTP port

Gather the MTA network address information from the Internet Agent 
section of the “IP Address Worksheet” on page 36.

For more information, see “Planning a Secondary IP Address and 
Cluster-Unique Port Numbers for the Internet Agent and Its MTA” on 
page 67.
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4.5  Internet Agent Quick Checklist
Plan the new clustered Internet Agent, including the new domain required to house the Internet 
Agent in a clustering environment.

See Section 4.1, “Planning the Internet Agent in a Cluster,” on page 65.
Make sure your firewall is configured to accommodate the Internet Agent.
See “Preparing Your Firewall for the Internet Agent” on page 67.
Cluster-enable the volume where the Internet Agent domain will reside. 
See “Cluster-Enabling a Shared Volume for Use with the WebAccess Agent” on page 89.
Create the new Internet Agent domain. 
See “Creating a Domain for the Internet Agent” on page 70.
Set up the MTA for the new Internet Agent domain.
See “Installing the MTA for the Internet Agent Domain” on page 70.
Install the Internet Agent.
See “Installing the Internet Agent Software in a Cluster” on page 70.
Modify the Internet Agent volume resource load script:

• Remove the trustmig command

6) Internet Agent 
Installation Location:

• vol:\system on the 
Internet Agent volume

• sys:\system on each 
node
Consolidate multiple 
Internet Agent configuration 
files on Internet Agent 
volume?

Mark the location where you will install the Internet Agent software. 

If necessary, specify the location where you will consolidate multiple 
Internet Agent configuration files (gwia.cfg) on an Internet Agent 
volume.

For more information, see “Deciding Where to Install the Internet 
Agent and Its MTA” on page 68.

7) Internet Agent 
Network Information:

• Internet Agent IP address

• Internet Agent HTTP port

Gather the Internet Agent network address information from the 
Internet Agent section of the “IP Address Worksheet” on page 36.

For more information, see “Planning a Secondary IP Address and 
Cluster-Unique Port Numbers for the Internet Agent and Its MTA” on 
page 67.

8) Load Internet Agent and Its 
MTA 
in Protected Memory?

• No

• Yes

Protected address space names:

• MTA:

• Internet Agent:

Mark whether you need to run the Internet Agent and its MTA in 
protected memory. If so, specify a unique address space for each 
agent.

For more information, see “Deciding Whether to Run the Internet 
Agent and Its MTA in Protected Memory” on page 68.

Item Explanation
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• Add the cvsbind add command (NetWare 5.1 only; optional)
• Add the search add command (optional)
• If you will not run the MTA and the Internet Agent in protected memory, add the set 
auto restart commands and the set developer option = off command

• Add the load commands for the MTA and the Internet Agent, separating them with a 
delay command

• If you will run the MTA and the Internet Agent in protected memory, add the address 
space parameter to the load commands and add a protection restart command 
for the address space

See “Modifying the Volume Resource Load Script for the Internet Agent” on page 71.
Modify the Internet Agent volume resource unload script:

• Add the MTA and Internet Agent or address space unload command(s)
• Add the cvsbind del command if you used the cvsbind add command in the load 

script (NetWare 5.1 only; optional)
• Remove the trustmig command

See “Modifying the Volume Resource Unload Script for the Internet Agent” on page 73.
Set up the Internet Agent volume failover path and policies. 
See “Setting the Failover Path and Policies for the Internet Agent” on page 75.
Enable Internet Addressing for the clustered Internet Agent.
See “Enabling Internet Addressing for Your Clustered GroupWise System” on page 76.
Double-check the cluster-specific GWIA object properties.
See “Verifying GWIA Object Properties” on page 76.
Test the clustered Internet Agent. 
See “Testing the Clustered Internet Agent” on page 77.
Record cluster-specific information in the properties pages of the GroupWise objects 
associated with the Internet Agent.
See “Updating GroupWise Objects with Cluster-Specific Descriptions” on page 78.
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5Implementing WebAccess in a 
NetWare Cluster

You should already have set up at least a basic GroupWise® system, as described in Chapter 2, 
“Planning GroupWise in a NetWare Cluster,” on page 19 and Chapter 3, “Setting Up a Domain and 
Post Office in a NetWare Cluster,” on page 39. As part of this process, the “System Clustering 
Worksheet” on page 34 and the “IP Address Worksheet” on page 36 were filled out. If you do not 
have access to the filled-out worksheets, print the worksheets now and fill in the clustering and 
network address information as it currently exists on your system. You need this information as you 
implement WebAccess in a cluster.

• Section 5.1, “Understanding the WebAccess Components,” on page 83
• Section 5.2, “Planning WebAccess in a Cluster,” on page 83
• Section 5.3, “Setting Up WebAccess in a Cluster,” on page 88
• Section 5.4, “Managing WebAccess in a Cluster,” on page 97
• Section 5.5, “WebAccess Clustering Worksheet,” on page 99
• Section 5.6, “WebAccess Quick Checklist,” on page 101

5.1  Understanding the WebAccess Components
If you are not familiar with GroupWise WebAccess, review “GroupWise WebAccess Overview” in 
“Installing GroupWise WebAccess” in the GroupWise 7 Installation Guide.

As you plan WebAccess in a clustering environment, you must keep in mind that you will plan and 
set up two WebAccess components: 

• WebAccess Agent (gwinter.nlm) that will be associated with a GroupWise WebAccess 
domain

• WebAccess Application (a Java* servlet) that will be added to your Web server (Netscape 
Enterprise Server for NetWare® required on NetWare 6)

5.2  Planning WebAccess in a Cluster
A main system configuration difference between a GroupWise system in a clustering environment 
and a GroupWise system in a regular environment is that you need to create a separate domain to 
house each GroupWise gateway, including the WebAccess Agent.

Section 5.5, “WebAccess Clustering Worksheet,” on page 99 lists all the information you need as 
you set up the WebAccess Agent and the WebAccess Application in a clustering environment. You 
should print the worksheet and fill it out as you complete the tasks listed below:

• “Setting Up the Netscape Enterprise Web Server for NetWare in a Cluster on NetWare 6” on 
page 84

• “Planning a New Domain for the WebAccess Agent” on page 85
• “Deciding Whether to Cluster-Enable the WebAccess Agent Volume” on page 85
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• “Determining an Appropriate Failover Path for the WebAccess Agent Volume” on page 85
• “Planning a Secondary IP Address and Cluster-Unique Port Numbers for the WebAccess Agent 

and Its MTA” on page 86
• “Deciding Where to Install the WebAccess Agent and Its MTA” on page 86
• “Deciding Whether to Run the WebAccess Agent and Its MTA in Protected Memory” on 

page 86
• “Planning the MTA Installation” on page 87
• “Planning the WebAccess Installation” on page 87

IMPORTANT: NetWare 6.5 provides Apache and Tomcat instead of the Netscape Enterprise Web 
Server, which was provided on NetWare 6. However, NetWare 6.5 Support Packs currently cannot 
update an Apache/Tomcat installation that is located on cluster-enabled volume. Consequently, 
clustering WebAccess with Apache and Tomcat is not currently supported by Novell®. However, 
helpful instructions are available from Tay Kratzer at www.taykratzer.com.

5.2.1  Setting Up the Netscape Enterprise Web Server for 
NetWare in a Cluster on NetWare 6
Although several Web servers are supported for use with GroupWise WebAccess in a non-clustered 
environment, only the Netscape Enterprise Server for NetWare is supported in a clustering 
environment because it is the only currently supported Web server that runs on NetWare 6. In 
preparation for installing WebAccess in your clustered GroupWise system, install and set up the 
Netscape Enterprise Server for NetWare, following the instructions in “Configuring NetWare 
Enterprise Web Server with Novell Cluster Services” in NetWare Cluster Services Resource 
Configuration Guide.

As you set up the Netscape Enterprise Server, record the following key configuration information on 
the WebAccess Clustering Worksheet:

The Netscape Enterprise Server for NetWare does not depend on the functionality of cluster-enabled 
volumes the way GroupWise does. Because the WebAccess Application will be installed to a 
subdirectory of the Netscape Enterprise Server installation directory 
(sys:\novonyx\suitespot\docs\com\novell\webaccess), the WebAccess 

WEBACCESS CLUSTERING WORKSHEET

Under Item 10: Physical Web Servers, list the physical NetWare servers where you are installing the 
Netscape Enterprise Server software.

Under Item 11: Netscape Enterprise Server IP Address, record the secondary IP address of the 
Netscape Enterprise Server cluster resource that you create. 

Under Item 12: Netscape Enterprise Server Mode, mark whether you have configured the Netscape 
Enterprise Server to run in active/active or active/passive mode. In active/active mode, the Netscape 
Enterprise Server runs on multiple nodes simultaneously; this is the recommended mode. 

Under Item 13: Netscape Enterprise Server Failover Path, list the nodes in the cluster where you want 
the Netscape Enterprise Server cluster resource to fail over.

Under Item 14: Hardware Virtual Server Information, record the dedicated IP address for the Web site 
and the document root directory.
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Application cannot be installed on a cluster-enabled volume. Instead, you install it to the sys: 
volume on each node where the Netscape Enterprise Server has been installed.

5.2.2  Planning a New Domain for the WebAccess Agent
The considerations involved in planning a domain for the WebAccess Agent are much the same as 
planning any other domain. In preparation, review “Planning a New Domain”, then print and fill out 
the “Domain Worksheet” in “Domains” in the GroupWise 7 Administration Guide. 

Keep in mind the following cluster-specific details:

• When you specify the location for the domain directory on the Domain Worksheet, include the 
shared volume where you want the domain directory to reside.

• Do not concern yourself with the GroupWise agent information on the Domain Worksheet. You 
can stop with item 10. You will plan the MTA installation later.

When you have completed the Domain Worksheet, transfer the key information from the Domain 
Worksheet to the WebAccess Clustering Worksheet.

5.2.3  Deciding Whether to Cluster-Enable the WebAccess 
Agent Volume
You should plan to cluster-enable the shared volume where the WebAccess Agent domain will 
reside. For a review of the benefits of cluster-enabling volumes, see Section 2.6, “Deciding Whether 
to Cluster-Enable the Shared Volumes Used by GroupWise,” on page 23, which describes the issues 
in the context of planning MTA and POA installations. 

Cluster-enabling relies on successful short name resolution throughout your system. Review Section 
2.7, “Ensuring Successful Name Resolution for GroupWise Volumes,” on page 25, which describes 
the issues in the context of planning MTA and POA installations.

5.2.4  Determining an Appropriate Failover Path for the 
WebAccess Agent Volume
As with the MTA and the POA, you need to decide which nodes in the cluster are appropriate 
locations where the WebAccess Agent volume could fail over. For a review of failover paths, see 
“Determining Appropriate Failover Paths for the Agents” on page 29, which describes the issues in 
the context of planning MTA and POA installations. 

WEBACCESS CLUSTERING WORKSHEET

Under Item 1: Shared Volume for WebAccess Agent, transfer the domain location from the Domain 
Worksheet to the WebAccess Clustering Worksheet. 

Under Item 2: WebAccess Agent Domain Name, transfer the domain name and database directory 
from the Domain Worksheet to the WebAccess Clustering Worksheet. 

WEBACCESS CLUSTERING WORKSHEET

Under Item 1: Shared Volume for WebAccess Agent, mark Yes under Cluster Enabled?.
Implementing WebAccess in a NetWare Cluster 85



86 GroupWise 

novdocx (E
N

U
)  6 D

ecem
ber 2005
5.2.5  Planning a Secondary IP Address and Cluster-Unique 
Port Numbers for the WebAccess Agent and Its MTA
As with the MTA and the POA, the WebAccess Agent needs a secondary IP address and cluster-
unique port numbers. As part of planning to install the MTA and POA, you should already have 
determined the secondary IP address and cluster-unique port numbers for the WebAccess Agent and 
its MTA as you filled out the “IP Address Worksheet” on page 36. If you do not have a filled-out 
copy of this worksheet for your system, print it now and fill in current system information.

5.2.6  Deciding Where to Install the WebAccess Agent and Its 
MTA
As with the MTA and the POA, you can choose to install the WebAccess Agent and its MTA to the 
sys:\system directory of each node or to a vol:\system directory on the WebAccess Agent 
volume. For a discussion of these alternatives, see “Deciding Where to Install the Agent Software” 
on page 30, which describes the issues in the context of planning MTA and POA installations. If you 
only have one WebAccess Agent for your GroupWise system with several nodes in its failover path, 
it is an easy choice.

5.2.7  Deciding Whether to Run the WebAccess Agent and Its 
MTA in Protected Memory
As with the MTA and the POA, you can choose whether to run the WebAccess Agent in protected 
memory. For a review of the benefits of protected memory, see “Deciding Whether to Run the 

WEBACCESS CLUSTERING WORKSHEET

Under Item 4: WebAccess Agent Failover Path, list the nodes that you want to have in the 
WebAccess Agent volume failover path.

WEBACCESS CLUSTERING WORKSHEET

Under Item 6: MTA Network Information, transfer the MTA secondary IP address and cluster-unique 
port numbers from the WebAccess section the IP Address Worksheet to the WebAccess Clustering 
Worksheet. 

Under Item 1: Shared Volume for WebAccess Agent, copy the MTA secondary IP address under 
Cluster Volume IP Address as well, because they are the same.

Under Item 8: WebAccess Agent Network Information, transfer the WebAccess Agent secondary IP 
address (the same as for its MTA) and the cluster-unique WebAccess Agent port number from the 
WebAccess section of the IP Address Worksheet to the WebAccess Clustering Worksheet.

WEBACCESS CLUSTERING WORKSHEET

Under Item 5: MTA Installation Location and Item 7: WebAccess Agent Installation Location, mark 
whether you will install the WebAccess Agent and its MTA to sys:\system on each node in the 
cluster or to a vol:\system directory on the WebAccess Agent volume. Also specify where the MTA 
startup file will be stored.
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Agents in Protected Memory” on page 32, which describes the issues in the context of planning 
MTA and POA installations.

You might think that protected memory is not necessary if you have only one WebAccess Agent for 
your GroupWise system because it could never fail over to a node where another WebAccess Agent 
was running. However, because the WebAccess Agent in a cluster is installed into its own domain 
with its own MTA, this MTA could fail over to a node where another MTA was already running. 
Therefore, it is safest to load the WebAccess Agent and its MTA into protected memory. Load each 
agent into its own memory space and mark each memory space as restartable. 

5.2.8  Planning the MTA Installation
Follow the instructions in “Planning the NetWare Agent Installation” on page 33, then return to this 
point. After you follow the instructions, you will have a filled-out NetWare Agent Worksheet to use 
when you install the MTA.

IMPORTANT: Do not install the NetWare MTA until you are instructed to do so in Section 5.3, 
“Setting Up WebAccess in a Cluster,” on page 88.

5.2.9  Planning the WebAccess Installation
Aside from the cluster-specific issues discussed in the preceding sections, the considerations 
involved in planning to install WebAccess are the same in a clustering environment as for any other 
environment. Review “Planning GroupWise WebAccess”, then print and fill out the “GroupWise 
WebAccess Installation Worksheet” in “Installing GroupWise WebAccess” in the GroupWise 7 
Installation Guide. When you set up WebAccess in a cluster, you install the WebAccess Agent and 
the WebAccess Application in two separate steps:

• “Planning the WebAccess Agent Installation” on page 87
• “Planning the WebAccess Application Installation” on page 88

IMPORTANT: Do not install the WebAccess software until you are instructed to do so in Section 
5.3, “Setting Up WebAccess in a Cluster,” on page 88.

Planning the WebAccess Agent Installation

For the WebAccess Agent, fill out items 2 through 12 on the GroupWise WebAccess Installation 
Worksheet, taking into account the following cluster-specific issues:

WEBACCESS CLUSTERING WORKSHEET

Under Item 8: Load WebAccess Agent and Its MTA in Protected Memory?, mark whether you need to 
run the WebAccess Agent and its MTA in protected memory. If you do, provide a protected memory 
address space name for each agent.
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Planning the WebAccess Application Installation

For the WebAccess Application, fill out items 13 through 19 on the GroupWise WebAccess 
Installation Worksheet, taking into account the following cluster-specific issues:

5.3  Setting Up WebAccess in a Cluster
You should already have reviewed Section 5.2, “Planning WebAccess in a Cluster,” on page 83 and 
filled out the Section 5.5, “WebAccess Clustering Worksheet,” on page 99. You are now ready to 
complete the following tasks to set up the WebAccess Agent in a clustering environment:

• “Cluster-Enabling a Shared Volume for Use with the WebAccess Agent” on page 89
• “Creating a Domain for the WebAccess Agent” on page 89
• “Installing the MTA for the WebAccess Agent Domain” on page 89
• “Installing and Configuring the WebAccess Agent in a Cluster” on page 89
• “Installing and Configuring the WebAccess Application in a Cluster” on page 95
• “Testing Your Clustered WebAccess Installation” on page 96
• Section 5.4, “Managing WebAccess in a Cluster,” on page 97

IMPORTANT: NetWare 6.5 provides Apache and Tomcat instead of the Netscape Enterprise Web 
Server, which was provided on NetWare 6. However, NetWare 6.5 Support Packs currently cannot 
update an Apache/Tomcat installation that is located on cluster-enabled volume. Consequently, 

WEBACCESS INSTALLATION WORKSHEET

Under Item 2: Installation Directory, take into account your decision recorded on the WebAccess 
Clustering Worksheet (Item 7: WebAccess Agent Installation Location).

Under Item 3: Server Address, transfer the IP address and port number from the WebAccess 
Clustering Worksheet (Item 8: WebAccess Agent Network Information) filled out in “Planning a 
Secondary IP Address and Cluster-Unique Port Numbers for the WebAccess Agent and Its MTA” on 
page 86.

Under Item 4: Enable Clustering Support?, mark Yes. This causes the WebAccess Installation 
program to customize the WebAccess files for clustering.

Under Item 5: Domain Directory Path, transfer the domain directory from the Domain Worksheet you 
filled out in “Planning a New Domain for the WebAccess Agent” on page 85.

WEBACCESS INSTALLATION WORKSHEET

Under Item 13: Web Server Type and Root Directory, mark Netscape Enterprise Server for NetWare 
if you are using NetWare 6. No other Web server is currently supported for use with GroupWise and 
Novell Cluster ServicesTM. The Web server root directory will be sys:\novonyx\suitespot.

Under Item 16: Novell Root Directory, do not choose a location on a cluster-enabled volume if you 
are running the Netscape Enterprise Server in active/active mode; it must be a directory on the sys: 
volume of the server. If you are using active/passive mode, you can choose a location on a cluster-
enabled volume. Just make sure that the Volume Resource load script mounts the volume before 
starting the Netscape Enterprise Server.
7 Interoperability Guide



novdocx (E
N

U
)  6 D

ecem
ber 2005
clustering WebAccess with Apache and Tomcat is not currently supported by Novell. However, 
helpful instructions are available from Tay Kratzer at www.taykratzer.com.

5.3.1  Cluster-Enabling a Shared Volume for Use with the 
WebAccess Agent

1 Complete the cluster-enabling steps in the applicable section of cluster documentation for your 
version of NetWare, as listed in Chapter 1, “Introduction to GroupWise 7 and Novell Cluster 
Services on NetWare,” on page 17.
The WebAccess Clustering Worksheet provides the volume to cluster-enable, the cluster-
enabled volume IP address, and the failover path for the WebAccess volume.
For a review of the new Novell eDirectoryTM objects that are created when you cluster-enable a 
shared volume, see Section 2.6, “Deciding Whether to Cluster-Enable the Shared Volumes 
Used by GroupWise,” on page 23.
If you have installed the latest version of ConsoleOne® and the Novell Cluster Services snap-
in, you can rename the cluster-related objects in case your DNS name server cannot resolve 
object names that include the underscore (_) character.

2 To ensure successful short name resolution, add entries for the WebAccess Agent virtual server 
to support your preferred methods of short name resolution, as described in “Configuring Short 
Name Resolution” on page 40.

3 Continue with “Creating a Domain for the WebAccess Agent” on page 89.

5.3.2  Creating a Domain for the WebAccess Agent
The WebAccess Agent domain will be a secondary domain. To create it, follow the instructions in 
Section 3.3, “Creating a New Secondary Domain in a Cluster,” on page 44, taking your information 
from the WebAccess Clustering Worksheet, rather than the System Clustering Worksheet, then 
return to this point. 

Do not create any post offices in the WebAccess Agent domain.

Continue with “Installing the MTA for the WebAccess Agent Domain” on page 89.

5.3.3  Installing the MTA for the WebAccess Agent Domain
The MTA for the WebAccess Agent domain can be installed just like any other MTA in your 
clustered GroupWise system. Follow the instructions in “Installing the Agent Software in a Cluster” 
on page 47, then return to this point. 

You do not need to edit the MTA startup file. You do not need to modify the Volume Resource 
properties until after you have installed the WebAccess Agent.

Continue with “Installing and Configuring the WebAccess Agent in a Cluster” on page 89.

5.3.4  Installing and Configuring the WebAccess Agent in a 
Cluster
After you have created a domain for the WebAccess Agent and installed the MTA for that domain, 
you are ready to install and configure the WebAccess Agent.
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• “Installing the WebAccess Agent Software in a Cluster” on page 90
• “Configuring the WebAccess Agent Volume Resource to Load and Unload the WebAccess 

Agent and Its MTA” on page 91

Installing the WebAccess Agent Software in a Cluster

The WebAccess Agent is the component of your WebAccess installation that accesses post offices 
and libraries to retrieve information for WebAccess client users.

1 Map a drive to the WebAccess Agent volume (WebAccess Clustering Worksheet item 1) where 
the WebAccess domain is located.
The WebAccess Agent volume name will be cluster_volume. For assistance with mapping a 
drive to a cluster-enabled volume, see “Configuring Short Name Resolution” on page 40.

2 If you selected vol:\system on WebAccess Agent volume as the WebAccess Agent 
installation location (WebAccess Clustering Worksheet item 7), create the vol:\system 
directory on the WebAccess Agent volume accessed in Step 1.
or
if you selected sys:\system on each node, decide which node you will install the 
WebAccess agent to first, then map a drive to its sys:\system directory.

3 Start the WebAccess Installation program and install the NetWare WebAccess Agent, following 
Step 1 through Step 5 provided in “Installing the WebAccess Agent” in “Installing GroupWise 
WebAccess” in the GroupWise 7 Installation Guide. Keep in mind the following cluster-
specific details:

• In the Components dialog box, select only GroupWise WebAccess Agent.

Do not install the WebAccess Application at this time.
• Use items 2 through 12 on the GroupWise WebAccess Installation Worksheet that you 

filled out in “Planning the WebAccess Installation” on page 87 to fill in the fields during 
the WebAccess Agent installation process.

• In the Network Address dialog box, select Configure GroupWise Agents for Clustering.
• In the Installation Path dialog box, be sure to browse through the drive you mapped to the 

location you chose in Step 2 above. 
• In the Gateway Directory dialog box, be sure to browse to the domain directory through 

the drive you mapped in Step 1 above. 
• In the Start Applications dialog box, deselect Start the GroupWise WebAccess Agent.
• The WebAccess Installation program creates the strtweb.ncf and stopweb.ncf 

files, which include the load and unload commands for the WebAccess Agent. You use 
this information later when you create the load and unload scripts for the WebAccess 
Volume Resource object.

4 If you need to install the WebAccess Agent to sys:\system on multiple nodes in the cluster, 
repeat Step 4, mapping new drives as needed.

5 Make sure you have completed all the WebAccess Agent tasks described in “NetWare and 
Windows: Setting Up GroupWise WebAccess” in “Installing GroupWise WebAccess” in the 
GroupWise 7 Installation Guide, but do not start the WebAccess Agent at this time.

6 Continue with “Configuring the WebAccess Agent Volume Resource to Load and Unload the 
WebAccess Agent and Its MTA” on page 91.
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Configuring the WebAccess Agent Volume Resource to Load and Unload the 
WebAccess Agent and Its MTA

The properties of the Volume Resource object define how the WebAccess Agent volume functions 
within the cluster, how NLMTM programs are loaded and unloaded, and how failover and failback 
situations are handled. Complete the following tasks for the WebAccess Agent volume:

• “Modifying the Volume Resource Load Script for the WebAccess Agent” on page 91
• “Modifying the Volume Resource Unload Script for the WebAccess Agent” on page 93
• “Setting the Failover Path and Policies for the WebAccess Agent” on page 94

Modifying the Volume Resource Load Script for the WebAccess Agent

The volume resource load script executes whenever the WebAccess Agent volume comes online.

To set up the load script:
1 In ConsoleOne®, browse to and select the Cluster object.

If necessary, click View > Console View to display its contents.
2 Right-click the Volume Resource object (volume_SERVER), then click Properties > Load to 

display the default volume resource load script for the WebAccess Agent volume.
The next step assumes that this is the first time you have edited the load script. If other 
GroupWise agents are already running from this volume, some of the modifications have 
already been made.

3 Make the following changes to the default load script:

• Remove the trustmig command. It is not necessary to migrate trustees for the 
WebAccess Agent volume. Removing this line helps the load script to execute faster.

• On NetWare 5.1, if you are using SLP as a short name resolution method, as described in 
“Configuring Short Name Resolution” on page 40, add the cvsbind add command for 
the WebAccess Agent volume to the load script. 
cvsbind add cluster_volume_SERVER IP_address

• If you selected vol:\system on WebAccess Agent volume as the installation location 
(WebAccess Clustering Worksheet items 5 and 7), add a search add command to add 
the new vol:\system directory to the server search path.
search add volume:\system

• If you selected sys:\system on each node as the installation location (WebAccess 
Clustering Worksheet items 5 and 7) but you are storing the MTA startup file on the 
WebAccess Agent volume, add that location to the server search path.

• If you selected No under Load WebAccess Agent and Its MTA in Protected Memory? 
(WebAccess Clustering Worksheet item 9), add the following abend recovery options:
set auto restart after abend = 2
set auto restart after abend delay time = 0
set auto restart down timeout = 60
set developer option = off

These settings provide the best possible handling of GroupWise databases in the event that 
an abend should occur within the cluster.
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• Transfer the MTA load command from the grpwise.ncf file located in the 
vol:\system directory into the load script. Use Ctrl+C and Ctrl+V to copy and paste 
text into the load script page. Then delete or rename the grpwise.ncf file to avoid 
future confusion.
load volume:\system\gwmta.nlm @domain.mta

• Add a delay so that the MTA is fully loaded before the WebAccess Agent starts to load:
load delay 
delay 10

The length of the delay varies from system to system; ten seconds is a good starting place.
• Transfer the WebAccess Agent load command from the strtweb.ncf file located in 

the vol:\system directory into the load script. Use Ctrl+C and Ctrl+V to copy and 
paste text into the load script page.
load volume:\system\gwinter.nlm 
 /ph=volume:\domain\wpgate\webac70a
 /user=username /PASSWORD=password

• If you selected Yes under Load WebAccess Agent and Its MTA in Protected Memory? 
(WebAccess Clustering Worksheet item 9), add the address space parameter to the 
load commands to specify the protected address space where the WebAccess Agent and 
its MTA will run. Add a protection restart command for the address space name. 
Load address space=addr_space_name

volume:\system\gwmta.nlm @domain.mta
load address space=addr_space_name
 volume:\system\gwinter.nlm 

/ph=volume:\domain\wpgate\webac70a
 /user=username /password=password
protection restart addr_space_name

The result would look similar to the following example:

NOTE: The set commands are needed only when the MTA and the WebAccess Agent are not 
running in protected memory. The address space parameters are needed in the load commands 
only when the MTA and the WebAccess Agent are running in protected memory.
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4 Click Apply to save the load script.
5 If necessary, click OK to confirm that you must offline and then online the volume resource in 

order for the changes to take effect.
6 Continue with “Modifying the Volume Resource Unload Script for the WebAccess Agent” on 

page 93.

Modifying the Volume Resource Unload Script for the WebAccess Agent

The volume resource unload script executes whenever the WebAccess Agent volume goes offline. 
Programs should be unloaded in the reverse order of how they were loaded. This ensures that 
supporting programs are not unloaded before programs that rely on them in order to function 
properly.

To set up the unload script:
1 In ConsoleOne, in the properties pages for the Volume Resource object (volume_SERVER), 

click Unload to display the default volume resource unload script.
The next step assumes that this is the first time you have edited the unload script. If other 
GroupWise agents are already running from this volume, some of the modifications have 
already been made.

2 Make the following changes to the default unload script:

• If you selected Yes under Load WebAccess Agent and Its MTA in Protected Memory? 
(WebAccess Clustering Worksheet item 9), add an unload address space 
command and an unload kill address space command to ensure that the 
address space is completely cleaned up. 

unload address space=addr_space_name
unload kill address space=addr_space_name

If your system seems to be trying to kill the address space before the WebAccess Agent 
and its MTA have been completely unloaded, resulting in the agents hanging in the 
unloading state, set a delay of several seconds before issuing the unload kill 
address space command to allow the WebAccess Agent and its MTA adequate time 
to unload completely. The length of the delay varies from system to system; ten seconds is 
a good starting place.

unload address space=addr_space_name
delay 10
unload kill address space=addr_space_name

• If you selected No under Load WebAccess Agent and Its MTA in Protected Memory? 
(WebAccess Clustering Worksheet items 9), create an unload command parallel to each 
load command that you placed in the load script. 
unload volume:\system\gwinter.nlm
unload volume:\system\gwmta.nlm

• On NetWare 5.1, if you are using SLP as a short name resolution method, add the 
cvsbind del command for the WebAccess Agent volume to the unload script. 
cvsbind del cluster_volume_SERVER ip_address

• Remove the trustmig command just like you did in the load script. 
The result would look similar to the following example:
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3 Click Apply to save the unload script.
4 If necessary, click OK to confirm that you must offline and then online the volume resource in 

order for the changes to take effect.
5 Continue with “Setting the Failover Path and Policies for the WebAccess Agent” on page 94.

Setting the Failover Path and Policies for the WebAccess Agent

To modify the failover path and policies for the WebAccess Agent volume resource:
1 In ConsoleOne, in the properties pages for the Volume Resource object (volume_SERVER), 

click Nodes to display the default failover path for the WebAccess Agent volume resource.

2 Arrange the nodes in the cluster into the desired failover path for the WebAccess Agent volume 
(WebAccess Clustering Worksheet item 4).

3 Click Apply to save the failover path.
4 Click Policies to display the default start, failover, and failback policies.
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The default policy settings are often appropriate. By default, a volume resource:

• Fails over automatically if the node it is running on fails
• Starts automatically on the next node in its failover path
• Continues running at its failover location, even after its most preferred node is again 

available
If you are considering changing these defaults, see the section about failover and failback mode 
modes in the clustering documentation for your version of NetWare, as listed in Chapter 1, 
“Introduction to GroupWise 7 and Novell Cluster Services on NetWare,” on page 17.

5 Click OK when you are finished editing the WebAccess Agent volume resource properties.
6 Continue with “Installing and Configuring the WebAccess Application in a Cluster” on 

page 95.

5.3.5  Installing and Configuring the WebAccess Application in 
a Cluster
Recall that the WebAccess Agent is the component of your WebAccess installation that accesses 
post offices and libraries to retrieve information for WebAccess client users. The WebAccess 
Application provides the link between the WebAccess Agent and the WebAccess clients’ Web 
browsers.

To install the WebAccess Application:
1 Map a drive to the WebAccess Agent volume (WebAccess Clustering Worksheet item 1) where 

the WebAccess domain is located.
The WebAccess Agent volume name will be cluster_volume. For assistance with mapping a 
drive to a cluster-enabled volume, see “Configuring Short Name Resolution” on page 40.

2 Map a drive to sys:\system on the first node where you want to install the WebAccess 
Application (WebAccess Clustering Worksheet item 10).

3 If the node where you are going to install the WebAccess Application is currently running any 
applications that rely on Java or on the Netscape Enterprise Server, migrate those applications 
to another node in the cluster. If any GroupWise agents are running on the node, migrate the 
agents. For assistance with migrating resources, see “Migrate Resources” in “Installation and 
Setup” in NetWare Cluster Services Overview and Installation.

4 Manually stop the Netscape Enterprise Server and unload Java.
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nvxwebdn unload java

If the WebAccess Installation program detects that the Netscape Enterprise Server and Java are 
still running, it attempts to stop them for you. However, the Installation program is not always 
successful, so performing this step manually is recommended.

5 Start the WebAccess Installation program as you did when you installed the WebAccess Agent 
(Step 3 on page 90). Keep in mind the following cluster-specific details:

• In the Components dialog box, select only GroupWise WebAccess Application.
• Use items 13 through 19 on the GroupWise WebAccess Installation Worksheet that you 

filled out in “Planning the WebAccess Installation” on page 87 to fill in the fields during 
the WebAccess Application installation process.

• In the Gateway Directory dialog box, be sure to browse to the WebAccess gateway 
directory (domain\wpgate\webac70a) through the drive you mapped in Step 1 
above. 

• In the Web Server Information dialog box, be sure to browse to the Web server root 
directory (sys:\novonyx\suitespot) through the drive you mapped in Step 2 
above. 

• In the Start Applications dialog box, deselect Restart Web Server.
6 Make sure you have completed all the WebAccess Application tasks described in “NetWare 

and Windows: Setting Up GroupWise WebAccess” in “Installing GroupWise WebAccess” in 
the GroupWise 7 Installation Guide.

7 Copy the sys:\novonyx\suitespot\docs\com directory from the node where you 
just installed the WebAccess Application to the document root directory of the hardware virtual 
server (WebAccess Clustering Worksheet item 13).

8 At the server console, manually restart Java and the Netscape Enterprise Server.

9 In the Cluster State View in ConsoleOne, offline and then online the Netscape Enterprise 
Server cluster resource, as well as any other Web server cluster resources that run on the node 
to reestablish their secondary IP addresses.

10 Repeat Step 2 through Step 9 for each node in the WebAccess Application failover path 
(WebAccess Clustering Worksheet item 13).

11 Continue with “Testing Your Clustered WebAccess Installation” on page 96.

5.3.6  Testing Your Clustered WebAccess Installation
Remember that the WebAccess Agent volume resource and the Netscape Enterprise Server cluster 
resource are separate resources that could fail over to different nodes at different times. 

To thoroughly test your WebAccess installation:
1 Make sure the initial combination of WebAccess Agent volume resource and Netscape 

Enterprise Server cluster resource is functioning properly.

NetWare 6.x 
with Tomcat Servlet Gateway

NetWare 5.1 
with Novell Servlet Gateway

tomcat33 nvxwebup load java nvxwebup
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2 Migrate the WebAccess Agent volume resource to each node on its failover path, making sure 
it functions with the initial Netscape Enterprise Server cluster resource.

3 Migrate the Netscape Enterprise Server cluster resource to a different node, migrate the 
WebAccess Agent volume resource to each node in its failover path, then make sure each 
combination works.

4 Repeat Step 3 for each Netscape Enterprise Server cluster resource.

5.4  Managing WebAccess in a Cluster
After you have installed WebAccess in a cluster, you should consider some long-term management 
issues.

• “Updating GroupWise Objects with Cluster-Specific Descriptions” on page 97
• “Knowing What to Expect in MTA and POA Failover Situations” on page 60
• “Updating the WebAccess Agent Configuration File (commgr.cfg)” on page 98

5.4.1  Updating GroupWise Objects with Cluster-Specific 
Descriptions
After installing WebAccess in your clustered GroupWise system, while the cluster-specific 
information is fresh in your mind, you should record that cluster-specific information as part of the 
GroupWise objects in ConsoleOne so that you can easily refer to it later. Be sure to update the 
information recorded in the GroupWise objects if the configuration of your system changes.

• “Recording Cluster-Specific Information about the Internet Agent Domain and Its MTA” on 
page 79

• “Recording Cluster-Specific Information about the Internet Agent” on page 79

Recording Cluster-Specific Information about the WebAccess Agent Domain and Its 
MTA

To permanently record important cluster-specific information for the WebAccess Agent domain:
1 In ConsoleOne, browse to and right-click the Domain object, then click Properties.
2 In the Description field of the WebAccess Agent domain Identification page, provide a cluster-

specific description of the WebAccess Agent domain, including the secondary IP address of its 
cluster-enabled volume and the cluster-unique port numbers used by its MTA. 
You might also want to include cluster-specific information about the WebAccess Application, 
such as the secondary IP address of the Netscape Enterprise Server cluster resource where the 
WebAccess Application is installed.

3 Click OK to save the WebAccess Agent domain description.
4 Select the WebAccess Agent Domain object to display its contents.
5 Right-click the MTA object, then click Properties.
6 In the Description field of the MTA Identification page, record the secondary IP address of the 

cluster-enabled WebAccess Agent domain volume and the cluster-unique port numbers used by 
the MTA. 
This information appears on the MTA console, no matter which node in the cluster it is 
currently running on.
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7 Click OK to save the MTA description.
8 Continue with “Recording Cluster-Specific Information about the Internet Agent” on page 79.

Recording Cluster-Specific Information about the WebAccess Agent

With the contents of the WebAccess Agent domain still displayed:
1 Right-click the WEBAC70A object, then click Properties.
2 Click GroupWise, then click Identification.
3 In the Description field, record the secondary IP address of the cluster-enabled WebAccess 

Agent domain volume and the cluster-unique port numbers used by the WebAccess Agent. 
This information appears on the WebAccess Agent console, no matter which node in the cluster 
it is currently running on.

4 Click OK to save the WebAccess Agent information.
5 Continue with “Knowing What to Expect in MTA and POA Failover Situations” on page 60.

5.4.2  Knowing What to Expect in WebAccess Failover 
Situations
The failover behavior of the MTA for the WebAccess Agent domain is the same as for an MTA in a 
regular domain. See “Knowing What to Expect in MTA and POA Failover Situations” on page 60.

The WebAccess Application caches users’ credentials on the node where it is running. Therefore, if 
that node fails, or if the WebAccess Application migrates to a different node, the cached credentials 
are lost. Consequently, the user needs to restart the WebAccess client in order to re-authenticate and 
re-establish the credentials.

If the WebAccess Agent fails over or migrates, the user receives an error message that the 
WebAccess Agent is no longer available. However, after the WebAccess Agent starts in its new 
location, the WebAccess Application passes the cached user credentials to the WebAccess Agent 
and the user reconnects automatically without having to re-authenticate.

As with the MTA and the POA, migration of the WebAccess Agent takes longer than failover. 
However, the WebAccess Agent restarts quickly so that users are able to reconnect quickly.

5.4.3  Updating the WebAccess Agent Configuration File 
(commgr.cfg)
As part of installing WebAccess, the WebAccess Agent configuration file (commgr.cfg) is 
created in the following subdirectory:

domain\wpgate\webac70a

It is also automatically copied to the following Web server subdirectory:

sys:\novell\webaccess

If you change WebAccess agent configuration information (for example, if you change its ip 
address), the information is changed in the following file:

domain\wpgate\webac70a\commgr.cfg
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because the domain is on a cluster-enabled volume, and it is changed in the following file:

sys:\novell\webaccess\commgr.cfg 

on the node where the WebAccess Application is currently running. However, the other nodes on the 
WebAccess Application failover path are not currently available for update. therefore, you must 
manually copy the updated commgr.cfg file to the sys:\novell\webaccess subdirectory 
on each node in the WebAccess Application failover path.

5.5  WebAccess Clustering Worksheet

Item Explanation

1) Shared Volume for 
WebAccess Agent:

Cluster Enabled?

• Yes (highly recommended)

Cluster volume IP address

• No

Specify the name (cluster_volume) of the shared volume where the 
WebAccess Agent domain will be created.

For cluster-enabling, specify the IP addresses of the virtual server 
(volume_.cluster) to which the cluster-enabled volume is tied.

For more information, see “Deciding Whether to Cluster-Enable the 
WebAccess Agent Volume” on page 85.

2) WebAccess Agent 
Domain Name:

Domain Database Location:

Specify a unique name for the WebAccess Agent domain. Specify the 
directory on the WebAccess Agent volume where you want to create 
the new domain.

For more information, see “Planning a New Domain for the 
WebAccess Agent” on page 85.

3) WebAccess Agent 
Failover Path:

List other nodes in the cluster where the WebAccess Agent and its 
MTA could fail over.

For more information, see “Determining an Appropriate Failover Path 
for the WebAccess Agent Volume” on page 85.

4) MTA Installation Location:

• vol:\system on 
WebAccess Agent volume

• sys:\system on each 
node

Consolidate multiple MTA 
startup files on WebAccess 
Agent volume?

Mark the location where you will install the MTA software. 

If necessary, specify the location where you will consolidate multiple 
MTA startup files on a WebAccess Agent volume.

For more information, see “Deciding Where to Install the WebAccess 
Agent and Its MTA” on page 86.

5) MTA Network Information:

• MTA IP address

• MTA message transfer port

• MTA live remote port

• MTA HTTP port

Gather the MTA network address information from the WebAccess 
section of the “IP Address Worksheet” on page 36.

For more information, see “Planning a Secondary IP Address and 
Cluster-Unique Port Numbers for the WebAccess Agent and Its MTA” 
on page 86.
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6) WebAccess Agent 
Installation Location:

• vol:\system on the 
WebAccess Agent volume

• sys:\system on each 
node

Mark the location where you will install the WebAccess Agent 
software. 

For more information, see “Deciding Where to Install the WebAccess 
Agent and Its MTA” on page 86.

7) WebAccess Agent 
Network Information:

• WebAccess Agent IP 
address

• WebAccess Agent HTTP 
port

Gather the WebAccess Agent network address information from the 
WebAccess section of the “IP Address Worksheet” on page 36.

For more information, see “Planning a Secondary IP Address and 
Cluster-Unique Port Numbers for the WebAccess Agent and Its MTA” 
on page 86.

8) Load WebAccess Agent and 
Its MTA in Protected Memory?

• No

• Yes

Protected address space names:

• MTA:

• WebAccess:

Mark whether you need to run the WebAccess Agent and its MTA in 
protected memory. If so, specify a unique address space for each 
agent.

For more information, see “Deciding Whether to Run the WebAccess 
Agent and Its MTA in Protected Memory” on page 86.

9) Physical Web Servers: List the NetWare servers in the cluster where you are installing the 
Netscape Enterprise Server for use with WebAccess.

For more information, see “Setting Up the Netscape Enterprise Web 
Server for NetWare in a Cluster on NetWare 6” on page 84.

10) Netscape Enterprise Server 
IP Address:

Record the secondary IP address for the Netscape Enterprise Server 
cluster resource, shown in the cluster resource load script.

For more information, see “Setting Up the Netscape Enterprise Web 
Server for NetWare in a Cluster on NetWare 6” on page 84.

11) Netscape Enterprise Server 
Mode:

• Active/active (highly 
recommended)

• Active/passive

Mark whether the Netscape Enterprise Server runs simultaneously on 
multiple nodes in the cluster (active/active) or whether it runs on only 
one node at a time (active/passive).

For more information, see “Setting Up the Netscape Enterprise Web 
Server for NetWare in a Cluster on NetWare 6” on page 84.

12) Netscape Enterprise Server 
Failover Path:

List other nodes in the cluster where the Netscape Enterprise Server 
can fail over. The WebAccess Application always fails over along with 
the Netscape Enterprise Server.

For more information, see “Setting Up the Netscape Enterprise Web 
Server for NetWare in a Cluster on NetWare 6” on page 84.

13) Hardware Virtual Server 
Information:

• Dedicated IP address:

• Document root

Record the hardware virtual server information for your shared disk 
system.

For more information, see “Setting Up the Netscape Enterprise Web 
Server for NetWare in a Cluster on NetWare 6” on page 84.

Item Explanation
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5.6  WebAccess Quick Checklist
Plan the new clustered WebAccess installation, including the new domain required to house the 
WebAccess Agent in a clustering environment.

See Section 5.2, “Planning WebAccess in a Cluster,” on page 83.
Install and set up the Netscape Enterprise Web Server for NetWare in the cluster.
See “Setting Up the Netscape Enterprise Web Server for NetWare in a Cluster on NetWare 6” 
on page 84.
Cluster-enable the volume where the WebAccess Agent domain will reside. 
See “Cluster-Enabling a Shared Volume for Use with the WebAccess Agent” on page 89.
Create the new WebAccess Agent domain. 
See “Creating a Domain for the WebAccess Agent” on page 89.
Set up the MTA for the new WebAccess Agent domain.
See “Installing the MTA for the WebAccess Agent Domain” on page 89.
Install the WebAccess Agent.
See “Installing and Configuring the WebAccess Agent in a Cluster” on page 89.
Modify the WebAccess Agent volume resource load script:

• Remove the trustmig command
• Add the cvsbind add command (NetWare 5.1 only; optional)
• Add the search add command (optional)
• If you will not run the MTA and the WebAccess Agent in protected memory, add the set 
auto restart commands and the set developer option = off command

• Add the load commands for the MTA and the WebAccess Agent, separating them with a 
delay command

• If you will run the MTA and the WebAccess Agent in protected memory, add the 
address space parameter to the load commands and add a protection 
restart command for the address space

See “Modifying the Volume Resource Load Script for the WebAccess Agent” on page 91.
Modify the WebAccess Agent volume resource unload script:

• Add the MTA and WebAccess Agent or address space unload command(s)
• Add the cvsbind del command if you used the cvsbind add command in the load 

script (NetWare 5.1 only; optional)
• Remove the trustmig command

See “Modifying the Volume Resource Unload Script for the WebAccess Agent” on page 93.
Set up the WebAccess Agent volume failover path and policies. 
See “Setting the Failover Path and Policies for the WebAccess Agent” on page 94.
Add the WebAccess Application to each node where the Netscape Enterprise Server is 
installed.
See “Installing and Configuring the WebAccess Application in a Cluster” on page 95.
Test the clustered WebAccess Agent. 
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See “Testing Your Clustered WebAccess Installation” on page 96.
Record cluster-specific information in the properties pages of the GroupWise objects 
associated with the WebAccess Agent.
See “Updating GroupWise Objects with Cluster-Specific Descriptions” on page 97.
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6Implementing GroupWise 
Gateways in a Novell Cluster

A significant system configuration difference between a GroupWise® system in a clustering 
environment and a GroupWise system in a regular environment is that you need to create a separate 
domain to house each GroupWise gateway. The gateway domain should be created on a cluster-
enabled volume. This enables the gateway to fail over independently from other GroupWise 
components.

If you have set up the Internet Agent or WebAccess in your clustered GroupWise system, you should 
already have the skills necessary to set up a GroupWise gateway as well.

GroupWise gateways that have not received recent development have not been thoroughly tested in 
a clustering environment. If you are currently using such GroupWise gateways, you might want to 
leave them outside of your cluster.
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7Monitoring a GroupWise System 
in a NetWare Cluster

Because the GroupWise® 7 Monitor currently runs on Windows and Linux, rather than NetWare®, 
you cannot run GroupWise Monitor in a NetWare cluster. However, GroupWise Monitor can easily 
monitor a clustered GroupWise system from a vantage point outside the NetWare cluster.

When you first install Monitor, it gathers information about agents to monitor from a domain 
database (wpdomain.db). This provides the secondary IP address of each agent (the IP address 
associated with the cluster-enabled volume where the agent’s domain or post office resides). When 
an agent fails over or migrates to a different node, its status in Monitor displays as Not Listening 
until it is up and running again, at which time its status returns to Normal.

Because Monitor must use secondary IP addresses to monitor the agents in a clustered GroupWise 
system, the Discover Machine and Discover Network options do not work in a cluster. Secondary IP 
addresses cannot be obtained by examining the network itself. If you need to add agents to monitor, 
use the Add Agent option and provide the agent’s secondary IP address.

For instructions on setting up GroupWise Monitor, see “Installing GroupWise Monitor” in the 
GroupWise 7 Installation Guide.
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8Backing Up a GroupWise System 
in a NetWare Cluster

The GroupWise® Target Service Agent (GWTSA) is a GroupWise-specific API that works with 
compatible backup software to provide reliable backups of a running GroupWise system on 
NetWare® 5.1. On NetWare 6.x, equivalent functionality is available with the GroupWise Target 
Service Agent for File Systems (TSAFWGW). These TSAs can be used in a clustered GroupWise 
system with appropriate preparation and understanding of how the TSAs work. For background 
information on the GroupWise TSAs, see “Target Service Agents” in “Databases” in the GroupWise 
7 Administration Guide.

In a clustering environment, the GroupWise TSA for your version of NetWare must be installed and 
loaded on each node from which your backup software backs up any portion of your GroupWise 
system. To accommodate the variable locations of data to back up from a clustered GroupWise 
system, the .ncf file for the GroupWise TSA on each node should be edited to include a /home 
startup switch for every domain and post office on every cluster-enabled volume that might ever be 
mounted on that node. Set the /home startup switch to the physical volume name (without the server 
name), rather than the cluster-enabled volume name, when specifying the location of each domain 
and post office. For example:

Correct:
 /home-gwvol1:\gwdom

Incorrect:
 /home-gwcluster_gwvol1:\gwdom

Before your backup software starts backing up your GroupWise system, it calls on the GroupWise 
TSA to verify the accessibility of each physical volume specified by the /home startup switch. Your 
backup software then backs up those domains and post offices that are currently accessible to the 
GroupWise TSA and skips those that are not accessible. The backup runs successfully, even if some 
locations are not currently mounted on the node where the GroupWise TSA is running. Locations 
skipped when backups are run from one node will be caught when backups are run from another 
node where the GroupWise TSA is also running.

If the node where the GroupWise TSA is running goes down, the backup needs to be rerun when the 
node is up again, unless the nodes where the domain and post office volumes failed over are also 
configured to back them up. There is currently no way to restart a backup from a checkpoint 
position. By configuring redundant backup jobs on all nodes where domains and post offices could 
fail over, you can ensure that domains and post offices are always backed up, regardless of the node 
they are mounted on when the backup takes place.

WARNING: You should not install the GroupWise TSA on the cluster-enabled volumes where 
domains and post offices are located. The GroupWise TSA cannot currently run in protected 
memory, nor can it run re-entrantly. If multiple GroupWise volumes failed over to the same node, 
and if that node attempted to start an instance of the GroupWise TSA for each GroupWise volume, 
only the first instance would run successfully. Subsequent instances of the GroupWise TSA would 
fail and the domains and post offices specified for backup by those instances would not be available 
to your backup software.
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To restore data in a clustering environment, you must run your backup/restore software on the node 
where the location to restore is currently mounted.
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9Moving an Existing GroupWise 7 
System into a NetWare Cluster

If you are adding the high availability benefits of Novell® Cluster ServicesTM to a GroupWise® 7 
system that is already up and running, the first step is to install Novell Cluster Services following the 
instructions in the clustering documentation for your version of NetWare®, as listed in Chapter 1, 
“Introduction to GroupWise 7 and Novell Cluster Services on NetWare,” on page 17. You should 
also review Chapter 1, “Introduction to GroupWise 7 and Novell Cluster Services on NetWare,” on 
page 17 to help you apply clustering principles and practices to your GroupWise system.

You do not need to transfer your entire GroupWise system into the cluster all at once. You could 
transfer individual post offices where the needs for high availability are greatest. You could transfer 
a domain and all of its post offices at the same time. You might decide that you don’t need to have all 
of your GroupWise system running in the cluster. 

This section provides a checklist to help you get started with moving your GroupWise system into a 
clustering environment:

Decide which shared volumes in your shared disk system you will use for GroupWise 
administration (ConsoleOne® and the software distribution directory).
Decide which shared volumes in your shared disk system you will use for GroupWise domains 
and post offices.
Decide which nodes in your storage area network you will have on failover paths for the 
GroupWise agents.
Review Chapter 2, “Planning GroupWise in a NetWare Cluster,” on page 19. Fill out the 
“System Clustering Worksheet” on page 34 to help you decide which domains and post offices 
you will move to which shared volumes.
Review “Planning Secondary IP Addresses and Cluster-Unique Port Numbers for Agents in the 
Cluster” on page 27 and fill out the “IP Address Worksheet” on page 36 to select secondary IP 
addresses for cluster-enabled volumes and to specify cluster-specific port numbers for all of 
your GroupWise agents.
Select the first shared volume that will be part of your clustered GroupWise system and cluster-
enable it, following the instructions in “Cluster-Enabling Shared Volumes for Use with 
GroupWise” on page 39 and “Configuring Short Name Resolution” on page 40.
Move a domain and/or post office onto the cluster-enabled volume, following the instructions 
in “Moving a Domain” in “Domains” or “Moving a Post Office” in “Post Offices” in the 
GroupWise 7 Administration Guide.

Review Section 2.8, “Deciding How to Install and Configure the Agents in a Cluster,” on 
page 27, fill out the “Agent Clustering Worksheet” on page 37, and install the agents as needed 
for the first clustered domain and/or post office, following the instructions in Section 3.5, 
“Installing and Configuring the MTA and the POA in a Cluster,” on page 46. This includes 
setting up the load and unload scripts for the cluster-enabled volume.
Test the first component of your clustered GroupWise system following the instructions in 
Section 3.6, “Testing Your Clustered GroupWise System,” on page 55.
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Take care of the cluster management details described in Section 3.7, “Managing Your 
Clustered GroupWise System,” on page 56.
Move more domains and post offices into the cluster as needed. If you have GroupWise 
libraries, see Section 2.5, “Planning a New Library for a Clustered Post Office,” on page 23.
Move GroupWise administration into the cluster as needed.
Add other components to your clustered GroupWise system as needed, following the 
instructions in:

• Chapter 4, “Implementing the Internet Agent in a NetWare Cluster,” on page 65
• Chapter 5, “Implementing WebAccess in a NetWare Cluster,” on page 83.
• Chapter 6, “Implementing GroupWise Gateways in a Novell Cluster,” on page 103
• Chapter 7, “Monitoring a GroupWise System in a NetWare Cluster,” on page 105
• Chapter 8, “Backing Up a GroupWise System in a NetWare Cluster,” on page 107
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10Implementing Messenger in a 
NetWare Cluster

Novell Messenger does not require the existence of a GroupWise® system in the cluster, but 
presumably one has already been set up as described in Chapter 2, “Planning GroupWise in a 
NetWare Cluster,” on page 19 and Chapter 3, “Setting Up a Domain and Post Office in a NetWare 
Cluster,” on page 39. As part of the process of setting up GroupWise in the cluster, you filled out the 
“System Clustering Worksheet” on page 34. Some of the information from that worksheet is helpful 
as you implement Messenger in your cluster.

• Section 10.1, “Planning Your Messenger System in a Cluster,” on page 111
• Section 10.2, “Setting Up Your Messenger System in a Cluster,” on page 114
• Section 10.3, “Messenger Clustering Worksheet,” on page 118

10.1  Planning Your Messenger System in a 
Cluster
Because the Messenger agents are not associated with GroupWise domains or post offices, the 
Messenger agents are easier to implement in a cluster than are the GroupWise agents. Section 10.3, 
“Messenger Clustering Worksheet,” on page 118 lists all the information you need as you set up the 
Messenger agents in a clustering environment. You should print the worksheet and fill it out as you 
complete the tasks listed below:

• “Understanding Your Cluster” on page 111
• “Planning Messenger Administration” on page 111
• “Deciding Where to Install the Messenger Agent Software” on page 112
• “Planning the Messenger Agent Installation” on page 114

10.1.1  Understanding Your Cluster
Fill out items 1 through 5 on the Section 10.3, “Messenger Clustering Worksheet,” on page 118 with 
information about your cluster. This information corresponds to items 1-5 on the “System Clustering 
Worksheet” on page 34. For background information, see Section 2.1, “Meeting Software Version 
Requirements,” on page 20 and Section 2.2, “Installing Novell Cluster Services,” on page 20.

10.1.2  Planning Messenger Administration
If you have set up a cluster-enabled shared volume for GroupWise administration, as described in 
Section 2.6, “Deciding Whether to Cluster-Enable the Shared Volumes Used by GroupWise,” on 
page 23, you can use the same cluster-enabled shared volume for the Messenger administration files. 
For example, you might have a shared pub: volume with a \public directory where you install the 
Messenger snap-in to ConsoleOne®. Or you can install the Messenger snap-in on one or more 
administrator workstations. 
Implementing Messenger in a NetWare Cluster 111



112 GroupWise 

novdocx (E
N

U
)  6 D

ecem
ber 2005
10.1.3  Deciding Where to Install the Messenger Agent Software
When you install the NetWare® Messenger agents in a clustering environment, you can choose 
between two different installation locations:

Table 10-1   Messenger Agent Software Installation Locations

You must install to a cluster-enabled shared volume if you do not want a separate Messenger archive 
to be created on each node where the Archive Agent runs. If you do not want to use a shared volume, 
you should plan to install the Archive Agent separately outside the cluster.

Continue with the planning instructions for the installation location you want to use:

• “Each Node in the Cluster” on page 113
• “Shared Volume” on page 113

MESSENGER CLUSTERING WORKSHEET

Under Item 6: Installation Location for Messenger Administration, mark where you want to install the 
Messenger snap-in to ConsoleOne.

If you plan to install the Messenger snap-in to ConsoleOne on a cluster-enabled shared volume, 
under Item 7: Shared Volume for Messenger Administration, list the IP address of the shared volume 
and the directory where you want to install the Messenger snap-in.

IMPORTANT: Cluster-enabling relies on successful short name resolution throughout your system. 
Review Section 2.7, “Ensuring Successful Name Resolution for GroupWise Volumes,” on page 25, 
which describes the issues in the context of planning MTA and POA installations for GroupWise.

Location Description

Each node
in the cluster

The sys:\system directory is the default location provided by the Messenger 
Installation program.

Shared volume If you create a vol:\system directory on a cluster-enabled shared volume, 
the agent software and startup files fail over and back along with supporting 
files such as the Messenger archive. 

IMPORTANT: Cluster-enabling relies on successful short name resolution 
throughout your system. Review Section 2.7, “Ensuring Successful Name 
Resolution for GroupWise Volumes,” on page 25, which describes the issues in 
the context of planning MTA and POA installations for GroupWise.

MESSENGER CLUSTERING WORKSHEET

Under Item 8: Installation Location for Messenger Agents, mark where you want to install the 
Messenger agent software.
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Each Node in the Cluster

Make sure you have filled out item 5 on the Messenger Clustering Worksheet with a complete list of 
nodes in the cluster. Continue with “Planning the Messenger Agent Installation” on page 114.

Shared Volume

For convenience throughout the rest of this section, the term “Messenger volume” means “a cluster-
enabled shared volume where the Messenger agents are installed.” Complete the following planning 
tasks for the Massager volume:

• “Selecting the Messenger Volume” on page 113
• “Determining an Appropriate Failover Path for the Messenger Volume” on page 113
• “Selecting IP Address Resolution Methods for the Messenger Volume” on page 113

Selecting the Messenger Volume

If you are not planning to enable archiving, or if you are not anticipating a large Messenger archive, 
you can use one Messenger volume. If you anticipate archiving a large number of messages so that 
the Messenger archive grows very large, you might want to have a separate Messenger volume for 
the Archive Agent and the archive database. The steps in this section cover setting up the Messenger 
agents on a single Messenger volume.

Determining an Appropriate Failover Path for the Messenger Volume

By default, a Messenger volume is configured to have all nodes in the cluster in its failover path, 
organized in ascending alphanumeric order. Only one node at a time can have the Messenger volume 
mounted and active. If a Messenger volume’s preferred node fails, the volume fails over to the next 
node in the failover path. 

Selecting IP Address Resolution Methods for the Messenger Volume

Because you are using a cluster-enabled volume for the Messenger agents, you must ensure that 
short name resolution is always successful. For background information, see Section 2.7, “Ensuring 
Successful Name Resolution for GroupWise Volumes,” on page 25.

MESSENGER CLUSTERING WORKSHEET

Under Item 9: Shared Volume for Messenger Agents, record the name and IP address of the 
Messenger volume.

MESSENGER CLUSTERING WORKSHEET

Under Item 10: Failover Path for Messenger Volume, list the nodes that you want to have in the 
Messenger volume failover path. The Messenger agents might need to run on any node that the 
Messenger volume fails over to.

MESSENGER CLUSTERING WORKSHEET

Under Item 11: IP Address Resolution Methods, mark the short name address resolution methods you 
want to implement to ensure that the UNC paths stored in ConsoleOne can be successfully resolved 
into the physical network address of the Messenger volume.
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10.1.4  Planning the Messenger Agent Installation
Aside from the cluster-specific issues discussed in the preceding sections, the considerations 
involved in planning to install the Messenger agents are the same in a clustering environment as for 
any other environment. Review “Planning Your Novell Messenger System”, then print and fill out 
the “Novell Messenger Worksheet” in “Installing a Novell Messenger System” in the Messenger 2.0 
Installation Guide. Transfer the following information from the Messenger Clustering Worksheet to 
the Messenger System Worksheet:

• For Item 3: Installation Path on the Messenger System Worksheet: 
• If you are installing the Messenger agents to each node in the cluster, use sys:\system.
• If you are installing the Messenger agents to a Messenger volume, use 
volume:\system, where volume is the name of the Messenger volume from Item 9: 
Shared Volume for Messenger Administration on the Messenger Clustering Worksheet.

• Under Item 12: Server Address on the Messenger System Worksheet:
• If you are installing the Messenger agents to each node in the cluster, use the cluster IP 

address from Item 3: Cluster Identification on the Messenger Clustering Worksheet.
• If you are installing the Messenger agents to a Messenger volume, specify the Messenger 

volume IP address from Item 9: Shared Volume for Messenger Agents on the Messenger 
Clustering Worksheet.

• Under Item 13: Configure Agents for Clustering? on the Messenger System Worksheet, mark 
Yes. This adds the /cluster switch to the agent startup files. The /cluster switch tells the 
Messenger agents to use the virtual server name of the cluster or the Messenger volume rather 
than the specific server name in pathnames obtained from agent object properties in Novell 
eDirectoryTM or from startup switches. This enables the Messenger agents to access the location 
no matter which node it is currently running on. This applies to the agents’ working directory, 
queue directory, log file directory, and so on.

• Under Item 14: Admin Configuration on the Messenger System Worksheet:
• If you are installing the Messenger snap-in to ConsoleOne to an administrator 

workstation, use the location where ConsoleOne is already installed (typically 
c:\novell\consoleone\version_number).

• If you are installing the Messenger snap-in to ConsoleOne to a shared volume, use 
volume:\directory, where volume is the name of the Messenger administration 
volume from Item 7: Shared Volume for Messenger Administration on the Messenger 
Clustering Worksheet and directory is typically \public.

Continue with Section 10.2, “Setting Up Your Messenger System in a Cluster,” on page 114.

10.2  Setting Up Your Messenger System in a 
Cluster
You should have already reviewed Section 10.1, “Planning Your Messenger System in a Cluster,” on 
page 111 and filled out the Section 10.3, “Messenger Clustering Worksheet,” on page 118 and the 
“Novell Messenger Worksheet” in the “Messenger 2.0 Installation Guide”. Follow the instructions 
for the installation location you have chosen:

• “Installing to Each Node in the Cluster” on page 115
• “Installing to a Messenger Volume” on page 115
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10.2.1  Installing to Each Node in the Cluster
There are two methods of installing the Messenger agents to each node in the cluster:

• Run the Messenger Installation program multiple times in order to install the agent software 
and to create the agent startup files on each node in the cluster.

• Run the Messenger Installation program, then copy the Messenger agent software and startup 
files to each node in the cluster.

Use whichever method you prefer, following the steps provided in “Starting the Messenger 
Installation Program” and “Creating Your Messenger System” in “Installing a Novell Messenger 
System” in the Messenger 2.0 Installation Guide. Make each node in the cluster active to make sure 
that the Messenger agents start successfully.

10.2.2  Installing to a Messenger Volume
Complete the following tasks to set up your Messenger system on a Messenger volume:

• “Preparing the Cluster for Messenger” on page 115
• “Running the Messenger Installation Program” on page 115
• “Configuring the Messenger Volume Resource to Load and Unload the Messenger Agents” on 

page 116
• “Copying LDAP and QuickFinder Files to Each Node” on page 117
• “Testing Your Clustered Messenger System” on page 117

Preparing the Cluster for Messenger

Cluster preparation for Messenger is the same as cluster preparation for GroupWise. Review Section 
3.1, “Preparing the Cluster for GroupWise,” on page 39 before running the Messenger installation 
program.

Running the Messenger Installation Program

The Messenger Installation program walks you through setting up your Messenger system and 
installing the Messenger agents. 

1 If necessary, map a drive to the Messenger administration volume (Messenger Clustering 
Worksheet item 7).

2 Map a drive to the Messenger volume (Messenger Clustering Worksheet item 9).
The Messenger volume name will be cluster_volume. For assistance with mapping a drive to a 
cluster-enabled volume, see “Configuring Short Name Resolution” on page 40.

3 Run the Messenger Installation program at an administrator workstation to set up your 
Messenger system, following the steps provided in “Starting the Messenger Installation 
Program” and “Creating Your Messenger System” in “Installing a Novell Messenger System” 
in the Messenger 2.0 Installation Guide. Keep in mind the following cluster-specific details:

• When you specify the Messenger installation directory, be sure to browse to the location 
through the Messenger volume accessed in Step 2 above.

• When you specify the ConsoleOne directory, be sure to browse to the location through the 
Messenger administration volume accessed in Step 1 above.
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• On the Start Copying Files page, the server object name should be the virtual server name, 
not a physical server name.

4 When you have finished creating your Messenger system, continue with “Configuring the 
Messenger Volume Resource to Load and Unload the Messenger Agents” on page 116.

Configuring the Messenger Volume Resource to Load and Unload the Messenger 
Agents

The properties of the Volume Resource object define how the Messenger volume functions within 
the cluster, how the Messenger agents are loaded and unloaded, and how failover and failback 
situations are handled. 

1 In ConsoleOne, browse to and select the Cluster object.
If necessary, click View > Console View to display its contents.

2 Right-click the Volume Resource object (volume_SERVER), then click Properties > Load to 
display the default volume resource load script for the Messenger volume.
The volume resource load script executes whenever the Messenger volume comes online.

3 Add the following lines to the load script:
load volume:\novell\nm\ma\nmma.nlm 
@volume:novel\nm\ma\strtup.ma
load volume:\novell\nm\aa\nmaa.nlm 
@volume:novel\nm\aa\strtup.aa

where volume is the name of the Messenger volume (Messenger Clustering Worksheet item 9).
For example:
load gwmsgr:\novell\nm\ma\nmma.nlm 
@gwmsgr:novel\nm\ma\strtup.ma
load gwmsg:\novell\nm\aa\nmaa.nlm @gwmsgr:novel\nm\aa\strtup.aa

4 Click Apply to save the load script.
5 Click Unload.
6 Add the following lines to the unload script:
unload nmma.nlm 
unload nmaa.nlm

7 Click Apply to save the unload script.
8 Click Nodes to display the default failover path for the Messenger volume.
9 Arrange the nodes in the cluster into the desired failover path for the Messenger volume 

(Messenger Clustering Worksheet item 10).
10 Click Apply to save the failover path.
11 Click Policies to display the default start, failover, and failback policies.

By default, a volume resource:

• Fails over automatically if the node it is running on fails
• Starts automatically on the net node in its failover path
• Continues running at its failover location even after its most preferred node is again 

available
12 Change the policies if necessary, then click OK.
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13 Continue with “Copying LDAP and QuickFinder Files to Each Node” on page 117.

Copying LDAP and QuickFinder Files to Each Node

During installation of the Messenger agents, some files were copied to sys:\system of the node 
where the Messenger volume was mounted. These files must be copied to sys:\system on each 
node of the cluster. Copy the following files from the Novell GroupWise Messenger CD to 
sys:\system on each node in the cluster:

\server\nlm\ldap\ldapsdk.nlm
\server\nlm\ldap\ldapssl.nlm
\server\nlm\ldap\ldapx.nlm
\server\nlm\qf\qfind215.nlm

If you are running in a language other than English, copy the following files from the CD to 
sys:\system\nls\language on each node in the cluster:

\server\nlm\language\*.msg
\server\nlm\language\*.hlp

where language is a two-letter language code.

Continue with “Testing Your Clustered Messenger System” on page 117.

Testing Your Clustered Messenger System

After you have configured the Messenger volume resource, you can test the load and unload scripts 
by bringing the Messenger volume online and taking it offline again.

1 In ConsoleOne, select the Cluster object, then click View > Cluster State.

The new Messenger volume resource shows Offline in the State column.
2 Click the new Messenger volume resource, then click Online.
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The State column for the volume resource now displays Running.
3 Observe the server console where the Messenger agents are loading to see that they start and 

run correctly. 
4 Click the new Messenger volume resource, then click Offline.

The State column for the volume resource returns to Offline.
5 Observe the server console where the Messenger agents are unloading to see that they shut 

down correctly. 
6 Repeat Step 2 whenever you are ready to bring the new Messenger volume resource online 

permanently.
On NetWare 6.x, these actions can also be performed from your Web browser. See “Using 
Novell Remote Manager on NetWare 6.x” on page 57.

10.3  Messenger Clustering Worksheet

Item Explanation

1) Software Version Updates
for Cluster:

• Support Pack 3 or higher for 
NetWare 5.1 

• Latest ConsoleOne Snap-In for 
Novell Cluster ServicesTM

Mark any updates that the nodes in your cluster need in order 
to meet the system requirements for Messenger system in a 
cluster.

To review the background information provided for GroupWise 
clustering, see Section 2.1, “Meeting Software Version 
Requirements,” on page 20.

2) eDirectory Tree for Cluster: Record the eDirectory tree where you created the Novell 
Cluster object when you installed Novell Cluster Services.

To review the background information provided for GroupWise 
clustering, see Section 2.2, “Installing Novell Cluster Services,” 
on page 20.

3) Cluster Identification:

Cluster Name:

Cluster IP Address:

Record the name of the name of the NetWare Cluster object 
where your Messenger system will be located. Also record the 
virtual IP address of the cluster that will remain constant 
regardless of which node is currently active.

To review the background information provided for GroupWise 
clustering, see Section 2.2, “Installing Novell Cluster Services,” 
on page 20.
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4) Cluster Context: Record the full context where you created the NetWare Cluster 
object.

To review the background information provided for GroupWise 
clustering, see Section 2.2, “Installing Novell Cluster Services,” 
on page 20.

5) Nodes in Cluster List the nodes that are part of the cluster.

To review the background information provided for GroupWise 
clustering, see Section 2.2, “Installing Novell Cluster Services,” 
on page 20.

6) Installation Location for Messenger 
Administration:

• Administrator workstation(s)

• Shared volume

Mark the location where you will install the Messenger snap-in 
to ConsoleOne. For more information, see “Planning 
Messenger Administration” on page 111.

7) Shared Volume for Messenger 
Administration:

Cluster Volume IP Address:

Installation Location for Messenger 
Snap-In to ConsoleOne:

• /public directory

• Other directory

If you plan to install the Messenger snap-in to ConsoleOne on 
a shared volume, specify the name (cluster_volume) of the 
shared volume where you will install it.

Specify the IP addresses of the virtual server 
(volume_SERVER.cluster) to which the shared volume is tied.

Specify the directory where you will install the Messenger 
snap-in to ConsoleOne on the shared volume.

To review the background information about cluster-enabled 
volumes provided for GroupWise, see Section 2.6, “Deciding 
Whether to Cluster-Enable the Shared Volumes Used by 
GroupWise,” on page 23.

8) Installation Location for Messenger 
Agents:

• Each node in the cluster

• Shared volume

Mark the location where you will install the Messaging Agent 
software.

For more information, see “Deciding Where to Install the 
Messenger Agent Software” on page 112.

9) Shared Volume for Messenger 
Agents:

Cluster volume IP address:

If you plan to install the Messenger agents on a shared 
volume, specify the name (cluster_volume) of the shared 
volume.

Specify the IP address of the virtual server 
(volume_SERVER.cluster) to which the cluster-enabled 
volume is tied.

To review the background information about cluster-enabled 
volumes provided for GroupWise, see Section 2.6, “Deciding 
Whether to Cluster-Enable the Shared Volumes Used by 
GroupWise,” on page 23.

For more information, see “Selecting the Messenger Volume” 
on page 113.

Item Explanation
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10) Failover Path for Messenger Shared 
Volume:

If you plan to install the Messenger agents on a shared 
volume, list other nodes in the cluster where the Messenger 
agents could fail over.

For more information, see “Determining an Appropriate 
Failover Path for the Messenger Volume” on page 113.

11) IP Address Resolution Methods:

• eDirectory

• hosts file

• DNS

• SLP (highly recommended)

Mark the short name address resolution methods you want to 
implement to ensure that the UNC paths stored in ConsoleOne 
can be successfully resolved into physical network addresses.

To review the background information provided for GroupWise, 
see Section 2.7, “Ensuring Successful Name Resolution for 
GroupWise Volumes,” on page 25.

Item Explanation
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IINovell Cluster Services on Linux

• Chapter 11, “Introduction to GroupWise 7 and Novell Cluster Services on Linux,” on page 123
• Chapter 12, “Planning GroupWise in a Linux Cluster,” on page 125
• Chapter 13, “Setting Up a Domain and a Post Office in a Linux Cluster,” on page 135
• Chapter 14, “Implementing the Internet Agent in a Linux Cluster,” on page 155
• Chapter 15, “Using WebAccess in a Linux Cluster,” on page 171
• Chapter 16, “Implementing GroupWise Monitor in a Linux Cluster,” on page 173
• Chapter 17, “Backing Up a GroupWise System in a Linux Cluster,” on page 185
• Chapter 18, “Moving an Existing Linux GroupWise 7 System into a Linux Cluster,” on 

page 187
• Chapter 19, “Moving a Clustered GroupWise 7 System from NetWare to Linux,” on page 189
• Chapter 20, “Implementing Messenger in a Linux Cluster,” on page 191
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11Introduction to GroupWise 7 and 
Novell Cluster Services on Linux

Before implementing GroupWise® 7 with Novell® Cluster ServicesTM on Linux, make sure you have 
a solid understanding of Novell Cluster Services by reviewing the OES Novell Cluster Services 1.8.1 
Administration Guide for Linux. When you review this information, you discover that clustering 
employs very specialized terminology. The following brief glossary provides basic definitions of 
clustering terms and relates them to your GroupWise system:

cluster: A grouping of from two to 32 servers configured using Novell Cluster Services so that data 
storage locations and applications can transfer from one server to another without interrupting their 
availability to users.

NOTE: Although a cluster can include both Linux and NetWare® servers, GroupWise components 
on Linux servers can fail over only to other Linux servers.

node: A clustered server; in other words, a single server that is part of a cluster. 

shared disk system: The hardware housing the physical disks that are shared among the cluster 
nodes. 

shared partition: A disk partition in a shared disk system that can be accessed from any cluster 
node that needs the data stored on it. On Linux, Novell Cluster Services supports shared partitions 
(Linux traditional file system disk partitions), shared NSS volumes (Novell Storage ServicesTM 
volumes), and shared pools (virtual servers). 

NOTE: For simplicity, this section uses the term “shared partition” to represent any of these three 
storage configuration alternatives. For more information, see “Creating Shared Disk Partitions and 
Pools” and “Creating NSS Volumes” in “Installation and Setup” in the OES Novell Cluster Services 
1.8.1 Administration Guide for Linux.

cluster-enabled shared partition: A shared partition for which a Cluster Resource object has been 
created in Novell eDirectoryTM. The properties of the Cluster Resource object provide load and 
unload scripts for applications and services installed on the partition, failover/failback/migration 
policies for the applications and services, and the failover list for the partition. 

IMPORTANT: Cluster-enabling is required for GroupWise. For more information, see “Cluster 
Enabling Linux Traditional File System Shared Disk Partitions” and “Cluster Enabling Pools and 
Volumes” in “Installation and Setup” in the OES Novell Cluster Services 1.8.1 Administration Guide 
for Linux.

GroupWise partition: As used in this section, a cluster-enabled shared partition that is used for 
GroupWise, such as for housing a domain, a post office, or a software distribution directory.

Messenger partition: As used in this section, a cluster-enabled shared partition that is used for 
Messenger, such as for storing conversation files, log files, temporary files, queue directories, and so 
on.
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cluster resource: A shared partition, secondary IP address, application, service, Web server, and so 
on, that can function successfully anywhere in the cluster. Cluster resources include the GroupWise 
agents, Messenger agents, and the Apache Web server.

failover: The process of moving cluster resources from a failed node to a functional node so that 
availability to users is uninterrupted. For example, if the node where the POA is running goes down, 
the POA and its post office fail over to a secondary node so that users can continue to use 
GroupWise. When setting up cluster resources, you must consider what components need to fail 
over together in order to continue functioning.

fan-out-failover: The configuration where cluster resources from a single failed node fail over to 
several different nodes in order to distribute the load from the failed node across multiple nodes. For 
example, if a node runs a cluster resource consisting of a domain and its MTA, another cluster 
resource consisting of a post office and its POA, and a third cluster resource for the Internet Agent, 
each cluster resource could be configured to fail over separately to different secondary nodes. 

failback: The process of returning cluster resources to their preferred node after the situation 
causing the failover has been resolved. For example, if a POA and its post office fail over to a 
secondary node, that cluster resource can be configured to fail back to its preferred node when the 
problem is resolved.

migration: The process of manually moving a cluster resource from its preferred node to a 
secondary node for the purpose of performing maintenance on the preferred node, temporarily 
lightening the load on the preferred node, and so on. 
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12Planning GroupWise in a Linux 
Cluster

The majority of this part of the GroupWise 7 Interoperability Guide (Chapter 12, “Planning 
GroupWise in a Linux Cluster,” on page 125 through Chapter 17, “Backing Up a GroupWise System 
in a Linux Cluster,” on page 185) is designed for those who are creating a new GroupWise® system, 
or at least new domains and post offices, in the context of Novell® Cluster ServicesTM on Linux. 

If you already have an existing GroupWise 7 system on OES Linux and need to configure it to work 
in a newly installed cluster, see Chapter 18, “Moving an Existing Linux GroupWise 7 System into a 
Linux Cluster,” on page 187. If you already have an existing clustered GroupWise 7 system on OES 
NetWare, see Chapter 19, “Moving a Clustered GroupWise 7 System from NetWare to Linux,” on 
page 189.

When you implement a new GroupWise system or a new domain or post office in a clustering 
environment, overall GroupWise system design does not need to change substantially. For a review, 
see “Installing a Basic GroupWise System” in the GroupWise 7 Installation Guide. However, the 
configuration of individual components of your GroupWise system will be significantly different. 
This section helps you plan the following GroupWise components in a cluster:

• A new GroupWise system consisting of the primary domain and the initial post office
• A new secondary domain 
• A new post office
• The GroupWise agents: Message Transfer Agent (MTA) and Post Office Agent (POA)

During the planning process, component configuration alternatives are explained. For example, you 
might want the domain and post office together on the same shared partition or on different shared 
partitions.

Section 12.7.1, “System Clustering Worksheet,” on page 131 lists the information you need as you 
set up GroupWise in a clustering environment. You should print the worksheet and fill it out as you 
complete the tasks listed below:

• Section 12.1, “Installing Novell Cluster Services on Linux,” on page 126
• Section 12.2, “Planning a Clustered Software Distribution Directory,” on page 127
• Section 12.3, “Planning a New Clustered Domain,” on page 128
• Section 12.4, “Planning a New Clustered Post Office,” on page 128
• Section 12.5, “Planning a New Library for a Clustered Post Office,” on page 129
• Section 12.6, “Deciding How to Install and Configure the Linux Agents in a Cluster,” on 

page 129
• Section 12.7, “GroupWise Clustering Worksheets,” on page 131

After you have completed the tasks and filled out Section 12.7.1, “System Clustering Worksheet,” 
on page 131 and Section 12.7.2, “Agent Clustering Worksheet,” on page 132, you are ready to 
continue with Chapter 13, “Setting Up a Domain and a Post Office in a Linux Cluster,” on page 135.
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12.1  Installing Novell Cluster Services on Linux
Install Novell Cluster Services on OES Linux by following the instructions provided in the OES 
Novell Cluster Services 1.8.1 Administration Guide for Linux.

The cluster installation process includes:

• Meeting hardware and software requirements
• Setting up a shared disk system
• Creating a new Cluster object to represent the cluster in Novell eDirectoryTM

• Adding nodes to the cluster
• Installing the Novell Cluster Services software on all nodes in the cluster
• Creating shared partitions, shared NSS volumes, or shared pools as needed for your cluster, as 

described in “Creating Shared Disk Partitions and Pools” and “Creating NSS Volumes” in 
“Installation and Setup” in the OES Novell Cluster Services 1.8.1 Administration Guide for 
Linux.

NOTE: For simplicity in this section, the term “shared partition” is intended to include any of 
these shared storage alternatives.

• Cluster-enabling any of these shared storage alternatives, as described in “Cluster Enabling 
Linux Traditional File System Shared Disk Partitions” and “Cluster Enabling Pools and 
Volumes” in “Installation and Setup” in the OES Novell Cluster Services 1.8.1 Administration 
Guide for Linux.

IMPORTANT: Cluster-enabling is required for GroupWise.

• Mounting the shared partitions where you want to set up GroupWise domains and post offices.

As you install Novell Cluster Services on Linux, record key information about the cluster on the 
System Clustering Worksheet:

The number of nodes and shared partitions that are available in the cluster strongly influences where 
you can place GroupWise domains and post offices. You have several alternatives:

• Your whole GroupWise system can run in a single cluster.

SYSTEM CLUSTERING WORKSHEET

Under Item 1: eDirectory Tree for Cluster, record the name of the eDirectory tree where the new 
Cluster object has been created.

Under Item 2: Cluster Name, record the name of the Cluster object that you created for your 
GroupWise system. 

Under Item 3: Cluster Context, record the full context of the Cluster object.

Under Item 4: Nodes in Cluster, list the nodes that you have added to the cluster. Include the file 
system information about each partition, including file system type (reiserfs, ext3, etc.), device name 
(sda2, hda1, etc.), and mount point directory (/mnt, /mail, etc.). You need this information when you 
set up the load and unload scripts for the GroupWise cluster resources.

Under Item 5: Shared Partitions, list the shared partitions that are available for use in your GroupWise 
system. 
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• Parts of your GroupWise system can run in one cluster while other parts of it run in one or more 
other clusters.

• Parts of your GroupWise system can run in a cluster while other parts run outside of the cluster, 
on non-clustered servers.

If you do not have the system resources to run all of your GroupWise system in a clustering 
environment, you must decide which parts have the most urgent need for the high availability 
provided by clustering. Here are some suggestions:

• Post offices and their POAs must be available in order for users to access their GroupWise 
mailboxes. Therefore, post offices and their POAs are excellent candidates for the high 
availability provided by clustering.

• Domains and their MTAs are less noticeable to users when they are unavailable (unless users in 
different post offices happen to be actively engaged in an e-mail discussion when the MTA 
goes down). On the other hand, domains and their MTAs are critical to GroupWise 
administrators, although administrators might be more tolerant of a down server than end users 
are. Critical domains in your system would be the primary domain and, if you have one, a hub 
or routing domain. These domains should be in the cluster, even if other domains are not.

• The Internet Agent might or might not require high availability in your GroupWise system, 
depending on the importance of immediate messaging across the Internet and the use of POP3 
or IMAP4 clients by GroupWise users. 

• The Monitor Agent is a vital partner with the GroupWise High Availability service, described 
in “Enabling the High Availability Service for the Linux Agents” in “Installing GroupWise 
Agents” in the GroupWise 7 Installation Guide. The High Availability service automatically 
restarts agents that go down under circumstances that do not cause the entire server to go down. 
If you want this protection for your GroupWise agents, you can run the Monitor Agent in your 
cluster.

There is no right or wrong way to implement GroupWise in a clustering environment. It all depends 
on the specific needs of your particular GroupWise system and its users.

12.2  Planning a Clustered Software Distribution 
Directory
During creation of a GroupWise system, you are prompted to create a software distribution 
directory. You can create the software distribution directory on each node where you install the 
GroupWise software or you can create it on a GroupWise partition so that you install it only once but 
it is still always available. For information about software distribution directories, see “Software 
Directory Management” in “System” in the GroupWise 7 Administration Guide.

SYSTEM CLUSTERING WORKSHEET

If you want to have your GroupWise software distribution directory as part of your cluster, under Item 
6: GroupWise Partition for Software Distribution Directory, list the GroupWise partition and associated 
secondary IP address for the software distribution directory. List the full path for the software 
distribution directory, regardless of whether it is located on a GroupWise partition or on each node in 
the cluster.
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12.3  Planning a New Clustered Domain
The considerations involved in planning a new domain in a clustering environment are essentially 
the same as for any other environment.

• Primary Domain: If you are setting up a new GroupWise system in a clustering environment, 
you are creating the primary domain as you complete the tasks in this section. To prepare, 
review “Planning Your Basic GroupWise System”, then print and fill out the “Basic GroupWise 
System Worksheet” in “Installing a Basic GroupWise System” in the GroupWise 7 Installation 
Guide. This covers planning the primary domain and an initial post office in the primary 
domain.

• Secondary Domain: If your GroupWise system already exists, you are creating a new 
secondary domain. To prepare, review “Planning a New Domain”, then print and fill out the 
“Domain Worksheet” in “Domains” in the GroupWise 7 Administration Guide.

Regardless of the type of domain you are creating, keep in mind the following cluster-specific 
details as you fill out the worksheet you need:

• When you specify the location for the domain directory (and for a new GroupWise system, the 
post office directory) on the worksheet, remember that it will be on a GroupWise partition, not 
on the node where you will be running the GroupWise Installation program.

• Do not concern yourself with the GroupWise agent information on the worksheet. You will 
plan the agent installation later. If you are filling out the Basic GroupWise System Worksheet, 
stop with item 17. If you are filling out the Domain Worksheet, stop with item 10.

When you have completed the worksheet, transfer the key information from the Basic GroupWise 
System Worksheet or the Domain Worksheet to the System Clustering Worksheet.

IMPORTANT: Do not create the new domain until you are instructed to do so in Chapter 13, 
“Setting Up a Domain and a Post Office in a Linux Cluster,” on page 135.

12.4  Planning a New Clustered Post Office
The considerations involved in planning a new post office in a clustering environment are 
essentially the same as for any other environment. The initial post office in a new GroupWise 
system is planned on the Basic GroupWise System Worksheet. To plan additional new post offices, 
review “Planning a New Post Office ”, then print and fill out the “Post Office Worksheet” in “Post 
Offices” in the GroupWise 7 Administration Guide. When you specify the location for the post office 
directory, remember that it will be on a GroupWise partition, not on the node where you will be 
running the GroupWise Installation program. 

When you have completed the worksheet, transfer key information from the Basic GroupWise 
System Worksheet or the Post Office Worksheet to the System Clustering Worksheet.

SYSTEM CLUSTERING WORKSHEET

Under Item 9: Domain Name, transfer the domain name and database directory to the System 
Clustering Worksheet. 

Under Item 7: GroupWise Partition for Domain, transfer the domain location to the System Clustering 
Worksheet. Also specify the secondary IP address of the shared partition where you plan to create 
the domain.
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IMPORTANT: Do not create the new post office until you are instructed to do so in Chapter 13, 
“Setting Up a Domain and a Post Office in a Linux Cluster,” on page 135.

12.5  Planning a New Library for a Clustered Post 
Office
The considerations involved in planning a new library in a clustering environment are essentially the 
same as for any other environment. However, in a Linux cluster, you should not plan to locate a 
document storage area on a remote storage area. If you choose to place it outside the post office 
directory structure, it should still be located on the same server with the post office.

You can plan a library for a clustered post office by following the standard instructions provided in 
“Creating and Managing Libraries” in the GroupWise 7 Administration Guide and filling out the 
“Basic Library Worksheet” or the “Full-Service Library Worksheet”. Then provide the library 
information on the System Clustering Worksheet.

IMPORTANT: Do not create the new library until you are instructed to do so in Chapter 13, 
“Setting Up a Domain and a Post Office in a Linux Cluster,” on page 135.

12.6  Deciding How to Install and Configure the 
Linux Agents in a Cluster
There are several cluster-specific issues to consider as you plan to install the Linux MTA and POA 
in your clustered GroupWise system:

• Section 12.6.1, “Recording Secondary IP Addresses for the Agents,” on page 130
• Section 12.6.2, “Determining Appropriate Failover Lists for the Agents,” on page 130
• Section 12.6.3, “Planning the Linux Agent Installation,” on page 131

SYSTEM CLUSTERING WORKSHEET

Under Item 10: Post Office Name, transfer the post office name and database location to the System 
Clustering Worksheet. Also specify the secondary IP address of the shared partition where you plan to 
create the domain.

If you will create the post office on a different GroupWise partition from where the domain is located, 
under Item 8: Shared Partition for Post Office, transfer the post office location to the System Clustering 
Worksheet. Also specify the secondary IP address of the shared partition where you plan to create the 
post office.

SYSTEM CLUSTERING WORKSHEET

Under Item 11: Document Storage Area Location, mark where you want to create the library’s 
document storage area. 
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12.6.1  Recording Secondary IP Addresses for the Agents
By default, the GroupWise agents listen on all IP addresses, both primary and secondary, that are 
bound to the server. This means that any time there is a possibility of two of the same type of agent 
loading on the same node, it is important that each agent use the appropriate secondary IP address of 
the GroupWise partition. After installation, you can bind each agent to its unique secondary IP 
address using the --ip switch in each agent startup file or using the Bind Exclusively to TCP/IP 
Address option in ConsoleOne®, so that there are never any conflicts within the cluster. Either 
method can be used to bind the agent to the secondary IP address of the GroupWise partition where 
its domain or post office is located.

If you are going to set up a GroupWise name server to help GroupWise clients locate their post 
offices, make sure that the default POA port number of 1677 is used somewhere in the cluster. For 
more information, see “Simplifying Client/Server Access with a GroupWise Name Server” in “Post 
Office Agent” in the GroupWise 7 Administration Guide.

12.6.2  Determining Appropriate Failover Lists for the Agents
By default, a GroupWise partition is configured to have all nodes in the cluster in its failover list, 
organized in ascending alphanumeric order. Only one node at a time can have a particular 
GroupWise partition mounted and active. If a GroupWise partition’s preferred node fails, the 
partition fails over to the next node in the failover list. You should customize the failover list for 
each GroupWise partition based on the fan-out-failover principle.

When a node fails, its partitions should not all fail over together to the same secondary node. 
Instead, the partitions should be distributed across multiple nodes in the cluster. This prevents any 
one node from shouldering the entire processing load typically carried by another node. In addition, 
some partitions should never have the potential of being mounted on the same node during a failover 
situation. For example, a post office and POA that service a large number of very active GroupWise 
client users should never fail over to a node where another very large post office and heavily loaded 
POA reside. If they did, users on both post offices would notice a decrease in responsiveness of the 
GroupWise client.

AGENT CLUSTERING WORKSHEET

Under Item 3: MTA Network Information, transfer the domain secondary IP address from the System 
Clustering Worksheet to the Agent Clustering Worksheet.

Under Item 6: POA Network Information, transfer the post office secondary IP address from the 
System Clustering Worksheet to the Agent Clustering Worksheet.

AGENT CLUSTERING WORKSHEET

Under Item 2: Domain Failover List, list the nodes that you want to have in the domain partition failover 
list. The MTA might need to run on any node that the domain partition fails over to. Therefore, you will 
install the agent software on all of the nodes in the domain failover list.

If you are planning the post office on a different GroupWise partition from where the domain is located, 
under Item 5: Post Office Failover List, list the nodes that you want to have in the post office partition 
failover list. The POA might need to run on any node that the post office partition fails over to. 
Therefore, you will install the agent software on all of the nodes in the post office failover list.
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12.6.3  Planning the Linux Agent Installation
Aside from the cluster-specific issues discussed in the preceding sections, the considerations 
involved in planning to install the GroupWise Linux agents are the same in a clustering environment 
as for any other environment. Review “Planning the GroupWise Agents”, then print and fill out the 
“GroupWise Agent Installation Worksheet” in “Installing GroupWise Agents” in the GroupWise 7 
Installation Guide for each location where you will install the Linux MTA and/or POA. 

IMPORTANT: Do not install the Linux agent software until you are instructed to do so in Chapter 
13, “Setting Up a Domain and a Post Office in a Linux Cluster,” on page 135.

Skip to Chapter 13, “Setting Up a Domain and a Post Office in a Linux Cluster,” on page 135.

12.7  GroupWise Clustering Worksheets
• Section 12.7.1, “System Clustering Worksheet,” on page 131
• Section 12.7.2, “Agent Clustering Worksheet,” on page 132

12.7.1  System Clustering Worksheet

Item Explanation

1) eDirectory Tree for Cluster: Record the eDirectory tree where you created the new Novell 
Cluster object when you installed Novell Cluster Services.

For more information, see Section 12.1, “Installing Novell 
Cluster Services on Linux,” on page 126

2) Cluster Name:

Master IP Address:

Record the name of the new Cluster object that you created for 
your GroupWise system. Also record the virtual IP address of 
the cluster that will remain constant regardless of which node 
is currently active.

For more information, see Section 12.1, “Installing Novell 
Cluster Services on Linux,” on page 126.

3) Cluster Context: Record the full context where you created the new Cluster 
object.

For more information, see Section 12.1, “Installing Novell 
Cluster Services on Linux,” on page 126.

4) Nodes in Cluster:

• File system type

• Device name

• Mount point directory

List the nodes that are part of the cluster that you set up for 
your GroupWise system. Also list the file system type (reiserfs, 
ext3, etc.), device name (sda2, hda1, etc.), and mount point 
directory (/mnt, /mail, etc.) for each. You need this 
information as you create load and unload scripts for 
GroupWise agents.

For more information, see Section 12.1, “Installing Novell 
Cluster Services on Linux,” on page 126.
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12.7.2  Agent Clustering Worksheet

5) Shared Partitions in Cluster: List the shared partitions that are available for use in your 
GroupWise system.

For more information, see Section 12.1, “Installing Novell 
Cluster Services on Linux,” on page 126.

6) GroupWise Partition for Software 
Distribution Directory:

Secondary IP Address:

Directory:

If desired, specify the name of the shared partition where the 
GroupWise software distribution directory will reside and the 
full path to its location.

For more information, see Section 12.2, “Planning a Clustered 
Software Distribution Directory,” on page 127.

7) GroupWise Partition for Domain:

Secondary IP Address:

Post Office on Same Partition as 
Domain?

• Yes

• No

Specify the name of the shared partition where the GroupWise 
domain will reside and its secondary IP address.

For more information, see Section 12.3, “Planning a New 
Clustered Domain,” on page 128.

8) GroupWise Partition for Post Office:

Secondary IP Address:

Specify the name of the shared partition where the GroupWise 
post office will reside and its secondary IP address.

For more information, see Section 12.4, “Planning a New 
Clustered Post Office,” on page 128.

9) Domain Name:

Domain Directory:

Specify a unique name for the domain. Specify the directory on 
the GroupWise partition where you want to create the new 
domain.

For more information, see Section 12.3, “Planning a New 
Clustered Domain,” on page 128.

10) Post Office Name:

Post Office Directory:

Specify a unique name for the post office. Specify the directory 
on the GroupWise partition where you want to create the post 
office.

For more information, see Section 12.4, “Planning a New 
Clustered Post Office,” on page 128.

11) Document Storage Area Location:

• At the post office

• Outside the post office

• Separate post office

If you need a library for a clustered post office, mark where you 
want to create its document storage area and provide a 
directory if necessary.

For more information, see Section 12.5, “Planning a New 
Library for a Clustered Post Office,” on page 129.

Item Explanation

1) Domain Name:

Domain Location:

Transfer this information from the System Clustering 
Worksheet (item 9).

Item Explanation
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2) Domain Failover List: List other nodes in the cluster where the GroupWise domain 
and its MTA could fail over.

For more information, see Section 12.6.2, “Determining 
Appropriate Failover Lists for the Agents,” on page 130.

3) MTA Network Information:

• MTA IP address

• MTA message transfer port

• MTA HTTP port

Record the MTA network address information for the server 
where the MTA will run. The MTA IP address is the same as the 
domain secondary IP address in the cluster.

See Section 12.6.1, “Recording Secondary IP Addresses for 
the Agents,” on page 130.

4) Post Office Name:

Post Office Location:

Transfer this information from the System Clustering 
Worksheet (item 10).

5) Post Office Failover List: List other nodes in the cluster where the GroupWise post office 
and its POA could fail over.

For more information, see Section 12.6.2, “Determining 
Appropriate Failover Lists for the Agents,” on page 130.

6) POA Network Information:

• POA IP address

• POA client/server port

• POA message transfer port

• POA HTTP port

Record the POA network address information for the server 
where the POA will run. The POA IP address is the same as 
the post office secondary IP address in the cluster.

See Section 12.6.1, “Recording Secondary IP Addresses for 
the Agents,” on page 130.

Item Explanation
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13Setting Up a Domain and a Post 
Office in a Linux Cluster

You should have already reviewed Chapter 12, “Planning GroupWise in a Linux Cluster,” on 
page 125 and filled out the Section 12.7.1, “System Clustering Worksheet,” on page 131 and the 
Section 12.7.2, “Agent Clustering Worksheet,” on page 132. You are now ready to complete the 
following tasks to set up GroupWise® in a clustering environment on Linux:

• Section 13.1, “Setting Up a New GroupWise System in a Linux Cluster,” on page 135
• Section 13.2, “Creating a New Secondary Domain in a Linux Cluster,” on page 136
• Section 13.3, “Creating a New Post Office in a Linux Cluster,” on page 137
• Section 13.4, “Installing and Configuring the MTA and the POA in a Cluster,” on page 138
• Section 13.5, “Testing Your Clustered GroupWise System,” on page 148
• Section 13.6, “Managing Your Clustered GroupWise System,” on page 150
• Section 13.7, “What’s Next,” on page 152
• Section 13.8, “Clustering Quick Checklists,” on page 152

13.1  Setting Up a New GroupWise System in a 
Linux Cluster
The GroupWise Installation program walks you through setting up the primary domain and an initial 
post office in the primary domain. You might be creating your primary domain and initial post office 
on the same GroupWise partition or on two different partitions. After you have created the primary 
domain and initial post office and then installed the GroupWise agents on multiple nodes in the 
cluster, you can create additional secondary domains and post offices as needed.

To set up the primary domain and initial post office for a new GroupWise system in a clustering 
environment:

1 Start with the first node on the domain failover list (Agent Clustering Worksheet item 2).
2 Make sure that ConsoleOne® is installed on the node.

If necessary, you can download ConsoleOne for Linux from the Novell Product Downloads site 
(http://download.novell.com). ConsoleOne is always installed in /usr/Consoleone.

3 If necessary, mount the GroupWise partition where you want to create the GroupWise software 
distribution directory (System Clustering Worksheet item 6).

4 Mount the GroupWise partition for the domain (System Clustering Worksheet item 7) and, if 
needed, the GroupWise partition for the post office (System Clustering Worksheet item 8), 
where the primary domain and the initial post office for your new GroupWise system will be 
created.

5 From the GroupWise 7 Administrator (Linux) CD, run the GroupWise Installation program, as 
described in “Starting the GroupWise Installation Program on Linux” in “Installing a Basic 
GroupWise System” in the GroupWise 7 Installation Guide, to create the software distribution 
directory and install the GroupWise software.
Setting Up a Domain and a Post Office in a Linux Cluster 135
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6 From the Installation program, run ConsoleOne to set up your initial GroupWise system, as 
described in “Using ConsoleOne to Create Your Basic GroupWise System” in “Installing a 
Basic GroupWise System” in the GroupWise 7 Installation Guide.

7 When providing the MTA and POA network address information, use the Agent Clustering 
Worksheet that you filled out in Section 12.6, “Deciding How to Install and Configure the 
Linux Agents in a Cluster,” on page 129. The information you provide is used to configure the 
MTA and POA objects in the domain and post office even though you have not yet installed the 
agent software on any nodes in the cluster.
Do not create users in the post office at this time.

8 When you have finished creating the primary domain and the initial post office, install the 
GroupWise agent software in your new GroupWise system by following the instructions 
starting with Step 3 in Section 13.4.1, “Installing and Setting Up the Agents in Your Cluster,” 
on page 138.

13.2  Creating a New Secondary Domain in a 
Linux Cluster
After you have set up the primary domain and initial post office, as described in Section 13.1, 
“Setting Up a New GroupWise System in a Linux Cluster,” on page 135, you can create additional 
secondary domains in your GroupWise system as needed.

To create a new secondary domain in a clustering environment:
1 Mount the GroupWise partition where the new secondary domain will be created.
2 In ConsoleOne, connect to the primary domain in your GroupWise system, as described in 

“Connecting to a Domain” in “Domains” in the GroupWise 7 Administration Guide.
3 Create the new domain, following the steps provided in “Creating the New Domain” in 

“Domains” in the GroupWise 7 Administration Guide.
Use the Domain Worksheet you filled out in Section 12.3, “Planning a New Clustered 
Domain,” on page 128 to fill in the fields in the Create GroupWise Domain dialog box.

4 In the Link to Domain field, link the new domain to the primary domain of your GroupWise 
system. 

5 Use the Link Configuration tool to change the links from the new domain to all other domains 
in the cluster to direct TCP/IP links, following the steps provided in “Changing the Link 
Protocol between Domains to TCP/IP” in “Message Transfer Agent” in the GroupWise 7 
Administration Guide. 
Although a complete mesh link configuration is the most efficient, it might not be feasible in all 
situations. Set up as many direct TCP/IP links as possible for best MTA performance in the 
cluster.

6 Make sure you are still connected to the primary domain.
7 Rebuild the domain database for the new domain, following the steps provided in “Rebuilding 

Domain or Post Office Databases” in “Databases” in the GroupWise 7 Administration Guide. 
The database rebuild is necessary in order to transfer the MTA configuration information and 
the domain link information into the secondary domain database, because the MTA for the new 
domain is not yet running.

8 Skip to Installing and Configuring the MTA and the POA in a Cluster to install the MTA 
software for the new domain.
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13.3  Creating a New Post Office in a Linux 
Cluster
You can create a new post office on the same GroupWise partition where its domain resides or on a 
separate GroupWise partition. If the post office and its domain are on the same GroupWise partition, 
they fail over together. If they are on separate GroupWise partitions, they fail over separately.

To create a new post office in a clustering environment on Linux:
1 Mount the GroupWise partition where the domain that will own the new post office located.
2 If necessary, mount the GroupWise partition for the new post office 
3 In ConsoleOne, connect to the GroupWise domain where you want to create the new post 

office, as described in “Connecting to a Domain” in “Domains” in the GroupWise 7 
Administration Guide. 

4 Create the new post office, following the steps provided in “Creating the New Post Office” in 
“Post Offices” in the GroupWise 7 Administration Guide.
Use the Post Office Worksheet you filled out in Section 12.4, “Planning a New Clustered Post 
Office,” on page 128 to fill in the fields in the Create GroupWise Post Office dialog box.

5 Refer to the Agent Clustering Worksheet that you filled in during Section 12.6, “Deciding How 
to Install and Configure the Linux Agents in a Cluster,” on page 129 for the secondary IP 
address and port numbers that you need to specify in order to configure the link.

6 If you want to create a library at the post office, select Create Library.
7 Right-click the new POA object, then click Properties.

On the POA Agent Settings and Scheduled Events pages, you might want to specify unique 
times for the following POA activities to prevent multiple POAs from performing the same 
activities on the same node at the same time during a failover situation:

• Start User Upkeep
• Generate Address Book for Remote
• Enable QuickFinder Indexing 
• Mailbox/Library Maintenance Event

For more information about these repetitive POA activities, see “Performing Nightly User 
Upkeep”, “Regulating Indexing”, and “Scheduling Database Maintenance” in “Post Office 
Agent” in the GroupWise 7 Administration Guide.

8 Make sure you are still connected to the domain that owns the new post office.
9 Rebuild the post office database for the new post office, following the steps provided in 

“Rebuilding Domain or Post Office Databases” in “Databases” in the GroupWise 7 
Administration Guide. Be sure to browse to the database location (under System Clustering 
Worksheet item 11) through the GroupWise partition.
The database rebuild is necessary in order to transfer the POA configuration information and 
the post office link information into the post office database, because the POA for the new post 
office is not yet running.

10 If you want to create a library for the clustered post office, follow the steps in “Setting Up a 
Basic Library” or “Setting Up a Full-Service Library” in “Libraries and Documents” in the 
GroupWise 7 Administration Guide, after you have completely finished setting up the clustered 
post office.
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11 Continue with Installing and Configuring the MTA and the POA in a Cluster to install the POA 
software for the new post office.

13.4  Installing and Configuring the MTA and the 
POA in a Cluster
By following the instructions in Section 13.1, “Setting Up a New GroupWise System in a Linux 
Cluster,” on page 135, you installed the MTA and the POA on the first node in your cluster, as well 
as created the initial domain and post office in your GroupWise system. You are now ready to install 
and configure the agents on additional nodes and set up the agent software for use in your cluster.

• Section 13.4.1, “Installing and Setting Up the Agents in Your Cluster,” on page 138
• Section 13.4.2, “Changing Agent Paths to Locations on GroupWise Partitions,” on page 140
• Section 13.4.3, “Configuring GroupWise Cluster Resources to Load and Unload the Agents,” 

on page 142

If you have added a new secondary domain or a new post office to an existing GroupWise system, 
the agent software has already been installed and you simply need to create a new startup file 
specific to the new domain or post office. In these circumstances, follow the instructions in Section 
13.4.4, “Setting Up New Instances of the Agents without Installing the Agent Software,” on 
page 147 instead of completing the tasks above.

13.4.1  Installing and Setting Up the Agents in Your Cluster
The agents must be installed on each node in domain failover list (Agent Clustering Worksheet item 
2) and the post office failover list (Agent Clustering Worksheet item 5).

• “Running the GroupWise Installation Program on Each Node” on page 138
• “Establishing the Secondary IP Addresses for the Agents on Each Node” on page 139
• “Setting Up Non-root Access on NSS Volumes on Each Node” on page 139
• “Configuring the GroupWise High Availability Service on Each Node” on page 139
• “Testing Your Agent Installation on Each Node” on page 139

After you have installed and tested the agents on each node in the cluster, continue with Section 
13.4.2, “Changing Agent Paths to Locations on GroupWise Partitions,” on page 140.

Running the GroupWise Installation Program on Each Node
1 Mount the GroupWise partition for the domain (System Clustering Worksheet item 7) or the 

post office (System Clustering Worksheet item 8).
2 From the GroupWise 7 Administrator (Linux) CD, start the Installation program and install the 

agent software, following the steps provided in “Installing the GroupWise Agents on Linux” in 
“Installing GroupWise Agents” in the GroupWise 7 Installation Guide. 

3 Configure the Linux agents according to the Section 12.7.2, “Agent Clustering Worksheet,” on 
page 132 that you filled out in Section 12.6, “Deciding How to Install and Configure the Linux 
Agents in a Cluster,” on page 129.

4 At the end of the configuration process, deselect Launch GroupWise Agents on System Startup.
5 Continue with “Establishing the Secondary IP Addresses for the Agents on Each Node” on 

page 139.
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Establishing the Secondary IP Addresses for the Agents on Each Node

The Agent Installation program creates agent startup files in the /opt/novell/groupwise/
agent/share directory. Each MTA startup file is named after the domain it services, with a .mta 
extension. Each POA startup file is named after the post office it services, with a .poa extension.

1 Edit the agent startup files to enable the --ip switch.
2 In the MTA startup file, uncomment the --ip startup switch and specify the secondary IP 

address of the GroupWise partition where the domain is located (System Clustering Worksheet 
item 7). 

3 In the POA startup file, uncomment the --ip startup switch and specify the secondary IP address 
of the GroupWise partition where the post office is located (System Clustering Worksheet item 
8). Depending on the configuration choice you made in Section 12.4, “Planning a New 
Clustered Post Office,” on page 128, this might be on the same GroupWise partition with the 
domain, or it might be on a separate GroupWise partition. Therefore, the POA might have the 
same secondary IP address as the MTA, or it might have a different secondary IP address.
The secondary IP address information can also be stored in eDirectoryTM, as described in 
“Recording Cluster-Specific Information for a Domain and Its MTA” on page 150 and 
“Recording Cluster-Specific Information for a Post Office and Its POA” on page 151.

NOTE: As an alternative to running the Configure option of the Installation program on each 
node, you can run the Install option on each node, then copy the agent startup files to each 
node. The result is the same and you do not need to have the GroupWise partitions mounted.

4 Continue with Configuring the GroupWise High Availability Service on Each Node.

Configuring the GroupWise High Availability Service on Each Node

Configure the GroupWise High Availability service on the node, as described in “Configuring the 
High Availability Service” in “Installing GroupWise Agents” in the GroupWise 7 Installation Guide. 

The GroupWise High Availability service will be enabled later, when you install GroupWise 
Monitor in your cluster, as described in Chapter 16, “Implementing GroupWise Monitor in a Linux 
Cluster,” on page 173.

If you use NSS volumes in your cluster, continue with “Setting Up Non-root Access on NSS 
Volumes on Each Node” on page 139. If you do not use NSS volumes, skip to “Testing Your Agent 
Installation on Each Node” on page 139. 

Setting Up Non-root Access on NSS Volumes on Each Node

If your cluster uses NSS volumes, as described in “Creating NSS Volumes” in “Installation and 
Setup” in the OES Novell Cluster Services 1.8.1 Administration Guide for Linux, you must set up 
non-root access to those NSS volumes, as described in “Setting Up Non-root Access on an NSS 
Volume on Novell Open Enterprise Server Linux” in “Installing GroupWise Agents” in the 
GroupWise 7 Installation Guide.

Continue with Testing Your Agent Installation on Each Node.

Testing Your Agent Installation on Each Node
1 Test the agents by starting them with a user interface, as described in “Starting the Linux 

Agents with a User Interface” in “Installing GroupWise Agents” in the GroupWise 7 
Administration Guide. 
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/opt/novell/groupwise/agents/bin/gwmta --show @domain.mta &
/opt/novell/groupwise/agents/bin/gwpoa --show @post_office.poa 
&

2 Stop the agents by clicking File > Exit
3 After you can see that the agents start successfully, test them by starting them as daemons, as 

described in “Starting the Linux Agents as Daemons” in “Installing GroupWise Agents” in the 
GroupWise 7 Administration Guide.
/etc/init.d/grpwise start
/etc/init.d grpwise status

4 Stop the agents.
/etc/init.d/grpwise stop
/etc/init.d grpwise status

5 Return to “Running the GroupWise Installation Program on Each Node” on page 138 for each 
node in the domain or post office failover list.

When you have installed the agents on all of the nodes in the domain and post office failover lists, 
continue with Changing Agent Paths to Locations on GroupWise Partitions.

13.4.2  Changing Agent Paths to Locations on GroupWise 
Partitions
The default locations for some agent files are on the cluster nodes along with the agent software, 
rather than being located with the domain and post office on one or more GroupWise partitions. To 
avoid having multiple copies of these files in multiple locations, you should set the locations in 
ConsoleOne.

• “Setting the MTA Log File Path” on page 140
• “Setting the MTA Message Log File Path” on page 140
• “Setting the MTA Certificate and Key File Path” on page 141
• “Setting the POA Log File Path” on page 141
• “Setting the POA Certificate and Key File Path” on page 141

Setting the MTA Log File Path
1 On the GroupWise partition where the domain is located, create the directory where you want 

to store MTA log files.
2 In ConsoleOne, browse to and select the Domain object.
3 Right-click the MTA object, then click Properties.
4 Click GroupWise > Log Settings.
5 In the Log File Path field, browse to and select the directory you created in Step 1, then click 

OK.

Setting the MTA Message Log File Path

If you plan to enable message logging, as described in “Enabling MTA Message Logging” in 
“Message Transfer Agent” in the GroupWise 7 Administration Guide:
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1 On the GroupWise partition where the domain is located, create the directory where you want 
to store MTA message log files.

2 In ConsoleOne, browse to and select the Domain object.
3 Right-click the MTA object, then click Properties.
4 Click GroupWise > Message Log Settings.
5 In the Message Log File Path field, browse to and select the directory you created in Step 1, 

then click OK.

Setting the MTA Certificate and Key File Path

If you plan to enable SSL, as described in “Enhancing Domain Security with SSL Connections to 
the MTA” in “Message Transfer Agent” in the GroupWise 7 Administration Guide:

1 On the GroupWise partition where the domain is located, create the directory where you want 
to store the certificate and key file required for SSL.

2 Copy the certificate file and key file into the new directory.
If you need assistance obtaining these files, see “Server Certificates and SSL Encryption” in 
“Security” in the GroupWise 7 Administration Guide.

3 In ConsoleOne, browse to and select the Domain object.
4 Right-click the MTA object, then click Properties.
5 Click GroupWise > SSL Settings.
6 In the Certificate File field, browse to and select the certificate file.
7 In the SSL Key File field, browse to and select the key file.
8 Click OK.

Setting the POA Log File Path
1 On the GroupWise partition where the post office is located, create the directory where you 

want to store POA log files.
2 In ConsoleOne, browse to and select the Post Office object.
3 Right-click the POA object, then click Properties.
4 Click GroupWise > Log Settings.
5 In the Log File Path field, browse to and select the directory you created in Step 1, then click 

OK.

Setting the POA Certificate and Key File Path

If you plan to enable SSL, as described in “Enhancing Post Office Security with SSL Connections to 
the POA” in “Post Office Agent” in the GroupWise 7 Administration Guide:

1 On the GroupWise partition where the post office is located, create the directory where you 
want to store the certificate and key file required for SSL.

2 Copy the certificate file and key file into the new directory.
If you need assistance obtaining these files, see “Server Certificates and SSL Encryption” in 
“Security” in the GroupWise 7 Administration Guide.

3 In ConsoleOne, browse to and select the Post Office object.
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4 Right-click the POA object, then click Properties.
5 Click GroupWise > SSL Settings.
6 In the Certificate File field, browse to and select the certificate file.
7 In the SSL Key File field, browse to and select the key file.
8 Click OK.

13.4.3  Configuring GroupWise Cluster Resources to Load and 
Unload the Agents
The properties of the Cluster Resource object associated with the GroupWise partition define how 
partitions function within the cluster, how agents are loaded and unloaded, and how failover and 
failback situations are handled. At this point, you might have one cluster resource for a GroupWise 
partition with a domain and post office on it, or you might have two cluster resources for two 
GroupWise partitions, one for the domain and one for the post office. Complete the following tasks 
for each cluster resource:

• “Modifying the Cluster Resource Load Script for the Agents” on page 142
• Section 13.4.3, “Configuring GroupWise Cluster Resources to Load and Unload the Agents,” 

on page 142
• “Setting the Failover List and Policies for the Agents” on page 146

Modifying the Cluster Resource Load Script for the Agents

The cluster resource load script executes whenever the GroupWise partition comes online. On OES 
Linux, all cluster management activities are performed in Novell iManager.

To set up the load script in iManager:
1 Expand Clusters, then click Cluster Options.

2 In the Cluster field, browse to the Cluster object where the GroupWise cluster resource is 
located.
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3 Click the Cluster object to display the cluster resources that belong to the cluster.

4 Select the GroupWise Cluster Resource object that you created when you set up the GroupWise 
partition, then click Properties.
The default load script from a generic IP service template appears as follows:

5 Make the following changes to set up the load script for the agents:
5a In the mount command, change reiserfs to whatever file system type is in use on nodes in 

the cluster (System Clustering Worksheet item 5).
5b In the mount command, change vol to the actual device name in use on nodes in the 

cluster (System Clustering Worksheet item 5).
5c In the mount command, change /mnt/generic to the mount point directory in use on 

nodes in the cluster (System Clustering Worksheet item 5).
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5d In the add_secondary_ipaddress command, change a.b.c.d to the secondary 
IP address of the GroupWise partition (System Clustering Worksheet item 7 or System 
Clustering Worksheet item 8)

5e In the start service command, change myservice start to the command to start the 
GroupWise agent or agents that you want to run on this GroupWise partition.
If you created a domain on the partition, you need to run the MTA. If you created a post 
office on the partition, you need to run the POA. If you created both a domain and a post 
office, you need to run both the MTA and the POA. Use the following commands as 
needed for your GroupWise partition:
/etc/init.d/grpwise start domain
/etc/init.d/grpwise start post_office.domain

The result would be similar to the following:

6 Click OK to save the load script.

Modifying the Cluster Resource Unload Script for the Agents

The cluster resource unload script executes whenever the GroupWise partition goes offline. 
Programs should be unloaded in the reverse order of how they were loaded. This ensures that 
supporting programs are not unloaded before programs that rely on them in order to function 
properly.

1 On the Cluster Resource Properties page of the GroupWise cluster resource, click Scripts > 
Unload Script. 
The default unload script appears as follows:
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2 Make the following changes:
2a In the service stop command, change myservice stop to the command to stop the 

GroupWise agent or agents that you want to run on this GroupWise partition.
If you created a domain on the partition, you need to stop the MTA. If you created a post 
office on the partition, you need to stop the POA. If you created both a domain and a post 
office, you need to stop both the MTA and the POA. Use the following commands as 
needed for your GroupWise partition:
/etc/init.d/grpwise stop domain
/etc/init.d/grpwise stop post_office.domain

2b Adjust the sleep command as needed so that the agents can shut down normally on your 
system without being inadvertently killed by the kill service command.

2c In the kill service command, used if the agents do not stop normally, change -k to -mk.
The -m parameter obtains the PID numbers of the processes to kill.

2d In the kill service command, change /mnt/generic to the mount point directory used 
in the load script.

2e In the del_secondary_ipaddress command, change a.b.c.d to the secondary IP 
address used in the load script.

2f In the umount command, change /mnt/generic to the mount point directory used in 
the load script.
The result would be similar to the following:
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2g Click OK to save the unload script.

Setting the Failover List and Policies for the Agents
1 On the Cluster Resource Properties page of the GroupWise cluster resource, click General. 

The default policy settings are often appropriate. By default, a cluster resource:

• Fails over automatically if the node it is running on fails
• Starts automatically on the next node in its failover list
• Continues running at its failover location, even after its most preferred node is again 

available
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If you are considering changing these defaults, see “Setting Start, Failover, and Failback 
Modes” in “Installation and Setup” in the OES Novell Cluster Services 1.8.1 
Administration Guide for Linux.

2 Under Preferred Nodes, arrange the nodes in the cluster into the desired failover list for the 
domain or post office (under Agent Clustering Worksheet items 3 or 6).

3 Click OK.

13.4.4  Setting Up New Instances of the Agents without 
Installing the Agent Software
There are two steps to setting up new instances of the agents without installing the agent software:

• “Creating New Startup Files” on page 147
• “Modifying Existing Load and Unload Scripts” on page 147

Creating New Startup Files

Each MTA startup file is named after the domain it services, with a .mta extension. Each POA 
startup file is named after the post office it services, with a .poa extension. The agent startup files 
are located in /opt/novell/groupwise/agents/share on each node where the agent 
software has been installed.

To create a new startup file without installing the agent software:
1 Make a copy of an existing startup file and name it after the domain or post office that will be 

serviced by the agent.
2 Edit the setting of the --home startup switch to point to the location of the new domain 

directory or post office directory. Be careful to maintain the syntax of the original line.
3 Scroll down through the new startup file looking for other active (not commented out) startup 

switches, then modify them as needed for the new agent.
4 Save the new startup file.
5 Edit the GroupWise High Availability service configuration file (/etc/opt/novell/
groupwise/gwha.conf). 

6 Make a copy of the section for an existing domain and its MTA or post office and its POA, then 
modify the information for the new domain or post office and its accompanying agent.

7 Save the gwha.conf file.
For more information about the High Availability service, see “Enabling the High Availability 
Service for the Linux Agents”.

8 Continue with Modifying Existing Load and Unload Scripts.

Modifying Existing Load and Unload Scripts

The agent startup file names are part of the load commands found in GroupWise cluster resource 
load scripts.

If you created the new domain and/or post office on a new GroupWise partition, skip back to Section 
13.4.3, “Configuring GroupWise Cluster Resources to Load and Unload the Agents,” on page 142 
for instructions to create new load and unload scripts.
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If you created the new domain and/or post office on an existing GroupWise partition, most of the 
configuration of the cluster resource has already been done. You just need to add new service start 
and stop commands to the existing scripts. Continue with the steps below:

To modify existing load and unload scripts:
1 In iManager, expand Cluster, then click Cluster Options.
2 In the Cluster field, browse to and click the Cluster object where the GroupWise cluster 

resource is located.
3 Select a cluster resource that contains a GroupWise partition, then click Properties > Scripts.
4 Following the pattern of the existing service start commands, add start commands for the new 

instances of the agents you are setting up. Use Ctrl+C to copy and Ctrl+V to paste lines in the 
load script page.

5 Click Apply to save the modified load script.
6 Click Unload Script.
7 Add corresponding service stop commands for the new instances of the agents.
8 Click Apply to save the modified unload script.

You might want to review other properties of the Cluster Resource object, such as the failover 
list and the failover/failback/migration procedures on the General page, in light of the fact that 
an additional domain and/or post office now resides on the GroupWise partition.

9 Change other Cluster Resource properties as needed.
10 Click OK to save the modified properties.
11 In the Cluster Manager, take the GroupWise partition offline and then bring it online again to 

test the new startup files and the modified load and unload scripts. If you need assistance with 
these tasks, see Testing Your Clustered GroupWise System.

13.5  Testing Your Clustered GroupWise System
After you have configured the GroupWise cluster resources, you can test the load and unload scripts 
by bringing the GroupWise cluster resource online and taking it offline again.

1 In iManager, expand Clusters, then click Cluster Manager.
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The new GroupWise cluster resource shows Offline in the State column.
2 Click the new GroupWise cluster resource, then click Online.

3 Select the cluster node where you want to online the GroupWise cluster resource, then click 
OK.
After a moment, the GroupWise cluster resource displays Running in the State column.

4 At the server where the MTA and/or POA are starting, use the following command to see if 
they are running:
/etc/init.d/grpwise status domain
/etc/init.d/grpwise status post_office.domain

5 Select the new GroupWise cluster resource, then click Offline.
The State column for the GroupWise cluster resource returns to Offline.

6 Use the same command you used in Step 4 to verify if they have stopped.
7 Repeat Step 2 whenever you are ready to bring the new GroupWise cluster resource online 

permanently.
8 Continue with Managing Your Clustered GroupWise System.
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13.6  Managing Your Clustered GroupWise 
System
After you have set up a basic clustered GroupWise system, you should consider some long-term 
management issues.

• Section 13.6.1, “Updating GroupWise Objects with Cluster-Specific Descriptions,” on 
page 150

• Section 13.6.2, “Knowing What to Expect in MTA and POA Failover Situations,” on page 151

13.6.1  Updating GroupWise Objects with Cluster-Specific 
Descriptions
After setting up your clustered GroupWise system, while the cluster-specific information is fresh in 
your mind, you should record the cluster-specific information as part of the GroupWise objects in 
ConsoleOne so that you can easily refer to it later. Be sure to update the information in the 
GroupWise objects if the configuration of your system changes.

• “Recording Cluster-Specific Information for a Domain and Its MTA” on page 150
• “Recording Cluster-Specific Information for a Post Office and Its POA” on page 151
• “Recording Cluster-Specific Information for a Software Distribution Directory” on page 151

Recording Cluster-Specific Information for a Domain and Its MTA

To permanently record important cluster-specific information for the domain:
1 In ConsoleOne, browse to and right-click the Domain object, then click Properties.
2 In the Description field of the domain Identification page, provide a cluster-specific description 

of the domain, including the secondary IP address of its GroupWise partition. 
3 Click OK to save the domain description.
4 Select the Domain object to display its contents.
5 Right-click the MTA object, then click Properties.
6 In the Description field of the MTA Identification page, record the secondary IP address of the 

domain’s GroupWise partition. 
This information appears on the MTA server console, no matter which node in the cluster it is 
currently running on.

7 Click Apply to save the description.
8 Click Network Address.
9 In the TCP/IP Address field, provide the secondary IP address that you specified using the --ip 

switch in the MTA startup file.
10 Select Bind Exclusively to TCP/IP Address.

This records this vital information in eDirectory as well as in the MTA startup file.
11 Click OK to save the MTA description and secondary IP address.
12 Continue with Recording Cluster-Specific Information for a Post Office and Its POA.
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Recording Cluster-Specific Information for a Post Office and Its POA

To permanently record important cluster-specific information for a post office:
1 In ConsoleOne, browse to and right-click the Post Office object, then click Properties.
2 In the Description field of the post office Identification page, provide a cluster-specific 

description of the post office, including the secondary IP address of its GroupWise partition. 
3 Click OK to save the post office description.
4 Select the Post Office object to display its contents.
5 Right-click the POA object, then click Properties.
6 In the Description field of the POA Identification page, record the secondary IP address of the 

post office’s GroupWise partition. 
This information appears on the POA server console, no matter which node in the cluster it is 
currently running on.

7 Click Apply to save the description.
8 Click Network Address.
9 In the TCP/IP Address field, provide the secondary IP address that you specified using the --ip 

switch in the POA startup file.
10 Select Bind Exclusively to TCP/IP Address.

This records this vital information in eDirectory as well as in the POA startup file.
11 Click OK to save the POA description and secondary IP address.
12 If applicable, continue with Recording Cluster-Specific Information for a Software Distribution 

Directory.
or
Skip to Section 13.6.2, “Knowing What to Expect in MTA and POA Failover Situations,” on 
page 151.

Recording Cluster-Specific Information for a Software Distribution Directory

To permanently record important cluster-specific information about a software distribution directory 
located on a GroupWise partition:

1 In ConsoleOne, click Tools > System Operations > Software Directory Management.
2 Select the software distribution directory, then click Edit.
3 In the description field, record the secondary IP address of the GroupWise partition where the 

software distribution directory resides. 
4 Click OK, then click Close to save the software distribution directory description.
5 Continue with Knowing What to Expect in MTA and POA Failover Situations.

13.6.2  Knowing What to Expect in MTA and POA Failover 
Situations
In a failover situation, the agents might need to perform some database repair as they start on the 
new node. The time required depends on the size of the databases involved. 
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Typically, the POA returns to full functionality faster than the MTA. This benefits GroupWise client 
users, who can reconnect to their mailboxes very quickly and probably do not notice if messages to 
users in other post offices are not delivered immediately. The only time a user needs to restart the 
GroupWise client is if he or she was actually in the process of sending a message when the POA 
went down. Notify can continue running even if the connection to the POA becomes unavailable and 
then it reconnects automatically when the POA is again available.

The MTA typically takes some time reestablishing the links to its post offices, other domains, and 
gateways, but this situation usually resolves itself in a few minutes without administrator 
intervention. If it does not, you can manually restart the MTA to speed up the process. 

In comparison to failover, migration typically takes longer because the agents methodically 
terminate their threads and close their databases as part of their normal shutdown procedure. 
However, as a result, no database repair is required when the agents start up again in their new 
location.

Continue with What’s Next.

13.7  What’s Next
Now that you have at least one GroupWise domain and post office up and running in a clustering 
environment, you are ready to proceed with the rest of your GroupWise system setup by:

• Adding users to post offices. See “Users” in the GroupWise 7 Administration Guide.
• Setting up the GroupWise client software and helping users to get started using it. See “Client” 

in the GroupWise 7 Administration Guide. Also see the GroupWise 7 Windows Client User 
Guide.

• Connecting your clustered GroupWise system to the Internet. See Chapter 14, “Implementing 
the Internet Agent in a Linux Cluster,” on page 155.

• Providing access to users’ GroupWise mailboxes from their Web browsers. See Chapter 15, 
“Using WebAccess in a Linux Cluster,” on page 171.

• Monitoring the status of your clustered GroupWise system from your Web browser. See 
Chapter 16, “Implementing GroupWise Monitor in a Linux Cluster,” on page 173.

• Backing up your clustered GroupWise system. See Chapter 17, “Backing Up a GroupWise 
System in a Linux Cluster,” on page 185.

13.8  Clustering Quick Checklists
• Section 13.8.1, “GroupWise System Quick Checklist,” on page 152
• Section 13.8.2, “Domain Quick Checklist,” on page 153
• Section 13.8.3, “Post Office Quick Checklist,” on page 153

13.8.1  GroupWise System Quick Checklist
Plan your new clustered GroupWise system.

See Chapter 12, “Planning GroupWise in a Linux Cluster,” on page 125.
Create the primary domain and initial post office in your new clustered GroupWise system.
See Section 13.1, “Setting Up a New GroupWise System in a Linux Cluster,” on page 135.
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Set up the agents for the primary domain and the initial post office. 
See Section 13.4, “Installing and Configuring the MTA and the POA in a Cluster,” on 
page 138.
Modify the cluster resource load scripts:
See “Modifying the Cluster Resource Load Script for the Agents” on page 142.
Modify the cluster resource unload scripts:
See “Modifying the Cluster Resource Unload Script for the Agents” on page 144.
Set up the cluster failover lists and policies. 
See “Setting the Failover List and Policies for the Agents” on page 146.
Test your new clustered GroupWise system. 
See Section 13.5, “Testing Your Clustered GroupWise System,” on page 148.
Record cluster-specific information in the properties pages of the GroupWise objects that the 
information pertains to.
See Section 13.6, “Managing Your Clustered GroupWise System,” on page 150.

13.8.2  Domain Quick Checklist
Plan your new clustered domain. 

See Section 12.3, “Planning a New Clustered Domain,” on page 128.
Create the new domain. 
See Section 13.2, “Creating a New Secondary Domain in a Linux Cluster,” on page 136.
Set up the MTA for the new domain.
See Section 13.4, “Installing and Configuring the MTA and the POA in a Cluster,” on 
page 138.
Modify the domain cluster resource load script.
See “Modifying the Cluster Resource Load Script for the Agents” on page 142.
Modify the domain cluster resource unload script.
See “Modifying the Cluster Resource Unload Script for the Agents” on page 144.
Set up the domain failover list and policies. 
See “Setting the Failover List and Policies for the Agents” on page 146.
Test your new clustered domain.
See Section 13.5, “Testing Your Clustered GroupWise System,” on page 148.
Record cluster-specific information in the properties pages of the GroupWise objects that the 
information pertains to.
See Section 13.6, “Managing Your Clustered GroupWise System,” on page 150.

13.8.3  Post Office Quick Checklist
Plan your new clustered post office.

See Section 12.4, “Planning a New Clustered Post Office,” on page 128 and Section 12.5, 
“Planning a New Library for a Clustered Post Office,” on page 129.
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Create the new post office.
See Section 13.3, “Creating a New Post Office in a Linux Cluster,” on page 137.
Set up the POA for the new post office.
See Section 13.4, “Installing and Configuring the MTA and the POA in a Cluster,” on 
page 138.
Modify the post office cluster resource load script:
See “Modifying the Cluster Resource Load Script for the Agents” on page 142.
Modify the post office cluster resource unload script:
See “Modifying the Cluster Resource Unload Script for the Agents” on page 144.
Set up the post office failover list and policies. 
See “Setting the Failover List and Policies for the Agents” on page 146.
Test your new clustered post office.
See Section 13.5, “Testing Your Clustered GroupWise System,” on page 148.
Record cluster-specific information in the properties pages of the GroupWise objects that the 
information pertains to. 
See Section 13.6, “Managing Your Clustered GroupWise System,” on page 150.
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14Implementing the Internet Agent in 
a Linux Cluster

You should already have set up at least a basic GroupWise® system, as described in Chapter 12, 
“Planning GroupWise in a Linux Cluster,” on page 125 and Chapter 13, “Setting Up a Domain and a 
Post Office in a Linux Cluster,” on page 135. As part of this process,Section 12.7.1, “System 
Clustering Worksheet,” on page 131 was filled out. If you do not have access to the filled-out 
worksheet, print the worksheet now and fill in the clustering information as it currently exists on 
your system. You need this information as you implement the Internet Agent in a cluster.

• Section 14.1, “Planning the Internet Agent in a Linux Cluster,” on page 155
• Section 14.2, “Setting Up the Internet Agent in a Linux Cluster,” on page 158
• Section 14.3, “Testing the Internet Agent in a Linux Cluster,” on page 165
• Section 14.4, “Managing the Internet Agent in a Linux Cluster,” on page 167
• Section 14.5, “Internet Agent Clustering Worksheet,” on page 168
• Section 14.6, “Internet Agent Quick Checklist,” on page 169

14.1  Planning the Internet Agent in a Linux 
Cluster
A major system configuration difference between the Internet Agent in a clustering environment and 
the Internet Agent in a regular environment is that you need to create a separate domain to house 
each GroupWise gateway, including the Internet Agent.

The Section 14.5, “Internet Agent Clustering Worksheet,” on page 168 lists the information you 
need as you set up the Internet Agent in a clustering environment. You should print the worksheet 
and fill it out as you complete the tasks listed below:

• Section 14.1.1, “Planning a Domain for the Internet Agent,” on page 155
• Section 14.1.2, “Selecting the Internet Agent Partition and Secondary IP Address,” on page 156
• Section 14.1.3, “Determining an Appropriate Failover List for the Internet Agent,” on page 156
• Section 14.1.4, “Preparing DNS for the Clustered Internet Agent,” on page 157
• Section 14.1.5, “Preparing Your Firewall for the Clustered Internet Agent,” on page 157
• Section 14.1.6, “Planning the MTA Installation,” on page 158
• Section 14.1.7, “Planning the Internet Agent Installation,” on page 158

14.1.1  Planning a Domain for the Internet Agent
The considerations involved in planning a domain for the Internet Agent are much the same as 
planning any other domain. In preparation, review “Planning a New Domain”, then print and fill out 
“Domain Worksheet” in “Domains” in the GroupWise 7 Administration Guide. 

Keep in mind the following cluster-specific details:
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• When you specify the location for the domain directory on the Domain Worksheet, remember 
that it is on a GroupWise partition, not on the node where you running the GroupWise 
Installation program. This location is referred to as the Internet Agent partition because it is 
where the Internet Agent message queues are located.

• Do not concern yourself with the GroupWise agent information on the Domain Worksheet. You 
can stop with item 10. You will plan the MTA installation later.

When you have completed the Domain Worksheet, transfer the key information from the Domain 
Worksheet to the Internet Agent Clustering Worksheet.

IMPORTANT: Do not create the new domain until you are instructed to do so in Section 14.2.1, 
“Creating a Domain for the Internet Agent,” on page 158.

14.1.2  Selecting the Internet Agent Partition and Secondary IP 
Address
As with the MTA and the POA, the Internet Agent needs a secondary IP address that remains the 
same no matter which node in the cluster it is running on. You can place the Internet Agent and its 
domain on a GroupWise partition where a domain or post office already reside, which would mean 
that the Internet Agent would share the same secondary IP address as that domain or post office and 
would fail over along with that domain or post office. Or you can place the Internet Agent and its 
domain on its own GroupWise partition, which would mean that it would have its own secondary IP 
address and would fail over independently.

14.1.3  Determining an Appropriate Failover List for the Internet 
Agent
By default, a GroupWise partition is configured to have all nodes in the cluster in its failover list, 
organized in ascending alphanumeric order. Only one node at a time can have a particular 
GroupWise partition mounted and active. If a GroupWise partition’s preferred node fails, the 
partition fails over to the next node in the failover list. You should customize the failover list for 
each GroupWise partition based on the fan-out-failover principle.

INTERNET AGENT CLUSTERING WORKSHEET

Under Item 1: GroupWise Partition for the Internet Agent, transfer the domain location to the Internet 
Agent Clustering Worksheet. 

Under Item 2: Internet Agent Domain Name, transfer the domain name and database directory to the 
Internet Agent Clustering Worksheet. 

INTERNET AGENT CLUSTERING WORKSHEET

Under Item 1: GroupWise Partition for Internet Agent, specify the secondary IP address for the 
Internet Agent partition.

Under Item 5: MTA Network Information, copy the secondary IP address, because it is the same.

Under Item 7: Internet Agent Network Information, copy the secondary IP address, because it is the 
same.
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As with the MTA and the POA, you need to decide which nodes in the cluster would be appropriate 
locations for the Internet Agent partition to fail over to. You must install the Internet Agent software 
on all of the nodes where you want the Internet Agent to be able to fail over. For a review of failover 
lists, see Section 12.6.2, “Determining Appropriate Failover Lists for the Agents,” on page 130, 
which describes the issues in the context of planning MTA and POA installations. 

14.1.4  Preparing DNS for the Clustered Internet Agent
In order for the Internet Agent partition to be recognized on your network, DNS must have an MX 
record that includes the hostname corresponding to the secondary IP address of the Internet Agent 
partition. A DNS A record associates the secondary IP address with the hostname.

14.1.5  Preparing Your Firewall for the Clustered Internet Agent
The Internet Agent receives incoming messages on the secondary IP address of the Internet Agent 
partition. Your firewall configuration must be modified to allow inbound TCP/IP traffic from the 
Internet to the Internet Agent secondary IP address on the following standard ports:

Table 14-1   Standard Ports

By default, the Internet Agent sends outgoing messages on the primary IP address of the server 
where it is running. If you decide to use this default configuration, your firewall must be configured 
to allow outbound TCP/IP traffic from all nodes in the Internet Agent partition failover list.

If the Internet Agent has a large number of nodes on its failover list, you could configure the Internet 
Agent to send outgoing messages to a relay host, which then sends them out through the firewall 
using its own IP address rather than the address of the particular node where the Internet Agent was 
running. This reduces the amount of modification to your firewall required to set up the Internet 
Agent. However, if the relay host goes down, outgoing messages are delayed.

As another alternative, you can configure the Internet Agent to use its secondary IP address for 
sending as well as receiving messages. Setup instructions for this configuration are provided in 
“Forcing Use of the Internet Agent Secondary IP Address” on page 165, which you can complete 
after installing the Internet Agent.

In preparation for installing the Internet Agent, configure your firewall as needed to handle the 
Internet Agent’s use of primary and secondary IP addresses when sending and receiving messages.

INTERNET AGENT CLUSTERING WORKSHEET

Under Item 3: Internet Agent Failover List, list the nodes that you want in the Internet Agent partition 
failover list.

Protocol Standard Port

IMAP4 143

LDAP 389

POP3 110

SMTP 25
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14.1.6  Planning the MTA Installation
Follow the instructions in Section 12.6.3, “Planning the Linux Agent Installation,” on page 131, 
then return to this point. After you follow the instructions, you will have a filled-out Agent 
Clustering Worksheet to use when you install the MTA.

IMPORTANT: Do not install the Linux MTA until you are instructed to do so in Section 14.2, 
“Setting Up the Internet Agent in a Linux Cluster,” on page 158.

14.1.7  Planning the Internet Agent Installation
Aside from the cluster-specific issues discussed in the preceding sections, the considerations 
involved in planning to install the Internet Agent are the same in a clustering environment as for any 
other environment. Review the installation instructions in “Linux: Installing the Internet Agent 
Software” in “Installing the GroupWise Internet Agent” in the GroupWise 7 Installation Guide. Use 
the “GroupWise Internet Agent Installation Worksheet” to record the planning information you will 
need as you install the Internet Agent in your cluster.

IMPORTANT: Do not install the Internet Agent software until you are instructed to do so in Setting 
Up the Internet Agent in a Linux Cluster.

14.2  Setting Up the Internet Agent in a Linux 
Cluster
You should already have reviewed Section 14.1, “Planning the Internet Agent in a Linux Cluster,” 
on page 155 and filled out Section 14.5, “Internet Agent Clustering Worksheet,” on page 168. You 
are now ready to complete the following tasks to set up the Internet Agent in a clustering 
environment:

• Section 14.2.1, “Creating a Domain for the Internet Agent,” on page 158
• Section 14.2.2, “Installing the MTA for the Internet Agent Domain,” on page 158
• Section 14.2.3, “Installing and Configuring the Internet Agent in a Cluster,” on page 159

14.2.1  Creating a Domain for the Internet Agent
The Internet Agent domain will be a secondary domain. To create it, follow the instructions in 
Section 13.2, “Creating a New Secondary Domain in a Linux Cluster,” on page 136, taking your 
information from the Internet Agent Clustering Worksheet, rather than the System Clustering 
Worksheet, then return to this point. 

Do not create any post offices in the Internet Agent domain.

Continue with Installing the MTA for the Internet Agent Domain.

14.2.2  Installing the MTA for the Internet Agent Domain
The MTA for the Internet Agent domain can be installed just like any other MTA in your clustered 
GroupWise system. Follow the instructions in Section 13.4.1, “Installing and Setting Up the Agents 
in Your Cluster,” on page 138, then return to this point. 
7 Interoperability Guide



novdocx (E
N

U
)  6 D

ecem
ber 2005
You do not need to edit the MTA startup file. You do not need to modify the Cluster Resource object 
properties until after you have installed the Internet Agent.

Continue with Installing and Configuring the Internet Agent in a Cluster.

14.2.3  Installing and Configuring the Internet Agent in a Cluster
After you have created a domain for the Internet Agent and installed the MTA for that domain, you 
are ready to install and configure the Internet Agent.

• “Installing and Setting Up the Internet Agent Software in Your Cluster” on page 159
• “Configuring the Internet Agent Cluster Resource to Load and Unload the Internet Agent and 

Its MTA” on page 161
• “Enabling Internet Addressing for Your Clustered GroupWise System” on page 164
• “Verifying GWIA Object Properties” on page 164

Installing and Setting Up the Internet Agent Software in Your Cluster

The Internet Agent must be installed on each node in its failover list (Internet Agent Clustering 
Worksheet item 3).

• “Running the Internet Agent Installation Program on Each Node” on page 159
• “Establishing the Secondary IP Address for the Internet Agent on Each Node” on page 159
• “Setting Up Non-root Access on NSS Volumes on Each Node” on page 160
• “Configuring the GroupWise High Availability Service on Each Node” on page 160
• “Testing Your Internet Agent Installation on Each Node” on page 160

Running the Internet Agent Installation Program on Each Node
1 Mount the Internet Agent partition (Internet Agent Clustering Worksheet item 1) where the 

Internet Agent message queues are located.
2 From the GroupWise 7 Administrator (Linux) CD, start the Installation program and install the 

Internet Agent software, following the steps provided in “Linux: Installing the Internet Agent 
Software” in “Installing the GroupWise Internet Agent” in the GroupWise 7 Installation Guide.

3 Configure the Internet Agent according to the “GroupWise Internet Agent Installation 
Worksheet” that you filled out in Section 14.1, “Planning the Internet Agent in a Linux 
Cluster,” on page 155.

4 At the end of the configuration process, deselect Launch Internet Agent on System Startup.
5 Continue with Establishing the Secondary IP Address for the Internet Agent on Each Node.

Establishing the Secondary IP Address for the Internet Agent on Each Node

The Installation program creates the Internet Agent startup file (gwia.cfg) in the /opt/
novell/groupwise/agents/share directory. Add the --ip switch and specify the secondary 
IP address of the Internet Agent partition (Internet Agent Clustering Worksheet item 1).

The secondary IP address information can also be stored in eDirectoryTM, as described in “Forcing 
Use of the Internet Agent Secondary IP Address” on page 165.
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NOTE: After the first installation, as an alternative to running the Configure option of the 
Installation program on each node, you can run the Install option on each node, then copy the 
gwia.cfg file to each node. The result is the same and you do not need to have the Internet Agent 
partition mounted.

If you use NSS volumes in your cluster, continue with “Setting Up Non-root Access on NSS 
Volumes on Each Node” on page 139. If you do not use NSS volumes, skip to “Testing Your Agent 
Installation on Each Node” on page 139. 

Setting Up Non-root Access on NSS Volumes on Each Node

If your cluster uses NSS volumes, as described in “Creating NSS Volumes” in “Installation and 
Setup” in the OES Novell Cluster Services 1.8.1 Administration Guide for Linux, you must set up 
non-root access to those NSS volumes, as described in “Setting Up Non-root Access on an NSS 
Volume on Novell Open Enterprise Server Linux” in “Installing GroupWise Agents” in the 
GroupWise 7 Installation Guide. 

Continue with Configuring the GroupWise High Availability Service on Each Node.

Configuring the GroupWise High Availability Service on Each Node

Configure the GroupWise High Availability service on the node, as described in “Configuring the 
High Availability Service” in “Installing GroupWise Agents” in the GroupWise 7 Installation Guide. 

The GroupWise High Availability service is enabled later, when you install GroupWise Monitor in 
your cluster, as described in Chapter 16, “Implementing GroupWise Monitor in a Linux Cluster,” on 
page 173.

Continue with “Testing Your Internet Agent Installation on Each Node” on page 160.

Testing Your Internet Agent Installation on Each Node
1 Test the Internet Agent by starting it with a user interface, as described in “Starting the Linux 

Internet Agent with a User Interface” in “Installing the GroupWise Internet Agent” in the 
GroupWise 7 Installation Guide.
/opt/novell/groupwise/agents/bin/gwia --show @gwia.cfg &

2 Stop the Internet Agent by clicking File > Exit.
3 After you can see that the Internet Agent started successfully, test it by starting it as a daemon, 

as described in “Starting the Linux Internet Agent as a Daemon” in “Installing the GroupWise 
Internet Agent” in the GroupWise 7 Installation Guide.
/etc/inet.d/grpwise start domain.gwia
/etc/inet.d/grpwise status domain.gwia

4 Stop the Internet Agent.
/etc/inet.d/grpwise stop domain.gwia
/etc/inet.d/grpwise status domain.gwia

5 Make sure you have completed all the tasks described in “Installing the GroupWise Internet 
Agent” in the GroupWise 7 Installation Guide. 
A few tasks, such as assigning a postmaster, are not dealt with in this cluster-oriented section.

6 Return to “Running the Internet Agent Installation Program on Each Node” on page 159 for 
each node in the Internet Agent failover list.
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When you have installed the Internet Agent on all of the nodes in the Internet Agent failover list, 
continue with “Changing Internet Agent Paths to Locations on the Internet Agent Partition” on 
page 161.

Changing Internet Agent Paths to Locations on the Internet Agent Partition

The default locations for some GroupWise files are on the cluster nodes along with the GroupWise 
software, rather than being located with the domain and post office on one or more GroupWise 
partitions. To avoid having multiple copies of these files in multiple locations, you should set the 
locations in ConsoleOne®.

• “Setting the Internet Agent Log File Path” on page 161
• “Setting the Internet Agent Certificate File and Key File Path” on page 161

After you have set these locations to the Internet Agent partition, continue with “Configuring the 
Internet Agent Cluster Resource to Load and Unload the Internet Agent and Its MTA” on page 161.

Setting the Internet Agent Log File Path
1 On the Internet Agent partition, create the directory where you want to store Internet Agent log 

files.
2 In ConsoleOne, browse to and select the Domain object.
3 Right-click the Internet Agent object, then click Properties.
4 Click GroupWise > Log Settings.
5 In the Log File Path field, browse to and select the directory you created in Step 1, then click 

OK.

Setting the Internet Agent Certificate File and Key File Path

If you plan to enable SSL, as described in “Securing Internet Agent Connections Via SSL” in 
“Internet Agent” in the GroupWise 7 Administration Guide:

1 On the Internet Agent partition, create the directory where you want to store the certificate and 
key file required for SSL.

2 Copy the certificate file and key file into the new directory.
If you need assistance obtaining these files, see “Server Certificates and SSL Encryption” in 
“Security” in the GroupWise 7 Administration Guide.

3 In ConsoleOne, browse to and select the Domain object.
4 Right-click the Internet Agent object, then click Properties.
5 Click GroupWise > SSL Settings.
6 In the Certificate File field, browse to and select the certificate file.
7 In the SSL Key File field, browse to and select the key file.
8 Click OK.

Configuring the Internet Agent Cluster Resource to Load and Unload the Internet 
Agent and Its MTA

The properties of the Cluster Resource object define how the Internet Agent partition functions 
within the cluster, how the Internet Agent is loaded and unloaded, and how failover and failback 
situations are handled. Complete the following tasks for the Internet Agent cluster resource:
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• “Modifying the Cluster Resource Load Script for the Internet Agent and Its MTA” on page 162
• “Modifying the Cluster Resource Unload Script for the Internet Agent and Its MTA” on 

page 163
• “Setting the Failover List and Policies for the Internet Agent and Its MTA” on page 163

Modifying the Cluster Resource Load Script for the Internet Agent and Its MTA

The cluster resource load script executes whenever the Internet Agent cluster resource comes online.

To set up the load script in iManager:
1 Expand Clusters, then click Cluster Options.
2 In the Cluster field, browse to the Cluster object where the Internet Agent cluster resource is 

located.
3 Click the Cluster object to display the cluster resources that belong to the cluster.
4 Select the Internet Agent cluster resource that you created when you set up the Internet Agent 

partition, then click Properties.
The default load script from a generic IP service template appears as follows:

5 Make the following changes to set up the Internet Agent load script:
5a In the mount command, change reiserfs to whatever file system type is in use on nodes in 

the cluster.
5b In the mount command, change vol to the actual device name in use on nodes in the 

cluster.
5c In the mount command, change /mnt/generic to the mount point directory in use on 

nodes in the cluster.
5d In the add_secondary_ipaddress command, change a.b.c.d to the secondary 

IP address of the Internet Agent partition (Internet Agent Clustering Worksheet item 1)
5e In the start service command, change myservice start to the command to start the 

Internet Agent and its MTA.
/etc/init.d/grpwise start domain
/etc/init.d/grpwise start domain.gwia

6 Click OK to save the load script.
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Modifying the Cluster Resource Unload Script for the Internet Agent and Its MTA

The cluster resource unload script executes whenever the Internet Agent cluster resource goes 
offline. Programs should be unloaded in the reverse order of how they were loaded. This ensures 
that supporting programs are not unloaded before programs that rely on them in order to function 
properly.

1 On the Cluster Resource Properties page of the Internet Agent cluster resource, click Scripts > 
Unload Script. 
The default unload script appears as follows:

2 Make the following changes:
2a In the stop service command, change myservice stop to the command to stop the 

Internet Agent and its MTA.
/etc/init.d/grpwise stop domain.gwia
/etc/init.d/grpwise stop domain

2b Adjust the sleep command as needed so that the Internet Agent and its MTA can shut 
down normally on your system without being inadvertently killed by the kill command.

2c In the kill service command, used if the Internet Agent and its MTA do not stop normally, 
change -k to -mk.
The -m parameter obtains the PID numbers of the processes to kill.

2d In the kill service command, change /mnt/generic to the mount point directory used 
in the load script.

2e In the del_secondary_ipaddress command, change a.b.c.d to the secondary 
IP address used in the load script.

2f In the umount command, change /mnt/generic to the mount point directory used in 
the load script.

2g Click OK to save the unload script.

Setting the Failover List and Policies for the Internet Agent and Its MTA
1 On the Cluster Resource Properties page of the Internet Agent cluster resource, click General. 

The default policy settings are often appropriate. By default, a cluster resource:
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• Fails over automatically if the node it is running on fails
• Starts automatically on the next node in its failover list
• Continues running at its failover location, even after its most preferred node is again 

available
If you are considering changing these defaults, see “Setting Start, Failover, and Failback 
Modes” in “Installation and Setup” in the OES Novell Cluster Services 1.8.1 
Administration Guide for Linux.

2 Under Preferred Nodes, arrange the nodes in the cluster into the desired failover list for the 
Internet Agent (under Internet Agent Clustering Worksheet item 3).

3 Click OK.

Enabling Internet Addressing for Your Clustered GroupWise System

Setting up Internet addressing for a clustered Internet Agent is no different from setting it up for an 
Internet Agent in any other environment. Follow the instructions in “Configuring Internet 
Addressing” in “Internet Agent” in the GroupWise 7 Administration Guide, then return to this point.

Verifying GWIA Object Properties

During installation of the Internet Agent, the GWIA object should have been configured correctly. 
However, it can be helpful to verify certain cluster-specific information in order to familiarize 
yourself with the configuration of a clustered Internet Agent.

• “Accessing GWIA Object Properties” on page 164
• “Verifying the Reference to the Internet Agent Cluster Resource” on page 164
• “Verifying the Reference to the Mount Point Directory” on page 165
• “Verifying Post Office Links” on page 165
• “Forcing Use of the Internet Agent Secondary IP Address” on page 165

Accessing GWIA Object Properties
1 In ConsoleOne, browse to and select the Internet Agent domain in order to display its contents.
2 Right-click the GWIA object, then click Properties.
3 Continue with Verifying the Reference to the Internet Agent Cluster Resource.

Verifying the Reference to the Internet Agent Cluster Resource

In the GWIA object properties pages:
1 Click SMTP/MIME > Settings. 
2 Verify the contents of the Hostname/DNS “A Record” Name field.

It displays the hostname as currently configured in DNS. It should display the hostname that 
corresponds to the secondary IP address of the Internet Agent cluster resource. For more 
information, see Section 14.1.4, “Preparing DNS for the Clustered Internet Agent,” on 
page 157.

3 Make changes if necessary.
4 Continue with Verifying the Reference to the Mount Point Directory.
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Verifying the Reference to the Mount Point Directory

In the GWIA object properties pages:
1 Click Server Directories. 
2 Verify that the displayed directories match the mount point directory and the domain directory.
3 Make changes if necessary.
4 Continue with Verifying Post Office Links.

Verifying Post Office Links

In the GWIA object properties pages:
1 Click Post Office Links.
2 Verify that the Access Mode column displays C/S (for client/server mode) for all post offices 

serviced by the Internet Agent.
3 Verify that the Links column displays the secondary IP addresses of the GroupWise partitions 

where post offices reside, not the IP addresses of any nodes in the cluster.
4 Make changes if necessary.
5 Continue with Forcing Use of the Internet Agent Secondary IP Address.

Forcing Use of the Internet Agent Secondary IP Address

If you want the Internet Agent to send outgoing messages on its secondary IP address, rather than 
using the default of its primary IP address:

1 Click GroupWise > Network Address.
2 In the TCP/IP Address field, provide the secondary IP address (under Internet Agent Clustering 

Worksheet item 1) for the Internet Agent to use for sending outgoing messages.
3 Select Bind Exclusively to TCP/IP Address.
4 Click OK.
5 Continue with Testing the Internet Agent in a Linux Cluster.

14.3  Testing the Internet Agent in a Linux Cluster
After you have configured the Internet Agent cluster resource, you can test the load and unload 
scripts by bringing the cluster resource online and taking it offline again.

1 In iManager, expand Clusters, then click Cluster Manager.
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The new Internet Agent cluster resource shows Offline in the State column.
2 Click the new Internet Agent cluster resource, then click Online.

3 Select the cluster node where you want to online the Internet Agent cluster resource, then click 
OK.
After a moment, the Internet Agent cluster resource displays Running in the State column.

4 At the server where the Internet Agent is starting, use the following command to see that the 
Internet Agent has started:
/etc/init.d/grpwise status domain.gwia

5 Select the new Internet Agent cluster resource, then click Offline.
The State column for the Internet Agent cluster resource returns to Offline.

6 Use the same command that you used in Step 4 to verify that the Internet Agent has stopped.
7 Repeat Step 2 whenever you are ready to bring the new Internet Agent cluster resource online 

permanently.
8 Continue with Managing Your Clustered GroupWise System.
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14.4  Managing the Internet Agent in a Linux 
Cluster
After you have installed the Internet Agent in a cluster, you should consider some long-term 
management issues.

• Section 14.4.1, “Updating GroupWise Objects with Cluster-Specific Descriptions,” on 
page 167

• Section 14.4.2, “Knowing What to Expect in an Internet Agent Failover Situation,” on 
page 168

14.4.1  Updating GroupWise Objects with Cluster-Specific 
Descriptions
After installing the Internet Agent in your clustered GroupWise system, while the cluster-specific 
information is fresh in your mind, you should record the cluster-specific information as part of the 
GroupWise objects in ConsoleOne so that you can easily refer to it later. Be sure to update the 
information in the GroupWise objects if the configuration of your system changes.

• “Recording Cluster-Specific Information about the Internet Agent Domain and Its MTA” on 
page 167

• “Recording Cluster-Specific Information about the Internet Agent” on page 167

Recording Cluster-Specific Information about the Internet Agent Domain and Its MTA

To permanently record important cluster-specific information for the Internet Agent domain:
1 In ConsoleOne, browse to and right-click the Domain object, then click Properties.
2 In the Description field of the Internet Agent domain Identification page, provide a cluster-

specific description of the Internet Agent domain, including the secondary IP address of its 
GroupWise partition. 

3 Click OK to save the Internet Agent domain description.
4 Select the Internet Agent Domain object to display its contents.
5 Right-click the MTA object, then click Properties.
6 In the Description field of the MTA Identification page, record the secondary IP address of the 

GroupWise partition. 
This information appears on the MTA console, no matter which node in the cluster it is 
currently running on.

7 Click OK to save the MTA description.
8 Continue with “Recording Cluster-Specific Information about the Internet Agent” on page 167.

Recording Cluster-Specific Information about the Internet Agent

With the contents of the Internet Agent domain still displayed:
1 Right-click the GWIA object, then click Properties.
2 Click GroupWise, then click Identification.
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3 In the Description field, record the secondary IP address of the GroupWise partition where the 
Internet Agent domain is location. 
This information appears on the Internet Agent console, no matter which node in the cluster it 
is currently running on.

4 Click OK to save the Internet Agent information.
5 Continue with Knowing What to Expect in an Internet Agent Failover Situation.

14.4.2  Knowing What to Expect in an Internet Agent Failover 
Situation
The failover behavior of the MTA for the Internet Agent domain is the same as for an MTA in a 
regular domain. See Section 13.6.2, “Knowing What to Expect in MTA and POA Failover 
Situations,” on page 151.

Failover of the Internet Agent itself is more complex. The various clients (POP3, IMAP4, and 
LDAP) receive an error message that the node is not available. Most of the clients do not attempt to 
reconnect automatically, so the user must exit the client and restart it to reestablish the connection 
after the failover process is complete. Fortunately, the Internet Agent restarts quickly in its failover 
location so users can reconnect quickly.

As with the MTA and the POA, migration of the Internet Agent takes longer than failover. In fact, 
the Internet Agent can seem especially slow to shut down properly as it finishes its normal 
processing and stops its threads. For a busy Internet Agent, you might need to wait several minutes 
for it to shut down properly.

14.5  Internet Agent Clustering Worksheet

Item Explanation

1) GroupWise Partition for the 
Internet Agent:

Secondary IP Address:

Specify the GroupWise partition where the Internet Agent domain will 
be created, along with its secondary IP address.

For more information, see Section 14.1.2, “Selecting the Internet 
Agent Partition and Secondary IP Address,” on page 156.

2) Internet Agent 
Domain Name:

Domain Database Location:

Specify a unique name for the Internet Agent domain. Specify the 
directory on the GroupWise partition where you want to create the 
new domain.

For more information, see Section 14.1.1, “Planning a Domain for the 
Internet Agent,” on page 155.

3) Internet Agent 
Failover List:

List other nodes in the cluster where the Internet Agent and its MTA 
could fail over.

For more information, see Section 14.1.3, “Determining an 
Appropriate Failover List for the Internet Agent,” on page 156.
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14.6  Internet Agent Quick Checklist
Plan the new clustered Internet Agent, including the new domain required to house the Internet 
Agent in a clustering environment.

See Section 14.1, “Planning the Internet Agent in a Linux Cluster,” on page 155.
Make sure DNS includes the secondary IP address of the Internet Agent partition
See Section 14.1.4, “Preparing DNS for the Clustered Internet Agent,” on page 157
Make sure your firewall is configured to accommodate the Internet Agent.
See Section 14.1.5, “Preparing Your Firewall for the Clustered Internet Agent,” on page 157.
Create the new Internet Agent domain. 
See Section 14.2.1, “Creating a Domain for the Internet Agent,” on page 158.
Set up the MTA for the new Internet Agent domain.
See Section 14.2.2, “Installing the MTA for the Internet Agent Domain,” on page 158.
Install the Internet Agent.
See “Installing and Setting Up the Internet Agent Software in Your Cluster” on page 159.
Modify the Internet Agent cluster resource load script.
See “Modifying the Cluster Resource Load Script for the Internet Agent and Its MTA” on 
page 162.
Modify the Internet Agent cluster resource unload script.
See “Modifying the Cluster Resource Unload Script for the Internet Agent and Its MTA” on 
page 163.
Set up the Internet Agent failover list and policies. 
See “Setting the Failover List and Policies for the Internet Agent and Its MTA” on page 163.
Enable Internet Addressing for the clustered Internet Agent.
See “Enabling Internet Addressing for Your Clustered GroupWise System” on page 164.
Double-check the cluster-specific GWIA object properties.
See “Verifying GWIA Object Properties” on page 164.
Test the clustered Internet Agent. 

4) MTA Network Information:

• MTA IP address

• MTA message transfer port

• MTA live remote port

• MTA HTTP port

Record the MTA network address information that you will need as 
you install the MTA.

For more information, see Section 14.1.6, “Planning the MTA 
Installation,” on page 158.

5) Internet Agent 
Network Information:

• Internet Agent IP address

• Internet Agent HTTP port

Record the Internet Agent network address information that you will 
need to install the Internet Agent.

For more information, see Section 14.1.7, “Planning the Internet 
Agent Installation,” on page 158.

Item Explanation
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See Section 14.3, “Testing the Internet Agent in a Linux Cluster,” on page 165.
Record cluster-specific information in the properties pages of the GroupWise objects 
associated with the Internet Agent.
See Section 14.4.1, “Updating GroupWise Objects with Cluster-Specific Descriptions,” on 
page 167.
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15Using WebAccess in a Linux 
Cluster

At present, GroupWise® WebAccess cannot be implemented in a Linux cluster. However, 
WebAccess is inherently fault tolerant, as described in “Configuring Redirection and Failover 
Support” in “WebAccess” in the GroupWise 7 Administration Guide. This inherent stability can be 
increased for the users in your clustered GroupWise system by running multiple WebAccess agents 
for a domain that is located outside the cluster.
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16Implementing GroupWise Monitor 
in a Linux Cluster

You should already have set up at least a basic GroupWise® system, as described in Chapter 12, 
“Planning GroupWise in a Linux Cluster,” on page 125 and Chapter 13, “Setting Up a Domain and a 
Post Office in a Linux Cluster,” on page 135. As part of this process, Section 12.7.1, “System 
Clustering Worksheet,” on page 131 was filled out. If you do not have access to the filled-out 
worksheet, print the worksheet now and fill in the clustering and network address information as it 
currently exists on your system. You need this information as you implement Monitor in a cluster.

• Section 16.1, “Understanding the Monitor Components,” on page 173
• Section 16.2, “Planning GroupWise Monitor in a Linux Cluster,” on page 174
• Section 16.3, “Setting Up GroupWise Monitor in a Linux Cluster,” on page 176
• Section 16.4, “Testing the Monitor Agent in a Linux Cluster,” on page 181
• Section 16.5, “Managing the Monitor Agent in a Linux Cluster,” on page 182
• Section 16.6, “Monitor Agent Clustering Worksheet,” on page 182
• Section 16.7, “Monitor Agent Quick Checklist,” on page 182

16.1  Understanding the Monitor Components
If you are not familiar with GroupWise Monitor, review “GroupWise Monitor Overview” in 
“Installing GroupWise Monitor” in the GroupWise 7 Installation Guide.

As you plan Monitor in a clustering environment, you must keep in mind that you will plan and set 
up two Monitor components: 

• Monitor Agent (gwmon) that will be associated with a domain in your GroupWise system
• Monitor Application (a Java servlet) that will be added to your Web server (Apache)

You install the Monitor Agent on each node in the cluster. You install the Monitor Application to 
your Web server, which will not be part of your cluster. This means that the Monitor Agent Web 
console at the following URL is always available, because it is part of the cluster:

http://secondary_IP_address:8200

However, the Monitor Web console at the following URLs are not available if the Web server is 
down:

Table 16-1   Monitor Web Console URLs

NetWare or 
Windows 
Web Server:

http://Web_server_address/gw/gwmonitor

Linux 
Web Server:

http://Web_server_address/gwmon/gwmonitor
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16.2  Planning GroupWise Monitor in a Linux 
Cluster
A major system configuration difference between the Monitor Agent and other GroupWise agents is 
that the Monitor Agent needs access to a domain during installation but does not need permanent 
access to a domain thereafter.

Section 16.6, “Monitor Agent Clustering Worksheet,” on page 182 lists information you need as you 
set up Monitor in a clustering environment. You should print the worksheet and fill it out as you 
complete the planning tasks listed below

• Section 16.2.1, “Selecting a Domain for Access during Monitor Agent Installation,” on 
page 174

• Section 16.2.2, “Selecting an MTA for the Monitor Agent to Access after Installation,” on 
page 174

• Section 16.2.3, “Selecting the Monitor Agent Partition and Secondary IP Address,” on 
page 175

• Section 16.2.4, “Determining an Appropriate Failover List for the Monitor Agent,” on 
page 175

• Section 16.2.5, “Planning the Monitor Agent Installation,” on page 175

16.2.1  Selecting a Domain for Access during Monitor Agent 
Installation
During installation, the Monitor Agent Installation program needs access to a domain database 
(wpdomain.db) in order to obtain information about agents to monitor. You might want to use the 
domain you created for use with the Internet Agent, as described in Section 14.2.1, “Creating a 
Domain for the Internet Agent,” on page 158, although you can use any domain in your GroupWise 
system. 

16.2.2  Selecting an MTA for the Monitor Agent to Access after 
Installation
After installation, you can configure the Monitor Agent to be independent of a domain database. To 
do this, you configure the Monitor Agent to communicate with an MTA by way of TCP/IP. 

MONITOR CLUSTERING WORKSHEET

Under Item 2: Domain Name, specify the domain and domain directory that the Monitor Agent 
Installation program can use to obtain information about your GroupWIse system.

MONITOR CLUSTERING WORKSHEET

Under Item 3: MTA IP Address, specify the MTA IP address and message transfer port that the 
Monitor Agent can use after installation to communicate with an MTA to obtain agent information.
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16.2.3  Selecting the Monitor Agent Partition and Secondary IP 
Address
As with the MTA and the POA, the Monitor Agent needs a secondary IP address that remains the 
same no matter which node in the cluster it is running on. You can associate the Monitor Agent with 
the domain that was accessed during installation or with any other domain, so that they fail over 
together, or you can associate the Monitor Agent with its own shared partition, so that it fails over 
independently of any domain.

16.2.4  Determining an Appropriate Failover List for the Monitor 
Agent
By default, a GroupWise partition is configured to have all nodes in the cluster in its failover list, 
organized in ascending alphanumeric order. Only one node at a time can have a particular 
GroupWise partition mounted and active. If a GroupWise partition’s preferred node fails, the 
partition fails over to the next node in the failover list. You should customize the failover list for 
each GroupWise partition based on the fan-out-failover principle.

As with the other agents, you need to decide which nodes in the cluster would be appropriate 
locations for the Monitor Agent to fail over to. You must install the Monitor Agent software on all of 
the nodes where you want the Monitor Agent to be able to fail over. For a review of failover lists, see 
Section 12.6.2, “Determining Appropriate Failover Lists for the Agents,” on page 130, which 
describes the issues in the context of planning MTA and POA installations. 

16.2.5  Planning the Monitor Agent Installation
Aside from the cluster-specific issues discussed in the preceding sections, the considerations 
involved in planning to install the Monitor Agent are the same in a clustering environment as for any 
other environment. Review the installation instructions in “Installing the Linux Monitor Agent” in 
“Installing GroupWise Monitor” in the GroupWise 7 Installation Guide. Use the “GroupWise 
Monitor Installation Worksheet” to record the types of planning information you need as you install 
the Monitor Agent in your cluster.

IMPORTANT: Do not install the Monitor Agent software until you are instructed to do so in 
Section 16.3, “Setting Up GroupWise Monitor in a Linux Cluster,” on page 176.

MONITOR CLUSTERING WORKSHEET

Under Item 1: GroupWise Partition for Monitor Agent, specify the secondary IP address for the 
Monitor Agent.

MONITOR CLUSTERING WORKSHEET

Under Item 4: Monitor Agent Failover List, list the nodes that you want in the Monitor Agent failover list.
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16.3  Setting Up GroupWise Monitor in a Linux 
Cluster
GroupWise Monitor depends on a Web server, Apache in particular on Linux. However, Apache is 
not typically installed in a Linux cluster. Therefore, these instructions do not include that task.

• Section 16.3.1, “Installing and Configuring the Monitor Agent on Each Node in Your Cluster,” 
on page 176

• Section 16.3.2, “Configuring the Monitor Agent Cluster Resource to Load and Unload the 
Monitor Agent,” on page 178

16.3.1  Installing and Configuring the Monitor Agent on Each 
Node in Your Cluster
The Monitor Agent must be installed on each node in the Monitor Agent failover list (Monitor 
Agent Clustering Worksheet item 4). The Monitor Application is installed to your Web server and is 
therefore not installed on nodes in the cluster.

• “Running the Monitor Installation Program on Each Node” on page 176
• “Establishing the Secondary IP Address for the Monitor Agent on Each Node” on page 176
• “Configuring the Monitor Agent to Be Independent from a Domain Database on Each Node 

(Optional)” on page 177
• “Enabling the GroupWise High Availability Service on Each Node” on page 177
• “Testing the Monitor Agent Installation on Each Node” on page 178

Running the Monitor Installation Program on Each Node
1 Mount the GroupWise partition (Monitor Agent Clustering Worksheet item 2) where the 

Monitor Agent Installation program can access a domain database.
2 From the GroupWise 7 Administrator (Linux) CD, start the Installation program and install the 

Monitor Agent software, following the steps provided in “Installing the Linux Monitor Agent” 
in “Installing GroupWise Monitor” in the GroupWise 7 Installation Guide.

3 Configure the Monitor Agent, following the steps provided in “Configuring the Linux Monitor 
Agent” in “Installing GroupWise Monitor” in the GroupWise 7 Installation Guide.

4 At the end of the configuration process, deselect Launch Monitor Agent on System Startup.
5 Continue with “Establishing the Secondary IP Address for the Monitor Agent on Each Node” 

on page 176

Establishing the Secondary IP Address for the Monitor Agent on Each Node

Unlike the other GroupWise agents, the Monitor Agent does not bind to a specific IP address. 
Therefore, no action is required to ensure that it listens on the secondary IP address of the 
GroupWise partition with which it is associated with. This happens automatically.

Continue with “Configuring the Monitor Agent to Be Independent from a Domain Database on Each 
Node (Optional)” on page 177.
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Configuring the Monitor Agent to Be Independent from a Domain Database on Each 
Node (Optional)

The Installation program creates the Monitor Agent configuration file (monitor.xml) in the /
opt/novell/groupwise/agents/share directory. If you want the Monitor Agent to fail 
over independently from the domain that it initially accessed to gather information about agents to 
monitor, delete the following line:

HOME_PATH path=“/domain”

and replace it with the following line:

HOME_MTA address=“IP_address” port=“port_number”

where IP_address and port_number are the MTA IP address and port number you planned under 
Monitor Agent Clustering Worksheet item 3

NOTE: After the first installation, as an alternative to running the Configure option of the Monitor 
Agent Installation program on each node, you can run the Monitor Agent Install option on each 
node, then copy the monitor.xml file to each node. The result is the same and you do not need to 
have the GroupWise partition mounted.

Continue with “Enabling the GroupWise High Availability Service on Each Node” on page 177.

Enabling the GroupWise High Availability Service on Each Node

Enable the GroupWise High Availability service for your clustered GroupWise system, as described 
in “Enabling the High Availability Service for the Linux Agents” in “Installing GroupWise Agents” 
in the GroupWise 7 Installation Guide. 

Continue with “Changing Monitor Agent Paths to Locations on the Monitor Agent Partition” on 
page 177

Changing Monitor Agent Paths to Locations on the Monitor Agent Partition

By default, Monitor Agent log files are stored in /var/log/novell/groupwise/gwmon, 
which is located on each node where the Monitor Agent has been installed. Gateway accounting 
files from which reports can be generated are stored in the acct subdirectory of this location. For 
convenience, you can consolidate these files to a location of your choice on the Monitor Agent 
partition.

1 Create a directory on the Monitor Agent partition where you want the Monitor Agent to store 
log files.
The acct subdirectory is created automatically when it is needed.
When you configured the Monitor Agent to communicate with the High Availability service, 
you edited the grpwise-ma script to set startup switches. You can use that same procedure to set 
a startup switch to specify a new location for Monitor Agent log files.

2 In the grpwise-ma script, use the --log switch to specify the full path to the directory you 
created in Step 1.

If you plan to secure the Monitor Web console using SSL, you need to provide an SSL certificate 
file. You can place the file on the Monitor Agent partition, rather than each node.

1 Create a directory on the Monitor Agent partition where you want to store the certificate file.
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2 In the grpwise-ma script, use the --httpcertfile switch to specify the full path to the directory 
you created in Step 1.

Continue with “Testing the Monitor Agent Installation on Each Node” on page 178.

Testing the Monitor Agent Installation on Each Node
1 Test the Monitor by starting it as a daemon, as described in “Starting the Linux Monitor Agent 

for the First Time” in “Installing GroupWise Monitor” in the GroupWise 7 Installation Guide.
/etc/initd/grpwise-ma start
/etc/initd/grpwise-ma status

2 Then stop the Monitor Agent.
/etc/initd/grpwise-ma stop
/etc/initd/grpwise-ma status

3 Return to “Running the Monitor Installation Program on Each Node” on page 176 for each 
node in the Monitor Agent failover list (Monitor Agent Clustering Worksheet item 4)

When you have installed the Monitor Agent on all of the nodes in the Monitor Agent fail over list, 
continue with Section 16.3.2, “Configuring the Monitor Agent Cluster Resource to Load and Unload 
the Monitor Agent,” on page 178.

16.3.2  Configuring the Monitor Agent Cluster Resource to 
Load and Unload the Monitor Agent
The properties of the Monitor Agent Cluster Resource object define how the Monitor Agent 
functions within the cluster, how the Monitor Agent is loaded and unloaded, and how failover and 
failback situations are handled. Complete the following tasks for the Monitor Agent cluster 
resource:

• “Modifying the Cluster Resource Load Script for the Monitor Agent” on page 178
• “Modifying the Cluster Resource Unload Script for the Monitor Agent” on page 179
• “Setting the Failover List and Policies for the Monitor Agent” on page 180

Modifying the Cluster Resource Load Script for the Monitor Agent

The cluster resource load script executes whenever the Monitor Agent cluster resource comes 
online.

To set up the load script in iManager:
1 Expand Clusters, then click Cluster Options.
2 In the Cluster field, browse to the Cluster object where the Monitor Agent cluster resource is 

located.
3 Click the Cluster object to display the cluster resources that belong to the cluster.
4 Select the Monitor Agent cluster resource that you created when you set up the Monitor Agent 

partition, then click Properties.
The default load script from a generic IP service template appears as follows:
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5 Make the following changes to set up the Monitor Agent load script:
5a In the mount command, change reiserfs to whatever file system type is in use on nodes in 

the cluster.
5b In the mount command, change vol to the actual device name of the device in use on 

nodes in the cluster.
5c In the mount command, change /mnt/generic to the mount point directory in use on 

nodes in the cluster.
5d In the add_secondary_ipaddress command, change a.b.c.d to the secondary 

IP address of the Monitor Agent cluster resource (Monitor Agent Clustering Worksheet 
item 1)

5e In the start service command, change myservice start to the command to start the Monitor 
Agent.
/etc/init.d/grpwise-ma start

6 Click OK to save the load script.

Modifying the Cluster Resource Unload Script for the Monitor Agent

The cluster resource unload script executes whenever the Monitor Agent cluster resource goes 
offline. 

1 On the Cluster Resource Properties page of the Monitor Agent cluster resource, click Scripts > 
Unload Script. 
The default unload script appears as follows:
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2 Make the following changes:
2a In the stop service command, change myservice stop to the command to stop the 

Monitor Agent.
/etc/init.d/grpwise-ma stop 

2b Adjust the sleep command as needed so that the Monitor Agent can shut down normally 
on your system without being inadvertently killed by the kill command.

2c In the kill service command, used if the Monitor Agent does not stop normally, change -k 
to -mk.
The -m parameter obtains the PID number of the process to kill.

2d In the kill service command, change /mnt/generic to the mount point directory used 
in the load script.

2e In the del_secondary_ipaddress command, change a.b.c.d to the secondary 
IP address used in the load script.

2f In the umount command, change /mnt/generic to the mount point directory used in 
the load script.

2g Click OK to save the unload script.

Setting the Failover List and Policies for the Monitor Agent
1 On the Cluster Resource Properties page of the Monitor Agent cluster resource, click General. 

The default policy settings are often appropriate. By default, a cluster resource:

• Fails over automatically if the node it is running on fails
• Starts automatically on the next node in its failover list
• Continues running at its failover location, even after its most preferred node is again 

available
If you are considering changing these defaults, see “Setting Start, Failover, and Failback 
Modes” in “Installation and Setup” in the OES Novell Cluster Services 1.8.1 
Administration Guide for Linux.

2 Under Preferred Nodes, arrange the nodes in the cluster into the desired failover list for the 
Internet Agent (under Monitor Agent Clustering Worksheet item 3).
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3 Click OK.

16.4  Testing the Monitor Agent in a Linux Cluster
After you have configured the Monitor Agent cluster resource, you can test the load and unload 
scripts by bringing the Monitor Agent cluster resource online and taking it offline again.

1 In iManager, expand Clusters, then click Cluster Manager.

The new Monitor Agent cluster resource shows Offline in the State column.
2 Click the new Monitor Agent cluster resource, then click Online.

3 Select the cluster node where you want to online the Monitor Agent cluster resource, then click 
OK.
After a moment, the Monitor Agent cluster resource displays Running in the State column.

4 At the server where the Monitor Agent is starting, use the following command to see that the 
Monitor Agent has started:
/etc/init.d/grpwise-ma status
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5 Select the new Monitor Agent cluster resource, then click Offline.
The State column for the Monitor Agent cluster resource returns to Offline.

6 Use the same command that you used in Step 4 to verify that the Monitor Agent has stopped.
7 Repeat Step 2 whenever you are ready to bring the new Monitor Agent cluster resource online 

permanently.
8 Continue with Managing the Monitor Agent in a Linux Cluster.

16.5  Managing the Monitor Agent in a Linux 
Cluster
When the Monitor Agent fails over, it must repoll all the monitored agents to ascertain their current 
status. This may take a few moments, depending on the number of agents being monitored. 
However, no action is necessary on your part as the Monitor Agent starts on the next node in the 
cluster.

16.6  Monitor Agent Clustering Worksheet

16.7  Monitor Agent Quick Checklist
Plan the new clustered Monitor Agent, including a domain to access during installation to 
gather information about agents to monitor

See Section 16.2, “Planning GroupWise Monitor in a Linux Cluster,” on page 174.
Install Apache on all nodes in the Monitor Agent’s failover list.

Item Explanation

1) GroupWise Partition for 
Monitor Agent:

Secondary IP Address:

Specify the name of the Cluster Resource object for the Monitor 
Agent, along with its secondary IP address.

For more information, see Section 16.2.3, “Selecting the Monitor 
Agent Partition and Secondary IP Address,” on page 175.

2) GroupWise Partition for 
Domain

Domain Name:

Domain Directory:

Specify a GroupWise partition where there is a domain database from 
which the Monitor Agent can gather information about agents to 
monitor. Also provide the domain name and directory.

For more information, see Section 16.2.1, “Selecting a Domain for 
Access during Monitor Agent Installation,” on page 174.

3) MTA IP Address:

MTA MTP Port Number:

If you want the Monitor Agent to be able to fail over independently, 
specify the IP address and message transfer port number of an MTA 
with which the Monitor Agent can communicate, as an alternative to 
accessing a domain database.

For more information, see Section 16.2.2, “Selecting an MTA for the 
Monitor Agent to Access after Installation,” on page 174

4) Monitor Agent Failover List: List the nodes in the cluster where the Monitor Agent could fail over.

For more information, see Section 16.2.4, “Determining an 
Appropriate Failover List for the Monitor Agent,” on page 175.
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See Section 16.3.1, “Installing and Configuring the Monitor Agent on Each Node in Your 
Cluster,” on page 176.
Install the Monitor Agent on all nodes in the Monitor Agent’s failover list.
See Section 16.3.1, “Installing and Configuring the Monitor Agent on Each Node in Your 
Cluster,” on page 176.
Modify the Monitor Agent cluster resource load script.
See “Modifying the Cluster Resource Load Script for the Monitor Agent” on page 178.
Modify the Monitor Agent cluster resource unload script.
See “Modifying the Cluster Resource Unload Script for the Monitor Agent” on page 179.
Set up the Monitor Agent failover list and policies. 
See “Setting the Failover List and Policies for the Monitor Agent” on page 180.
Test the clustered Monitored Agent.
See Section 16.4, “Testing the Monitor Agent in a Linux Cluster,” on page 181.
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17Backing Up a GroupWise System 
in a Linux Cluster

To back up GroupWise® data in a Linux cluster, use the GroupWise Database Copy (DBCopy) 
utility to copy the data from the live GroupWise system to a static location for backup. For more 
information, see “Backing Up GroupWise Databases” and “GroupWise Database Copy Utility” in 
“Databases” in the GroupWise 7 Administration Guide.
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18Moving an Existing Linux 
GroupWise 7 System into a Linux 
Cluster

If you are adding the high availability benefits of Novell® Cluster ServicesTM to a GroupWise® 7 
system that is already up and running, the first step is to install Novell Cluster Services following the 
instructions in OES Novell Cluster Services 1.8.1 Administration Guide for Linux. You should also 
review Chapter 11, “Introduction to GroupWise 7 and Novell Cluster Services on Linux,” on 
page 123 to help you apply clustering principles and practices to your GroupWise system.

You do not need to transfer your entire GroupWise system into the cluster all at once. You could 
transfer individual post offices where the needs for high availability are greatest. You could transfer 
a domain and all of its post offices at the same time. You might decide that you don’t need to have all 
of your GroupWise system running in the cluster. 

This section provides a checklist to help you get started with moving your GroupWise system into a 
clustering environment:

Decide which shared partitions in your cluster you want to use for GroupWise domains and 
post offices.
Decide which nodes in your storage area network you want have on failover lists for the 
GroupWise agents.
Review Chapter 12, “Planning GroupWise in a Linux Cluster,” on page 125. Fill out the 
Section 12.7.1, “System Clustering Worksheet,” on page 131 to help you decide which 
domains and post offices you want move to which shared partitions.
Move a domain and/or post office onto the GroupWise partition, following the instructions in 
“Moving a Domain” in “Domains” or “Moving a Post Office” in “Post Offices” in the 
GroupWise 7 Administration Guide.

Review Section 12.6, “Deciding How to Install and Configure the Linux Agents in a Cluster,” 
on page 129, fill out the Section 12.7.2, “Agent Clustering Worksheet,” on page 132, and 
install the agents as needed for the first clustered domain and/or post office, following the 
instructions in Section 13.4, “Installing and Configuring the MTA and the POA in a Cluster,” 
on page 138. This includes setting up the load and unload scripts for the GroupWise partition.
Test the first component of your clustered GroupWise system, following the instructions in 
Section 13.5, “Testing Your Clustered GroupWise System,” on page 148.
Take care of the cluster management details described in Section 13.6, “Managing Your 
Clustered GroupWise System,” on page 150.
Move more domains and post offices into the cluster as needed. If you have GroupWise 
libraries, see Section 12.5, “Planning a New Library for a Clustered Post Office,” on page 129.
Add other components to your clustered GroupWise system as needed, following the 
instructions in:

• Chapter 14, “Implementing the Internet Agent in a Linux Cluster,” on page 155
• Chapter 15, “Using WebAccess in a Linux Cluster,” on page 171.
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• Chapter 16, “Implementing GroupWise Monitor in a Linux Cluster,” on page 173
• Chapter 17, “Backing Up a GroupWise System in a Linux Cluster,” on page 185
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19Moving a Clustered GroupWise 7 
System from NetWare to Linux

For general information about moving from a NetWare® cluster to a Linux cluster, see “Converting 
a NetWare Cluster to Linux” in “Installation and Setup” in the OES Novell Cluster Services 1.8.1 
Administration Guide for Linux. It is possible to have a cluster that includes both NetWare and 
Linux servers. Therefore, you can move your GroupWise® 7 system from NetWare servers to Linux 
servers one component at a time. However, all of the servers on the failover list of each GroupWise 
component must be of the same platform. For example, a domain and MTA on a NetWare server 
cannot fail over to a Linux server; they must fail over to another NetWare server.

You should administer a GroupWise system on Linux using the Linux version of ConsoleOne®, 
which is available from Novell Product Downloads site (http://download.novell.com).

The GroupWise 7 Installation Guide provides the following sections to help you move components 
of your GroupWise system to Linux:

• “Moving a Post Office to Linux”
• “Moving a Domain to Linux”

GroupWise 6.5 cannot run in a cluster on Linux. Therefore, if you have a clustered GroupWise 6.5 
system, you must update it to GroupWise 7 before you can move it into a Linux cluster.
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20Implementing Messenger in a 
Linux Cluster

Novell Messenger does not require the existence of a GroupWise® system in the cluster, but 
presumably one has already been set up as described in Chapter 12, “Planning GroupWise in a 
Linux Cluster,” on page 125 and Chapter 13, “Setting Up a Domain and a Post Office in a Linux 
Cluster,” on page 135. As part of the process of setting up GroupWise in the cluster, you filled out 
Section 12.7.1, “System Clustering Worksheet,” on page 131. Some of the information from that 
worksheet is helpful as you implement Messenger in your cluster.

• Section 20.1, “Planning Your Messenger System in a Linux Cluster,” on page 191
• Section 20.2, “Setting Up Your Messenger System in a Linux Cluster,” on page 192
• Section 20.3, “Testing Your Clustered Messenger System,” on page 198
• Section 20.4, “Managing Your Clustered Messenger System,” on page 199
• Section 20.5, “Messenger Clustering Worksheet,” on page 199
• Section 20.6, “Messenger Clustering Quick Checklist,” on page 200

20.1  Planning Your Messenger System in a Linux 
Cluster
Because the Messenger agents are not associated with GroupWise domains or post offices, the 
Messenger agents are easier to implement in a cluster than are the GroupWise agents. Section 20.5, 
“Messenger Clustering Worksheet,” on page 199 lists the information you need as you set up the 
Messenger agents in a clustering environment. You should print the worksheet and fill it out as you 
complete the tasks listed below:

• Section 20.1.1, “Understanding Your Cluster,” on page 191
• Section 20.1.2, “Selecting the Messenger Partition and Secondary IP Address,” on page 192
• Section 20.1.3, “Determining an Appropriate Failover List for the Messenger Agents,” on 

page 192
• Section 20.1.4, “Planning the Messenger Agent Installation,” on page 192

20.1.1  Understanding Your Cluster
As described in Section 12.1, “Installing Novell Cluster Services on Linux,” on page 126, you set up 
your cluster with a certain number of shared partitions and cluster resources. 

MESSENGER CLUSTERING WORKSHEET

Under Items 1-5, record information about your cluster. This information corresponds to items 1-5 on 
the Section 12.7.1, “System Clustering Worksheet,” on page 131.
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20.1.2  Selecting the Messenger Partition and Secondary IP 
Address
If you are not planning to enable archiving, or if you are not anticipating a large Messenger archive, 
you can use one Messenger partition for both the Messaging Agent and the Archive Agent. If you 
anticipate archiving a large number of messages so that the Messenger archive grows very large, you 
might want to have a separate Messenger partition for the Archive Agent and its archive database. 
The steps in this section focus on setting up the Messenger agents on a single Messenger partition.

20.1.3  Determining an Appropriate Failover List for the 
Messenger Agents
By default, a Messenger partition is configured to have all nodes in the cluster in its failover list, 
organized in ascending alphanumeric order. Only one node at a time can have the Messenger 
partition mounted and active and the Messenger agents running. If a Messenger partition’s preferred 
node fails, the partition fails over to the next node in the failover list. The Messenger agents might 
need to run on any node that the Messenger partition fails over to.

20.1.4  Planning the Messenger Agent Installation
Aside from the cluster-specific issues discussed in the preceding sections, the considerations 
involved in planning to install the Messenger agents are the same in a clustering environment as for 
any other environment. Review “Planning Your Novell Messenger System”, then print and fill out 
the “Novell Messenger Worksheet” in “Installing a Novell Messenger System” in the Messenger 2.0 
Installation Guide. Messenger must be installed on each node in the failover list (Messenger 
Clustering Worksheet item 8)

Continue with Setting Up Your Messenger System in a Linux Cluster.

20.2  Setting Up Your Messenger System in a 
Linux Cluster
You should have already reviewed Section 20.1, “Planning Your Messenger System in a Linux 
Cluster,” on page 191 and filled out the Section 20.5, “Messenger Clustering Worksheet,” on 
page 199 and the “Novell Messenger Worksheet” in the Messenger 2.0 Installation Guide. 

MESSENGER CLUSTERING WORKSHEET

Under Item 6: Shared Partition for Messenger, record the name and secondary IP address of the 
Messenger partition in your cluster.

If you want a separate Messenger partition for archiving, under Item 7: Shared Partition for Archiving, 
record the name and secondary IP address of the archiving partition in your cluster. 

MESSENGER CLUSTERING WORKSHEET

Under Item 8: Failover List for Messenger Agents, list the nodes that you want to have in the 
Messenger agents’ failover list. 
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• Section 20.2.1, “Creating Your Messenger System and Installing the Messenger Agents,” on 
page 193

• “Setting Up Non-root Access on NSS Volumes on Each Node” on page 193
• Section 20.2.2, “Changing Messenger Paths to Locations on the Messenger Partition,” on 

page 194
• Section 20.2.3, “Configuring the Messenger Cluster Resource to Load and Unload the 

Messenger Agents,” on page 196

20.2.1  Creating Your Messenger System and Installing the 
Messenger Agents
The Messenger Installation program walks you through setting up your Messenger system and 
installing the Messenger agents. The first time you run the Messenger Installation program, you 
create your Messenger system, which includes creating various Messenger objects in eDirectoryTM 
and installing the Messenger software on the node where you run the Messenger Installation 
program. After that, you run the Messenger Installation program on each node in the Messenger 
failover list to install the Messenger software on each node, but you do not create any more objects 
in eDirectory.

Running the Messenger Installation Program on Each Node
1 Mount the Messenger partition (Messenger Clustering Worksheet item 6).
2 From the Messenger 2 Administrator (Linux) CD, run the Messenger Installation program, 

following the steps provided in “Starting the Messenger Installation Program on Linux” and 
“Configuring Your Messenger System on Linux” in “Installing a Novell Messenger System” in 
the Messenger 2.0 Installation Guide.

3 Continue with “Setting Up Non-root Access on NSS Volumes on Each Node” on page 193.

Setting Up Non-root Access on NSS Volumes on Each Node

If your cluster uses NSS volumes, as described in “Creating NSS Volumes” in “Installation and 
Setup” in the OES Novell Cluster Services 1.8.1 Administration Guide for Linux, you must set up 
non-root access to those NSS volumes, as described in “Setting Up Non-root Access on an NSS 
Volume on Novell Open Enterprise Server Linux” in “Installing a Novell Messenger System” in the 
Messenger 2.0 Installation Guide. Then continue with “Testing Your Messenger Agent Installation 
on Each Node” on page 193.

Testing Your Messenger Agent Installation on Each Node
1 Test the Messenger agents by starting them as daemons, as described in “Starting the Linux 

Messenger Agents” in “Installing a Novell Messenger System” in the Messenger 2.0 
Installation Guide.
/etc/initd/novell-nmma start
/etc/initd/novell-nmaa start
/etc/initd/novell-nmma status
/etc/initd/novell-nmaa status

2 Stop the Messenger agents.
/etc/initd/novell-nmma stop
/etc/initd/novell-nmaa stop
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/etc/initd/novell-nmma status
/etc/initd/novell-nmaa status

3 Return to “Running the Messenger Installation Program on Each Node” on page 193 for each 
node in the Messenger failover list (Messenger Clustering Worksheet item 8).

When you have installed the Messenger agents on all of the nodes in the Messenger failover list, 
continue with Section 20.2.2, “Changing Messenger Paths to Locations on the Messenger Partition,” 
on page 194.

20.2.2  Changing Messenger Paths to Locations on the 
Messenger Partition
During installation, various Messenger paths are set to locations on the node where the software is 
installed. After installation, you need to set these paths to locations on the Messenger partition, so 
that the files stored at these locations are available to the Messenger agents regardless of which node 
in the cluster the agents are running on: 

• “Setting the Store Path” on page 194
• “Setting the Messaging Agent Queue Path” on page 194
• “Setting the Messaging Agent Log Path” on page 195
• “Setting the Archive Agent Log Path” on page 195

After settings these directories, continue with Section 20.2.3, “Configuring the Messenger Cluster 
Resource to Load and Unload the Messenger Agents,” on page 196.

Setting the Store Path

The store path is the location where you want the archive created. During installation, the default 
store path is created in /var/opt/novell/messenger/aa/store on each node, but you 
need the archive to be stored on the Messenger partition.

1 Choose a directory where you want to store the archive and create that directory on the 
Messenger partition.

2 In ConsoleOne®, browse to and select the Novell Messenger Service object 
(MessengerService), then click Messenger Server > Archive Agent.

3 Right-click the File Module object, then click Properties.
4 In the Store Path field, specify your archive store path, then click OK.

Setting the Messaging Agent Queue Path

When archiving is enabled, the Messaging Agent passes conversations to the Archive Agent when 
the conversations are completed. If the Messaging Agent cannot communicate with the Archive 
Agent when it has a conversation to archive, it saves the conversation in its holding directory 
(queue) until it can communicate with the Archive Agent again. During installation, the default 
Messaging Agent queue path is created in /var/opt/novell/messenger/ma/queue, but 
you need the queue directory to be located on the Messenger partition.

1 Choose a directory for the Messaging Agent queue and create that directory on the Messenger 
partition.

2 In ConsoleOne, browse to and select the Novell Messenger Service object (MessengerService), 
then click Messenger Server.
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3 Right-click the Messaging Agent object, then click Properties.
4 Click Agent > Messaging.
5 In the Messaging Queue Path field, specify the Messaging Agent queue path, then click OK.

Setting the Archive Agent Queue Path

When the Archive Agent receives a conversation to archive, if it is already busy processing other 
conversations, it temporarily stores the conversation in its holding directory (queue). During 
installation, the default Archive Agent queue path is created in /var/opt/novell/
messenger/aa/queue, but you need the queue directory to be located on the Messenger 
partition.

1 Choose a directory for the Archive Agent queue and create that directory on the Messenger 
partition.

2 In ConsoleOne, browse to and select the Novell Messenger Service object (MessengerService), 
then click Messenger Server.

3 Right-click the Archive Agent object, then click Properties.
4 Click Agent > Messaging.
5 In the Messaging Queue Path field, specify the Archive Agent queue path, then click OK.

Setting the Messaging Agent Log Path

During installation, the default Messaging Agent log path is created in /var/opt/novell/
log/messenger/ma, but you need the log file directory to be located on the Messenger partition.

1 Choose a directory for the Messaging Agent log files and create that directory on the 
Messenger partition.

2 In ConsoleOne, browse to and select the Novell Messenger Service object (MessengerService), 
then click Messenger Server.

3 Right-click the Messaging Agent object, then click Properties.
4 Click Agent > Log Settings.
5 In the Log Files Path field, specify the Messaging Agent log path, then click OK.

Setting the Archive Agent Log Path

During installation, the default Archive Agent log path is created in /var/opt/novell/log/
messenger/aa, but you need the log file directory to be located on the Messenger partition.

1 Choose a directory for the Archive Agent queue and create that directory on the Messenger 
partition.

2 In ConsoleOne, browse to and select the Novell Messenger Service object (MessengerService), 
then click Messenger Server.

3 Right-click the Archive Agent object, then click Properties.
4 Click Agent > Log Settings.
5 In the Log Files Path field, specify the Archive Agent log path, then click OK.
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20.2.3  Configuring the Messenger Cluster Resource to Load 
and Unload the Messenger Agents
The properties of the Messenger Cluster Resource object define how the Messenger partition 
functions within the cluster, how the Messenger agents are loaded and unloaded, and how failover 
and failback situations are handled. 

• “Modifying the Cluster Load Script for the Messenger Agents” on page 196
• “Modifying the Cluster Resource Unload Script for the Messenger Agents” on page 197
• “Setting the Failover List and Policies for the Messenger Agents” on page 197

Modifying the Cluster Load Script for the Messenger Agents

To set up the load script in iManager:
1 Expand Clusters, then click Cluster Options.
2 In the Cluster field, browse to the Cluster object where the Messenger cluster resource is 

located.
3 Click the Cluster object to display the cluster resources that belong to the cluster.
4 Select the Messenger cluster resource that you created when you set up the Messenger 

partition, then click Properties.
The default load script from a generic IP service template appears as follows:

5 Make the following changes to set up the Messenger load script:
5a In the mount command, change reiserfs to whatever file system type is in use on nodes in 

the cluster.
5b In the mount command, change vol to the actual device name in use on nodes in the 

cluster.
5c In the mount command, change /mnt/generic to the mount point directory in use on 

nodes in the cluster.
5d In the add_secondary_ipaddress command, change a.b.c.d to the secondary IP 

address of the Messenger partition.
5e In the start service command, change myservice start to the command to start the 

Messenger agents.
/etc/init.d/novell-nmma start
/etc/init.d/novell-nmaa start
7 Interoperability Guide



novdocx (E
N

U
)  6 D

ecem
ber 2005
6 Click Apply to save the load script.

Modifying the Cluster Resource Unload Script for the Messenger Agents

The cluster resource unload script executes whenever the Messenger cluster resource goes offline.
1 On the Cluster Resource Properties page of the Monitor Agent cluster resource, click Scripts > 

Unload Script. 
The default unload script appears as follows:

2 Make the following changes to the Messenger unload script:
2a In the stop service command, change myservice stop to the command to stop the 

Messenger agents.
/etc/init.d/novell-nmma stop
/etc/init.d/novell-nmaa stop

2b Adjust the sleep command as needed so that the Messenger agents can shut down 
normally on your system without being inadvertently killed by the kill command.

2c In the kill service command, used if the Messenger agents do not stop normally, change -
k to -mk.
The -m parameter obtains the PID numbers of the processes to kill.

2d In the kill service command, change /mnt/generic to the mount point directory used 
in the load script.

2e In the del_secondary_ipaddress command, change a.b.c.d to the secondary IP 
address used in the load script.

2f In the umount command, change /mnt/generic to the mount point directory used in 
the load script.

2g Click Apply to save the unload script.

Setting the Failover List and Policies for the Messenger Agents
1 On the Cluster Resource Properties page of the Messenger cluster resource, click General. 

The default policy settings are often appropriate. By default, a cluster resource:

• Fails over automatically if the node it is running on fails
Implementing Messenger in a Linux Cluster 197



198 GroupWise 

novdocx (E
N

U
)  6 D

ecem
ber 2005
• Starts automatically on the next node in its failover list
• Continues running at its failover location, even after its most preferred node is again 

available
If you are considering changing these defaults, see “Setting Start, Failover, and Failback 
Modes” in “Installation and Setup” in the OES Novell Cluster Services 1.8.1 
Administration Guide for Linux.

2 Under Preferred Nodes, arrange the nodes in the cluster into the desired failover list for the 
Messenger agents (under Messenger Clustering Worksheet item 3).

3 Click OK.

20.3  Testing Your Clustered Messenger System
After you have configured the Messenger cluster resource, you can test the load and unload scripts 
by bringing the Messenger cluster resource online and taking it offline again.

1 In iManager, expand Clusters, then click Cluster Manager.

The new Messenger cluster resource shows Offline in the State column.
2 Click the new Messenger cluster resource, then click Online.
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3 Select the cluster node where you want to online the Messenger cluster resource, then click OK.
After a moment, the Messenger cluster resource displays Running in the State column.

4 At the server where the Messenger agents are starting, use the following commands to see that 
the Messenger agents have started:
/etc/init.d/novell-nmma status
/etc/init.d/novell-nmaa status

5 Select the new Messenger cluster resource, then click Offline.
The State column for the Messenger cluster resource returns to Offline.

6 Use the same command that you used in Step 4 to verify that the Messenger agents have 
stopped.

7 Repeat Step 2 whenever you are ready to bring the new Messenger cluster resource online 
permanently.

8 Continue with Managing Your Clustered Messenger System.

20.4  Managing Your Clustered Messenger 
System
If the node where your Messenger system is running goes down, it fails over to the next node it its 
fail over list. Messenger clients reconnect automatically as soon as the Messaging Agent restarts on 
the next node. Users who are actively carrying on conversations notice the interruption, but do not 
need to do anything to reestablish their conversation when the Messaging Agent is up and running 
again.

In comparison to failover, migration typically takes longer because the Messaging Agent 
methodically terminates its thread as part of its normal shutdown procedure.

20.5  Messenger Clustering Worksheet

Item Explanation

1) eDirectory Tree for Cluster: Record the eDirectory tree where you created the Novell 
Cluster object when you installed Novell Cluster ServicesTM.

For more information, see Section 12.1, “Installing Novell 
Cluster Services on Linux,” on page 126.
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20.6  Messenger Clustering Quick Checklist
Plan your clustered Messenger system.

2) Cluster Name:

Master IP Address:

Record the name of the name of the Cluster object where your 
Messenger system will be located. Also record the master IP 
address of the cluster.

For more information, see Section 2.2, “Installing Novell 
Cluster Services,” on page 20.

3) Cluster Context: Record the full context where you created the Cluster object.

For more information, see Section 12.1, “Installing Novell 
Cluster Services on Linux,” on page 126.

4) Nodes in Cluster

• FIle system type

• Device name

• Mount point

List the nodes that are part of the cluster that will include 
Messenger. Also list technical information, including file system 
type (reiserfs, ext3, etc.), device name (sda2, hda1, etc.), and 
mount point directory (/mnt, /mail, etc.) in use on the nodes 
the cluster. You need this information as you create load and 
unload scripts for the Messenger agents.

For more information, see Section 12.1, “Installing Novell 
Cluster Services on Linux,” on page 126.

5) Shared Partitions in Cluster: List the shared partitions that are available for use in your 
Messenger system.

For more information, see Section 12.1, “Installing Novell 
Cluster Services on Linux,” on page 126.

6) Messenger Partition for Messaging 
Agent:

Secondary IP address:

Use Same Partition for Archive Agent?

• Yes

• No

The Messaging Agent software is installed on each node in its 
failover list but it does use a shared partition to store its log 
files, temporary files, and queue directories. Specify the name 
of the shared partition in the your cluster that the Messaging 
Agent can use for these purposes. also specify the secondary 
IP address of that shared partition.

For more information, see “Selecting the Messenger Volume” 
on page 113.

7) Messenger Partition for Archive 
Agent?

Secondary IP address:

In addition to the data storage needs of the Messaging Agent, 
the Archive Agent can be configured to store all instant 
message conversations. It is possible that this might consume 
a large quantity of disk space. If so, you could choose to use a 
separate shared partition for the Archive Agent.

For more information, see “Selecting the Messenger Volume” 
on page 113.

8) Failover List for Messenger Agents: List other nodes in the cluster where the Messenger agents 
can fail over. You might want to have the same nodes on the 
both agents’ lists or have separate lists for each agent. It 
depends on the loads that each agent will be carrying.

For more information, see “Determining an Appropriate 
Failover Path for the Messenger Volume” on page 113.

Item Explanation
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See Section 20.1, “Planning Your Messenger System in a Linux Cluster,” on page 191.
Create your Messenger system and install the Messenger agents.
See Section 20.2.1, “Creating Your Messenger System and Installing the Messenger Agents,” 
on page 193. 
If you use NSS volumes in your cluster, configure the Messenger agents so that they run as a 
non-root user.
See “Setting Up Non-root Access on NSS Volumes on Each Node” on page 193.
In ConsoleOne, change the locations of various Messenger files from their default locations on 
local nodes to the Messenger partition that is always available not matter what node the 
Messenger agents are running on.
See Section 20.2.2, “Changing Messenger Paths to Locations on the Messenger Partition,” on 
page 194.
Modify the Messenger agents cluster resource load script.
See “Modifying the Cluster Load Script for the Messenger Agents” on page 196.
Modify the Messenger agents cluster resource unload script.
See “Modifying the Cluster Resource Unload Script for the Messenger Agents” on page 197.
Set up the Messenger agents failover list and policies. 
See “Setting the Failover List and Policies for the Messenger Agents” on page 197.
Test your clustered Messenger system.
See Section 20.3, “Testing Your Clustered Messenger System,” on page 198.
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IIIOther Novell Products

• Chapter 21, “GroupWise DirXML Driver for Novell Identity Manager,” on page 205
• Chapter 22, “GroupWise Customization Tools,” on page 209
• Chapter 23, “Novell exteNd,” on page 211
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21GroupWise DirXML Driver for 
Novell Identity Manager

The GroupWise® DirXML® driver for use with Novell® Identity Manager provides data integration 
between users in Novell eDirectoryTM with GroupWise accounts in your GroupWise system. For 
example, the driver can create e-mail accounts automatically when employees are hired. The driver 
can also disable an e-mail account when a user is no longer active. This configurable solution gives 
you the ability to increase productivity and streamline business processes by integrating GroupWise 
and eDirectory. 

This guide gives information about certain administrative actions in ConsoleOne® that require you 
to stop the GroupWise DirXML driver or disable a user’s association:

• Chapter 21.1, “Identity Manager Warnings in ConsoleOne,” on page 205

For additional information, see:

• Novell Identity Manager (http://www.novell.com/documentation/dirxml20)
• Identity Manager Drivers (http://www.novell.com/documentation/dirxmldrivers)

21.1  Identity Manager Warnings in ConsoleOne
Some GroupWise administrative actions in ConsoleOne® require that you stop the GroupWise 
DirXML driver or disable a user’s association with it before you perform the action and usually 
restart the GroupWise DirXML driver or re-enable the user’s association when you have completed 
the action. By default, these activities generate a warning message in ConsoleOne:

• Section 21.1.1, “Recovering a Deleted GroupWise Account,” on page 205
• Section 21.1.2, “Grafting Users,” on page 206
• Section 21.1.3, “Converting an External Entity to a User,” on page 206
• Section 21.1.4, “Converting a User to an External Entity,” on page 206
• Section 21.1.5, “Associating a GroupWise Object with an eDirectory Object,” on page 206
• Section 21.1.6, “Disassociating a GroupWise Object’s Attributes from an eDirectory Object,” 

on page 206
• Section 21.1.7, “Resolving an Invalid Association,” on page 207
• Section 21.1.8, “Disabling the DirXML Warnings,” on page 207
• Section 21.1.9, “Enabling the DirXML Warnings,” on page 207

21.1.1  Recovering a Deleted GroupWise Account
1 Using the DirXML Management role in Novell iManager, stop the GroupWise DirXML driver.
2 Recover the deleted account, as described in “Recovering Deleted GroupWise Accounts” in 

“Databases” in the GroupWise 7 Administration Guide.
3 Using the DirXML Management role, restart the GroupWise DirXML driver.
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21.1.2  Grafting Users
1 If you are grafting the users into a different eDirectory tree, on the DirXML tab of each User 

object in Novell iManager, disable the association with the GroupWise DirXML driver.
2 Using the DirXML Management role in Novell iManager, stop the GroupWise DirXML driver 

for the tree into which you are grafting the users.
3 Graft the users, as described in “Graft GroupWise Objects” in “Databases” in the GroupWise 7 

Administration Guide.
4 If you grafted the users into a different eDirectory tree, on the DirXML tab of each User object, 

enable the association with the GroupWise DirXML driver in the new tree.
5 Using the DirXML Management role, restart the GroupWise DirXML driver for the tree into 

which you grafted the users.

21.1.3  Converting an External Entity to a User
1 Using the DirXML Management role in Novell iManager, stop the GroupWise DirXML driver.
2 Convert the external entity, as described in “Convert External Entity to User” in “System” in 

the GroupWise 7 Administration Guide.
3 Using the DirXML Management role, restart the GroupWise DirXML driver.

21.1.4  Converting a User to an External Entity
1 On the DirXML tab of the User object in Novell iManager, disable the association with the 

GroupWise DirXML driver.
2 Convert the user, as described in “Convert User to External Entity” in “System” in the 

GroupWise 7 Administration Guide.

21.1.5  Associating a GroupWise Object with an eDirectory 
Object

1 Using the DirXML Management role in Novell iManager, stop the GroupWise DirXML driver.
2 Establish the association, as described in “Associate Objects” in “System” in the GroupWise 7 

Administration Guide.
3 Using the DirXML Management role, restart the GroupWise DirXML driver.

21.1.6  Disassociating a GroupWise Object’s Attributes from an 
eDirectory Object

1 On the DirXML tab of the User object in Novell iManager, disable the association with the 
GroupWise DirXML driver.

2 Disassociate the objects, as described in “Disassociate GroupWise Attributes” in “System” in 
the GroupWise 7 Administration Guide.

3 On the DirXML tab of the User object, enable the association with the GroupWise DirXML 
driver.
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21.1.7  Resolving an Invalid Association
1 On the DirXML tab of the User object in Novell iManager, disable the association with the 

GroupWise DirXML driver.
2 Resolve the invalid association, as described in “Invalid Associations” in “System” in the 

GroupWise 7 Administration Guide.

21.1.8  Disabling the DirXML Warnings
1 In ConsoleOne, deselect Display DirXML Warnings in any DirXML warning dialog box.

21.1.9  Enabling the DirXML Warnings
1 In ConsoleOne, click Tools > GroupWise System Operations > System Preferences.
2 On the Admin Preferences tab, select Display DirXML Warnings.
3 Click OK.
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22GroupWise Customization Tools

The GroupWise® Software Developer Kit provides tools for customizing GroupWise to the specific 
needs of your organization. It includes the following components:

• WebAccess Customization: Lets you modify the WebAccess client HTML source files to 
include your own graphics or company information. You can also enhance the WebAccess 
client by creating additional calendar views. For more information, see GroupWise WebAccess 
Customization (http://developer.novell.com/ndk/gwwbacc.htm).

• GroupWise Object API: Lets you create your own client application. It provides access to the 
Address Book, along with documents, mail messages, appointments, tasks, notes, phone 
messages, and workflow items. The GroupWise Object API supports COM Automation, which 
is an industry standard for interfacing applications and is simple to use with languages such as 
Delphi*, Visual Basic*, and C++. For more information, see GroupWise Object API (http://
developer.novell.com/ndk/gwobjapi.htm).

• GroupWise Administrative Object API: Lets you see, use, and manipulate GroupWise 
administration information from outside GroupWise. You can use the GroupWise 
Administrative Object API through COM languages, such as Visual Basic, Delphi, and object-
oriented languages (such as C++). It also supports COM Automation, which is an industry 
standard for interfacing applications. For more information, see GroupWise Administrative 
Object API (http://developer.novell.com/ndk/gwadmin.htm).

• GroupWise C3PO (Custom 3rd-Party Object): Works with C++, Delphi, or Visual Basic to 
let you add menu and toolbar items to trigger applications. For example, you can modify the 
GroupWise client toolbar or define new record types in the GroupWise information store. For 
more information, see GroupWise C3PO (http://developer.novell.com/ndk/gwc3po.htm).

• GroupWise Tokens: Let you manipulate the GroupWise client interface by subscribing to 
internal token events or by publishing new tokens to the client. It names low-level events, such 
as “save a file” or “send mail,” which allows you to extend GroupWise functionality. A 
C3POTM lets you extend GroupWise objects and the Object API lets you see and manipulate the 
GroupWise information store from outside GroupWise. In addition, tokens let your solution 
command the GroupWise client from DLLs and DDE scripts, using the Third-Party Handler. 
You can also use tokens to create Visual Basic executables that users can run from the client 
interface. For more information, see GroupWise Tokens (http://developer.novell.com/ndk/
gwtoken.htm).

• GroupWise Trusted Applications: Enables you to develop applications that can log in to any 
user’s mailbox without supplying the user’s password and perform various tasks such as virus 
scanning, content filtering, or e-mail auditing. For more information, see GroupWise Trusted 
Application API (http://developer.novell.com/ndk/gwtapp.htm).

• GroupWise SOAP: Provides access to GroupWise data, through defined standards, directly 
from the GroupWise post office. The standards used include: HTTP, SOAP, XML, XML 
schemas, and WSDL. HTTP, SOAP, and XML are used to transport data from between 
computers. XML schemas define the structure and the types of GroupWise data that is 
transported. The GroupWise WSDL (Service Descriptive Language) combines everything into 
a GroupWise Web service. For more information, see GroupWise Web Service (SOAP) (http://
developer.novell.com/ndk/gwsoap.htm).
GroupWise Customization Tools 209

http://developer.novell.com/ndk/gwwbacc.htm
http://developer.novell.com/ndk/gwwbacc.htm
http://developer.novell.com/ndk/gwobjapi.htm
http://developer.novell.com/ndk/gwadmin.htm
http://developer.novell.com/ndk/gwadmin.htm
http://developer.novell.com/ndk/gwc3po.htm
http://developer.novell.com/ndk/gwtoken.htm
http://developer.novell.com/ndk/gwtapp.htm
http://developer.novell.com/ndk/gwtapp.htm
http://developer.novell.com/ndk/gwsoap.htm


210 GroupWise 

novdocx (E
N

U
)  6 D

ecem
ber 2005
• GroupWise MAPI: Uses a set of object-oriented functions that provide messaging 
capabilities. The Messaging Application Programming Interface (MAPI) is used by mail-
enabled applications to create, transfer, and store messages, as well as to handle complex 
addressing information. MAPI objects are data structures that support a set of properties and 
that comply with the component object model (which requires that objects support one or more 
interfaces or sets of functions). For more information, see GroupWise MAPI (http://
developer.novell.com/ndk/gwmapi.htm).

• GroupWise Events: Provides event notification to registered third-party applications, and is 
responsive to queries, while not significantly degrading the overall performance of the 
GroupWise Post Office Agent (POA). This functionality is included in the GroupWise Object 
API (http://developer.novell.com/ndk/gwobjapi.htm).

• GroupWise Controls for ActiveX: Lets you embed an Address Book or Name Completion 
COM Control (OCX) in your Visual Basic, Delphi, and C++ solutions. OCX properties let you 
customize user access to Address Book contents and control return information for your 
solution to use. For more information, see GroupWise Controls for ActiveX (http://
developer.novell.com/ndk/gwactive.htm).
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23Novell exteNd

In earlier versions of GroupWise®, WebAccess stored its default user interface files in the following 
directory on the Web server:

tomcat_root/webapps/gw/WEB-INF/classes/com/novell/webaccess/
    templates/frames

In GroupWise 7, the user interface files are stored in the css subdirectory of templates rather than 
the frames subdirectory.

If you have exteNdTM portlets configured to use WebAccess, you must copy some of the exteNd 
template files from the frames directory into the css directory. Refer to the Identity Manager 
Accessory Portlet Reference Guide (http://www.novell.com/documentation/idm/agprtlt/data/
bookinfo.html) to determine which exteNd template files you should copy to the css directory. Do 
not copy the entire contents of the frames directory into the css directory; this would damage the 
new GroupWise 7 WebAccess user interface.

In addition, modify the WebAccess URL in the exteNd Portal Preferences from:

http://Web_server_address/servlet/webacc

to:

http://Web_server_address/gw/webacc
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IVMicrosoft Clustering Services

Chapter 24, “Introduction to GroupWise 7 and Microsoft Clusters,” on page 215
Chapter 25, “Planning GroupWise in a Microsoft Cluster,” on page 217
Chapter 26, “Setting Up a Domain and Post Office in a Microsoft Cluster,” on page 233
Chapter 27, “Implementing the Internet Agent in a Microsoft Cluster,” on page 245
Chapter 28, “Implementing WebAccess in a Microsoft Cluster,” on page 255
Chapter 29, “Implementing GroupWise Gateways in a Microsoft Cluster,” on page 267
Chapter 30, “Monitoring a GroupWise System in a Microsoft Cluster,” on page 269
Chapter 31, “Backing Up a GroupWise System in a Microsoft Cluster,” on page 271
Chapter 32, “Moving an Existing GroupWise 7 System into a Microsoft Cluster,” on page 273
Chapter 33, “Implementing Messenger in a Microsoft Cluster,” on page 275
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24Introduction to GroupWise 7 and 
Microsoft Clusters

Before implementing GroupWise® 7 in a Microsoft* cluster, make sure you have a solid 
understanding of Microsoft clustering technologies by reviewing the following information 
resources:

• Cluster Technologies Community Center (http://www.microsoft.com/windowsserver2003/
community/centers/clustering/more_resources.asp)

• Windows 2003 Clustering Services (http://www.microsoft.com/windowsserver2003/
technologies/clustering/default.mspx)

• Windows 2000 Clustering Technologies (http://www.microsoft.com/windows2000/
technologies/clustering/default.asp)

When you review the information resources recommended above, you discover that clustering 
employs very specialized terminology. The following brief glossary provides basic definitions of 
clustering terms and relates them to your GroupWise system:

cluster: A grouping of from two to eight Windows servers configured so that data storage locations 
and applications can transfer from one server to another without interrupting their availability to 
users. 

node: A clustered server; in other words, a single Windows server that is part of a cluster.

active node: A node in the cluster that is actively running programs. An active node makes its 
resources available in the cluster.

passive node: A node in the cluster that is not currently running programs, but is waiting for an 
active node to fail. A passive node does not make its resources available in the cluster until an active 
node fails over to it.

resource: A data storage location or application. For example, a domain directory and the MTA for 
the domain are resources. A post office directory and the POA for the post office are resources.

resource group: Two or more resources that must fail over together in order to remain functional. 
For example, for a domain to be functional, the domain directory and its MTA must fail over 
together. For a post office to be functional, the post office directory and its POA must fail over 
together

physical disk: The physical location where resources are created or installed. For example, a 
domain or post office directory is created on a physical disk. The agent software is installed on a 
physical disk.

shared disk: A physical disk that can be made active on any node in the cluster.

failover: The process of moving resources and resource groups on a shared disk from a failed node 
to a functional node so that availability to users is uninterrupted. For example, if the node where the 
POA is running goes down, the post office resource group would fail over to another node so that 
users could continue to use GroupWise.
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fan-out-failover: The configuration where resources and resource groups from a failed node fail 
over to different nodes in order to distribute the load from the failed node across multiple nodes in 
the cluster. For example, if a node runs a resource group consisting of a domain and its MTA, 
another resource group consisting of a post office and its POA, and a third resource group for 
WebAccess, each resource group could be configured to fail over separately to different nodes in the 
cluster. 

failback: The process of returning resources and resource groups to their original node after the 
situation causing the failover has been resolved. For example, if a POA and its post office fail over 
to another node in the cluster, that resource group can be configured to fail back to its original node 
when the problem is resolved.

shared disk system: The hardware housing the physical disks that are shared among the nodes in 
the cluster. The C: drives in the clustered nodes are not part of the shared disk system. Each C: drive 
belongs to its own server.

storage area network (SAN): The clustered nodes together with their shared disk system and 
shared physical disks.
7 Interoperability Guide
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25Planning GroupWise in a 
Microsoft Cluster

The majority of this part of the guide (Chapter 25, “Planning GroupWise in a Microsoft Cluster,” on 
page 217 through Chapter 31, “Backing Up a GroupWise System in a Microsoft Cluster,” on 
page 271) is designed for those who are creating a new GroupWise® system, or at least new domains 
and post offices, in a Microsoft cluster. If you already have an existing GroupWise 6.x system and 
need to configure it to work in a newly installed cluster, see Chapter 32, “Moving an Existing 
GroupWise 7 System into a Microsoft Cluster,” on page 273.

When you implement a new GroupWise system or a new domain or post office in a Microsoft 
cluster, overall GroupWise system design does not need to change substantially. For a review, see 
“Installing a Basic GroupWise System” in the GroupWise 7 Installation Guide. However, the 
configuration of individual components of your GroupWise system will be significantly different. 
This section helps you plan the following GroupWise components in a Microsoft cluster:

• A new GroupWise system consisting of the primary domain and the initial post office
• A new secondary domain 
• A new post office
• The GroupWise agents (MTA and POA)

During the planning process, component configuration alternatives are explained. For example, you 
might want the domain and post office together in the same resource group or in separate resource 
groups. You might want to install the agents to the standard c:\grpwise directory on each node 
or to manually create a drive:\grpwise directory for each shared disk for domains and post 
offices so that the agents fail over with the domains and post offices they service. 

The “System Clustering Worksheet” on page 228 lists all the information you need as you set up 
GroupWise in a Microsoft cluster. You should print the worksheet and fill it out as you complete the 
tasks listed below:

• Section 25.1, “Setting Up Your Microsoft Cluster,” on page 218
• Section 25.2, “Planning a New Clustered Domain,” on page 218
• Section 25.3, “Planning a New Clustered Post Office,” on page 219
• Section 25.4, “Planning a New Library for a Clustered Post Office,” on page 220
• Section 25.5, “Planning GroupWise Resource Groups,” on page 220
• Section 25.6, “Planning Shared Administrative Resources,” on page 221
• Section 25.7, “Ensuring Successful Name Resolution for GroupWise Resource Groups,” on 

page 221
• Section 25.8, “Deciding How to Install and Configure the Agents in a Cluster,” on page 223
• Section 25.9, “GroupWise Clustering Worksheets,” on page 228

After you have completed the tasks and filled out the “System Clustering Worksheet” on page 228, 
you are ready to continue with Chapter 26, “Setting Up a Domain and Post Office in a Microsoft 
Cluster,” on page 233.
Planning GroupWise in a Microsoft Cluster 217
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25.1  Setting Up Your Microsoft Cluster
As you set up your Microsoft cluster, record key information about the cluster on the System 
Clustering Worksheet:

The number of nodes in the cluster strongly influences where you place GroupWise domains and 
post offices. You have several alternatives:

• Your whole GroupWise system can run in a single cluster.
• Parts of your GroupWise system can run in one cluster while other parts of it run in one or more 

other clusters.
• Parts of your GroupWise system can run in a cluster while other parts run outside of the cluster, 

on non-clustered servers.

If you do not have the system resources to run all of your GroupWise system in the cluster, you must 
decide which parts have the most urgent need for the high availability provided by clustering. Here 
are some suggestions:

• Post offices and their POAs must be available in order for users to access their GroupWise 
mailboxes. Therefore, post offices and their POAs are excellent candidates for the high 
availability provided in a cluster.

• In a like manner, WebAccess provides user access to GroupWise mailboxes across the Internet 
through users’ Web browsers. It is another good candidate for the cluster.

• Domains and their MTAs are less noticeable to GroupWise client users when they are 
unavailable (unless users in different post offices happen to be actively engaged in an e-mail 
discussion when the MTA goes down). On the other hand, domains and their MTAs are critical 
to GroupWise administrators, although administrators might be more tolerant of a down server 
than client users are. Critical domains in your GroupWise system are the primary domain and, 
if you have one, a hub or routing domain. These domains should be in the cluster, even if other 
domains are not.

• The Internet Agent might or might not require high availability in your GroupWise system, 
depending on the importance of immediate messaging across the Internet and the use of POP3 
or IMAP4 clients by GroupWise users. 

There is no right or wrong way to implement GroupWise in a cluster. It all depends on the specific 
needs of your particular GroupWise system and its users.

25.2  Planning a New Clustered Domain
The considerations involved in planning a new domain in a Microsoft cluster are essentially the 
same as for any other environment.

• Primary Domain: If you are setting up a new GroupWise system in a Microsoft cluster, you 
will be creating the primary domain as you complete the tasks in this section. In preparation, 
review “Planning Your Basic GroupWise System”, then print and fill out the “Basic GroupWise 

SYSTEM CLUSTERING WORKSHEET

Under Item 1: Cluster Name, record the name of your Microsoft cluster. 

Under Item 2: Nodes in Cluster, list the servers that you have added to the cluster.
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System Worksheet” in “Installing a Basic GroupWise System” in the GroupWise 7 Installation 
Guide. This covers planning the primary domain and an initial post office in the primary 
domain.

• Secondary Domain: If your GroupWise system already exists, you will be creating a new 
secondary domain. In preparation, review “Planning a New Domain”, then print and fill out the 
“Domain Worksheet” in “Domains” in the GroupWise 7 Administration Guide.

Regardless of the type of domain you are creating, keep in mind the following cluster-specific 
details as you fill out the worksheet you need:

• When you specify the location for the domain directory (and for a new GroupWise system, the 
post office directory) on the worksheet, include the shared disk where you want the directory to 
reside.

• Do not concern yourself with the GroupWise agent information on the worksheet. You will 
plan the agent installation later. If you are filling out the Basic GroupWise System Worksheet, 
stop with item 17. If you are filling out the Domain Worksheet, stop with item 10.

When you have completed the worksheet, transfer the key information from the Basic GroupWise 
System Worksheet or the Domain Worksheet to the System Clustering Worksheet.

IMPORTANT: Do not create the new domain until you are instructed to do so in Chapter 3, 
“Setting Up a Domain and Post Office in a NetWare Cluster,” on page 39.

25.3  Planning a New Clustered Post Office
The considerations involved in planning a new post office in a Microsoft cluster are essentially the 
same as for any other environment. The initial post office in a new GroupWise system is planned on 
the Basic GroupWise System Worksheet. To plan additional new post offices, review “Planning a 
New Post Office ”, then print and fill out the “Post Office Worksheet” in “Post Offices” in the 
GroupWise 7 Administration Guide. When you specify the locations for the post office directories, 
include the shared disks where you want the post office directories to reside. 

When you have completed the worksheet, transfer key information from the Basic GroupWise 
System Worksheet or the Post Office Worksheet to the System Clustering Worksheet.

IMPORTANT: Do not create the new post office until you are instructed to do so in Chapter 3, 
“Setting Up a Domain and Post Office in a NetWare Cluster,” on page 39.

SYSTEM CLUSTERING WORKSHEET

Under Item 7: Domain Name, transfer the domain name and directory to the System Clustering 
Worksheet. 

SYSTEM CLUSTERING WORKSHEET

Under Item 8: Post Office Name, transfer the post office name and directory to the System Clustering 
Worksheet. 
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25.4  Planning a New Library for a Clustered Post 
Office
The considerations involved in planning a library in a Microsoft cluster are essentially the same as 
for any other environment. You can plan a library for a new clustered post office by following the 
standard instructions provided in “Creating and Managing Libraries” in the GroupWise 7 
Administration Guide and filling out the “Basic Library Worksheet” or the “Full-Service Library 
Worksheet”. Then provide the library information on the System Clustering Worksheet.

IMPORTANT: Do not create the new library until you are instructed to do so in Chapter 3, “Setting 
Up a Domain and Post Office in a NetWare Cluster,” on page 39.

25.5  Planning GroupWise Resource Groups 
Resource groups ensure that resources that depend on each other fail over together. If your 
GroupWise system is very small (for example, one domain and one post office), you could have a 
single GroupWise resource group so that your whole GroupWise system would fail over together. 
More typically, multiple domains and post offices are located throughout your organization, so you 
would set up a resource group for each domain and post office.

A resource group for a domain or post office must include the following types of resources:

• Network Name: The virtual name by which the domain or post office resource group will be 
known on the network, regardless of which node it is active on

• IP Address: The virtual IP address that will be associated with the network name, regardless of 
which node the domain or post office resource group is active on

• Physical Disk: The drive letter where the domain or post office directory will be located, used 
when mapping a drive to the physical disk

• File Share: The name of the physical disk, used when mapping a drive to the physical disk
• Generic Service: The GroupWise agent, running as a Windows service, that will service the 

domain or post office

For convenience, you might want to name each resource group after the domain or post office it 
represents. In this documentation, a resource group that could include a domain, a post office, or 
both, is termed a “GroupWise resource group.”

Each GroupWise resource group has associated with it a list of possible owners. The possible 
owners are the nodes to which the resource group could fail over. By default, a resource group is 
configured to have all nodes in the cluster in its possible owners list, organized in ascending 
alphanumeric order. Only one node at a time can have a particular GroupWise resource group active. 
If a resource group’s current owner node fails, the resource group fails over to the next node in the 

SYSTEM CLUSTERING WORKSHEET

Under Item 9: Document Storage Area Location, mark where you want to create the library’s 
document storage area. 

If the document storage area will be located outside the post office directory structure and outside the 
cluster, specify a user name and password that the POA can use to access the server where the 
document storage area will reside.
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possible owners list. You should customize the owners list for each GroupWise resource group 
based on the fan-out-failover principle.

When a node fails, its resource groups should not all fail over together to the same node in the 
cluster. Instead, the resource groups should be distributed across multiple nodes throughout the 
cluster. This prevents any one node from shouldering the entire processing load typically carried by 
another node. In addition, some GroupWise resource groups should never have the potential of 
failing over to the same node. For example, a post office and POA that service a large number of 
very active GroupWise client users should never fail over to a node where another very large post 
office and heavily loaded POA reside. If they did, users on both post offices would notice a decrease 
in responsiveness of the GroupWise client.

25.6  Planning Shared Administrative Resources
Depending on your administrative needs, you might or might not want to set up shared 
administrative resources. For example, you might want to have a shared disk where you install the 
GroupWise snap-ins to ConsoleOne® instead of installing them on multiple administrator 
workstations. You might also have a shared disk where you create the GroupWise software 
distribution directory. These shared disks could be configured to fail over as part of your clustered 
environment.

25.7  Ensuring Successful Name Resolution for 
GroupWise Resource Groups
When you establish GroupWise resource groups, you establish network names for the locations of 
domains and post offices. The network names remain constant no matter which node in the cluster 
the domain or post office is currently active on. Because you are using virtual network names, not 
physical locations, you must ensure that short name resolution is always successful. For example, in 
ConsoleOne, if you right-click a Domain object in the GroupWise View and then click Connect, 
ConsoleOne must be able to resolve the domain database location, as provided in the UNC Path 
field, to the network name of that domain within your cluster. It is through short name resolution that 
all GroupWise resource groups are accessed and managed in ConsoleOne.

A client program (such as ConsoleOne) that runs on a Windows workstation, can be configured to 
use several different short name resolution methods. To see which methods are in use at a particular 
workstation, view the protocol preferences for the Novell® ClientTM that is installed on the Windows 
workstation:

SYSTEM CLUSTERING WORKSHEET

Under Item 4: Resource Group for Domain, specify the network name and other required information 
for the domain resource group. Mark whether you will place the post office in the same resource 
group with the domain.

If you want the post office in a different resource group from where the domain is located, under Item 
5: Resource Group for Post Office, specify the network name and other required information for the 
post office resource group. 

SYSTEM CLUSTERING WORKSHEET

Under Item 3: Resources for GroupWise Administration, list any shared disks you want to use for 
GroupWise administration purposes. 
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Figure 25-1   Novell Client Preferences Property Page

Short name resolution methods that pertain to your clustered GroupWise system are discussed 
below:

Table 25-1   Short Name Resolution Methods

Specific setup instructions for each of these short name resolution methods are provided in Chapter 
26, “Setting Up a Domain and Post Office in a Microsoft Cluster,” on page 233.

Short 
Name 
Resolution 
Method

Description

eDirectory You can use Novell eDirectoryTM to resolve short names into specific network addresses. 
However, when using eDirectory for short name resolution, you must remember to 
consider current context in the name resolution process. eDirectory short name resolution 
works only if your current context is the same as the context of the eDirectory object you 
need to access.

Hosts Files Windows 2000/2003uses the \winnt\system32\drivers\etc\hosts file when 
performing short name resolution at the workstation:

Using this file at the Windows workstation is not a preferred method for short name 
resolution (except perhaps for the administrator’s workstation).

DNS Perhaps the most common short name resolution option is Domain Name Service (DNS). 
As with the hosts file, it is good practice to place all the network names of your 
GroupWise resource groups into DNS. 

For short name resolution to work using DNS, the client workstation must either belong to 
the same DNS zone (such as support.novell.com) as the resource group, or the cluster 
resource zone must be configured in the client’s DNS suffix search path under TCP/IP 
settings for the workstation.
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25.8  Deciding How to Install and Configure the 

Agents in a Cluster
There are several cluster-specific issues to consider as you plan to install the Windows MTA and 
POA in your clustered GroupWise system:

• “Planning Cluster-Unique Port Numbers for Agents in the Cluster” on page 223
• “Deciding Where to Install the Agent Software” on page 225
• “Planning the Agent Services” on page 227
• “Planning the Windows Agent Installation” on page 227

25.8.1  Planning Cluster-Unique Port Numbers for Agents in the 
Cluster
By default, the GroupWise agents listen on all IP addresses, both primary and secondary, that are 
bound to the server on their specified port numbers. The primary IP address is the IP address of the 
physical node. Secondary IP addresses are the IP addresses associated with GroupWise resource 
groups.

Any time there is a possibility of two of the same type of agent running on the same node, it is 
important that each agent use a cluster-unique port number, even though each agent is using the 
unique IP address established for each GroupWise resource group. The best way for you to avoid 
port conflicts is to plan your cluster so that each agent in the cluster runs on a cluster-unique port. 
Print out a copy of the “Network Address Worksheet” on page 230 to help you plan cluster-unique 
port numbers for all GroupWise agents in your GroupWise system.

The following filled-out version of the Network Address Worksheet illustrates one way this can be 
done:

Domain Information

Post Office Information

SYSTEM CLUSTERING WORKSHEET

Under Item 6: IP Address Resolution Methods, mark which methods you want to implement in order 
to resolve the locations stored as UNC paths in ConsoleOne into the network names of the 
GroupWise resource groups.

Domain MTA
IP Address

MTA 
MTP Port

MTA 
HTTP Port

Provo1 172.16.5.81 7100 7180

Post Office POA
IP Address

POA 
C/S Port

POA 
MTP Port

POA 
HTTP Port

Development (same as MTA) 1677 7101 7181
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Internet Agent Information

WebAccess Information

This example places the Development post office in the same resource group with the Provo1 
domain; therefore, the Provo1 MTA and the Development POA use the same IP address. The 
Manufacturing post office is placed in a different resource group, so the Manufacturing post office 
has a different IP address. The Internet Agent and the WebAccess Agent each have their own 
domains and separate resource groups.

The example also illustrates that the MTA, the POA, and the Internet Agent use different port 
numbers for agent ports and HTTP ports. In contrast, the WebAccess Agent uses the same port 
number for the agent port and the HTTP port.

The example uses default port numbers where possible. For example, the default MTA message 
transfer port is 7100 and the default POA client/server port is 1677. Incrementing port numbers are 
used in the example when multiple components have the same type of ports. For example, port 
numbers 1677 and 1678 are both POA client/server ports and port numbers 7180 through 7184 are 
all HTTP ports. Incrementing from the default port numbers generates unique, though related, port 
numbers. 

If you are going to set up a GroupWise name server to help GroupWise clients locate their post 
offices, make sure that the default POA port number of 1677 is used somewhere in the cluster and 
specify the IP address of the post office resource group, not the IP address of a specific node. For 
more information, see “Simplifying Client/Server Access with a GroupWise Name Server” in “Post 
Office Agent” in the GroupWise 7 Administration Guide.

Manufacturing 172.16.5.82 1678 7102 7182

Internet Agent GWIA
IP Address

MTA 
MTP Port

MTA Live 
Remote Port

MTA 
HTTP 
Port

GWIA 
HTTP Port

GWIA Domain
MTA

172.16.5.83 7110 7677 7183 N/A

Internet Agent 
(GWIA)

(same as MTA) N/A N/A N/A 9850

WebAccess Agent WebAccess 
IP Address

MTA 
MTP Port

MTA 
HTTP Port

WebAccess 
Agent Port

WebAccess
HTTP Port

WebAccess 
Domain MTA

172.16.5.84 7120 7184 N/A N/A

WebAccess Agent 
(GWINTER)

(same as MTA) N/A N/A 7205 7205
(same as agent)

Post Office POA
IP Address

POA 
C/S Port

POA 
MTP Port

POA 
HTTP Port
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After you have filled out the Network Address Worksheet, transfer the IP addresses and the cluster-
unique port numbers from the Network Address Worksheet to the Agent Clustering Worksheet so 
that they will be available in the sequence in which you will need them as you set up the GroupWise 
agents in the cluster.

25.8.2  Deciding Where to Install the Agent Software 
In a Microsoft cluster, the agents must run as Windows services. When you install the Windows 
MTA and POA, you can choose between two different installation locations:

Table 25-2   Agent Software Installation Locations

Because the agents must be installed as Windows services in a Microsoft cluster, you must initially 
run the Agent Installation program for each node in the cluster so that the Windows services for the 
agents get created, regardless of where you are planning to run the agents from. However, for 
updates, you need to run the Agent Installation program only once if you are running the agents 
from a shared disk. 

The following sections can help you choose which installation location would be best for your 
clustered GroupWise system:

• “Advantages of Installing to a Shared Disk” on page 226
• “Disadvantages of Installing to a Shared Disk” on page 226
• “Recommendation” on page 226

NETWORK ADDRESS WORKSHEET

Fill out the “Network Address Worksheet” on page 230 to help you determine resource group IP 
addresses and cluster-unique port numbers for all GroupWise agents in the cluster. (MTA, POA, 
Internet Agent, WebAccess Agent). Refer to the IP addresses you planned for the domain and post 
office resource groups under items 4 and 5 on the System Clustering Worksheet.

AGENT CLUSTERING WORKSHEET

Under Item 4: MTA Network Information, transfer the resource group IP address and cluster-unique 
port numbers for the MTA from the Network Address Worksheet to the Agent Clustering Worksheet.

Under Item 7: POA Network Information, transfer the resource group IP address and cluster-unique 
port numbers for the POA from the Network Address Worksheet to the Agent Clustering Worksheet.

Location Description

Each node in the 
cluster

The c:\grpwise directory is the default location provided by the Agent 
Installation program.

Shared disk If you create a drive:\grpwise directory on the same shared disk with the 
domain or post office directory, the agent software and startup files fail over and 
back with the domains and post offices that the agents service.
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Advantages of Installing to a Shared Disk

Using a drive:\grpwise directory for each GroupWise shared disk has several advantages:

• When you update the agent software, you only need to update it in one place for a particular 
domain or post office, not on every node in the resource group’s possible owners list. This 
prevents the potential problem of having a domain or post office fail over to a node where a 
different version of the agent software is installed.

• Having the agent startup files on the same node as the domain or post office makes them easy 
to find. 

• If you change information in the agent startup files, you only need to change it in one place, not 
on every node in the resource group’s possible owners list. 

• If you want to back up the GroupWise data, you can back up the domain and/or post office 
directories and the agent software from the same shared disk.

Disadvantages of Installing to a Shared Disk

Installing the agents on the same shared disk with a domain or post office does have some 
disadvantages:

• You must install the agent software each time you create a new domain or post office on a new 
shared disk.

• GroupWise administrators who are used to the GroupWise agents being installed in 
c:\grpwise might be confused by not finding them there in the clustered GroupWise 
system.

• You must remember where you installed the GroupWise agents when you update the agent 
software. Accidently installing a GroupWise Support Pack to the default location of 
c:\grpwise on the active node would not have the desired results if the original agent 
software was installed to a shared disk.

Recommendation

Whichever method you choose, be consistent throughout the entire cluster. Either put all the 
GroupWise agents on the shared disks with the domains and post offices they service, or put them all 
in c:\grpwise directories on all nodes. If you put them on shared disks with domains and post 
offices, make sure there are no agent files in c:\grpwise directories on nodes to confuse the issue 
at a later time.

Even if you choose to install the agents to the c:\grpwise directory of multiple nodes, you can 
still store the agent startup files on shared disks with the domains and post offices. The significant 
advantage of this approach is that you only have one startup file to modify per agent.
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25.8.3  Planning the Agent Services
In a Microsoft cluster, the MTA and POA must be set up as service resources. A service resource for 
a GroupWise agent must include the following information:

• Name: The name by which the agent service will be listed in the resource group (for example, 
MTA Service or POA Service)

• Possible Owners: The list of nodes in the cluster to which the GroupWise agent can fail over 
(the same as the possible owners of the resource group to which the agent service belongs)

• Resource Dependencies: Other resources in the resource group that must be online before the 
GroupWise agent can start on a new node (for example, the Group IP Address resource and the 
Physical Disk resource where the domain or post office directory is located)

25.8.4  Planning the Windows Agent Installation
Aside from the cluster-specific issues discussed in the preceding sections, the considerations 
involved in planning to install the GroupWise Windows agents are the same in a Microsoft cluster as 
in any other environment. Review “Planning the GroupWise Agents”, then print and fill out the 
“GroupWise Agent Installation Worksheet” in “Installing GroupWise Agents” in the GroupWise 7 
Installation Guide for each location where you will install the Windows MTA and/or POA. 

Fill out the Windows Agent Worksheet. 

AGENT CLUSTERING WORKSHEET

Under Item 1: Agent Installation Location, mark whether you will install the agent software to the 
shared disk with a domain or post office, or to each node in the cluster. If necessary, specify where the 
agent startup files will be stored.

Under Item 2: Domain Name, transfer the domain name, shared disk, and directory from the System 
Clustering Worksheet to the Agent Clustering Worksheet.

Under Item 5: Post Office Name, transfer the post office name, shared disk, and directory from the 
System Clustering Worksheet to the Agent Clustering Worksheet.

AGENT CLUSTERING WORKSHEET

Under Item 3: MTA Service Resource, specify the MTA service resource name and list any possible 
resource dependencies.

Under Item 6: POA Service Resource, specify the POA service resource name and list any possible 
resource dependencies.
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IMPORTANT: Do not install the Windows agent software until you are instructed to do so in 
Chapter 26, “Setting Up a Domain and Post Office in a Microsoft Cluster,” on page 233.

Continue with Chapter 26, “Setting Up a Domain and Post Office in a Microsoft Cluster,” on 
page 233.

25.9  GroupWise Clustering Worksheets
• “System Clustering Worksheet” on page 228
• “Network Address Worksheet” on page 230
• “Agent Clustering Worksheet” on page 231

25.9.1  System Clustering Worksheet

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Item 2: Agents and Locations, mark POA Local to Post Office and MTA Local to Domain. In a 
Microsoft cluster, a domain or post office and its agent must be located on the same node in order to 
fail over together.

Under Item 3: Installation Path, take into account your decision based on “Deciding Where to Install 
the Agent Software” on page 225.

Under Item 8: Installation Options, mark Install as Windows Services.

Under Item 6: Domains and Item 7: Post Offices, refer to the Domain and Post Office Worksheets you 
filled out in Section 25.2, “Planning a New Clustered Domain,” on page 218 and Section 25.3, 
“Planning a New Clustered Post Office,” on page 219, and to the Network Address Worksheet you 
completed during “Planning Cluster-Unique Port Numbers for Agents in the Cluster” on page 223.

Item Explanation

1) Cluster Name: Record the name of the name of your Microsoft cluster.

For more information, see Section 25.1, “Setting Up Your 
Microsoft Cluster,” on page 218.

2) Nodes in Cluster: List the servers that are part of the cluster that you set up for 
your GroupWise system.

For more information, see Section 25.1, “Setting Up Your 
Microsoft Cluster,” on page 218.
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3) Resources for GroupWise 
Administration:

ConsoleOne:

Shared disk:
Possible owners:

Software Distribution Directory:

Shared disk:
Possible owners:

List any shared locations that you want to set up for 
ConsoleOne or the software distribution directory.

For more information, see Section 25.6, “Planning Shared 
Administrative Resources,” on page 221.

4) Resource Group for Domain:

Network name:
IP address:
Physical disk:
File share:
MTA service:
Possible owners

Post Office in Same Resource Group as 
Domain?

• Yes

• No

Specify the information for the domain resource group.

For more information, see Section 25.2, “Planning a New 
Clustered Domain,” on page 218.

5) Resource Group for Post Office:

Network name:
IP address:
Physical disk:
File share:
MTA service:
Possible owners

Specify the information for the post office resource group.

For more information, see Section 25.3, “Planning a New 
Clustered Post Office,” on page 219.

6) IP Address Resolution Methods:

• eDirectory

• hosts file

• DNS

Mark the short name address resolution methods you want to 
implement to ensure that the UNC paths stored in ConsoleOne 
with network names can be successfully resolved into physical 
network addresses.

For more information, see Section 25.7, “Ensuring Successful 
Name Resolution for GroupWise Resource Groups,” on 
page 221

7) Domain Name:

Domain Directory:

Specify a unique name for the domain. Specify the directory 
where you want to create the new domain.

For more information, see Section 25.2, “Planning a New 
Clustered Domain,” on page 218.

8) Post Office Name:

Post Office Directory:

Specify a unique name for the post office. Specify the directory 
where you want to create the post office.

For more information, see Section 25.3, “Planning a New 
Clustered Post Office,” on page 219.

Item Explanation
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25.9.2  Network Address Worksheet
• “Domain Information” on page 230
• “Post Office Information” on page 230
• “Internet Agent Information” on page 230
• “WebAccess Information” on page 231

Domain Information

Post Office Information

Internet Agent Information

9) Document Storage Area Location:

• At the post office

• Outside the post office

• Separate post office

Document Storage Area Access

• POA /user startup switch setting

• POA /password startup switch 
setting

If you need a library for a clustered post office, mark where you 
want to create its document storage area and provide a 
directory if necessary.

For more information, see Section 25.4, “Planning a New 
Library for a Clustered Post Office,” on page 220.

Domain MTA
IP Address

MTA 
MTP Port

MTA 
HTTP Port

Post Office POA
IP Address

POA 
C/S Port

POA 
MTP Port

POA 
HTTP Port

Internet Agent GWIA
IP Address

MTA 
MTP Port

MTA 
Live Remote 
Port

MTA 
HTTP Port

GWIA 
HTTP Port

GWIA Domain 
MTA

N/A

Internet Agent 
(GWIA)

(same) N/A N/A N/A

Item Explanation
7 Interoperability Guide



novdocx (E
N

U
)  6 D

ecem
ber 2005
WebAccess Information

25.9.3  Agent Clustering Worksheet

WebAccess 
Agent

WebAccess 
IP Address

MTA 
MTP Port

MTA 
HTTP Port

WebAccess 
Agent Port

WebAccess
HTTP Port

WebAccess 
Domain MTA

N/A N/A

WebAccess 
Agent 
(GWINTER)

(same) N/A N/A

Item Explanation

1) Agent installation location:

• Shared disk with domain or post 
office

• Each node in the cluster

Consolidate startup files?

Mark the location where you will install the agent software. 

If necessary, specify the location where you will store agent 
startup files on the same shared disk with the domain or post 
office.

For more information, see “Deciding Where to Install the 
Agent Software” on page 225.

2) Domain Name:

Domain Directory:

Transfer this information from the System Clustering 
Worksheet (item 6).

3) MTA Service Resource:

Service name:
Possible owners:
Resource dependencies:

List other nodes in the cluster where the domain resource 
group could fail over and any resources that must be online 
before the MTA can start.

For more information, see “Planning the Agent Services” on 
page 227.

4) MTA Network Information:

MTA IP address:
MTA message transfer port:
MTA HTTP port:

Gather the MTA network address information from the 
“Network Address Worksheet” on page 230.

For more information, see “Planning Cluster-Unique Port 
Numbers for Agents in the Cluster” on page 223.

5) Post Office Name:

Post Office Directory:

Transfer this information from the System Clustering 
Worksheet (item 7).

6) POA Service Resource:

Service name:
Possible owners:
Resource dependencies:

List other nodes in the cluster where post office resource 
group could fail over and any resources that must be online 
before the POA can start.

For more information, see “Planning the Agent Services” on 
page 227.
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7) POA Network Information:

POA IP address
POA client/server port
POA message transfer port
POA HTTP port

Gather the POA network address information from the 
“Network Address Worksheet” on page 230.

For more information, see “Planning Cluster-Unique Port 
Numbers for Agents in the Cluster” on page 223.

Item Explanation
7 Interoperability Guide
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26Setting Up a Domain and Post 
Office in a Microsoft Cluster

You should have already reviewed “Planning GroupWise in a Microsoft Cluster” on page 217 and 
filled out the “System Clustering Worksheet” on page 228, the “Network Address Worksheet” on 
page 230, and the “Agent Clustering Worksheet” on page 231. You are now ready to complete the 
following tasks to set up GroupWise® in your Microsoft cluster:

• Section 26.1, “Preparing the Cluster for GroupWise,” on page 233
• Section 26.2, “Setting Up a New GroupWise System in a Cluster,” on page 234
• Section 26.3, “Creating a New Secondary Domain in a Cluster,” on page 235
• Section 26.4, “Creating a New Post Office in a Cluster,” on page 237
• Section 26.5, “Installing and Configuring the MTA and the POA in a Cluster,” on page 238
• Section 26.6, “Testing Your Clustered GroupWise System,” on page 240
• Section 26.7, “Managing Your Clustered GroupWise System,” on page 240
• Section 26.8, “What’s Next,” on page 242

26.1  Preparing the Cluster for GroupWise
After you have set up your Microsoft cluster and become familiar with its functioning, as described 
in Chapter 24, “Introduction to GroupWise 7 and Microsoft Clusters,” on page 215, complete the 
following tasks to prepare the cluster for your GroupWise system:

• “Creating GroupWise Resource Groups” on page 233
• “Creating Agent Service Resources” on page 233
• “Configuring Short Name Resolution” on page 233

26.1.1  Creating GroupWise Resource Groups
Create the needed domain and post office resource groups in your Microsoft cluster (System 
Clustering Worksheet items 3 and 4), as planned in Section 25.2, “Planning a New Clustered 
Domain,” on page 218 and Section 25.3, “Planning a New Clustered Post Office,” on page 219.

26.1.2  Creating Agent Service Resources
Within each GroupWise resource group, create the MTA or POA service resource (Agent Clustering 
Worksheet items 3 and 6), as planned in “Planning the Agent Services” on page 227.

26.1.3  Configuring Short Name Resolution
To ensure that GroupWise resource groups are always locatable on the network, configure the short 
name resolution methods that you want to rely on for your clustered GroupWise system (System 
Clustering Worksheet item 9), as planned in Section 25.7, “Ensuring Successful Name Resolution 
for GroupWise Resource Groups,” on page 221.
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• “eDirectory” on page 234
• “Hosts Files” on page 234
• “DNS” on page 234

After configuring your selected short name resolution methods, continue with the task you need to 
perform:

• Section 26.2, “Setting Up a New GroupWise System in a Cluster,” on page 234
• Section 26.3, “Creating a New Secondary Domain in a Cluster,” on page 235
• Section 26.4, “Creating a New Post Office in a Cluster,” on page 237

eDirectory

ConsoleOne® uses Novell® eDirectoryTM to resolve the UNC path of a domain or post office 
directory into its network name in the cluster. For example, on the workstation where you run 
ConsoleOne, you need to map a drive to the location of a domain directory using the network name 
of the domain resource group so that ConsoleOne can access the domain database no matter which 
node in the cluster it is active on. 

Hosts Files

Because each GroupWise resource group has been associated with a network name, you should add 
lines for the new network names to the \winnt\system32\drivers\etc\hosts file as 
needed This should only be done on the administrator’s workstation.

The lines you add to a hosts file could look similar to the following example (all on one line, of 
course):

Syntax:
 IP_address network_name.context 

Remember that network_name represents the name of the virtual server, which remains unchanged 
regardless of which node is currently active.

Example:
 172.16.5.81 gwcluster.novell.com

When specifying the lines in the hosts files, use System Clustering Worksheet item 7 or 8 for each 
IP_address and network_name where a domain or post office resides. Use System Clustering 
Worksheet item 3 for cluster. Use System Clustering Worksheet item 4 for context.

DNS

Because each GroupWise resource group has been associated with a virtual network name, you 
should add all your new network names to DNS. 

26.2  Setting Up a New GroupWise System in a 
Cluster
The GroupWise Installation Advisor walks you through setting up the primary domain and an initial 
post office in the primary domain. You might be creating your primary domain and initial post office 
in the same resource group or in two different resource groups. After you have created the primary 
7 Interoperability Guide
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domain and initial post office and installed the GroupWise agents, you can create additional 
secondary domains and post offices in the cluster as needed.

To set up the primary domain and initial post office for a new GroupWise system in a Microsoft 
cluster:

1 If necessary, map a drive to each GroupWise administration shared disk (System Clustering 
Worksheet item 3).

2 Map a drive to the shared disk of the domain resource group (System Clustering Worksheet 
item 6) and, if needed, to the shared disk of the post office resource group (System Clustering 
Worksheet item 7), where the primary domain and the initial post office for your new 
GroupWise system will be created.

3 Manually create the domain directory (System Clustering Worksheet item 6) and the post office 
directory (System Clustering Worksheet item 7). 
This step is not required, but in a Microsoft cluster, the following step is easier if the directory 
already exists.

4 Run the GroupWise Installation Advisor to set up your initial GroupWise system, following the 
steps provided in “NetWare and Windows: Setting Up a Basic GroupWise System” in 
“Installing a Basic GroupWise System” in the GroupWise 7 Installation Guide. Keep in mind 
the following cluster-specific details:

• When you specify the ConsoleOne directory and the software distribution directory, be 
sure to browse to each location through the shared disk accessed in Step 1 above.

• When you specify the domain directory and post office directory, be sure to browse 
through the shared disk accessed in Step 2 to select the directory created in Step 3 above.

• For the post office link type, select TCP/IP Link.

• When providing the MTA and POA network address information, use the Agent 
Clustering Worksheet that you filled out in Section 25.8, “Deciding How to Install and 
Configure the Agents in a Cluster,” on page 223. The information you provide will be 
used to configure the MTA and POA objects in the domain and post office even though 
you have not yet installed the agent software.

• Do not create users in the post office at this time.

• In the Summary dialog box, the domain directory and post office directory that you 
browsed to should display as UNC paths using the network name of the GroupWise 
resource group, not the name of a specific node in the cluster.

5 When you have finished creating the primary domain and the initial post office, continue with 
installing the GroupWise Agents, starting with Step 5 in “Installing the Agent Software in a 
Cluster” on page 238.
The GroupWise Installation Advisor starts the Agent Installation program for you.

26.3  Creating a New Secondary Domain in a 
Cluster
After you have set up the primary domain and initial post office, as described in Section 26.2, 
“Setting Up a New GroupWise System in a Cluster,” on page 234, you can create additional 
secondary domains as needed.
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To create a new secondary domain in a Microsoft cluster:
1 Create a domain resource group for the new domain, as described in “Creating GroupWise 

Resource Groups” on page 233.
2 Create an MTA service resource for the domain’s MTA, as described in “Creating Agent 

Service Resources” on page 233.
3 Map a drive to the shared disk of the domain resource group (System Clustering Worksheet 

item 7) where the new secondary domain will be created.
4 Manually create the domain directory (System Clustering Worksheet item 7).

This step is not required, but in a clustered environment, Step 7 is easier if the domain directory 
already exists.

5 If you selected the same shared disk with the domain as the agent installation location (Agent 
Clustering Worksheet item 1), create the drive:\grpwise directory on the drive accessed 
in Step 3.
or
If you selected c:\grpwise on each node in the cluster, decide which node to install the 
agents to first.

6 In ConsoleOne, connect to the primary domain in your GroupWise system, as described in 
“Connecting to a Domain” in “Domains” in the GroupWise 7 Administration Guide.

7 Create the new domain, following the steps provided in “Creating the New Domain” in 
“Domains” in the GroupWise 7 Administration Guide. Keep in mind the following cluster-
specific details:

• Use the Domain Worksheet you filled out in Section 25.2, “Planning a New Clustered 
Domain,” on page 218 to fill in the fields on the Create GroupWise Domain page.

• In the Domain Database Location field, be sure to browse through the drive you accessed 
in Step 3 to the domain directory you created in Step 4 above.

• In the Link to Domain field, link the new domain to the primary domain of your 
GroupWise system. 

• The Configure Link option is selected by default. Select TCP/IP Link to the Other 
Domain. Refer to the Agent Clustering Worksheet that you filled out in “Planning Cluster-
Unique Port Numbers for Agents in the Cluster” on page 223 for the resource group IP 
address and cluster-unique port numbers that you need to specify in order to configure the 
link.

8 Use the Link Configuration tool to change the links from the new domain to all other domains 
in the cluster to direct TCP/IP links, following the steps provided in “Changing the Link 
Protocol between Domains to TCP/IP” in “Message Transfer Agent” in the GroupWise 7 
Administration Guide. 
Although a complete mesh link configuration is the most efficient, it might not be feasible in all 
situations. Set up as many direct TCP/IP links as possible for best MTA performance in the 
cluster.

9 Make sure you are still connected to the primary domain.
10 Rebuild the domain database for the new domain, following the steps provided in “Rebuilding 

Domain or Post Office Databases” in “Databases” in the GroupWise 7 Administration Guide. 
Be sure to browse to the database location (System Clustering Worksheet item 7) through the 
shared disk you accessed in Step 3 to the domain directory you created in Step 4 above.
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The database rebuild is necessary in order to transfer the MTA configuration information and 
the domain link information into the secondary domain database, because the MTA for the new 
secondary domain is not yet running.

11 Continue with Section 26.4, “Creating a New Post Office in a Cluster,” on page 237.

26.4  Creating a New Post Office in a Cluster
You can create a new post office in the same resource group where its domain is located or in a 
separate resource group. If the post office and its domain are in the same resource group, they fail 
over together. If they are in separate resource groups, they fail over separately.

To create a new post office in a Microsoft cluster:
1 If you selected Yes for Post Office in Same Resource Group as Domain? (under System 

Clustering Worksheet item 4), map a drive to the shared disk of the domain resource group. 
or
Map a drive to the shared disk of the post office resource group (System Clustering Worksheet 
item 5). 

2 Manually create the post office directory (System Clustering Worksheet item 8).
This step is not required, but in a Microsoft cluster, Step 4 is easier if the post office directory 
already exists.

3 In ConsoleOne, connect to the GroupWise domain where you want to create the new post 
office, as described in “Connecting to a Domain” in “Domains” in the GroupWise 7 
Administration Guide. 

4 Create the new post office, following the steps provided in “Creating the New Post Office” in 
“Post Offices” in the GroupWise 7 Administration Guide. Keep in mind the following cluster-
specific details:

• Use the Post Office Worksheet you filled out in Section 25.3, “Planning a New Clustered 
Post Office,” on page 219 to fill in the fields on the Create GroupWise Post Office page.

• In the Post Office Database Location field, be sure to browse through the shared disk you 
accessed in Step 1 to the post office directory you created in Step 2 above.

• If you want to create a library at the post office (System Clustering Worksheet item 9), 
select Create Library.

• The Configure Link option is selected by default. Select TCP/IP Link from Domain to New 
Post Office. Refer to the Agent Clustering Worksheet that you filled in during “Planning 
Cluster-Unique Port Numbers for Agents in the Cluster” on page 223 for the resource 
group IP address and cluster-unique port numbers that you need to specify in order to 
configure the link.

5 In ConsoleOne, right-click the new Post Office object, then click Properties.
6 Click GroupWise > Post Office Settings, then in the Access Mode field, select Client/Server 

Only.
7 Right-click the new POA object, then click Properties.

On the POA Agent Settings and Scheduled Events pages, you might want to specify unique 
times for the following POA activities to prevent multiple POAs from performing the same 
activities on the same node at the same time during a failover situation:

• Start User Upkeep
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• Generate Address Book for Remote
• Enable QuickFinder Indexing 
• Mailbox/Library Maintenance Event

For more information about these repetitive POA activities, see “Performing Nightly User 
Upkeep”, “Regulating Indexing”, and “Scheduling Database Maintenance” in “Post Office 
Agent” in the GroupWise 7 Administration Guide.

8 Make sure you are still connected to the domain that owns the new post office.
9 Rebuild the post office database for the new post office, following the steps provided in 

“Rebuilding Domain or Post Office Databases” in “Databases” in the GroupWise 7 
Administration Guide. Be sure to browse to the database location (System Clustering 
Worksheet item 7) through the shared disk you accessed in Step 1 to the post office directory 
you created in Step 2 above.
The database rebuild is necessary in order to transfer the POA configuration information and 
the post office link information into the post office database, because the POA for the new post 
office is not yet running.

10 If you want to create a library (System Clustering Worksheet item 9) for the new clustered post 
office, follow the steps in “Setting Up a Basic Library” or “Setting Up a Full-Service Library” 
in “Libraries and Documents” in the GroupWise 7 Administration Guide, after you have 
completely finished setting up the new clustered post office.

11 Continue with Section 26.5, “Installing and Configuring the MTA and the POA in a Cluster,” 
on page 238.

26.5  Installing and Configuring the MTA and the 
POA in a Cluster
After you have created a new domain and/or post office, you are ready to install and configure the 
GroupWise agents. Complete all the tasks below if you are setting up a new GroupWise system or if 
you have created a new GroupWise resource group where you want to install the agent software:

• “Installing the Agent Software in a Cluster” on page 238
• “Editing Clustered Agent Startup Files” on page 239

Under some circumstances, the agent software has already been installed in the cluster and you 
simply need to create a new startup file specific to the new domain or post office. For example: 

• You have created a new domain and/or post office in a GroupWise resource group where the 
agent software is already installed in the drive:\grpwise directory for the resource group.

• In your GroupWise system, the agent software is already installed to the c:\grpwise 
directory on each node in the cluster.

In these circumstances, follow the instructions in “Setting Up New Instances of the Agents without 
Installing the Agent Software” on page 240 instead of completing the tasks listed above.

26.5.1  Installing the Agent Software in a Cluster
To install the MTA and the POA:

1 Map a drive to the shared disk of the domain resource group (Agent Clustering Worksheet item 
2) or the post office resource group (Agent Clustering Worksheet item 5).
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2 Map a drive to c:\ on the first node in the cluster where you will set up the agents as Windows 
services (System Clustering Worksheet item 2).

3 If you plan to install the agent software to the shared disk of the domain or post office resource 
group (under Agent Clustering Worksheet item 1), create the drive:\grpwise directory on 
the shared disk accessed in Step 1.
or
If you plan to install the agent software to each node in the cluster, create the c:\grpwise 
directory on the drive accessed in Step 2.

4 Start the Agent Installation program, following the steps provided in “Installing the Windows 
Agent Software” in “Installing GroupWise Agents” in the GroupWise 7 Installation Guide. 

5 Install the Windows agents, keeping in mind the following cluster-specific details:

• Use the Windows Agent Clustering Worksheet that you filled out in “Planning the 
Windows Agent Installation” on page 227 to fill in the fields during the agent installation 
process.

• On the Installation Path page, be sure to browse through the mapped drive to the directory 
you created in Step 3 above. Be sure that Install as Windows Services is selected.

• On the Domains / Post Offices page, click Add for each domain and post office that the 
agents will service. In the Path to Database field, be sure to browse through the drive you 
mapped in Step 1 above to the domain directory or the post office directory on the shared 
disk. 

• On the Installation Complete page, do not select Launch GroupWise Agents Now. 
6 If you need to install the agent software to c:\grpwise on each node in the cluster, repeat 

Step 4 and Step 5, mapping a drive to each node in the cluster.
or
If you installed the agent software to a shared disk and need only to set up the agents as 
Windows services on each node, repeat Step 4 and Step 5, mapping drives to new nodes as 
needed. On the Installation Options page, select only the Install as Windows Services option to 
speed up the installation process for each node.

7 If you installed the agent software to each node and you selected Yes for Consolidate Startup 
Files? (under Agent Clustering Worksheet item 1), copy one complete set of agent startup files 
to the planned location on the shared disk, then delete all agent startup files from the 
c:\grpwise directories on the nodes to avoid future confusion. 

8 Continue with “Editing Clustered Agent Startup Files” on page 239.

26.5.2  Editing Clustered Agent Startup Files
By default, the Agent Installation program creates agent startup files in the agent installation 
directory. Each MTA startup file is named after the domain it services, with a .mta extension. Each 
POA startup file is named after the post office it services, with a .poa extension.

Because you mapped a drive to the shared disk of the GroupWise resource group using the physical 
disk and file share information from the resource group, the setting for the MTA /home startup 
switch and the POA /home startup switch are always correct, no matter which node in the cluster the 
domain and post office are currently active on.
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One manual modification of POA startup files is required for robust functionality in a Microsoft 
cluster. Uncomment the /ip startup switch and provide the IP address of the post office resource 
group (Agent Clustering Worksheet item 7). This information is available to the POA in its 
eDirectory object properties. However, in some failover situations, the POA reconnects to the MTA 
more quickly when the information is immediately available to the POA in its startup file.

If the POA needs to access a remote document storage area that is outside the cluster, add the /user 
and /password startup switches (under System Clustering Worksheet item 9) in order to provide a 
user name and password that the POA can use to access the server where the document storage area 
resides. As an alternative to startup switches, you can assign the POA object all rights except 
Supervisor and Access control, as long as the remote document storage area is located in the same 
tree with the post office.

Continue with Section 26.6, “Testing Your Clustered GroupWise System,” on page 240.

26.5.3  Setting Up New Instances of the Agents without 
Installing the Agent Software
To set up new instances of the agents without installing the agent software, you simply create new 
startup files. Each MTA startup file is named after the domain it services, with a .mta extension. 
Each POA startup file is named after the post office it services, with a .poa extension.

If the existing agent software is located in the drive:\grpwise directory of a shared disk with a 
domain or post office, the startup files are located there as well. If the existing agent software is 
located in the c:\grpwise directory on each node in the cluster, the startup files might be located 
there, or they might be located on the shared disk with the domain or post office.

To create a new startup file without installing the agent software:
1 Make a copy of an existing startup file and name it after the domain or post office that will be 

serviced by the new instance of the agent.
2 Edit the setting of the /home startup switch to point to the location of the new domain directory 

or post office directory. Be careful to maintain the syntax of the original line, using the physical 
disk and file share provided in the GroupWise resource group.

3 Scroll down through the startup file looking for other active (not commented out) startup 
switches, then modify them as needed for the new instance of the agent.

4 Save the new startup file.
5 Continue with Section 26.6, “Testing Your Clustered GroupWise System,” on page 240.

26.6  Testing Your Clustered GroupWise System
After you have configured the GroupWise resource group, you can test the failover and failback 
functionality by bringing the GroupWise resource group online and taking it offline again.

Continue with Section 26.7, “Managing Your Clustered GroupWise System,” on page 240.

26.7  Managing Your Clustered GroupWise 
System
After you have set up a basic clustered GroupWise system, you should consider some long-term 
management issues.
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• “Updating GroupWise Objects with Cluster-Specific Descriptions” on page 241
• “Knowing What to Expect in MTA and POA Failover Situations” on page 242

26.7.1  Updating GroupWise Objects with Cluster-Specific 
Descriptions
After setting up your clustered GroupWise system, while the cluster-specific information is fresh in 
your mind, you should record that cluster-specific information as part of the GroupWise objects in 
ConsoleOne so that you can easily refer to it later. Be sure to keep the information recorded in the 
GroupWise objects up to date if the configuration of your system changes.

• “Recording Cluster-Specific Information for a Domain and Its MTA” on page 241
• “Recording Cluster-Specific Information for a Post Office and Its POA” on page 241
• “Recording Cluster-Specific Information for a Software Distribution Directory” on page 242

Recording Cluster-Specific Information for a Domain and Its MTA

To permanently record important cluster-specific information for the domain:
1 In ConsoleOne, browse to and right-click the Domain object, then click Properties.
2 In the Description field of the domain Identification page, provide a cluster-specific description 

of the domain, including the resource group IP address and the cluster-unique port numbers 
used by its MTA. 

3 Click OK to save the domain description.
4 Select the Domain object to display its contents.
5 Right-click the MTA object, then click Properties.
6 In the Description field of the MTA Identification page, record the domain resource group IP 

address and the cluster-unique port numbers used by the MTA. 
This information appears on the MTA console, no matter which node in the cluster it is 
currently running on.

7 Click OK to save the MTA description.
8 Continue with “Recording Cluster-Specific Information for a Post Office and Its POA” on 

page 241.

Recording Cluster-Specific Information for a Post Office and Its POA

To permanently record important cluster-specific information for a post office:
1 In ConsoleOne, browse to and right-click the Post Office object, then click Properties.
2 In the Description field of the post office Identification page, provide a cluster-specific 

description of the post office, including the resource group IP address and the cluster-unique 
port numbers used by its POA. 

3 Click OK to save the post office description.
4 Select the Post Office object to display its contents.
5 Right-click the POA object, then click Properties.
6 In the Description field of the POA Identification page, record the post office resource group IP 

address and the cluster-unique port numbers used by the POA. 
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This information appears on the POA console, no matter which node in the cluster it is 
currently running on.

7 Click OK to save the POA description.
8 If necessary, continue with “Recording Cluster-Specific Information for a Software 

Distribution Directory” on page 242.
or
Continue with “Knowing What to Expect in MTA and POA Failover Situations” on page 242.

Recording Cluster-Specific Information for a Software Distribution Directory

To permanently record important cluster-specific information about a software distribution directory 
located on a shared disk:

1 In ConsoleOne, click Tools > System Operations > Software Directory Management.
2 Select the software distribution directory, then click Edit.
3 In the Description field, record the IP address of the cluster resource where the software 

distribution directory resides. 
4 Click OK, then click Close to save the software distribution directory description.
5 Continue with “Knowing What to Expect in MTA and POA Failover Situations” on page 242.

26.7.2  Knowing What to Expect in MTA and POA Failover 
Situations
In a failover situation, the agents might need to perform some database repair as they start on the 
new node. The time required depends on the size of the databases involved. 

Typically, the POA returns to full functionality faster than the MTA. This benefits GroupWise client 
users, who can reconnect to their mailboxes very quickly and probably do not notice if messages to 
users in other post offices are not delivered immediately. The only time a user would need to restart 
the GroupWise client would be if he or she was actually in the process of sending a message when 
the POA went down. Notify can continue running even if the connection to the POA becomes 
unavailable and then it reconnects automatically when the POA is again available.

The MTA typically takes some time reestablishing the links to its post offices, other domains, and 
gateways, but this situation usually resolves itself in a few minutes without administrator 
intervention. If it does not, you can manually restart the MTA to speed up the process. 

In comparison to failover, manual migration typically takes longer because the agents methodically 
terminate their threads and close their databases as part of their normal shutdown procedure. 
However, as a result, no database repair is required when the agents start up again in their new 
location.

Continue with Section 3.8, “What’s Next,” on page 60.

26.8  What’s Next
Now that you have at least one GroupWise domain and post office up and running in your Microsoft 
cluster, you are ready to proceed with the rest of your GroupWise system setup by:

• Adding users to post offices. See “Users” in the GroupWise 7 Administration Guide.
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• Setting up the GroupWise client software and helping users to get started using it. See “Client” 
in the GroupWise 7 Administration Guide. Also see the GroupWise 7 Windows Client User 
Guide.

• Connecting your clustered GroupWise system to the Internet. See Chapter 4, “Implementing 
the Internet Agent in a NetWare Cluster,” on page 65.

• Providing access to users’ GroupWise mailboxes from their Web browsers. See Chapter 5, 
“Implementing WebAccess in a NetWare Cluster,” on page 83.

• Connecting your clustered GroupWise system to other e-mail systems through GroupWise 
gateways. See Chapter 6, “Implementing GroupWise Gateways in a Novell Cluster,” on 
page 103. 

• Monitoring the status of your clustered GroupWise system from your Web browser. See 
Chapter 7, “Monitoring a GroupWise System in a NetWare Cluster,” on page 105.

• Backing up your clustered GroupWise system. See Chapter 8, “Backing Up a GroupWise 
System in a NetWare Cluster,” on page 107.
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27Implementing the Internet Agent in 
a Microsoft Cluster

You should already have set up at least a basic GroupWise® system, as described in Chapter 25, 
“Planning GroupWise in a Microsoft Cluster,” on page 217 and Chapter 26, “Setting Up a Domain 
and Post Office in a Microsoft Cluster,” on page 233. As part of this process, the “System Clustering 
Worksheet” on page 228 and the “Network Address Worksheet” on page 230 were filled out. If you 
do not have access to the filled-out worksheets, print the worksheets now and fill in the clustering 
and network address information as it currently exists on your system. You need this information as 
you implement the Internet Agent in a cluster.

• Section 27.1, “Planning the Internet Agent in a Cluster,” on page 245
• Section 27.2, “Setting Up the Internet Agent in a Cluster,” on page 248
• Section 27.3, “Managing the Internet Agent in a Cluster,” on page 252
• Section 27.4, “Internet Agent Clustering Worksheet,” on page 253

27.1  Planning the Internet Agent in a Cluster
A main system configuration difference between a GroupWise system in a clustering environment 
and a GroupWise system in a regular environment is that you need to create a separate domain to 
house each GroupWise gateway, including the Internet Agent. The Internet Agent is faster and more 
stable when it runs on the same server with its domain. In a cluster, creating a separate domain for 
the Internet Agent ensures that the Internet Agent and its domain always fail over together.

Section 27.4, “Internet Agent Clustering Worksheet,” on page 253 lists all the information you need 
as you set up the Internet Agent in a Microsoft cluster. You should print the worksheet and fill it out 
as you complete the tasks listed below:

• “Planning a Domain for the Internet Agent” on page 245
• “Planning the Internet Agent Resource Group” on page 246
• “Planning Cluster-Unique Port Numbers for the Internet Agent and Its MTA” on page 246
• “Preparing Your Firewall for the Internet Agent” on page 247
• “Deciding Where to Install the Internet Agent and Its MTA” on page 247
• “Planning the MTA Installation” on page 248
• “Planning the Internet Agent Installation” on page 248

27.1.1  Planning a Domain for the Internet Agent
The considerations involved in planning a domain for the Internet Agent are much the same as 
planning any other domain. In preparation, review “Planning a New Domain”, then print and fill out 
the “Domain Worksheet” in “Domains” in the GroupWise 7 Administration Guide. 

Keep in mind the following cluster-specific details:
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• When you specify the location for the domain directory on the Domain Worksheet, include the 
shared disk where you want the domain directory to be located.

• Do not concern yourself with the GroupWise agent information on the Domain Worksheet. You 
can stop with item 10. You will plan the MTA installation later.

When you have completed the Domain Worksheet, transfer the key information from the Domain 
Worksheet to the Internet Agent Clustering Worksheet.

27.1.2  Planning the Internet Agent Resource Group
The Internet Agent resource group is similar to the GroupWise resource groups you have already set 
up, as described in Section 25.5, “Planning GroupWise Resource Groups,” on page 220 and 
“Creating GroupWise Resource Groups” on page 233. The Internet Agent resource group contains a 
domain whose only role is to connect the Internet Agent into your clustered GroupWise system. It 
also contains two agent service resources, one for the MTA that services the domain and one for the 
Internet Agent.

To ensure successful short name resolution, add entries for the Internet Agent network name to 
support your preferred methods of short name resolution, as described in “Configuring Short Name 
Resolution” on page 233.

27.1.3  Planning Cluster-Unique Port Numbers for the Internet 
Agent and Its MTA
As with the MTA and the POA, the Internet Agent needs cluster-unique port numbers. As part of 
planning to install the MTA and POA, you should already have determined the resource group IP 
address and cluster-unique port numbers for the Internet Agent and its MTA as you filled out the 
“Network Address Worksheet” on page 230. If you do not have a filled-out copy of this worksheet 
for your system, print it now and fill in current system information.

INTERNET AGENT CLUSTERING WORKSHEET

Under Item 1: Resource Group for Internet Agent, transfer the disk drive to the Internet Agent 
Clustering Worksheet. 

Under Item 2: Internet Agent Domain Name, transfer the domain name and directory to the Internet 
Agent Clustering Worksheet. 

INTERNET AGENT CLUSTERING WORKSHEET

Under Item 1: Resource Group for Internet Agent, specify the network name and other required 
information for the Internet Agent resource group. 
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27.1.4  Preparing Your Firewall for the Internet Agent
The Internet Agent receives incoming messages on the IP address of the Internet Agent resource 
group. Your firewall configuration must be modified to allow inbound TCP/IP traffic from the 
Internet to the Internet Agent IP address on the following standard ports:

Table 27-1   Standard Ports

By default, the Internet Agent sends outgoing messages on the IP address of the node where it is 
running. If you decide to use this default configuration, your firewall must be configured to allow 
outbound TCP/IP traffic from all nodes on the Internet Agent resource group’s possible owners list.

If the Internet Agent has a large number of nodes in its possible owners list, you could configure the 
Internet Agent to send outgoing messages to a relay host, which would then send them out through 
the firewall using its own IP address rather than the IP address of the particular node where the 
Internet Agent is running. This reduces the amount of modification to your firewall required to set 
up the Internet Agent. However, if the relay host goes down, all outgoing messages are delayed.

As another alternative, you can configure the Internet Agent to use its resource group IP address for 
sending as well as receiving messages. Setup instructions for this configuration are provided in 
“Forcing Use of the Internet Agent Secondary IP Address” on page 77, which you can complete 
after installing the Internet Agent.

In preparation for installing the Internet Agent, configure your firewall as needed to handle the 
Internet Agent’s use of node and resource group IP addresses when sending and receiving messages.

27.1.5  Deciding Where to Install the Internet Agent and Its MTA
The default Internet Agent installation directory is c:\grpwise\gwia. As with the MTA and the 
POA, you can choose to install the Internet Agent and its MTA to each node in the cluster or to the 
shared disk of the Internet Agent resource group. For a discussion of these alternatives, see 
“Deciding Where to Install the Agent Software” on page 225, which describes the issues in the 

INTERNET AGENT CLUSTERING WORKSHEET

Under Item 5: MTA Network Information, transfer the resource group IP address and cluster-unique 
port numbers from the Internet Agent section of the Network Address Worksheet to the Internet Agent 
Clustering Worksheet. 

Under Item 7: Internet Agent Network Information, transfer the resource group IP address (the same 
as for its MTA) and the cluster-unique Internet Agent port number from the Internet Agent section of 
the Network Address Worksheet to the Internet Agent Clustering Worksheet.

Protocol Standard Port

IMAP4 143

LDAP 389

POP3 110

SMTP 25
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context of planning MTA and POA installations. As with the MTA and POA, the Internet Agent and 
its MTA must be installed as Windows services.

27.1.6  Planning the MTA Installation
Follow the instructions in “Planning the Windows Agent Installation” on page 227 to plan the MTA 
installation for the Internet Agent domain, then return to this point. After you follow the 
instructions, you will have a filled-out Windows Agent Worksheet to use when you install the MTA.

IMPORTANT: Do not install the Windows MTA until you are instructed to do so in Section 27.2, 
“Setting Up the Internet Agent in a Cluster,” on page 248.

27.1.7  Planning the Internet Agent Installation
Aside from the cluster-specific issues discussed in the preceding sections, the considerations 
involved in planning to install the Internet Agent are the same in a Microsoft cluster as for any other 
environment. Review “NetWare and Windows: Installing the Internet Agent Software”, then print 
and fill out the “GroupWise Internet Agent Installation Worksheet” in “Installing the GroupWise 
Internet Agent” in the GroupWise 7 Installation Guide. You need this information as you install the 
Internet Agent in your cluster.

IMPORTANT: Do not install the Internet Agent software until you are instructed to do so in 
Section 27.2, “Setting Up the Internet Agent in a Cluster,” on page 248.

27.2  Setting Up the Internet Agent in a Cluster
You should already have reviewed Section 27.1, “Planning the Internet Agent in a Cluster,” on 
page 245 and filled out Section 27.4, “Internet Agent Clustering Worksheet,” on page 253. You are 
now ready to complete the following tasks to set up the Internet Agent in a Microsoft cluster:

• “Setting Up the Internet Agent Resource Group” on page 248
• “Creating a Domain for the Internet Agent” on page 249
• “Installing the MTA for the Internet Agent Domain” on page 249
• “Installing and Configuring the Internet Agent in a Cluster” on page 249
• “Testing the Clustered Internet Agent” on page 252

27.2.1  Setting Up the Internet Agent Resource Group
1 Create the Internet Agent resource group and agent services resources (Internet Agent 

Clustering Worksheet item 1), as planned in “Planning the Internet Agent Resource Group” on 
page 246.

INTERNET AGENT CLUSTERING WORKSHEET

Under Item 4: MTA Installation Location and Item 6: Internet Agent Installation Location, mark whether 
you will install the Internet Agent and its MTA to the shared disk of the Internet Agent resource group 
or to each node in the cluster. If necessary, specify where the MTA startup file and the Internet Agent 
configuration file (gwia.cfg) will be stored.
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2 To ensure successful short name resolution, add entries for the Internet Agent network name to 
support your preferred methods of short name resolution, as described in “Configuring Short 
Name Resolution” on page 233.

3 To ensure that the Internet Agent has incoming and outgoing access to the Internet, make sure 
your firewall is properly configured, as described in “Preparing Your Firewall for the Internet 
Agent” on page 247.

4 Continue with “Creating a Domain for the Internet Agent” on page 70.

27.2.2  Creating a Domain for the Internet Agent
The Internet Agent domain will be a secondary domain. To create it, follow the instructions in 
Section 26.3, “Creating a New Secondary Domain in a Cluster,” on page 235, taking your 
information from the Internet Agent Clustering Worksheet, rather than the System Clustering 
Worksheet, then return to this point. 

Do not create any post offices in the Internet Agent domain.

Continue with “Installing the MTA for the Internet Agent Domain” on page 249.

27.2.3  Installing the MTA for the Internet Agent Domain
The MTA for the Internet Agent domain can be installed just like any other MTA in your clustered 
GroupWise system. Follow the instructions in “Installing the Agent Software in a Cluster” on 
page 238, then return to this point. 

You do not need to edit the MTA startup file. 

Continue with “Installing and Configuring the Internet Agent in a Cluster” on page 249.

27.2.4  Installing and Configuring the Internet Agent in a Cluster
After you have created a domain for the Internet Agent and installed the MTA for that domain, you 
are ready to install and configure the Internet Agent.

• “Installing and Configuring the Internet Agent in a Cluster” on page 249
• “Enabling Internet Addressing for Your Clustered GroupWise System” on page 250
• “Verifying GWIA Object Properties” on page 250

Installing the Internet Agent Software in a Cluster
1 Map a drive to the shared disk of the Internet Agent resource group (Internet Agent Clustering 

Worksheet item 1).
2 Map a drive to c:\ on the first node in the cluster where you will set up the Internet Agent as a 

Windows service (System Clustering Worksheet item 2).
3 If you plan to install the Internet Agent software to the shared disk of the Internet Agent 

resource group (Internet Agent Clustering Worksheet item 6), create the 
drive:\grpwise\gwia directory on the shared disk accessed in Step 1.
or
If you plan to install the Internet Agent software to each node in the cluster, create the 
c:\grpwise\gwia directory on the drive accessed in Step 2).
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4 Start the Internet Agent Installation program, following the steps provided in “NetWare and 
Windows: Installing the Internet Agent Software” in “Installing the GroupWise Internet Agent” 
in the GroupWise 7 Installation Guide.

5 Install the Windows Internet Agent, keeping in mind the following cluster-specific details:

• Use the Windows Internet Agent Clustering Worksheet that you filled out in “Planning the 
Internet Agent Installation” on page 69 to fill in the fields during the Internet Agent 
installation process. 

• On the Installation Path page, be sure to browse through the mapped drive to the directory 
you created in Step 3 above. Be sure that Run WebAccess Agent as a Windows Service is 
selected.

• On the GroupWise Domain page, be sure to browse through the drive you mapped in 
Step 1 to the domain directory on the shared disk. 

• On the Post Installation Task List page, deselect Launch Internet Agent Now so that the 
Installation program does not start the Internet Agent after installation is complete.

6 Repeat Step 4 and Step 5, mapping a drive to each node in the cluster.
Even if you installed the Internet Agent software to a shared disk, you need to repeat the 
installation process for each node so that the Internet Agent gets set up as a Windows service on 
each node.

7 If you installed the software to each node in the cluster and you selected Yes for Consolidate 
Configuration Files? (under Internet Agent Clustering Worksheet item 6), copy the 
gwia.cfg file to the planned location on the shared disk, then delete it from the 
c:\grpwise\gwia directory on each node to avoid future confusion.

8 Make sure you have completed all the tasks described in “Installing the GroupWise Internet 
Agent” in the GroupWise 7 Installation Guide. 

9 Continue with “Enabling Internet Addressing for Your Clustered GroupWise System” on 
page 250.

Enabling Internet Addressing for Your Clustered GroupWise System

Setting up Internet addressing for a clustered Internet Agent is no different from setting it up for an 
Internet Agent in a any other environment. Follow the instructions in “Enabling Internet 
Addressing” in “System” in the GroupWise 7 Administration Guide, then continue with “Verifying 
GWIA Object Properties” on page 250.

Verifying GWIA Object Properties

During installation of the Internet Agent, the GWIA object should have been configured correctly. 
However, it can be helpful to verify certain cluster-specific information in order to familiarize 
yourself with the configuration of a clustered Internet Agent.

• “Accessing GWIA Object Properties” on page 251
• “Verifying the Reference to the Network Name for Use by DNS” on page 251
• “Verifying the Reference to the Network Name in Directory Paths” on page 251
• “Verifying Post Office Links” on page 251
• “Forcing Use of the Internet Agent Resource Group IP Address” on page 251
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Accessing GWIA Object Properties
1 In ConsoleOne®, browse to and select the Internet Agent domain in order to display its 

contents.
2 Right-click the GWIA object, then click Properties.
3 Continue with “Verifying the Reference to the Volume Resource” on page 76.

Verifying the Reference to the Network Name for Use by DNS

In the GWIA object properties page tabs:
1 Click SMTP/MIME > Settings. 
2 Verify the contents of the Hostname/DNS “A Record” Name field.

It displays the hostname as currently configured in DNS. It should match the network name of 
the domain resource group, not the name of a node in the cluster.

3 Make changes if necessary.
4 Continue with “Verifying the Reference to the Network Name in Directory Paths” on page 251.

Verifying the Reference to the Network Name in Directory Paths

In the GWIA object properties page tabs:
1 Click Server Directories. 
2 Verify that the displayed directories match the network name of the domain resource group, not 

the name of a node in the cluster.
3 Make changes if necessary.
4 Continue with “Verifying Post Office Links” on page 251.

Verifying Post Office Links

In the GWIA object properties page tabs:
1 Click Post Office Links.
2 Verify that the Access Mode column displays C/S (for client/server mode) for all post offices 

serviced by the clustered Internet Agent.
3 Verify that the Links column displays the IP addresses of the post office resource groups, not 

the IP addresses of any nodes in the cluster.
4 Make changes if necessary.
5 Continue with “Forcing Use of the Internet Agent Resource Group IP Address” on page 251.

Forcing Use of the Internet Agent Resource Group IP Address

If you want the Internet Agent to send outgoing messages on its resource group IP address, rather 
than using the default the node IP address:

1 Click GroupWise > Network Address.
2 In the TCP/IP Address field, provide the resource group IP address (under Internet Agent 

Clustering Worksheet item 1) for the Internet Agent to use for sending outgoing messages.
3 Click SMTP/MIME, then click Settings.
4 Select Bind to TCIP/IP Address at Connection Time.
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5 Click OK.
6 Continue with “Testing the Clustered Internet Agent” on page 252.

27.2.5  Testing the Clustered Internet Agent
After you have set up the Internet Agent resource group, you can test it by manually bringing it 
online and taking it offline again.

Continue with Section 27.3, “Managing the Internet Agent in a Cluster,” on page 252

27.3  Managing the Internet Agent in a Cluster
After you have installed the Internet Agent in a cluster, you should consider some long-term 
management issues.

• “Updating GroupWise Objects with Cluster-Specific Descriptions” on page 252
• “Knowing What to Expect in an Internet Agent Failover Situation” on page 253.

27.3.1  Updating GroupWise Objects with Cluster-Specific 
Descriptions
After installing the Internet Agent in your clustered GroupWise system, while the cluster-specific 
information is fresh in your mind, you should record that cluster-specific information as part of the 
GroupWise objects in ConsoleOne so that you can easily refer to it later. Be sure to update the 
information recorded in the GroupWise objects if the configuration of your system changes.

• “Recording Cluster-Specific Information about the Internet Agent Domain and Its MTA” on 
page 252

• “Recording Cluster-Specific Information about the Internet Agent” on page 253

Recording Cluster-Specific Information about the Internet Agent Domain and Its MTA

To permanently record important cluster-specific information for the Internet Agent domain:
1 In ConsoleOne, browse to and right-click the Domain object, then click Properties.
2 In the Description field of the Internet Agent domain Identification page, provide a cluster-

specific description of the Internet Agent domain, including its resource group IP address and 
the cluster-unique port numbers used by its MTA. 

3 Click OK to save the Internet Agent domain description.
4 Select the Internet Agent Domain object to display its contents.
5 Right-click the MTA object, then click Properties.
6 In the Description field of the MTA Identification page, record the domain resource group IP 

address and the cluster-unique port numbers used by the MTA. 
This information appears on the MTA console, no matter which node in the cluster it is 
currently running on.

7 Click OK to save the MTA description.
8 Continue with “Recording Cluster-Specific Information about the Internet Agent” on page 253.
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Recording Cluster-Specific Information about the Internet Agent

With the contents of the Internet Agent domain still displayed:
1 Right-click the GWIA object, then click Properties.
2 Click GroupWise, then click Identification.
3 In the Description field, record the resource group IP address and the cluster-unique port 

numbers used by the Internet Agent. 
This information appears on the Internet Agent console, no matter which node in the cluster it 
is currently running on.

4 Click OK to save the Internet Agent information.
5 Continue with “Knowing What to Expect in an Internet Agent Failover Situation” on page 253.

27.3.2  Knowing What to Expect in an Internet Agent Failover 
Situation
The failover behavior of the MTA for the Internet Agent domain is the same as for an MTA in a 
regular domain. See “Knowing What to Expect in MTA and POA Failover Situations” on page 242.

Failover of the Internet Agent itself is more complex. The various e-mail clients (POP3, IMAP4, 
and LDAP) receive an error message when the server they were connected to becomes unavailable. 
Most of the clients do not attempt to reconnect automatically, so the user must exit the e-mail client 
and restart it to reestablish the connection after the failover process is complete. Fortunately, the 
Internet Agent restarts quickly in its failover location so users can reconnect quickly.

As with the MTA and the POA, manual migration of the Internet Agent takes longer than failover. In 
fact, the Internet Agent can seem especially slow to shut down properly, as it finishes its normal 
processing and stops its threads. For a busy Internet Agent, you might need to wait several minutes 
for it to shut down properly when you are manually migrating it.

27.4  Internet Agent Clustering Worksheet

Item Explanation

1) Resource Group for Internet 
Agent:

Network name:
IP address:
Physical disk:
File share:
MTA service resource:
Internet Agent service resource:
Possible owners:

Specify the information for the Internet Agent resource group.

For more information, see “Planning the Internet Agent Resource 
Group” on page 246.

2) Internet Agent Domain Name:

Domain Directory:

Specify a unique name for the Internet Agent domain. Specify the 
directory on the physical disk that belongs to the Internet Agent 
resource group where you want to create the new domain.

For more information, see “Planning a Domain for the Internet Agent” 
on page 245.
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4) MTA Installation Location:

• Shared disk of the Internet 
Agent resource group

• Each node in the cluster

Consolidate MTA startup 
files?

Mark the location where you will install the MTA software. If 
necessary, specify the location where you will consolidate the MTA 
startup files from the various nodes where the Internet Agent is 
installed.

For more information, see “Deciding Where to Install the Internet 
Agent and Its MTA” on page 247.

5) MTA Network Information:

MTA IP address:
MTA message transfer port:
MTA live remote port:
MTA HTTP port

Gather the MTA network address information from the Internet Agent 
section of the “Network Address Worksheet” on page 230.

For more information, see “Planning Cluster-Unique Port Numbers for 
the Internet Agent and Its MTA” on page 246.

6) Internet Agent Installation 
Location:

• Shared disk in the Internet 
Agent resource group

• Each node in the cluster

Consolidate configuration 
files?

Mark the location where you will install the Internet Agent software. 

If necessary, specify the location on the shared disk of the Internet 
Agent resource group where you will consolidate the Internet Agent 
configuration files (gwia.cfg) from the various nodes where it is 
installed.

For more information, see “Deciding Where to Install the Internet 
Agent and Its MTA” on page 247.

7) Internet Agent Network 
Information:

Internet Agent IP address:
Internet Agent HTTP port:

Gather the Internet Agent network address information from the 
Internet Agent section of the “Network Address Worksheet” on 
page 230.

For more information, see “Planning Cluster-Unique Port Numbers for 
the Internet Agent and Its MTA” on page 246.

Item Explanation
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28Implementing WebAccess in a 
Microsoft Cluster

You should already have set up at least a basic GroupWise® system, as described in Chapter 25, 
“Planning GroupWise in a Microsoft Cluster,” on page 217 and Chapter 26, “Setting Up a Domain 
and Post Office in a Microsoft Cluster,” on page 233. As part of this process, the “System Clustering 
Worksheet” on page 228 and the “Network Address Worksheet” on page 230 were filled out. If you 
do not have access to the filled-out worksheets, print the worksheets now and fill in the clustering 
and network address information as it currently exists on your system. You will need this 
information as you implement WebAccess in a cluster.

• Section 28.1, “Understanding the WebAccess Components,” on page 255
• Section 28.2, “Planning WebAccess in a Cluster,” on page 255
• Section 28.3, “Setting Up WebAccess in a Cluster,” on page 259
• Section 28.4, “Managing WebAccess in a Cluster,” on page 262
• Section 28.5, “WebAccess Clustering Worksheet,” on page 264

28.1  Understanding the WebAccess 
Components
If you are not familiar with GroupWise WebAccess, review “GroupWise WebAccess Overview” in 
“Installing GroupWise WebAccess” in the GroupWise 7 Installation Guide.

As you plan WebAccess in a clustering environment, you must keep in mind that you will plan and 
set up two separate WebAccess components: 

• WebAccess Agent (gwinter.exe) that will be associated with a GroupWise WebAccess 
domain

• WebAccess Application (a Java servlet) that will be added to your Web server 

28.2  Planning WebAccess in a Cluster
A main system configuration difference between a GroupWise system in a clustering environment 
and a GroupWise system in a regular environment is that you need to create a separate domain to 
house each GroupWise gateway, including the WebAccess Agent. The WebAccess Agent is faster 
and more stable when it runs on the same server with its domain. In a cluster, creating a separate 
domain for the WebAccess Agent ensures that the WebAccess Agent and its domain always fail over 
together.

Section 28.5, “WebAccess Clustering Worksheet,” on page 264 lists all the information you need as 
you set up the WebAccess Agent and the WebAccess Application in a clustering environment. You 
should print the worksheet and fill it out as you complete the tasks listed below:

• “Setting Up the Netscape Enterprise Web Server for NetWare in a Cluster on NetWare 6” on 
page 84

• “Planning a New Domain for the WebAccess Agent” on page 256
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• “Planning the WebAccess Resource Group” on page 257
• “Planning Cluster-Unique Port Numbers for the WebAccess Agent and Its MTA” on page 257
• “Deciding Where to Install the WebAccess Agent and Its MTA” on page 258
• “Planning the MTA Installation” on page 258
• “Planning the WebAccess Installation” on page 258

28.2.1  Setting Up Your Web Server in the Microsoft cluster
Before you install WebAccess, your Web server must already be set up and running in the cluster. 
Make sure that it can fail over and fail back successfully.

As you set up your Web server, record the following key configuration information on the 
WebAccess Clustering Worksheet:

Because the WebAccess Application is installed to a subdirectory of the Web server installation 
directory (directory\com\novell\webaccess), the WebAccess Application cannot be 
installed on a shared disk. Instead, you will install it to each node in the cluster where the Web server 
has been installed.

28.2.2  Planning a New Domain for the WebAccess Agent
The considerations involved in planning a domain for the WebAccess Agent are much the same as 
planning any other domain. In preparation, review “Planning a New Domain”, then print and fill out 
the “Domain Worksheet” in “Domains” in the GroupWise 7 Administration Guide. 

Keep in mind the following cluster-specific details:

• When you specify the location for the domain directory on the Domain Worksheet, include the 
physical disk in your shared disk system where you want the domain directory to be located.

• Do not concern yourself with the GroupWise agent information on the Domain Worksheet. You 
can stop with item 10. You will plan the MTA installation later.

When you have completed the Domain Worksheet, transfer the key information from the Domain 
Worksheet to the WebAccess Clustering Worksheet.

WEBACCESS CLUSTERING WORKSHEET

Under Item 7: Physical Web Servers, list the nodes in the cluster where you are installing the Web 
server software.

Under Item 8: Web Server IP Address, record the secondary IP address of the Web server resource 
that you create. 

Under Item 9: Hardware Virtual Server Information, record the dedicated IP address for the Web site 
and the document root directory.
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28.2.3  Planning the WebAccess Resource Group
The WebAccess resource group is similar to the domain and post office resource groups you have 
already set up, as described in Section 25.5, “Planning GroupWise Resource Groups,” on page 220 
and “Creating GroupWise Resource Groups” on page 233. The WebAccess resource group contains 
a domain whose only role is to connect the WebAccess Agent into your clustered GroupWise 
system. It also contains two agent service resources, one for the MTA that services the domain and 
one for the WebAccess Agent.

To ensure successful short name resolution, add entries for the WebAccess network name to support 
your preferred methods of short name resolution, as described in “Configuring Short Name 
Resolution” on page 233.

28.2.4  Planning Cluster-Unique Port Numbers for the 
WebAccess Agent and Its MTA
As with the MTA and the POA, the WebAccess Agent needs cluster-unique port numbers. As part of 
planning to install the MTA and POA, you should already have determined the IP address and 
cluster-unique port numbers for the WebAccess Agent and its MTA as you filled out “Network 
Address Worksheet” on page 230. If you do not have a filled-out copy of this worksheet for your 
system, print it now and fill in current system information.

WEBACCESS CLUSTERING WORKSHEET

Under Item 1: Resource Group for WebAccess Agent, transfer the shared disk from the Domain 
Worksheet to the WebAccess Clustering Worksheet. 

Under Item 2: WebAccess Agent Domain Name, transfer the domain name and directory from the 
Domain Worksheet to the WebAccess Clustering Worksheet. 

WEBACCESS CLUSTERING WORKSHEET

Under Item 1: Resource Group for WebAccess, specify the network name and other required 
information for the WebAccess resource group. 

WEBACCESS CLUSTERING WORKSHEET

Under Item 1: Resource Group for WebAccess, transfer the WebAccess resource group IP address.

Under Item 4: MTA Network Information, transfer the cluster-unique MTA port numbers from the 
WebAccess section of the Network Address Worksheet to the WebAccess Clustering Worksheet. 

Under Item 6: WebAccess Agent Network Information, transfer the cluster-unique WebAccess Agent 
port number from the WebAccess section of the Network Address Worksheet to the WebAccess 
Clustering Worksheet.
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28.2.5  Deciding Where to Install the WebAccess Agent and Its 
MTA
As with the MTA and the POA, you can choose to install the WebAccess Agent and its MTA to each 
node in the cluster or to the shared disk of the WebAccess resource group. For a discussion of these 
alternatives, see “Deciding Where to Install the Agent Software” on page 225, which describes the 
issues in the context of planning MTA and POA installations. 

28.2.6  Planning the MTA Installation
Follow the instructions in “Planning the MTA Installation” on page 258, then return to this point. 
After you follow the instructions, you will have a filled-out Windows Agent Worksheet to use when 
you install the MTA.

IMPORTANT: Do not install the Windows MTA until you are instructed to do so in Section 28.3, 
“Setting Up WebAccess in a Cluster,” on page 259.

28.2.7  Planning the WebAccess Installation
Aside from the cluster-specific issues discussed in the preceding sections, the considerations 
involved in planning to install WebAccess are the same in a clustering environment as for any other 
environment. Review “Planning GroupWise WebAccess”, then print and fill out the “GroupWise 
WebAccess Installation Worksheet” in “Installing GroupWise WebAccess” in the GroupWise 7 
Installation Guide. When you set up WebAccess in a cluster, you will install the WebAccess Agent 
and the WebAccess Application in two separate steps:

• “Planning the WebAccess Agent Installation” on page 258
• “Planning the WebAccess Application Installation” on page 259

IMPORTANT: Do not install the WebAccess software until you are instructed to do so in Section 
28.3, “Setting Up WebAccess in a Cluster,” on page 259.

Planning the WebAccess Agent Installation

For the WebAccess Agent, fill out items 2 through 12 on the GroupWise WebAccess Installation 
Worksheet, taking into account the following cluster-specific issues:

WEBACCESS CLUSTERING WORKSHEET

Under Item 3: MTA Installation Location and Item 5: WebAccess Agent Installation Location, mark 
whether you will install the WebAccess Agent and its MTA to each node in the cluster or to the shared 
disk of the WebAccess resource group. Also specify where the MTA startup file will be stored.
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Planning the WebAccess Application Installation

For the WebAccess Application, fill out items 13 through 19 on the GroupWise WebAccess 
Installation Worksheet, taking into account the following cluster-specific issues:

28.3  Setting Up WebAccess in a Cluster
You should already have reviewed “Planning GroupWise in a Microsoft Cluster” on page 217 and 
filled out the Section 28.5, “WebAccess Clustering Worksheet,” on page 264. You are now ready to 
complete the following tasks to set up the WebAccess Agent in a clustering environment:

• “Setting Up the WebAccess Resource Group” on page 259
• “Creating a Domain for the WebAccess Agent” on page 89
• “Installing the MTA for the WebAccess Agent Domain” on page 89
• “Installing and Configuring the WebAccess Agent in a Cluster” on page 89
• “Installing and Configuring the WebAccess Application in a Cluster” on page 95
• “Testing Your Clustered WebAccess Installation” on page 96
• Section 5.4, “Managing WebAccess in a Cluster,” on page 97

28.3.1  Setting Up the WebAccess Resource Group
1 Create the WebAccess resource group and agent services resources (WebAccess Clustering 

Worksheet item 1), as planned in “Planning the WebAccess Resource Group” on page 257.
2 To ensure successful short name resolution, add entries for the WebAccess Agent network 

name to support your preferred methods of short name resolution, as described in “Configuring 
Short Name Resolution” on page 233.

3 Continue with “Creating a Domain for the WebAccess Agent” on page 260.

WEBACCESS INSTALLATION WORKSHEET

Under Item 2: Installation Directory, take into account your decision recorded on the WebAccess 
Clustering Worksheet (Item 5: WebAccess Agent Installation Location).

Under Item 3: Server Address, transfer the IP address and port number from the WebAccess 
Clustering Worksheet (Item 6: WebAccess Agent Network Information) filled out in “Planning Cluster-
Unique Port Numbers for the WebAccess Agent and Its MTA” on page 257.

Under Item 5: Domain Directory Path, transfer the domain directory from the Domain Worksheet you 
filled out in “Planning a New Domain for the WebAccess Agent” on page 256.

WEBACCESS INSTALLATION WORKSHEET

Under Item 13: Web Server Type and Root Directory, mark the Web server you have installed in your 
cluster and specify the Web server root directory.

Under Item 16: Novell Root Directory, specify a directory on the Web server where you want to install 
the WebAccess Agent configuration file. the default is c:\novell
Implementing WebAccess in a Microsoft Cluster 259



260 GroupWise 

novdocx (E
N

U
)  6 D

ecem
ber 2005
28.3.2  Creating a Domain for the WebAccess Agent
The WebAccess Agent domain will be a secondary domain. To create it, follow the instructions in 
Section 26.3, “Creating a New Secondary Domain in a Cluster,” on page 235, taking your 
information from the WebAccess Clustering Worksheet, rather than the System Clustering 
Worksheet, then return to this point. 

Do not create any post offices in the WebAccess Agent domain.

Continue with “Installing the MTA for the WebAccess Agent Domain” on page 260.

28.3.3  Installing the MTA for the WebAccess Agent Domain
The MTA for the WebAccess Agent domain can be installed just like any other MTA in your 
clustered GroupWise system. Follow the instructions in “Installing the Agent Software in a Cluster” 
on page 238, then return to this point. 

You do not need to edit the MTA startup file.

Continue with “Installing the WebAccess Agent in a Cluster” on page 260.

28.3.4  Installing the WebAccess Agent in a Cluster
After you have created a domain for the WebAccess Agent and installed the MTA for that domain, 
you are ready to install and configure the WebAccess Agent. The WebAccess Agent is the 
component of your WebAccess installation that accesses post offices and libraries to retrieve 
information for WebAccess client users.

1 Map a drive to the shared disk of the WebAccess resource group (WebAccess Clustering 
Worksheet item 1).

2 Map a drive to c:\ on the first node in the cluster where you will set up the WebAccess Agent 
as a Windows service (System Clustering Worksheet item 2).

3 If you plan to install the WebAccess Agent software to the shared disk of the WebAccess 
resource group (WebAccess Clustering Worksheet item 5), create the 
drive:\grpwise\webacc directory on the WebAccess shared disk accessed in Step 1.
or
If you plan to install the WebAccess Agent software to each node in the cluster, create the 
c:\grpwise\webacc directory on the drive accessed in Step 2.

4 Start the WebAccess Installation program, following the steps provided in “Installing the 
WebAccess Agent” in “Installing GroupWise WebAccess” in the GroupWise 7 Installation 
Guide.

5 Install the Windows WebAccess Agent, keeping in mind the following cluster-specific details:

• On the Components page select only GroupWise WebAccess Agent.

Do not install the WebAccess Application at this time.
• Use items 2 through 12 on the GroupWise WebAccess Installation Worksheet that you 

filled out in “Planning the WebAccess Installation” on page 258 to fill in the fields during 
the WebAccess Agent installation process.

• On the Installation Path page, be sure to browse through the mapped drive to the 
installation directory you created in Step 3 above. 
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• On the Gateway Directory page, be sure to browse to the domain directory through the 
drive you mapped in Step 1 above. 

• On the Execution Options page, be sure that Run WebAccess Agent as a Windows Service 
is selected.

• On the Start Applications page, deselect Start the GroupWise WebAccess Agent.
6 Repeat Step 4 and Step 5, mapping a drive to each node in the cluster.

Even if you installed the WebAccess Agent software to a shared disk, you need to repeat the 
installation process for each node so that the Internet Agent gets set up as a Windows service on 
each node.

7 Make sure you have completed all the WebAccess Agent tasks described in “NetWare and 
Windows: Setting Up GroupWise WebAccess” in “Installing GroupWise WebAccess” in the 
GroupWise 7 Installation Guide, but do not start the WebAccess Agent at this time.

8 Continue with “Installing and Configuring the WebAccess Application in a Cluster” on 
page 261.

28.3.5  Installing and Configuring the WebAccess Application 
in a Cluster
Recall that the WebAccess Agent is the component of your WebAccess installation that accesses 
post offices and libraries to retrieve information for WebAccess client users. The WebAccess 
Application provides the link between the WebAccess Agent and the WebAccess clients’ Web 
browsers.

To install the WebAccess Application:
1 Map a drive to the shared disk of the WebAccess resource group (WebAccess Clustering 

Worksheet item 1) where the WebAccess domain is located.
2 Map a drive to the first Web server node where you want to install the WebAccess Application 

(WebAccess Clustering Worksheet item 7).
3 If the Web server node where you are going to install the WebAccess Application is currently 

running any applications that rely on Java or on the Web server, migrate those applications to 
another node in the cluster. If any GroupWise agents are running on the node, migrate the 
agents. 

4 Stop the Web server.
5 Start the WebAccess Installation program as you did when you installed the WebAccess Agent 

(Step 5 on page 260). Keep in mind the following cluster-specific details:

• On the Components page, select only GroupWise WebAccess Application.
• Use items 13 through 19 on the GroupWise WebAccess Installation Worksheet that you 

filled out in “Planning the WebAccess Installation” on page 258 to fill in the fields during 
the WebAccess Application installation process.

• On the Gateway Directory page, be sure to browse to the WebAccess gateway directory 
(domain\wpgate\webac70a) through the drive you mapped in Step 1 above. 

• On the Web Server Information page be sure to browse to the Web server root directory 
through the drive you mapped in Step 2 above. 

• On the Start Applications page, deselect Restart Web Server.
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6 Make sure you have completed all the WebAccess Application tasks described in “NetWare 
and Windows: Setting Up GroupWise WebAccess” in “Installing GroupWise WebAccess” in 
the GroupWise 7 Installation Guide.

7 Copy the directory\docs\com directory from the server where you just installed the 
WebAccess Application to the document root directory of the Web server (WebAccess 
Clustering Worksheet item 13). 

8 Restart the Web server.
9 Offline and then online the Web server to reestablish its resource group IP address.

10 Repeat Step 2 through Step 9 for each Web server node in the Web server resource group 
possible owners list (WebAccess Clustering Worksheet item 1). 

11 Continue with “Testing Your Clustered WebAccess Installation” on page 262.

28.3.6  Testing Your Clustered WebAccess Installation
Remember that the WebAccess resource group and the Web server resource group are separate 
resource groups that could fail over to different nodes at different times. 

To thoroughly test your WebAccess installation:
1 Make sure the initial combination of WebAccess resource group and Web server resource 

group is functioning properly.
2 Migrate the WebAccess resource group to each node in its possible owners list, making sure it 

functions with the initial Web server node.
3 Migrate the Web server to a different node, migrate the WebAccess resource group to each 

node in its possible owners list, then make sure each combination works.
4 Repeat Step 3 for each Web server resource group.
5 Continue with Section 28.4, “Managing WebAccess in a Cluster,” on page 262.

28.4  Managing WebAccess in a Cluster
After you have installed WebAccess in a cluster, you should consider some long-term management 
issues.

• “Updating GroupWise Objects with Cluster-Specific Descriptions” on page 262
• “Knowing What to Expect in WebAccess Failover Situations” on page 263
• “Updating the WebAccess Agent Configuration File (commgr.cfg)” on page 264

28.4.1  Updating GroupWise Objects with Cluster-Specific 
Descriptions
After installing WebAccess in your clustered GroupWise system, while the cluster-specific 
information is fresh in your mind, you should record that cluster-specific information as part of the 
GroupWise objects in ConsoleOne so that you can easily refer to it later. Be sure to update the 
information recorded in the GroupWise objects if the configuration of your system changes.

• “Recording Cluster-Specific Information about the WebAccess Agent Domain and Its MTA” 
on page 263
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• “Recording Cluster-Specific Information about the WebAccess Agent” on page 263

Recording Cluster-Specific Information about the WebAccess Agent Domain and Its 
MTA

To permanently record important cluster-specific information for the WebAccess Agent domain:
1 In ConsoleOne, browse to and right-click the Domain object, then click Properties.
2 In the Description field of the WebAccess Agent domain Identification page, provide a cluster-

specific description of the WebAccess Agent domain, including the resource group IP address 
and the cluster-unique port numbers used by its MTA. 
You might also want to include cluster-specific information about the WebAccess Application, 
such as the resource group IP address of the Web server where the WebAccess Application is 
installed.

3 Click OK to save the WebAccess domain description.
4 Select the WebAccess Domain object to display its contents.
5 Right-click the MTA object, then click Properties.
6 In the Description field of the MTA Identification page, record the WebAccess resource group 

IP address and the cluster-unique port numbers used by the MTA. 
This information appears on the MTA console, no matter which node in the cluster it is 
currently running on.

7 Click OK to save the MTA description.
8 Continue with “Recording Cluster-Specific Information about the WebAccess Agent” on 

page 263.

Recording Cluster-Specific Information about the WebAccess Agent

With the contents of the WebAccess domain still displayed:
1 Right-click the WEBAC70A object, then click Properties.
2 Click GroupWise > Identification.
3 In the Description field, record the WebAccess resource group IP address and the cluster-

unique port numbers used by the WebAccess Agent. 
This information appears on the WebAccess Agent console, no matter which node in the cluster 
it is currently running on.

4 Click OK to save the WebAccess Agent information.
5 Continue with “Knowing What to Expect in WebAccess Failover Situations” on page 263.

28.4.2  Knowing What to Expect in WebAccess Failover 
Situations
The failover behavior of the MTA for the WebAccess domain is the same as for an MTA in a regular 
domain. See “Knowing What to Expect in MTA and POA Failover Situations” on page 242.

The WebAccess Application caches users’ credentials on the node where it is running. Therefore, if 
that node fails, or if the WebAccess Application migrates to a different node, the cached credentials 
are lost. Consequently, the user needs to restart the WebAccess client in order to re-authenticate and 
re-establish the credentials.
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If the WebAccess Agent fails over or migrates, the user receives an error message that the 
WebAccess Agent is no longer available. However, after the WebAccess Agent starts in its new 
location, the WebAccess Application passes the cached user credentials to the WebAccess Agent 
and the user reconnects automatically without having to re-authenticate.

As with the MTA and the POA, migration of the WebAccess Agent takes longer than failover. 
However, the WebAccess Agent restarts quickly so that users are able to reconnect quickly.

28.4.3  Updating the WebAccess Agent Configuration File 
(commgr.cfg)
As part of installing WebAccess, the WebAccess Agent configuration file (commgr.cfg) is 
created in the following subdirectory:

domain\wpgate\webac70a

It is also automatically copied to the following Web server subdirectory:

drive:\novell\webaccess

If you change WebAccess agent configuration information (for example, if you change its IP 
address), the information is changed in the following file:

domain\wpgate\webac70a\commgr.cfg

because the domain is on the shared disk of a resource group, and it is changed in the following file:

drive:\novell\webaccess\commgr.cfg 

on the node where the WebAccess Application is currently running. However, the other nodes in the 
Web server possible owners list are not currently available for update. Therefore, you must manually 
copy the updated commgr.cfg file to the drive:\novell\webaccess subdirectory on each 
node in the Web serve possible owners list.

28.5  WebAccess Clustering Worksheet

Item Explanation

1) Resource Group for 
WebAccess Agent:

Group name:
Network name:
IP address:
Shared disk:
Share name:
MTA service resource:
WebAccess Agent service 
resource:
Possible owners:

Specify the information for the WebAccess resource group.

For more information, see “Planning the WebAccess Resource 
Group” on page 257.
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2) WebAccess Agent Domain 
Name:

Domain Directory:

Specify a unique name for the WebAccess Agent domain. Specify the 
directory on the WebAccess Agent resource group disk where you 
want to create the new domain.

For more information, see “Planning a New Domain for the 
WebAccess Agent” on page 256.

3) MTA Installation Location:

• Shared disk of WebAccess 
resource group

• Each node in the cluster

Consolidate MTA startup 
files?

Mark the location where you will install the MTA software. 

If necessary, specify the location where you will consolidate the MTA 
startup files on the shared disk of the WebAccess resource group.

For more information, see “Deciding Where to Install the WebAccess 
Agent and Its MTA” on page 258.

4) MTA Network Information:

MTA IP address:
MTA message transfer port:
MTA live remote port:
MTA HTTP port:

Gather the MTA network address information from the WebAccess 
section of the “Network Address Worksheet” on page 230.

For more information, see “Planning Cluster-Unique Port Numbers for 
the WebAccess Agent and Its MTA” on page 257.

5) WebAccess Agent Installation 
Location:

• Shared disk of WebAccess 
resource group

• Each node in the cluster

Mark the location where you will install the WebAccess Agent 
software. 

For more information, see “Deciding Where to Install the WebAccess 
Agent and Its MTA” on page 258.

6) WebAccess Agent 
Network Information:

WebAccess Agent IP address:
WebAccess Agent HTTP port:

Gather the WebAccess Agent network address information from the 
WebAccess section of the “Network Address Worksheet” on 
page 230.

For more information, see “Planning Cluster-Unique Port Numbers for 
the WebAccess Agent and Its MTA” on page 257.

7) Physical Web Servers: List the servers in the cluster where you are installing the Web server 
for use with WebAccess.

For more information, see “Setting Up Your Web Server in the 
Microsoft cluster” on page 256.

8) Web Server 
IP Address:

Record the secondary IP address for the Web server in the cluster.

For more information, see “Setting Up Your Web Server in the 
Microsoft cluster” on page 256.

9) Hardware Virtual Server 
Information:

• Dedicated IP address:

• Document root

Record the hardware virtual server information for your shared disk 
system.

For more information, see “Setting Up Your Web Server in the 
Microsoft cluster” on page 256.

Item Explanation
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29Implementing GroupWise 
Gateways in a Microsoft Cluster

A significant system configuration difference between a GroupWise® system in a clustering 
environment and a GroupWise system in a regular environment is that you need to create a separate 
domain to house each GroupWise gateway. The gateway domain should be created in its own 
resource group. This enables the gateway to fail over independently from other GroupWise 
components.

If you have set up the Internet Agent or WebAccess in your clustered GroupWise system, you should 
already have the skills necessary to set up a GroupWise gateway as well.

GroupWise gateways that have not received recent development have not been thoroughly tested in 
a clustering environment. If you are currently using such GroupWise gateways, you might want to 
leave them outside of your cluster.
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30Monitoring a GroupWise System 
in a Microsoft Cluster

GroupWise® Monitor is similar to WebAccess in that it relies on a Web server for communication 
with administrators’ Web browsers. Consequently, the setup procedure for GroupWise Monitor in a 
Microsoft cluster is similar to the setup procedure for WebAccess. If you have set up WebAccess in 
your clustered GroupWise system, you should already have the skills necessary to set up GroupWise 
Monitor as well. 

When you first install Monitor, it gathers information about agents to monitor from a domain 
database (wpdomain.db). This provides the resource group IP address of each agent. When an 
agent fails over or migrates to a different node, its status in Monitor displays as Not Listening until it 
is up and running again, at which time its status returns to Normal.

Because Monitor must use resource group IP addresses to monitor the agents in a clustered 
GroupWise system, the Discover Machine and Discover Network options do not work in a cluster. 
Resource group IP addresses cannot be obtained by examining the network itself. If you need to add 
agents to monitor, use the Add Agent option and provide the agent’s resource group IP address.

For instructions on setting up GroupWise Monitor, see “Installing GroupWise Monitor” in the 
GroupWise 7 Installation Guide.
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31Backing Up a GroupWise System 
in a Microsoft Cluster

The issues involved in backing up a GroupWise®system in a Microsoft cluster are the same as in 
backing up any GroupWise system that is running on Windows. If you want to back up your 
GroupWise system while it is running, you must use backup software that can back up open files. If 
your backup software cannot back up open files, then you must stop all GroupWise agents before 
running the backup and start them again when the backup is finished. This means that GroupWise 
users cannot be logged into their mailboxes while backups are running.

To find backup software that is compatible with GroupWise, see the Novell Partner Product Guide 
(http://www.novell.com/partnerguide).
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32Moving an Existing GroupWise 7 
System into a Microsoft Cluster

If you are adding the high availability benefits of a Microsoft cluster to a GroupWise® 7 system that 
is already up and running, the first step is to set up the cluster and review Chapter 24, “Introduction 
to GroupWise 7 and Microsoft Clusters,” on page 215 to help you apply clustering principles and 
practices to your GroupWise system. 

You do not need to transfer your entire GroupWise system into the cluster all at once. You could 
transfer individual post offices where the needs for high availability are greatest. You could transfer 
a domain and all of its post offices at the same time. You might decide that you don’t need to have all 
of your GroupWise system running in the cluster. 

This section provides a checklist to help you get started with moving your GroupWise system into a 
Microsoft cluster:

Decide which shared disks you will use for GroupWise administration (ConsoleOne® and the 
software distribution directory).
Decide which shared disks you will use for GroupWise domains and post offices.
Plan the resource groups for domains and post offices.
Review Chapter 25, “Planning GroupWise in a Microsoft Cluster,” on page 217. Fill out the 
“System Clustering Worksheet” on page 228 to help you decide which domains and post 
offices you will move to which shared disks.
Review “Planning Cluster-Unique Port Numbers for Agents in the Cluster” on page 223 and 
fill out the “Network Address Worksheet” on page 230 to record resource group IP addresses 
and to specify cluster-specific port numbers for all of your GroupWise agents.
Select the first shared disk that will be part of your clustered GroupWise system and set up the 
resource group for it, following the instructions in “Creating GroupWise Resource Groups” on 
page 233 and “Configuring Short Name Resolution” on page 233.
Move a domain and/or post office onto the shared disk, following the instructions in “Moving a 
Domain” in “Domains” or “Moving a Post Office” in “Post Offices” in the GroupWise 7 
Administration Guide.

Review Section 25.8, “Deciding How to Install and Configure the Agents in a Cluster,” on 
page 223, fill out the “Agent Clustering Worksheet” on page 231, and install the agents as 
needed for the first clustered domain and/or post office, following the instructions in Section 
26.5, “Installing and Configuring the MTA and the POA in a Cluster,” on page 238. 
Test the first component of your clustered GroupWise system following the instructions in 
Section 26.6, “Testing Your Clustered GroupWise System,” on page 240.
Take care of the cluster management details described in Section 26.7, “Managing Your 
Clustered GroupWise System,” on page 240.
Move more domains and post offices into the cluster as needed. If you have GroupWise 
libraries, see Section 25.4, “Planning a New Library for a Clustered Post Office,” on page 220.
Move GroupWise administration into the cluster as needed.
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Add other components to your clustered GroupWise system as needed, following the 
instructions in:

• Chapter 27, “Implementing the Internet Agent in a Microsoft Cluster,” on page 245
• Chapter 28, “Implementing WebAccess in a Microsoft Cluster,” on page 255.
• Chapter 29, “Implementing GroupWise Gateways in a Microsoft Cluster,” on page 267
• Chapter 30, “Monitoring a GroupWise System in a Microsoft Cluster,” on page 269
• Chapter 31, “Backing Up a GroupWise System in a Microsoft Cluster,” on page 271
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33Implementing Messenger in a 
Microsoft Cluster

Novell® Messenger does not require the existence of a GroupWise® system in your Microsoft 
cluster, but presumably one has already been set up as described in Chapter 25, “Planning 
GroupWise in a Microsoft Cluster,” on page 217 and Chapter 26, “Setting Up a Domain and Post 
Office in a Microsoft Cluster,” on page 233. As part of the process of setting up GroupWise in your 
cluster, you filled out the “System Clustering Worksheet” on page 228. Some of the information 
from this worksheet will be helpful as you implement Messenger in your cluster.

• Section 33.1, “Planning Your Messenger System in a Cluster,” on page 275
• Section 33.2, “Setting Up Your Messenger System in a Cluster,” on page 278
• Section 33.3, “Messenger Clustering Worksheet,” on page 279

33.1  Planning Your Messenger System in a 
Cluster
Because the Messenger agents are not associated with GroupWise domains or post offices, the 
Messenger agents are easier to implement in a cluster than are the GroupWise agents. Section 33.3, 
“Messenger Clustering Worksheet,” on page 279 lists all the information you need as you set up the 
Messenger agents in a clustering environment. You should print the worksheet and fill it out as you 
complete the tasks listed below:

• “Understanding Your Cluster” on page 275
• “Planning Messenger Administration” on page 275
• “Deciding Where to Install the Messenger Agent Software” on page 276
• “Planning the Messenger Agent Installation” on page 277

33.1.1  Understanding Your Cluster
Fill out items 1 and 2 in Section 33.3, “Messenger Clustering Worksheet,” on page 279 with 
information about your cluster. This information corresponds to items 1 and 2 on the “System 
Clustering Worksheet” on page 228 that you filled out for GroupWise. For background information, 
see Section 25.1, “Setting Up Your Microsoft Cluster,” on page 218.

33.1.2  Planning Messenger Administration
If you have set up a shared disk for GroupWise administration, as described in Section 25.6, 
“Planning Shared Administrative Resources,” on page 221, you can use the same shared disk for the 
Messenger administration files. For example, you might want to have a shared disk where you 
install the Messenger snap-in to ConsoleOne® instead of installing it to multiple administrator 
workstations.
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33.1.3  Deciding Where to Install the Messenger Agent Software
In a Microsoft cluster, the Messenger agents must run as Windows services. When you install the 
Windows Messenger Agents, you can choose between two different installation locations:

Table 33-1   Messenger Agent Software Installation Locations

Because the Messenger agents must be installed as Windows services in a Microsoft cluster, you 
must initially run the Messenger Installation program for each node in the cluster so that the 
Windows services for the agents get created, regardless of where you are planning to run the 
Messenger agents from. However, for updates, you need to run the Messenger Installation program 
only once if you are running the Messenger agents from a shared disk. 

Continue with the planning instructions for the installation location you want to use:

• “Planning the Messenger Agents on Each Node in the Cluster” on page 276
• “Planning the Messenger Agents on a Shared Disk” on page 277

Planning the Messenger Agents on Each Node in the Cluster

Make sure you have filled out item 2 on the Messenger Clustering Worksheet with a complete list of 
nodes in the cluster where you need to install the Messenger agents. Continue with “Planning the 
Messenger Agent Installation” on page 277.

MESSENGER CLUSTERING WORKSHEET

Under Item 5: Installation Location for Messenger Administration, mark whether you want to install 
the Messenger snap-in to ConsoleOne to administrator workstations or to a shared disk.

If you plan to install the Messenger snap-in to ConsoleOne to a shared disk, under Item 6: Resource 
for Messenger Administration, list the network name and IP address of the shared disk, the physical 
disk name and file share for mapping to it, and the nodes in the cluster that it could fail over to.

Location Description

Each node in the 
cluster

The c:\novell\nm directory is the default installation location provided by the 
Messenger Installation program.

Shared disk If you create a drive:\novell\nm directory on a shared disk, the Messenger 
agent software and startup files fail over and fail back along with supporting files 
such as the Messenger archive.

IMPORTANT: You must install to a shared disk if you do not want a separate 
Messenger archive to be created on each node where the Archive Agent runs. 
If you do not want to use a shared disk, you should plan to install the Archive 
Agent separately outside the cluster.

MESSENGER CLUSTERING WORKSHEET

Under Item 3: Installation Location for Messenger Agents, mark whether you want to install the 
Messenger agent software to each node in the cluster or to a shared disk.
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Planning the Messenger Agents on a Shared Disk

If you do not anticipate a large Messenger archive, you can use one Messenger shared disk. If you 
anticipate archiving a large number of messages so that the Messenger archive grows very large, you 
might want to have a separate Messenger shared disk for the Archive Agent and the archive 
database. The steps in this section cover setting up the Messenger agents on a single shared disk.

Continue with “Planning the Messenger Agent Installation” on page 277.

33.1.4  Planning the Messenger Agent Installation
Aside from the cluster-specific issues discussed in the preceding sections, the considerations 
involved in planning to install the Messenger agents are the same in a clustering environment as for 
any other environment. Review “Planning Your Novell Messenger System”, then print and fill out 
the “Novell Messenger Worksheet” in “Installing a Novell Messenger System” in the Messenger 2.0 
Installation Guide. Transfer the following information from the Messenger Clustering Worksheet to 
the Messenger System Worksheet:

• For Item 3: Installation Path on the Messenger System Worksheet: 
• If you are installing the Messenger agents to each node in the cluster, use 
c:\novell\nm.

• If you are installing the Messenger agents to a shared disk, use drive:\novell\nm 
where drive is the shared disk from Item 4: Resource Group for Messenger Agents on the 
Messenger Clustering Worksheet.

• Under Item 12: Server Address on the Messenger System Worksheet:
• If you are installing the Messenger agents to each node in the cluster, use the cluster IP 

address from Item 1: Cluster Identification on the Messenger Clustering Worksheet.
• If you are installing the Messenger agents to a shared disk, specify the Messenger resource 

group IP address from Item 4: Resource Group for Messenger Agents on the Messenger 
Clustering Worksheet.

• Under Item 13: Configure Agents for Clustering? on the Messenger System Worksheet, mark 
No. This applies to the Messenger Agents running with Novell Cluster ServicesTM, not in a 
Microsoft cluster. 

• Under Item 14: Admin Configuration on the Messenger System Worksheet:
• If you are installing the Messenger snap-in to ConsoleOne to an administrator 

workstation, use the location where ConsoleOne is already installed (typically 
c:\novell\consoleone\version_number).

• If you are installing the Messenger snap-in to ConsoleOne to a shared disk, use 
drive:\directory, where drive is the shared disk from Item 6: Resource for 
Messenger Administration on the Messenger Clustering Worksheet and directory is 
typically c:\novell\consoleone\version_number.

Continue with Section 33.2, “Setting Up Your Messenger System in a Cluster,” on page 278.

MESSENGER CLUSTERING WORKSHEET

Under Item 4: Resource Group for Messenger Agents, plan the network name and IP address of the 
resource group, the physical disk and share name for mapping to it, the agent service names, and the 
nodes in the cluster where the Messenger resource group can fail over.
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33.2  Setting Up Your Messenger System in a 
Cluster
You should have already reviewed Section 33.1, “Planning Your Messenger System in a Cluster,” on 
page 275 and filled out Section 33.3, “Messenger Clustering Worksheet,” on page 279 and the 
“Novell Messenger Worksheet” in the Messenger 2.0 Installation Guide. Follow the instructions for 
the installation location you have chosen:

• “Installing the Messenger Agents to Each Node in the Cluster” on page 278
• “Installing the Messenger Agents to a Shared Disk” on page 278

33.2.1  Installing the Messenger Agents to Each Node in the 
Cluster

1 Follow the steps provided in “Starting the Messenger Installation Program” and “Creating Your 
Messenger System” in “Installing a Novell Messenger System” in the Messenger 2.0 
Installation Guide for each node in the cluster. 

2 After you have installed the software to each node in the cluster, if you selected Yes for 
Consolidate Startup Files? (under Messenger Clustering Worksheet item 3), copy the 
Messenger agent startup files to the planned location on the shared disk, then delete them from 
the c:\novell\nm\ma and c:\novell\nm\aa directories on each node to avoid future 
confusion.

3 Make each node in the cluster active to make sure that the Messenger agents start successfully 
on each node.

4 Continue setting up your Messenger system following the instructions in “What's Next” in 
“Installing a Novell Messenger System” in the Messenger 2.0 Installation Guide.

33.2.2  Installing the Messenger Agents to a Shared Disk
Complete the following tasks to set up your Messenger system on a shared disk:

• “Setting Up the Messenger Resource Group” on page 278
• “Running the Messenger Installation Program” on page 278
• “Testing the Clustered Messenger Agents” on page 279

Setting Up the Messenger Resource Group
1 Create the Messenger resource group and agent services resources (Messenger Clustering 

Worksheet item 4), as planned in “Planning the Messenger Agents on Each Node in the 
Cluster” on page 276.

2 To ensure successful short name resolution, add entries for the Messenger network name to 
support your preferred methods of short name resolution, as described in “Configuring Short 
Name Resolution” on page 233.

3 Continue with “Running the Messenger Installation Program” on page 278.

Running the Messenger Installation Program
1 If necessary, map a drive to the shared disk for Messenger administration (Messenger 

Clustering worksheet item 6) where you will install the Messenger snap-ins to ConsoleOne.
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2 Map a drive to the shared disk of the Messenger resource group (Messenger Clustering 
Worksheet item 4) where you will install the Messenger agent software.

3 Map a drive to c:\ on the first node in the cluster (Messenger Clustering Worksheet item 2) 
where you will set up the Messenger agents as a Windows services.

4 Start the Messenger Installation program, following the steps provided in “Setting Up Your 
Novell Messenger System” in “Installing a Novell Messenger System” in the Messenger 2.0 
Installation Guide.

5 Install the Windows Messenger agents, keeping in mind the following cluster-specific details:

• Use the Novell Messenger System Worksheet that you filled out in “Planning the 
Messenger Agent Installation” on page 114 to fill in the fields during the Messenger 
installation process. 

• When you specify the Messenger installation directory, be sure to browse to the location 
through the drive mapped in Step 2 above.

• When you specify the ConsoleOne directory, be sure to browse to the location through the 
drive mapped in Step 1 above.

• On the Setup Complete page, do not select Launch Agents Now.
6 Repeat Step 4 and Step 5, mapping a drive to each node in the cluster.

Initially, you need to repeat the installation process for each node so that the Messenger agents 
are set up as Windows services on each node. For updates, you need to install only once to the 
shared disk.

7 Continue with “Testing the Clustered Messenger Agents” on page 279.

Testing the Clustered Messenger Agents

After you have set up the Messenger agents on a shared disk in your Microsoft cluster, you can test 
them by manually bringing the Messenger resource group online and taking it offline again.

Continue setting up your Messenger system following the instructions in “What's Next” in 
“Installing a Novell Messenger System” in the Messenger 2.0 Installation Guide

33.3  Messenger Clustering Worksheet

Item Explanation

1) Cluster Identification:

Cluster name:
Cluster IP address:

Record the name and IP address of your Microsoft cluster.

For more information, see Section 25.1, “Setting Up Your 
Microsoft Cluster,” on page 218.

2) Nodes in Cluster: List the servers that are included in your Microsoft cluster.

For more information, see Section 25.1, “Setting Up Your 
Microsoft Cluster,” on page 218.
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3) Installation Location for Messenger 
Agents:

• Each node in the cluster
Consolidate startup files?

• Shared disk

Mark the location where you will install the Messenger agent 
software.

For more information, see “Deciding Where to Install the 
Messenger Agent Software” on page 276.

4) Resource Group for Messenger 
Agents

Network name:
IP address:
Physical disk:
File share:
Messaging Agent service:
Archive Agent service:
Possible owners:

If you plan to install the Messenger agent software to a shared 
disk, provide the information about the shared disk you want to 
use.

For more information, see “Planning the Messenger Agents on 
a Shared Disk” on page 277.

5) Installation Location for Messenger 
Administration:

• Administrator workstation(s)

• Shared disk

Mark the location where you want to install the Messenger 
snap-in to ConsoleOne. 

For more information, see “Planning Messenger 
Administration” on page 275.

6) Resource for Messenger 
Administration:

Network name:
IP address:
Physical disk:
File share:
Possible owners:

If you want to install the Messenger snap-in to ConsoleOne to 
a shared disk, provide the required information about the 
shared disk you want to use.

For more information, see Section 25.6, “Planning Shared 
Administrative Resources,” on page 221.

7) IP Address Resolution Methods:

• eDirectory

• hosts file

• DNS

Mark the short name address resolution methods you want to 
implement to ensure that the UNC paths stored in ConsoleOne 
with network names can be successfully resolved into physical 
network addresses.

For more information, see Section 25.7, “Ensuring Successful 
Name Resolution for GroupWise Resource Groups,” on 
page 221. 

Item Explanation
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VNon-GroupWise Clients

If your users already have a common POP, IMAP, or SOAP e-mail client that comes with Linux or 
Windows, they can continue to use it to access their GroupWise® mailboxes. Users of non-
GroupWise® e-mail clients retain the feature sets of their familiar e-mail clients, but many 
GroupWise features are not available to such users because they are not offered in POP, IMAP, and 
SOAP e-mail clients. 

If your users have a mobile device (Palm* OS* or Pocket PC) and want to synchronize it with 
GroupWise, they can accomplish this by using GroupWise PDA Connect 1.0. In addition, there are 
several third-party tools available from third-party partners. 

• Chapter 34, “Outlook Express,” on page 283
• Chapter 35, “Microsoft Outlook,” on page 285
• Chapter 36, “Evolution,” on page 287
• Chapter 37, “Mobile Devices,” on page 291
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34Outlook Express

The GroupWise® Internet Agent is required in order for users to access their mailboxes using non-
GroupWise clients. If you have not already installed the Internet Agent, follow the instructions in the 
GroupWise 7 Installation Guide.

In order for users to access their GroupWise mailboxes from a third-party e-mail client, they must 
configure their e-mail clients to access their GroupWise accounts. For example, Outlook* Express 
users would follow steps similar to the following:

NOTE: Steps might vary depending on the versions of Windows and Outlook Express installed on 
the workstation.

1 In Outlook Express, click Tools > Accounts > Add > Mail.
2 Follow the prompts and provide personal information until you are prompted for the e-mail 

server information.

3 Select POP3 or IMAP as your incoming mail server type.
4 In the Incoming and Outgoing Mail fields, specify the IP address or hostname of your outgoing 

mail server, then click Next.
5 Continue following the prompts and providing personal information until the new account has 

been set up in Outlook Express.
6 Click Tools > Accounts.
7 Select the new account you just created, then click Properties > Servers.
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8 Select My Server Requires Authentication, then click OK.
The default setting for server authentication is Use Same Settings as My Incoming Mail Server, 
so you do not need to change any settings.

9 To access your GroupWise mailbox in Outlook Express, click Tools > Send and Receive.
10 Click the IP address or hostname of your mail server.
11 Provide your username and password, then click OK.
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35Microsoft Outlook

The GroupWise® Internet Agent is required in order for users to access their mailboxes using non-
GroupWise clients. If you have not already installed the Internet Agent, follow the instructions in the 
GroupWise 7 Installation Guide, available on the GroupWise 7 Documentation Web site (http://
www.novell.com/documentation/gw7).

If your users have been using the Microsoft Outlook e-mail client that comes with Microsoft Office, 
they can continue to use POP or IMAP in it to access their GroupWise mailboxes.

In order for users to access their GroupWise mailboxes from Outlook, they must configure Windows 
to access their GroupWise accounts. For example, Outlook users would follow steps similar to the 
following.

NOTE: Steps might vary depending on the versions of Windows and Outlook installed on the 
workstation.

1 In the Windows Control Panel, double-click Mail.
2 Click Show Profiles > Add to add a new profile for your GroupWise account.
3 Type a name for the new profile, the click OK.
4 Select Add a New E-Mail Account, then click Next. 

5 Select POP3 or IMAP as your incoming mail server type, then click Next.
Microsoft Outlook 285
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6 Provide the e-mail account settings for the type of server you selected.
7 Click Test Account Settings to make sure that you have provided the information correctly.
8 Click Next, then click Finish.

You can now access your GroupWise mailbox using Microsoft Outlook by selecting the profile you 
just created. 

For additional functionality, you can install the GroupWise Connector for Microsoft Outlook, 
available along with the GroupWise client from the Novell Product Downloads site (http://
download.novell.com). For more information, see the GroupWise Connector for Microsoft Outlook 
Quick Start on the GroupWise 7 Documentation Web site (http://www.novell.com/documentation/
gw)
7 Interoperability Guide
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36Evolution

EvolutionTM makes the tasks of storing, organizing, and retrieving your personal information easy, so 
you can work and communicate more effectively with others. It’s a highly evolved groupware 
program, an integral part of the Internet-connected desktop.

Evolution can help you work in a group by handling e-mail, address, and other contact information, 
and one or more calendars. It can do that on one or more computers, connected directly or over a 
network, for one person or for large groups.

With Evolution, you can accomplish your most common daily tasks quickly. For example, it takes 
only one or two clicks to enter appointment or contact information sent to you by e-mail, or to send 
e-mail to a contact or appointment. People who get lots of e-mail will appreciate advanced features 
like vFolders, which let you save searches as though they were ordinary e-mail folders.

If you have Evolution 2.4 installed, you can access accounts on Novell® GroupWise® 7.

• Section 36.1, “GroupWise Features Available in Evolution,” on page 287
• Section 36.2, “Configuring Evolution,” on page 288

36.1  GroupWise Features Available in Evolution
Evolution connecting to GroupWise supports the following basic GroupWise features: 

• Mail 
• View mail and folders stored on the GroupWise system.
• Send mail from you GroupWise account.
• Convert mail to a task or meeting.

• Calendar 
• Send and receive appointment and meeting requests. Allows Evolution users to schedule 

meetings and view attendee availability for other users on GroupWise.
• Receive an iCalendar meeting request and add it to your calendar. It is saved to your 

GroupWise calendar.
• Contacts 

• Address Completion is supported for your GroupWise address books, including the 
corporate address book, the Frequent Contacts address book, and your personal address 
book.

• Adding vCards to the Address Book. If you receive a vCard attachment and click Save in 
Address Book, it is saved to your Personal address book. New Address Book entries can be 
added to your Personal address book from received e-mail messages with a single click.

• Proxy
• Assign Proxy access to other users.
• View other users’ accounts through Proxy access.
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36.2  Configuring Evolution
In order for users to access their GroupWise mailboxes from Evolution, they must configure 
Evolution to access their GroupWise accounts.

1 Click Edit > Preferences, then click Mail Accounts.
2 Click Add.
3 On the Identity page, type your e-mail address, then click Forward.

4 On the Receiving Mail page, select Novell GroupWise as your server type. 
5 Type the name of your mail server, your user name, and select whether to use SSL.
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6 Click Forward.
7 On the Receive Options page, select if you want Evolution to automatically check for new 

mail.
If you select this option, you need to specify how often Evolution should check for new 
messages.

8 Select if you want to check for new messages in all folders.
9 Select if you want to apply filters to new messages in the Inbox on the server.

10 Select if you want to check new messages for junk content.
11 Select if you want to only check for junk messages in the Inbox folder.
12 Select if you want to automatically synchronize remote mail locally.
13 Type your Post Office Agent SOAP port number in the Post Office Agent SOAP Port field, then 

click Forward.
If you are unsure of what your Post Office Agent SOAP port number is, contact your system 
administrator.

14 On the Account Management page, type the name for the account, then click Forward.
15 Click Apply.
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37Mobile Devices

If you own a mobile device (Palm OS or Pocket PC), you can synchronize it with GroupWise® using 
GroupWise PDA Connect 1.0. GroupWise PDA Connect is designed to work on a Windows 
computer to synchronize data between GroupWise and a PDA device. It is comprised of a 
synchronization engine and translators, which are used for seamless integration with the data 
source’s features and data.

• Section 37.1, “Prerequisites,” on page 291
• Section 37.2, “Downloading the Software,” on page 291
• Section 37.3, “Third-Party Partners,” on page 291

37.1  Prerequisites
Before installing GroupWise PDA Connect 1.0:

• Ensure that Microsoft ActiveSync* is installed for the Pocket PC or Palm HotSync* Manager 
is installed for the Palm OS.

• Ensure that you are not synchronizing anything in Outlook (such as e-mail, calendar, tasks, or 
notes) in either ActiveSync or PocketMirror*.

37.2  Downloading the Software
GroupWise PDA Connect 1.0 is available for download at the Novell Product Downloads Web site 
(http://download.novell.com/pages/PublicSearch.jsp).

The download is an executable (.exe) file.
1 Select GroupWise as the product, then click Submit Search.
2 Click GroupWise PDA Connect 1.0.
3 Click the filename (setup.exe), then follow the instructions to download the file.
4 Click Start > Run > Browse. 
5 Select the setup.exe file on the local or network drive.
6 Click OK to run the GroupWise PDA Connect Installation program.
7 Follow the on-screen instructions provided in the GroupWise PDA Connect Installation to 

install the software.

37.3  Third-Party Partners
Novell partners with several third-party companies for synchronization of mobile devices. A 
complete list of the third-party partners can be found in the Novell Partner Product Guide (http://
www.novell.com/partnerguide).
Mobile Devices 291
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VIOther Third-Party Products

• Chapter 38, “Unsupported Web Servers,” on page 295
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38Unsupported Web Servers

The GroupWise® WebAccess Installation program installs the WebAccess and WebPublisher 
Applications to the Web servers listed in “WebAccess System Requirements” in “Installing 
GroupWise WebAccess” in the GroupWise 7 Installation Guide. These are the Web servers for 
which Novell® Support provides support.

You can manually set up WebAccess to work with other Web servers and servlet engines by 
completing the following tasks:

• Chapter 38.1, “Installing WebAccess to Unsupported Web Servers,” on page 295
• Chapter 38.2, “Configuring WebAccess to Use a Java Servlet Engine Other Than the Tomcat 

Servlet Engine,” on page 296

38.1  Installing WebAccess to Unsupported Web 
Servers
If necessary, you can run the WebAccess and WebPublisher Applications on an unsupported Web 
server as long as the Web server supports a Java servlet engine that is JSDK 2.0 and JDK* 1.1.6 
compatible. However, the Installation program does not install the applications to other Web servers, 
which means you must manually install and configure them. When you run the Installation program, 
deselect the options to install the WebAccess Application and WebPublisher Application, install the 
WebAccess Agent, then complete the following steps to install the applications:

1 Unzip webaccess.zip to the root of the network server volume where the Web server 
resides. 
The webaccess.zip file and the ZIP files referred to in the next three steps are in the 
\internet\webacces\other directory of the GroupWise Administrator CD.

2 Unzip webaccessdocs.zip to the Web server’s document root directory.
3 Unzip webaccessservlets.zip to the servlet root directory.
4 Unzip webaccessjars.zip to a library or jar file directory on the network server (for 

example, you might want to create a \novell\lib directory), then add the jar files 
(ldapfilt.jar, ldapjdk.jar, njgwap.jar, njweb.jar, spellservlet.jar, 
xalan.jar, and xerces.jar) to the class path.

5 Modify your Java engine’s servlet properties file to include the settings provided in the sample 
WebAccess servlets.properties file. 
The WebAccess servlet.properties file is located in the 
\internet\webacces\other directory of the GroupWise Administrator CD.

6 Modify the Templates.path setting in the webacc.cfg and webpub.cfg files, located in the 
\novell\webaccess and \novell\webpublisher directories, to replace java/
servlets with the path to the servlet root directory.

7 If you created the \novell directory structure in the location specified in Step 4 (the root of 
the volume where the Web server resides), the paths for the following settings in the 
webacc.cfg and webpub.cfg should already be correct. If not, you need to modify the 
paths to make them correct from the perspective of the Web server.
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File.Upload.path
Log.path
Security.Timeout.path
Provider.GWAP.Config.file
Provider.LDAP.Config.file (webacc.cfg only)

8 Copy the index.html file to the Web server’s document root directory. 
You can replace your Web server’s current default home page with this file, or you can rename 
the file and link to it from your current default home page.

9 Copy the commgr.cfg file, located in the WebAccess gateway home directory 
(domain\wpgate\webac70a), to the \novell\webaccess directory and the 
\novell\webpublisher directory.

38.2  Configuring WebAccess to Use a Java 
Servlet Engine Other Than the Tomcat Servlet 
Engine
If you use a Java servlet engine other than the Tomcat servlet engine, the servlet engine needs to be 
JSDK 2.0 and JDK 1.1.6 compatible.

After you’ve installed WebAccess, complete the following steps to configure WebAccess to work 
with the Java servlet engine:

1 Modify the Java servlet engine’s servlet properties file to include the settings provided in the 
sample WebAccess servlets.properties file. 
The sample servlets.properties file is located in the 
\internet\webacces\other directory of the GroupWise Administrator CD.

2 In the webacc.cfg and webpub.cfg files, modify the Templates.path setting to replace 
java/servlets with the path to the servlet root directory. 
The files are located in the novell\webaccess and novell\webpublisher directories 
on the root of the server.

3 Add the WebAccess jar files (ldapfilt.jar, ldapjdk.jar, njgwap.jar, 
njweb.jar, spellservlet.jar, xalan.jar, and xerces.jar) to the class path. 
The location of the jar files varies by platform:

NetWare: java\lib

Windows: novell\java\lib
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This section lists updates to the Interoperability Guide that have been made since the initial release 
of Novell® GroupWise® 7. The information helps you to keep current on documentation updates 
and, in some cases, software updates (such as a Support Pack release).

The information is grouped according to the date when the Interoperability Guide was republished. 
Within each dated section, the updates are listed by the section title.

The GroupWise 7 Interoperability has been updated on the following dates:

• Section A, “November 30, 2005,” on page 299
Documentation Updates 297
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Location Change

Novell exteNd 

Chapter 23, “Novell exteNd,” 
on page 211

Added information about Novell® exteNdTM compatibility with 
GroupWise® WebAccess and provided a link to the exteNd 
documentation that explains how to configure exteNd for use with 
GroupWise.

Entire Guide Page design reformatted to comply with revised Novell documentation 
standards.
November 30, 2005 299
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